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Chapter 1 : 

Introduction 

  

What is Finite Element Analysis? 

Until the advent of computers, the only way to find the answer to the engineering question 

"What would happen if I did this to my new design?" was to build a prototype and carry out 

the necessary tests. Today computers allow designs to be assessed much more quickly and 

easily. Evaluating a complex engineering design by exact mathematical models, however, is 

not a simple process. 

Since we cannot calculate the response of a complex shape to any external loading, we must 

divide the complex shape up into lots of smaller simpler shapes. These are the finite elements 

that give the method its name. The shape of each finite element is defined by the coordinates 

of its nodes. Adjoining elements with common nodes will interact. 

Engineering Problem 
   

Finite Element Model 

 

  

 

The real engineering problem responds in an infinite number of ways to external forces. The 

manner in which the Finite Element Model will react is given by the degrees of freedom, 

which are expressed at the nodes. For example, a three-dimensional solid element has three 

degrees of freedom at each node representing the three global directions in which it may 

move. 

Since we can express the response of a single Finite Element to a known stimulus we can 

build up a model for the whole structure by assembling all of the simple expressions into a set 
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of simultaneous equations with the degrees of freedom at each node as the unknowns. These 

are then solved using a matrix solution technique. 

For a mechanical analysis, once the displacements are known the strains and stresses can be 

calculated. For a thermal analysis, the gradients and fluxes can be calculated from the 

potentials. 

Finite Element Analysis with LUSAS 

Finite element analysis using LUSAS software involves three stages.  

1. Creating the finite element model 

2. Running the analysis 

3. Viewing the results 

      

Each LUSAS software package consists of: 

 LUSAS Modeller a fully interactive graphical user interface for modelling and 

viewing of results 

 LUSAS Solver a powerful finite element analysis system 

Modelling 

Modelling involves creating a geometric representation of the structure, assigning attributes 

and outputting the information as a formatted data file (.dat) suitable for processing by 

LUSAS Solver. See Using LUSAS for a quick introduction to the LUSAS Modeller interface. 

Creating a Model 

A model is a graphical representation consisting of Geometry (Points, Lines, Surfaces and 

Volumes) and Attributes (Materials, Loading, Supports, Mesh, etc.). The model is created by 

Defining the Geometry and Attributes and Assigning  the Attributes to the Geometry. 

Geometry can be defined by entering coordinates, selecting Points on the screen, by using 

utilities such as transformations or by importing it from a CAD system. Attributes are first 

defined and then assigned to selected features. 

To complete a model it may be necessary to define analysis control data. This is used to 

control the progress of an advanced analysis. 

Running the Analysis 

Once a model has been created click on the solve button  to begin the analysis. LUSAS 

creates a data file from the model, solves the stiffness matrix, and produces a results file. The 

results file will contains some or all of the following data: 
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 Stresses 

 Strains 

 Displacements 

 Velocities 

 Accelerations 

 Residuals 

 Reactions 

 Yield flags 

 Potentials 

 Fluxes 

 Gradients 

 Named variables 

 Strain energy 

Viewing the Results 

This involves using a selection of tools for viewing the results file produced from the 

analysis. Many different ways of viewing results are supported: 

 Undeformed/Deformed Mesh Plots 

 Contours (Averaged and Unaveraged) 

 Vectors 

 Diagrams (Bending Moments and Forces) 

 Animated Display of Modes/Load Increments 

 Sections (Lines and Slices) 

 Yield Flag Display 

 Graphing 

 Printed Output 

What Help and Documentation is Provided? 

Comprehensive documentation is provided with LUSAS. Some is available in the form of 

printed manuals, whilst some is only available in electronic format. 

The documentation includes: 

 Installation Guide 

 Getting Started Guide 

 Modeller Reference Manual 

 Examples Manual 

 Application Examples Manual (Bridge, Civil & Structural) 

 Application Manual (Bridge, Civil & Structural) 

 Autoloader Reference Manual 

 IMDPlus User Manual 

 Rail Track Analysis User Manual 

 Element Reference Manual 

 Solver Reference Manual 
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 Theory Manual (Volume 1 and 2) 

 Verification Manual 

 CAD Toolkit User Manual 

 LUSAS Programmable Interface (LPI) 

 Glossary 

Installation Guide 

 Details of installing LUSAS software for various licensing options. 

 Available in PDF and printed form. 

Getting Started Guide 

 Contains a brief overview of LUSAS. 

 Available in PDF and printed form. 

Modeller Reference Manual 

 Provides detailed reference material for modelling and results viewing with LUSAS 

Modeller. 

 Provided in on-line help format and also available in PDF and printed form. 

Examples Manual  

 Contains general worked examples to help you get up to speed with modelling, 

analysis and viewing of results for a range of different analysis types. 

 Available in PDF and printed form. 

Application Examples Manual (Bridge, Civil & Structural) 

 Contains application specific worked examples to help you get up to speed with 

modelling, analysis and viewing of results for a range of different analysis types. 

 Available in PDF and printed form. 

Application Manual (Bridge, Civil & Structural) 

 Describes the bridge, civil and structural application specific features of LUSAS and 

their uses. 
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 Available in PDF and printed form. 

Autoloader Reference Manual 

 Provides detailed reference material for Autoloader, a bridge loading optimisation 

module for use with LUSAS. 

 Available in PDF form. 

IMDPlus User Manual 

 Contains details of how to carry out multiple loading events with advanced loading 

conditions for two main uses: seismic response analysis of structures subjected to 

acceleration time histories of support motion, and for the analysis of 3D structures, 

such as bridges, subjected to constant moving vehicle or train loads.  

 Provided in on-line help format and also available in PDF and printed form. 

Rail Track Analysis User Manual 

 Provides detailed reference material for the Rail Track Analysis option which permits 

track/bridge interaction analysis to the International Union of Railways Code UIC 

774-3. 

 Available in PDF form. 

Element Reference Manual 

 Contains full element specifications. This is the place to go to find out which 

functionality your elements support and what output you will obtain from your 

element selection. 

 Provided in on-line help format and also available in PDF and printed form. 

Solver Reference Manual 

 The data files required by the LUSAS Solver can be edited directly with a text editor. 

This manual contains full details of the data syntax supported by LUSAS Solver. 

 Available in PDF and printed form. 
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Theory Manuals (Volume 1 and 2) 

 These contain more detailed theoretical information for the more experienced user. 

They cover topics specific to LUSAS and where appropriate list references to other 

publications. The topics covered include: 

 Analysis procedures including: linear, nonlinear, dynamics, eigenvalue 

extraction, modal analysis, all forms of field analysis, fourier analysis and 

superelement analysis. 

 Geometric nonlinearity. 

 Constitutive material model formulations. 

 Loads and boundary conditions with particular reference to general load types, 

constraint equations, slidelines and thermal surfaces. 

 More complex post processing calculations, including nodal extrapolation and 

calculation of Wood Armer reinforcement moments. 

 Element formulation theory. 

 Available in PDF and printed form. 

Verification Manual 

 A manual of LUSAS testcase examples benchmarked against known solutions. 

 Available in PDF form only. 

CAD Toolkit User Manual 

 Describes interfaces to LUSAS involving the use of external pre- and post-processing 

packages. 

 Provided in PDF form only. 

LUSAS Programmable Interface (LPI) 

 Provides information for application programmers wishing to customise the LUSAS 

environment or interface LUSAS with other applications. 

 Provided in on-line help format only. This can be accessed from the Start > All 

Programs > LUSAS > LUSAS Help menu. 



  Chapter 1 

    

7 

Glossary 

 Contains definitions of general terms used in all manuals. 

 Provided in on-line help format. Included in the Modeller Reference Manual. 
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Chapter 2 : Using 

Modeller 

  

Welcome to LUSAS Modeller 

LUSAS Modeller is an easy to use Windows-based finite element modelling system. 

Creating a Model 

In LUSAS Modeller two types of models can be created: 

 Feature-based geometry models - these comprise geometry features (points, lines, 

surfaces, volumes etc.), that are created either by using a whole range of tools under 

the Geometry menu, or the buttons on the Toolbars, or by importing third-party data 

that is supported  

 Mesh-only models - these comprise only elements (and their associated nodes, edges 

and faces) and are created by importing only those types of LUSAS or third party data 

that are supported. 

To both types of model attributeswhich describe the properties of the model (materials, 

thicknesses, loading, supports, mesh, etc.) are assigned. Attributes are defined from the 

Attributes menu. Once defined, attributes are listed in the Attributes  Treeview 

Treeview 

The Treeview is used to organise various aspects of the model in a graphical frame. It has six 

panels each with a Treeview showing Layers , Groups , Attributes , Loadcases  , 

Utilities  and Reports  respectively. The Treeviews use drag and drop functionality. For 

example, an attribute in the  Treeview can be assigned to geometry by dragging the 

attribute onto the previously selected object. 
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LUSAS Modeller Interface 

Context Menu 

Although commands can be accessed from the main menu, pressing the right-hand mouse 

button with an object selected in the Graphics Window usually displays a context menu 

which provides access to relevant operations. In addition, most items in the various Treeview 

panels also have a context menu which provides access to additional functionality such as 

editing of data, control of visibility, visualisation of assignments, and selective control of 

results plotting on selected attributes. 

Properties 

General information relating to a model is presented in property dialogs. Properties may 

relate to the whole model or the current window, or a single geometric feature - in fact most 

objects have properties. To view an object‟s properties, select it, press the right mouse button, 

then choose Properties from the context menu. 

Status Bar 

The Status Bar displays progress messages and help text during a modelling session, the 

model units, the current cursor position in model units (if the model is displayed in an 
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orthogonal plane) and the item or number of items in the current selection.  The View> 

Status Bar menu item may be used to hide or show the Status Bar. 

Text Window 

By default the Text Window appears at the bottom of the graphics window just above the 

Status Bar. The size of the Text Window may be resized using the cursor and it may be 

undocked or hidden from view. The Text Window displays messages and warnings during a 

modelling session. The View> Text Output menu item may be used to hide or show the Text 

Window. The Text Window context menu allows the Font to be defined and the output to be 

directed to a log file. By default the selection mode is set to select lines of text. This may be 

changed to select characters by changing to Character select mode but subsequent output to 

the text output window will be slower.   

Usually when an error message or warning relating to a particular object is written to the text 

output window, extra information is available by double-clicking on that line of text. In doing 

so, a popup window provides options to help identify the offending area of the model. For 

example, if a Modeller error refers to an assignment on line 25 it may be selected, moved to 

the centre of the screen, scaled to fill the screen, have its properties displayed, or be identified 

by an annotation arrow or a temporary indicator. Similarly, if a Solver error or warning refers 

to a particular numbered element, the popup window will help you find that element quickly 

and easily. 

Toolbars 

Toolbars contain the toolbar buttons. On initial start-up the Main, Define and View Toolbars 

are displayed. All toolbars can be shown, hidden, or customised, using the View> Toolbar 

menu item. When a modelling session is completed the current toolbar settings are saved and 

reloaded the next time Modeller is used.  

User defined toolbars and buttons can also be added to the user interface. Actions are 

assigned to user defined buttons using the scripting language.  

Tree Frames 

By default a single Tree Frame is displayed with the Layers , Groups , Attributes , 

Loadcases , Utilities  and  Reports Treeviews visible. Multiple Tree Frames can be 

utilised from the View> Tree Frame menu item. Treeviews can then be dragged and dropped 

between Tree Frames as required. 

Browse Selection 

This window is not displayed by default but can be viewed using the View> Browse 

Selection menu item. Once visible it will contain a list of all currently selected items which 

may then be individually deselected. 
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Browse Selection Memory 

This window is not displayed by default but can be viewed using the View> Selection 

Memory> Browse Memory Selection menu item. Once visible it will contain a list of all 

items currently in Selection Memory which may then be individually deselected. 

Browse Cyclable Items 

This window is not displayed by default but can be viewed using the View> Browse 

Cyclable Items menu item. Once visible it will contain a list of all cyclable items. These may 

then be individually selected or deselected.  Note that once an object is selected other 

selectable items at the same position within the graphics window can be cycled using the Tab 

key or by reselecting with the left hand mouse button at the same position within the graphics 

window. 

Data Tips 

Data tips (also sometimes referred to as datatips) provide basic information about whatever is 

under the cursor. The data tip mechanism is only invoked when the cursor hovers over a 

model feature within the graphics window. If more than one item is present at the location on 

the screen, you may use the Tab key to cycle between all possible selectable objects, with the 

data tip updated each time. As additional feedback, if a object is selected, dynamic selection 

is invoked to highlight each object as it becomes the focus. Thus with two intersecting lines 

or overlapping surfaces, it is clear which one is being displayed in the data tip. 

Pressing the Enter key whilst a data tip is active adds the current object to the selection. 

This provides an easy way to select a specified "one of many" objects at a given location. 

Getting Help 

LUSAS contains a comprehensive Help system. The Help consists of the following:  

 The Help button  on the Main toolbar is used to get context-sensitive help on the 

LUSAS interface. Click on the Help button, then click on any toolbar button or menu 

item (even when greyed out). 

 Help Topics accessed from the Help menu provides access to the Help files. They 

include the Modeller Reference Manual, reference help files such as the Element 

Reference Manual and access to other manuals that are available in PDF format such 

as the Examples Manuals, Theory Manuals and Solver Reference Manuals. 

 Every dialog also includes a Help button which provides information. 
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Modeller Licence Selection 

 

When running LUSAS, the Modeller licence selection dialog lists all software products that 

are available for selection, along with details of the licenced product options, licence type, 

server name, number of available licences and the number of days left until expiry. Invalid 

licences (those that have already been completely taken by others prior to the display of this 

dialog, or are unavailable for some other reason) are greyed out. Licences expiring within 14 

days are displayed in red. 

The licence selection dialog is always displayed on start-up of LUSAS unless it has been 

disabled by unchecking an option on the Licencing page of the Configuration Utility, or 

unless there is only one licence available to LUSAS. 

Use the Modeller licence selection dialog to select a licence for use. Use the Configuration 

Utility to add licences to the list of those available. 

License order and usage 

Standalone or network licences are 'tumbled' based upon Configuration Utility settings. The 

order of the licence types listed on the Modeller licence selection dialog follows the order of 

the keys set on the Licensing page of the LUSAS Configuration Utility. If the display of the 

main licencing dialog has been disabled the first licence in the list of those available will be 

used in preference to all others. As licences are used the number of licences available for 
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others to use is updated accordingly. When LUSAS Modeller is run the system will work its 

way down the list of licences until a valid and available licence is found.  

Creating shortcuts 

 The Create shortcut... button provides the means to tie a licence type to a shortcut 

used to run Modeller or Solver and with the choice to Emulate LT or use Teaching 

and Training limits. It enables LUSAS Modeller or LUSAS Solver to run without 

having to select a licence type each time (unless that licence has already been used).  

Example of shortcut created: 

 <LUSAS Installation folder>\Programs\lusas_m.exe 

LICNAM=[SENTINELLM,TECHNICAL01,6274(6270)] 

Licence details 

 By selecting a licence and then selecting Licence details additional information such 

as the product options, the licence version, the Key ID and the licence expiry date can 

be viewed. 

 Selecting a licence that is invalid and clicking the licence details button will yield 

extra details as to why the license in unavailable. 

Refresh 

 Refresh simply updates the numbers of licences available. 

 Emulating LT Behaviour  

 When Emulate LT is selected it restricts the user interface to that of an LT licence, 

even though the selected licence may be a standard or plus licence. This may be of use 

when training staff who are new to LUSAS. 

Teaching and training limits 

 When Teaching and training limits is selected no licence is taken. LUSAS can be 

used as normal for this session only but with the restricted model size, node, element 

and loadcase limits of the Teaching and Training version. 

Creating a New Model 

The New Model dialog is displayed every time a new model is to be created. The dialog 

enables the model file to be named and located in a selected project folder and for initial 

model set-up information to be specified.  
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The model title, job number, units and designated vertical axis are also defined. The style of 

user interface can be also set (dependent upon licence key options). This simplifies the user 

interface and also defines the class of model to be created. The model title and the style of 

user interface can be subsequently modified on the General tab of the Model Properties 

dialog accessed via the File> Model Properties menu item but note that changing an 

interface type will not remove any properties created and assigned to the model when using 

the previous interface. 

Within LUSAS consistent units must be used. A wide range of consistent units is available 

from the units drop-down list.  

By selecting a startup template, useful predefined attributes can be setup in the model. User-

defined startup templates can be created and accessed via the button alongside the Startup 

template drop-down list.  

 The vertical axis (used to orientate the model, define a default gravity loading direction, and 

the vertical axis and orientation of particular element types and library items such as steel 

sections) is set on the New Model dialog. It may be changed subsequently using the Utilities> 

Vertical Axis menu item. 

Model Types 

Two types of model can be created in LUSAS:  

 Feature-based geometry models - these are based on defined features (such as 

points, lines, surfaces and volumes) or are created from imported geometry and 

require the definition of mesh objects such as elements with their associated nodes. 

Prior to version 14.7 of LUSAS these were the only model type available in LUSAS. 

 Mesh-only models - these comprise only mesh objects (elements and their associated 

nodes, edges and faces) and are created by importing only those types of LUSAS or 

third party data that are supported. Initial support for these models was introduced in 

version 14.7 of LUSAS. 

The Modeller user interface presents different menu and context menu items according to the 

type of model in use. Cursor selection filters also differ according to the model in use.  

Attribute assignments to different model types 

Both feature-based models and mesh-only models require the assignment of materials, 

properties and thicknesses, loading and supports etc to geometric features or the comparable 

and equivalent mesh objects prior to an analysis taking place.  

Note: In general, whenever an assignment of an attribute to a geometric feature is described 

in this manual, the same attribute assignment can be made to an equivalent mesh object if a 

mesh-only model is being used. See the table below for details. 
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Feature-based  
model 

Mesh-only  
solid model 

Mesh-only  
surface model 

Mesh-only  
line model 

POINT NODE - - 

LINE ELEMENT EDGE - ELEMENT 

SURFACE ELEMENT FACE ELEMENT - 

VOLUME ELEMENT 
- 

- 

Geometric features and their comparable equivalent mesh objects for attribute assignment purposes 

Feature-based geometry models 

Feature-based geometry models are created using the four geometric feature types in LUSAS 

(points, lines, surfaces and volumes). In LUSAS, geometry is defined using a whole range of 

tools under the Geometry menu, or the buttons on the Toolbars. Feature-based geometry 

models can also be created by importing supported data from third-party software packages 

using the File > Import menu item. Once created, the geometry features are then assigned 

attributes (materials, properties and thicknesses, loading, supports and mesh/element type 

etc.) to fully describe the model prior to an analysis taking place. One of the many benefits 

obtained from using this feature-based modelling method is that built-in associativity ensures 

that if the model geometry is amended, all assigned loadings, supports, geometric attributes 

and particularly any mesh assignments and arrangements are automatically updated to suit. 

When a feature-based geometry model is being edited all user interface menu items 

appropriate to the application software in use are available. 

Mesh-only models 

Mesh-only models are comprised of nodes and elements and do not contain any geometric 

feature types, or indeed any geometric data at all. They are created by importing finite 

element data files created either by the prior running of an analysis in LUSAS or by 

importing data files from other supported software applications. The File > Import Mesh 

menu item is used to do this. During the mesh import process, LUSAS Modeller creates 

separate Groups for each element type encountered and for models created from LUSAS data 

file these will be familiar LUSAS element names. For models created from other third-party 

software they will be the names used within that system, whatever they may be. An option to 

create additional groups during the import process based upon the element material type is 

also available.  

On import of a LUSAS Solver data file, element types that are present in the datafile are used 

directly for the elements that are imported. For datafiles other than those created by LUSAS 

Solver, the proprietary element types that are present in the datafile are mapped to an 

equivalent LUSAS element based upon each element's shape and its topology. If the Coupled 

user interface option has been selected on the New Model dialog prior to a mesh import being 

carried out then coupled elements will be created during the import process. If a different 

analysis type is specified after the import of mesh data the element types previously used will 

be changed accordingly. 
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Assigning attribute data to mesh objects in mesh-only models 

No import of any attribute data is done when element data is imported, so the mesh objects 

(the elements and their nodes, edges and faces) must be assigned attributes (materials, 

properties and thicknesses, loading and supports), prior to carrying out an analysis within 

LUSAS, in a similar way and as documented for a feature-based geometry model. Rather than 

selecting points, lines, surfaces or volumes to make an attribute assignment, nodes, edges, 

faces, or elements are selected instead. To assist in the attribute assignment process the 

cursor selection filter can be used to identify specific mesh objects. 

Editing mesh-only models 

When a mesh-only model is being edited any main menu items normally used with feature-

based models that are not valid are removed or shown greyed-out to prevent selection. Mesh-

only menu items (such as Geometry > Element for instance) are added to the main menu. 

Context menus may contain different menu items also. 

Additional elements cannot be added to a mesh-only model. Once imported, the number and 

shapes of the elements are fixed but the type of element may be changed by use of the 

Change Element Type option on the context menu on the element group name. In doing so, 

the number of nodes defining the element topology may be reduced but not increased. For 

instance, an 8-noded brick elements may be defined for use on previously defined 20-noded 

brick elements. 

Notes for mesh-only models 

 The File > Import Mesh menu item is only available if no Geometry data is present 

in the Modeller window. 

 Mesh-only models cannot contain geometry layer data. As a result, the option to add a 

Geometry layer is not accessible. 

 By default, when element types from non-LUSAS created datafiles are mapped to an 

equivalent LUSAS elements, structural element types are created. If the Coupled user 

interface option has been selected on the New Model dialog prior to a mesh import 

being carried out then coupled elements will be created during the import process. If a 

different analysis type is specified after the import of mesh data the element types 

previously used will be changed accordingly. 

 Local coordinate systems are not imported into newly created mesh-only models so 

these need to be defined as necessary to obtain specific types of results as, for 

example, to get moments around a cylindrical axis. 

Restricted / unsupported functionality for mesh-only models 

With reference to the user interface menus for feature-based geometry models: 
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 The Utilities > Slice resultants beams and shells menu item is not currently supported  

 The Utlities > IMDPlus > Moving load wizard functionality is not currently supported 

 The Bridge > Moving load menu item is not currently supported 

 The Bridge > Prestress Wizard > Tendon profile and Multiple tendon prestress menu 

items are not currently supported. 

 The Bridge > Prestress Wizard > Single Tendon design code options are not currently 

supported.  

 Single tendon definition is only permissible by importing data from a spreadsheet. 

 Reference paths can only be created currently by typing in the coordinates defining 

the path. 

Model Properties 

The Model Properties dialog allows many settings relating to the current model to be defined. 

Model properties may be accessed from the File> Model Properties menu item, or by right-

clicking the model name (top level) in the  Treeview and selecting Properties from the 

context menu. The model properties are defined on the following tabs: 

 General 

 Notes 

 Geometry 

 Meshing 

 Attributes 

 Solution 

 Defaults 

 Solver System Variables 

General 

 Title  Brief description of the current model as entered in the New Model startup 

dialog.  

 User Interface Enables the user interface to be simplified by specifying the type of 

analysis model being generated. Options dependent upon licence key is use are 

Coupled, Structural, Thermal. Associated main menu items are removed if licence key 

does not include a thermal option. Note that changing an interface type will not 

remove any properties created when using the previous interface. 

 Auto backup Saves the model automatically as it is being developed or modified. 

 Precision shown in dialogs Controls the number of significant figures or decimal 

places displayed in the dialogs.  
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 Pens  Sets the Pens that are used to draw Points, Lines, Surfaces and Volumes.  

 Click on the Choose Pen button to use a different pen, or to modify the Pen Library.  

 Changing a Pen allocation can be applied to existing features and/or new features 

using the two check boxes. 

 Units Specifies the modelling units. 

Notes 

 Notes relating to a model can be typed in the Notes panel of the Model Properties 

dialog and stored with the model.  

Geometry 

The method by which the geometry is displayed is controlled using the Geometry drawing 

layer. 

 Merge Options 

 Action controls the criteria that must be satisfied before features sharing a 

common definition will be merged. 

 New geometry unmergable sets the merge status of all new features to 

Unmergable rather than the default which is Mergable. 

 Tolerance controls the distance within which Point features must lie before 

they will be considered for merging. Note: The merge tolerance should only be 

changed with extreme caution because changing it from its default value can 

lead to instability of the underlying geometry engine. 

See Merging Features for more details. 

 Active Local Coordinate 

Sets the coordinate system as either the Global coordinate or any defined local 

Cartesian, cylindrical or spherical coordinate.  

If a local coordinate is set activate then all subsequent geometry definition is carried 

out in transformed coordinates. 

Advanced Geometric Properties 

 Splitting Defaults 

The state of the splitting defaults may be set from the advanced geometry dialog for 

all operations involving splitting operations. The defaults control the check box state 

and may be overridden during geometry creation. 
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 Creation Defaults 

Process objects in selection order forces objects to be processed in selection order 

rather than Modellers best fit. 

Allow hollow volume creation allows hollow volumes to be created. This option is 

automatically set true when IGES files are imported. Once set the create volume 

button will try to create a closed hollow volume when it is not possible to create a 

solid volume. In addition, extra menu items will appear under the Geometry> 

Volume to enable hollow volumes to be defined. 

 Hole Removal Defaults 

The state of the holes removal defaults may be set from the advanced geometry dialog 

for all operations involving hole removal operations. The defaults control the check 

box state and may be overridden during geometry creation. 

 Merge Defaults 

The state of the merge defaults may be set from the advanced geometry dialog for all 

operations involving merging.  The defaults control the check box state, and may be 

overridden during geometry creation. 

 Drawing defaults (faceting) 

The default faceting controls the number of facets used for shading. Increasing the 

number of facets improves the shaded geometry visualisation but takes longer to 

display. See Facet Density for more details. 

Meshing 

 Equivalence Defines the default nodal equivalence tolerance used in a equivalence 

attribute. If automatic is switched on equivalencing is carried out automatically for all 

nodes in the model and no equivalence attribute assignment is required. See Nodal 

Equivalencing for details. 

 Line Mesh Defaults Sets the default number of mesh divisions on a line and the 

maximum subtended angle per element for an arc or splines. If an element exceeds the 

max subtended angle the number of divisions on the arc or spline will be increased. 

 Irregular tet meshing specifies the number of the passes and attempts to be made by 

the tetrahedral mesh generation when attempting to mesh a volume. 

 Create a group of objects that failed to mesh creates a group named 

$failedToMeshObjects which contains all features which failed to mesh. 

Advanced meshing parameters 

 Draw failed parts of mesh only - draws those parts of the mesh that failed to mesh 

 Linearise element edges  
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 Constrain adjacent linear/quadratic edges forces mid-side nodes on lines or 

surfaces to be averaged between the corner/end node positions. This option is turned 

on by default. 

 Element edge collapsing invokes edge collapsing which removes elements/faces 

with short edges and small subtended angles by merging them with neighbouring 

elements. 

Attributes 

 General Options 

 Apply concentrated loads in cylindrical coordinates for Fourier elements 
(LUSAS Solver option 202). 

 Body force given as acceleration This option is turned on by default. Turning 

it off converts body forces to global loads per unit volume. (LUSAS Solver 

option 48). 

 Slideline Options 

 Suppress stringent slave search For simpler geometries, such as flat surfaces 

in contact, a slight reduction in processing time may be achieved by 

suppressing the "stringent" local node search but this is not usually 

recommended. (LUSAS Solver option 184). See the Theory Manual for more 

details. 

 Suppress initial slide-surface stiffness check  Slideline stiffnesses are 

automatically scaled at the beginning of an analysis if the average master/slave 

stiffnesses differ by a factor greater than 100. This is to account for contact 

between bodies that have significantly different material properties. See the 

Theory Manual for more details. 

 Suppress initial penetration check The coordinates of all contact nodes that 

have penetrated prior to the commencement of an analysis, are reset back to 

the closest point on the contacted surface. This option should be set if the node 

resetting is to be suppressed, such as when performing an interference fit 

analysis. See the Theory Manual for more details.  
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Solution 

Optimiser Options   

When using the standard frontal solver the frontwidth of the problem may be reduced 

by optimising the order in which the elements are presented to the frontal solver. The 

type of optimiser to be used is selected from an options dialog. No optimisation is 

required when using the fast multi-frontal solver. For further information see 

Selecting a Frontal Optimiser. 

 Solver Options   

When the type of solver selected is set to Default the fast multi-frontal solver will be 

used if this option is included in the licence agreement. This may be overridden by 

selecting the solver required. For further information see Selecting a Solver. 

 Element Options 

See the Element Reference Manual for details of which elements can be used with 

these options. 

 Assign 6 degrees of freedom to all thick shell element nodes By default this 

option is on. It has the effect of adding a rotational spring stiffness to the 

drilling rotation of the thick shell elements making the analysis more stable. 

The value of the spring stiffness can be adjusted using the system parameter 

STFINP. For problems in which geometric nonlinearity (Option 87) is being 

used more accurate results may be obtained by switching this option off and 

letting LUSAS automatically establish the need for 5 or 6 degrees of freedom 

at a node. (LUSAS Solver option 278). 

 Axisymmetry about Global X axis When selected, LUSAS considers the line 

of axisymmetry in an analysis to be about the global X axis and not the 

default, which is the global Y axis. (LUSAS Solver option 47). 

 Lumped Mass Matrix Formulate lumped mass matrix instead of consistent 

mass matrix for elements. (LUSAS Solver option 105). 

 Write strains to output file causes element strains to be written to the Solver 

output file. 

 Preserve loading whilst elements deactivated retains the loading assigned to 

all elements in model (activated and deactivated) until a subsequent load case 

is applied. Typical usage would, for example, be when carrying out a staged 

construction analysis. Self weight would be assigned to all elements (activated 

and deactivated) in the loadcase representing stage 1 of the analysis. As stage 

2 and subsequent loadcases are activated the loading initially applied to 

elements in stage 1 would automatically be applied as the elements become 

active. Note that when using this option no additional loading should be 

applied to any loadcases following the one that contained the load 
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assignments. If done so, the initial applied loading for those loadcases will be 

lost. 

 Integration options 

 Fine integration for stiffness and mass Invokes a finer numerical integration 

rule for elements. (LUSAS Solver option 18). 

 Fine integration for mass HX16 and HX20 Formulate mass matrix with fine 

integration. (LUSAS Solver option 91). 

 Coarse integration for semi-loof shells Invokes coarse numerical integration 

rule for semiloof elements. This option under-integrates the semi-loof shell 

element which may have the effect of removing low energy mechanisms when 

the element is very thin and/or pressure loaded. (LUSAS Solver option 19). 

 Newton-Cotes Integration for beam elements  Newton-Cotes is a form of 

numerical integration or quadrature. It is often used for through-thickness 

integrals since sampling points are located at the extremes of the range. 

(LUSAS Solver option 134). 

 Nonlinear Options 

 These options define the type of geometric nonlinearity to be used in the 

analysis. The default is for no geometric nonlinearity. See Geometric 

Nonlinearity. Consult the Element Reference Manual to check which 

geometric nonlinearity type is supported for selected elements. 

Geometric nonlinearity 

 Total Lagrangian A strain formulation that has its reference as the initial 

configuration at the start of the analysis. (LUSAS Solver option 87). 

 Updated Lagrangian A strain formulation that has its reference as the end of 

the last converged increment. (LUSAS Solver option 54). 

 Eulerian A strain formulation that has its reference as the current 

configuration. (LUSAS Solver option 167). 

 Co-rotational Form of geometric nonlinearity in which large displacement 

effects are related to a set of axes that follow and rotate with the element. 

(LUSAS Solver option 229). 

Solution control 

Allows fine control over advanced nonlinear solution procedures. 
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 Continue solution after convergence fails This option continues with a 

nonlinear analysis even after an increment has failed to converge. It is useful 

for creating a results dump of an unconverged results file to visualise problem 

areas. This option should be used with care. (LUSAS Solver option 16). 

 Continue solution if more than one negative pivot occurs will step over the 

LUSAS error that stops the analysis if more than one negative pivot is 

encountered. This can be useful if pivot problems are encountered at an early 

stage but the problem is free from them during later stages. This option should 

be used with care as it is likely to hide more fundamental analysis problems. 

(LUSAS Solver option 62). 

 Non-symmetric solution (LUSAS Solver option 64). This is set automatically 

by LUSAS Modeller when, for example, carrying out a nonlinear concrete 

material modelling of cracking. 

 Coupling Options 

These allow control of a coupled analysis. 

 Coupling type defines which analysis to run first, Thermal or Structural.  

 Parallel coupling requires both analyses to run simultaneously such that the 

temperatures from the thermal analysis are read into the structural analysis and 

the displacements from the structural analysis into the thermal analysis. If the 

temperatures are to be calculated in a thermal analysis and then transferred to a 

structural analysis this option is not required.  

 Initialise reference temperatures takes the first temperature distribution from 

the thermal analysis and uses them as the reference temperatures in the 

structural analysis. 

 Suppress recalculation of view factors in coupled analysis Turns on/off the 

view factor recalculation. The option should be turned on when the radiation 

surface geometry is unchanged by the structural analysis to suppress the re-

calculation of view factors. (LUSAS Solver option 256). 

 Step coupling is used for coupling thermal to structural analysis such that the 

nonlinear increment is used to control the coupling steps. 

 Time coupling is used for coupling thermal to structural/transient analysis 

such that the time is used to control the coupling steps. 

 First data read and first data write are the time/increment to read/write the 

first set of data. 

 Draping Options 

The draping options control the composite lamina draping process. The draping 

process works by effectively draping a square mesh of pinned bars over the structure. 
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The length of the bars is considered to be the drape mesh size. A smaller bar size 

provides a more accurate drape at the expense of computer time and memory usage. 

Typically the drape mesh size should be about half the element size. 

 Drape by mesh size - Desired drape cell size. If the desired drape cell size 

would generate more than the specified maximum number of drape cells then 

the drape mesh size would be adjusted to generate the maximum number of 

drape cells. Likewise, if the desired drape cell size would generate less than 

the specified minimum number of drape cells then the drape mesh size would 

be adjusted to generate the minimum number of drape cells. 

 Drape by number - Desired number of drape cells on draping surface. This 

must be between the maximum and minimum values stated below. 

 Drape by face multiplier - A number that is used to multiply the actual 

number of mesh divisions on a draping surface to arrive at a desired drape cell 

number. This must be between the maximum and minimum values stated 

below. A default value of 4 is entered. 

 Maximum number of drape cells - Maximum number of drape cells to be 

generated. 

 Minimum number of drape cells - Minimum number of drape cells to be 

generated. 

 Extend drape grid one row - Ensures the edges of the component are fully 

enclosed by the draping grid. Note that the grids for LUSAS draped solids and 

shells are automatically trimmed at Surface boundaries. 

Defaults 

Sets the defaults for symbols, arrows and text which are used when visualising attributes. 

Actual settings are controlled from the Attribute Visualisation layer for the current window. 

The value and units for Gravity that are currently in use may be checked on this tab of the 

dialog. 

The Advanced... button enables a new Modeller option to be specified or particular default 

values or settings to be modified. Advanced settings should generally only be modified with 

the assistance of LUSAS technical support. 

Solver System Variables 

By default the LUSAS Solver is set up to operate efficiently for a wide range of modelling 

and analysis problems. In some cases it may be occasionally necessary to adjust the Solver 

system variables. Variables that can be modified inside Modeller are accessed via the File > 

Model Properties > Solver System Variables dialog. Making changes to Solver system 

variables should be done only after seeking advice from LUSAS Technical Support. 
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Using Windows 

Each view of the model is contained in a window. View layers inside each window hold 

model information and can be added or removed from the current window as required. 

Multiple windows can be opened using the Window> New Window menu item. Closing the 

last window will close the model. 

Windows consist of the following components: 

 Drawing Layers  By default the first panel of the tree frame displays each model 

window currently open, and shows the view layers contained in that window. 

 Window Properties Double-clicking in a window or right-clicking in a window with 

no selection, will display the properties of that window. The Window Properties can 

be altered as required. 

Saving a View 

A view of a model may be saved with the current settings for future use using the Window> 

Save View menu item. Any new window is based on the default view. Therefore, if a view is 

saved with the name default, all new windows are based on this view. The view name 

Factory default cannot be changed and is the default view when the system is installed. The 

following settings are saved: 

 Rotation The current rotation consists of a vector and an origin as specified on the 

View tab of the Window properties 

 Layers The window layers contained in the  Treeview. 

 Colours The colourmap as used for plotting results contours. 

 Page size & borders The page size and border setting as defined from the File> Page 

Setup menu item. 

 Pen Library The pen library referenced every time a item is drawn. 

All the above settings are saved. The choice of which to apply to a new or current window is 

made when a view is loaded. 

Pen Library 

The choice of colour for various operations is linked to the Pen Library. The Pen Library 

contains twenty pens, each numbered, each with a colour, style and thickness that may be set 

if desired.  

Pens are used in a number of dialogs. Whenever a pen is used a Choose pen button allows 

access to the Pen Library to specify a different pen, or to change the pen colour or style. If a 

particular pen style or colour is changed then this will affect every operation that references 

that pen. 
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Loading a View 

A previously saved view may be loaded into a new window, or into the current window using 

the Window> Load View menu item. Any of the saved view settings can be chosen. 

Copying Windows 

A window can be copied by selecting and copying the window name in the  Treeview, then 

pasting the window back into the  Treeview. The window layers and settings are also 

copied. 

Using Layers 

Model information is held in separate pre-named layers to aid selective viewing of both 

model and results data. Layers can be added or removed from a view window by right-

clicking on a blank part of the graphics area, or by right-clicking the window name in the  

Treeview and selecting Properties from the context menu, or by selecting the View> Insert 

Layer menu item.  

The display of layers in the current window can be turned on or off by right-clicking on the 

layer name in the  Treeview and selecting / deselecting the On/Off option. Turning a layer 

off retains the layer in the Layers  Treeview but removes the display of that layer from the 

Graphics Area.  

Layer symbols explained 

A symbol adjacent to each layer name in the Layers  Treeview shows the display status of 

each layer:  

  A coloured layer symbol indicates that the display of a layer has been turned 'on'. 

  A greyed-out layer symbol indicates that the layer has been turned 'off'. 

  A red circle with a line through it indicates that no results are loaded or currently 

available for this layer, or inappropriate settings are currently set. 

Note. Double-clicking on a layer name (whether or not is it On or Off) will display a 

Properties dialog where the style of the viewed layer can be changed. Clicking OK will turn 

On a previously turned Off layer. 

Layers available 

The following layers can be added /removed, have their display turned on/off and be 

generally manipulated from a view window: 

 Geometry 

 Mesh 

 Attributes 
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 Labels 

 Annotation 

 Utilities 

 Contours 

 Vectors 

 Deformed mesh 

 Diagrams 

 Values 

Note. The order in which the layers are drawn is defined by the order or the layers in the  

Treeview. The top layer in the Treeview is drawn first to the screen. If the display of one 

layer is eclipsed by another layer, (i.e. the mesh is eclipsed by the contours, or the annotation 

is eclipsed by the deformed mesh), the eclipsed layer can be moved down in the  Treeview 

by selecting it, then dragging and dropping it to a new position to cause it to be drawn 

following a particular layer.   

Selecting Model Features 

Items displayed in the graphics window may be selected with the cursor by clicking on them 

individually or by dragging over an area. Following selection, items may be added or 

removed from the initial selection by carrying out further selections based upon either menu 

choices or upon particular keystrokes used.. 

Area selections 

Regions or areas of the model may be selected as a rectangular, a circle, or a polygon either 

using the appropriate toolbar buttons or the keyboard short cut.  

 

To select a rectangular area click to define one corner, hold the mouse button down, 

and drag the cursor to the opposite diagonal corner. 

 

Pick the circle selection tool or hold down the C key then select the centre of the 

circle and drag the edge of the circle to the required radius. 

 

Pick the polygon selection tool or hold down the X key then select each corner of a 

polygon and either double click to close the polygon or select Close Polygon from 

the context menu. It is invalid to define a vertex which would cause two lines on the 

perimeter to cross. Because more than one click is needed to define a polygon, 

individual items may not be selected whilst in polygon select mode. 

Notes 

 Holding down the Shift key whilst selecting items will add the newly selected items 

to those currently selected. 
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 Holding down the Control key while selecting items will enable the selection state of 

the item selected to be toggled.   

 Holding down the Shift and Control keys while selecting will remove from the 

current selection 

 By default all items completely enclosed in a selected area will be selected. By 

holding down the Alt key, items intersecting the selection perimeter will also be 

selected. The Alt key may be used with, or independently from, the Shift or Ctrl 

keys. The Alt key can also be used with feature selection shortcuts e.g. Alt + Shft + L 

adds lines to the current selection. 

 All visible items can be selected together using the Select All command which can be 

invoked from the Edit> Select All menu item, from the right-click context menu or 

using the Control + A keyboard shortcut.  

 Items in the current selection may be viewed in the Browse Selection window which 

can be displayed from the View> Browse Selection menu item or using a right hand 

click in the Selected area of the status bar at the bottom of the graphics area. By 

means of checkboxes the selected items may be individually unselected. 

Selection Filters 

 

Greater control over what is selected can be achieved by changing the cursor 

selection filter. The cursor options listed change according to the type of model in 

use. 

Feature-based models 

 Normally the cursor will select any object, i.e. Points, 

Lines, Surfaces, Volumes, Nodes, Elements, Annotation 

 The selection filters allow only specific objects to be 

selected i.e. with the Line filter only Lines can be 

selected and with the Surface filter only Surfaces can be 

selected. 

 Selection filters can be activated either from the drop 

buttons to the right of the cursor button, or using 

keyboard shortcuts. To display the drop buttons click on 

the down-arrow to the right of the cursor button. 

 Alternatively hold down the appropriate key whilst 

selecting using the normal cursor as follows: 

  

G – Geometry selection filter 

P – Point selection filter 

L – Line selection filter 
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S – Surface selection filter 

V – Volume selection filter 

M – Mesh selection filter 

A – Annotation selection filter 

N – Node selection filter 

E – Element selection filter 

A – Annotation selection filter 

When a specific selection option has been chosen the on-screen cursor will show a 

graphical representation of the chosen option 

  

Mesh-only models 

 The selection cursor will select only Nodes, Elements 

or Annotation 

 The selection filters allow only specific objects to be 

selected, i.e. with the Edges filter only edges of 

elements can be selected and with the Faces filter only 

Faces can be selected. 

 Selection filters can be activated either from the drop 

buttons to the right of the cursor button, or using 

keyboard shortcuts. To display the drop buttons click 

on the down-arrow to the right of the cursor button.  Alternatively hold down the 

appropriate key whilst selecting using the normal cursor as follows: 

  

M – Mesh selection filter 

N – Node selection filter 

B  – Edge selection filter 

F – Face selection filter 

E – Element selection filter 

A – Annotation selection filter 

When a specific selection option has been chosen the on-screen cursor will show a 

graphical representation of the chosen option 
 

See Appendix C - Model Selection Shortcuts for a complete listing of the selection keys 

available. 

Selecting coplanar neighbours 

After selecting a surface or element face the Select Coplanar Neighbours menu item can be 

selected from its context menu. This provides a quick way to select a number of surfaces or 
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element faces according to their alignment in relation to the selected surface or element face. 

By specifying an angular tolerance all surfaces or element faces where the angle between the 

normals of adjacent surfaces or element faces lies within that tolerance will be added to the 

selection. This is of particular use when defining a draping surface as used in composites 

analysis. An option to ignore internal faces helps to ensure that when an element has faces 

that both lie within the angular tolerance, only the external face is selected. 

Advanced Selection Filter 

The advanced selection filter enables geometry, nodes or elements to be selected based on a 

number of different criteria and is activated from the context menu. Items may be selected by 

number or range or numbers, for example 1T5I2 (representing 'one to five in increments of 2') 

will select item 1,3,5). When a results only file is loaded the geometric and material attributes 

reflect the numbers in the solver data file. Geometry can by selected according to the 

connectivity of the feature to surrounding features; End Points, Free Lines and External 

Surfaces can be highlighted in this manner. 

Cycling through the Selection 

When features lie close together or overlap it can be difficult to select the required feature 

first time. In these circumstances, each separate press of the Tab key or click with the mouse 

at the same position selects a different feature. The currently selected feature is displayed in 

the Status Bar at the bottom of the screen.  

Alternatively, click in the Status Bar to cycle the selectable features. Or right-click in the 

Status Bar to display a context menu from which Next, Previous, Closest or Furthest may 

be selected  
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Even closer control over the selection of items at the same cursor location can be attained 

using the Browse Cyclable Items window which is available on the right-click in the status 

bar or from the View> Browse Cyclable Items menu. 

Associate Selection Downwards 

Associate selection downwards is an option to automatically select lower order features 

when selecting objects in the model. For example, selecting a Surface will also select the 

Lines and Points that define the Surface. This option may be invoked from the Edit> 

Associate Selection Downwards menu item. Associate selection downwards is set off by 

default. 

Associate Operations Downwards 

Associate Operations downwards is a option to operate on lower order features when a 

command is issued. For example, deleting a Surface will also delete the Lines and Points 

which define that Surface. This option may be invoked from the Edit> Associate Operations 

Downwards menu item. Associate operations downwards is set on by default. 

Selection Memory 

Some operations require features to be stored in selection memory. The selection memory 

commands are available from the Edit> Selection Memory menu item or from the context 

menu enabled by right-clicking in the graphics area. The selection memory commands are: 
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 Set - clears the selection memory and set the contents to the items in the selection. 

 Add - adds the selected items into selection memory. 

 Remove - removes the selected item from selection memory. (Only available if the 

selected item is already in selection memory) 

 Recall - places all objects in selection memory into the main selection. Objects are not 

removed from selection memory. 

 Clear - clears the selection memory. 

 Browse- displays the Selection Memory browse window. 

Selection Colour 

The Pen used to draw items in the selection or the selection memory may be changed from 

the Window properties. To display the Window properties choose properties from the 

window context menu enabled by right-clicking in the graphics area. 

Groups 

User-defined groups are used to conveniently store selected collections of objects (geometry, 

nodes or elements) under a collective name. For example, a certain set of geometry might be 

grouped together with the name Nut, whilst another set might be grouped and named Bolt.  

LUSAS also automatically creates groups as part of the general modelling process as slice 

sections are created, or as a result of an analysis when slidelines are present in the model. 

With slice sections, groups are created with the group name Slices with each slice section 

having a group name of Slice 1, Slice 2 etc. With slidelines, a group named Slideline Results 

is created containing master and slave group names for each defined slideline. 

Groups are also automatically created when importing data files from other supported third-

party software applications to create mesh-only models. In this case groups are named after 

element or with material references, if present in the data file. 

When using LUSAS HPM software, groups are automatically created to simplify the 

modelling of the composite parts, as well as the interface surface and other items. 

Uses of Groups 

 Enabling unique components to be identified, manipulated, hidden, or have results 

plotted only on those features. 

 Allowing the assignment of attributes to a group in one step. The appropriate 

geometry features will be used if attributes can not be assigned to all geometry types. 

 Identifying all the features that failed to mesh during any command that invokes 

meshing. See Fixing Meshing Problems 

 When defining slice sections through a model in order to view the internal 

arrangement or to plot results. 

 To allow easy manipulation of master and slave results following a slideline analysis. 
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Defining Groups 

First, select the model features to be grouped together and then select either the  icon on 

the main toolbar or use the Geometry> Group> New Group menu item.  

All current group definitions are listed in the Group panel of the  Treeview. Manipulation 

of Groups can be carried out using the context menu of the Group panel, and/or using the sub-

menu entries under the main Geometry> Group menu item.  

Naming Groups 

Groups can be given a meaningful name at the time they are defined. They may later be 

renamed in the  Treeview or from the group properties accessed from the context menu.  

Manipulating Groups 

Groups are listed in the  Treeview. From a group‟s context menu the following commands 

will act on that group in the current window:. 

 Visible Makes all members of the group visible.  

 Invisible Makes all members of the group invisible.  

 Set as Only Visible Makes the whole model invisible 

and then sets all the members of the group to be 

visible. 

 Advanced Visibility Enables the visibility of the 

higher and lower order features of the members of a 

group to be manipulated. 

 Results Plots permits results to be selectively plotted 

for the chosen group. For details see plotting results 

for groups in the results viewing section. 

 Change element type (mesh-only models) permits 

changing the element type of a group of imported 

elements by description, or by entering a specific known element name. 

 Current Group Set the group to be the current group. 

 Rename Enables a group to renamed. 

 Delete Deletes the group. The group is deleted but the contents of the group are not. 

 Select Members Adds the members of the group to the current selection. 

 Deselect Members Removes the members of the group from the current selection. 

 Add to Group Adds the currently selected items to the group. 

 Remove from Group Removes the currently selected items from the group. 

 Properties Displays a list of the member items of the group. 
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When the group defines a slice section the 

otherwise generally available Rename, Delete, Add 

to group, and Remove from group options are 

unavailable but additional slice-related options are 

include on the context menu: 

 Draw axes Draws the local axes for the 

slice section. Note that options on the 

Contours properties dialog allow for 

plotting of results on slice sections and at 

slice axis directions. 

 Print Properties Displays information 

about the slice including cross-sectional 

area of the slice, centroid and section 

property data. 

 Print Forces Displays force and moment information for the slice. 

Group symbols explained 

A symbol adjacent to each group name in the  Treeview shows the visibility and status of 

each group. 

When modelling: 

 A black dot next to a symbol denotes the current group into which all new geometry will 

be added when created.  

 (green tick) All of the objects in this group are visible. 

 (blue tick) Some of the objects in this group are visible. 

 (red cross) None of the objects in this group are visible. 

When a results file is loaded: 

 (green tick, green border) All of the objects in this group are showing results. 

 (blue tick, blue border) Some of the objects in this group are visible and some are 

showing results. 

 (green tick, blue border) All of the objects in this group are visible but only some are 

showing results 

Changing the Visibility of Features 

By default all model geometry is visible (providing the geometry layer is present and turned 

'on' in the  Treeview, and providing it is not hidden by another layer) but as models get 

larger it is convenient to temporarily turn-off the display of parts of the model.  
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Features may be made invisible using any of the following methods: 

 By selecting features and choosing Invisible from the context menu activated from the 

graphics window. 

 By selecting an attribute from the  Treeview  and choosing Invisible from its 

context menu. 

 By creating a group from selected model features and choosing Invisible from the 

group name's context menu to make the members of the group invisible.  

Features may be made visible by using any of the following methods: 

 By choosing  All Visible from the context menu activated from the graphics window 

(used if any features have been made invisible) 

 By choosing Visible from an attribute's context menu to re-display the features 

assigned to the attribute 

 By choosing Visible from a group name's context menu to make the members of the 

group visible again. 

In addition the advanced visibility dialog activated from the graphics window context menu 

allows fine control on the visible / invisible items by controlling the visibility of higher order 

and lower order features. i.e. This allows all Lines attached to a Point to made visible or all 

Surfaces connected to a Line to be made invisible. 

Notes: 

 All visible features will always have their lower order features visible. i.e. If a line is 

visible its defining points will also be visible. 

 When a feature is made visible any associated elements or nodes will also be made 

visible. Use the Advanced Visibility dialog to override this behaviour. 

 An element can only be made invisible if its defining feature is invisible. To make a 

chosen element invisible, select the element and then use the Advanced Visibility 

dialog to make the element invisible by selecting the Also apply to higher order 

option. This makes the selected elements and the defining features invisible without 

making the unselected elements invisible. 
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Rotating, Zooming and Panning 

A number of tools are available to manipulate the view of the model. 

 Dynamic rotation is carried out by selecting the dynamic rotate button, or by 

pressing the scroll wheel button and either the left or right mouse button or by holding 

down the R key, while moving the mouse in normal cursor mode. The model will be 

rotated about the centre of the model unless any part of the model is selected in which 

case the model will rotate about the centre of the selection. The model can 

additionally be rotated around any of the screen axes by pressing additional keys. See 

Rotating the Model. 

 Dynamic zoom is carried out by selecting the dynamic zoom button, or by scrolling 

the mouse wheel or by holding down the Z key while moving the cursor in normal 

cursor more. If any part of the model is selected the location of the centre of the 

selection will remain fixed. 

 Dynamic pan (drag) is carried out by selecting the pan button, or by depressing the 

scroll wheel button or holding down the D key while moving the mouse in normal 

cursor mode.  

Notes:  

 Rotation, zoom and pan model manipulations are applicable for all cursor input modes 

including normal cursor selection of features, defining lines by cursor or when section 

slicing.  

 For larger models when the refresh time is significant the model display will reduce to 

an outline view when using rotate, zoom and pan.   

Rotating the Model 

Three methods of rotating the view of the model are available, each one is a button on the 

View toolbar: 

  Dynamic rotate  Allows the model 

to be rotated dynamically using the cursor. 

The model rotates around various multiple 

axes when the cursor is moved. By 

holding down the Control key, the 

Control and Shift keys or the Shift key 

while using the dynamic rotate the model 

can be rotated independently about the 

screen Z, Y and X axis respectively. Click 

on the normal cursor to return to selection 

mode. Note also that holding down the Alt 

key provides a one-key option for rotating about the the screen Y axis. 
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Note. Models are dynamically rotated using the 'model ball' 

method. With this method, a model can be imagined to be 

surrounded by a sphere such that a mouse-click and a drag of 

the cursor on the screen represents clicking on the surface of the 

sphere and dragging to rotate it to a new position. In doing so, it 

is important to note that the model rotation is restrained to rotate 

only around the model's vertical axis (as defined on the Vertical 

Axis dialog) - unless any model viewing shortcuts are being 

used at the same time. A benefit of this approach is that, no 

matter where on the screen you click to start the rotation of your 

model, if you return the mouse pointer to the same spot, (whilst you are dynamically rotating 

the model), the model will return to its original position and orientation on the screen. 

  

 Incremental rotate Allows the model to be rotated by 

an specified rotation about a chosen global axis. The 

specified rotation may be modified by adjusting the 

rotation increment on the window's properties. 

  

 View along axis Views the model along a chosen global 

axis. 

Note that this toolbar button is not provided as part of the 

standard user interface but it can be added by selecting the View 

> Toolbars > Customise > menu item.  

Note that this facility is also available by clicking in the X, Y or 

Z boxes in the Status Bar (holding-down the Shift key, if 

needed, to obtain the views along the negative screen axes.)  

Zooming in or out 

 
Zoom tool This tool works in two ways: 

1. By dragging a box around part of the model the view will zoom into that area.  
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2. Clicking on part of the model will zoom in progressively for each click. Hold 

the Control key to zoom out. 

 
Dynamic Zoom is similar to dynamic rotate. Using the cursor the model can be 

visually enlarged or reduced in size. 

Panning (Dragging) the Model 

 
Dynamic Pan allows the model to be dragged into position on the screen. 

Reseting the View 

 
Home Restores the view to a scaled to fit view in the XY plane. 

 
Resize When the resize button is depressed the model will fit into the available screen 

area.  

See Appendix C - Model Viewing Shortcuts for a complete listing of all model viewing 

facilities and keyboard shortcuts available 

Undo/Redo 

 The Undo button allows any number of actions since the last save to be undone. If 

more than the last action is to be undone then the actions to be undone may be selected from 

the undo history list by clicking on the down arrow at the side of the undo button. 

 Redo is available immediately after choosing an undo event to enable the undone 

action to be reinstated. 

Notes: 

 The undo facility works by replaying the session file from the last save. Because of 

this, it is advisable to save the model frequently to speed-up the undo facility. 

 Undo is only available when a model file is loaded. (i.e. undo is not available when a 

results file is loaded without a corresponding model file) 

Page Layout Mode 

Two viewing modes are available, both accessed from the View menu: 

 Working Mode is useful for model generation. In working mode annotation is scaled 

and moved so it is always visible. 
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 Page Layout Mode enables the model to be viewed as it would appear on a printed 

page. This makes annotation easier to position and allows pictures to be created to a 

specified scale. 

Scaling 

In Page Layout Mode the model is scaled and positioned within the margins defined using 

Page Setup> File menu item. This behaviour may be modified by toggling the scale to fit 

window   button.  

If a picture is to be created to a specified scale the page size should first be set using the File> 

Print Setup menu item. The desired scale and position should then be set on the View tab of 

the Window Properties accessed from the context menu. In this dialog the scale to fit 

window option should be switched off and the scale and origin position defined. 

Annotating the Model 

The view window may be annotated using the Utilities> Annotation menu item. Annotation 

can be placed by either cursor positioning or by specifying a coordinate location in Frame or 

Model coordinates. Annotation added to the model is displayed in the Annotation layer in the  

 Treeview. 

Cursor positioned annotation 

 Line Single lines may be added in a selection of colours and line styles.  

 Polygon Filled or unfilled polygons may be annotated on the screen in a selection of 

colours. Left click to indicate successive polygon vertices. When at least three vertices 

have been indicated, right click and select Cancel or Close from the context menu.  

 Bitmap Adds a bitmap from a selected file 

 Banner Adds the LUSAS banner 

 Arrow Defines an annotation arrow of a default size and colour 

Coordinate positioned annotation 

Several types of annotation are available: 

 Text Any number of lines of text may be plotted in a selection of fonts, character 

heights, angles and colours. Requires text setting-out point to be defined. 

 Line Requires start and end points of line to be defined. Single or multiple lines may 

be added in a selection of colours and line styles. 

 Polygon Requires points to be defined for each vertex. 

 Bitmap Adds a bitmap from a selected file at a specified location point 
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 Banner Adds the LUSAS banner at a specified location point 

 Arrow Defines an annotation arrow at specified start and finish points in chosen pen 

colour. 

 Symbol A selection of symbols may be plotted in a 

selection of sizes, angles and colours.  

 

Other Annotation 

 Window border Displays an annotated frame around the Window containing the 

LUSAS version number in use with the model name, the date, the model title, and the 

model units.  

 Window summary Window summary annotation is 

added in the form of an automatically assembled text 

block. It displays information about the model such as its 

view scale and orientation, and if a results file is loaded a 

summary of key values for a particular loadcase. 

 

 Window summary position The location of the summary block of text with reference 

to the left, right, bottom or top of paper. Note that the Window summary can be 

moved easier graphically by selecting it and then dragging it to a new position. 

Notes 

 If the annotation is eclipsed by other model data drag the layer (in the Treeview) to 

the bottom of the stack so that it is drawn last. 

 An annotation toolbar is available but by default is hidden. It can be displayed from 

the View> Toolbar menu item. From this toolbar coordinate positioned text and 

bitmaps can be defined, and cursor positioned lines, boxes, polygons and arrows 

added. 

Editing Annotation 

After being added to a model window, both cursor positioned and coordinate position 

annotation can be easily moved by selecting it with the cursor and dragging to a new position. 

In addition all defining parameters such as location, style and in some cases content can be 

edited.  
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To modify the properties of a piece of annotation select the annotation, right-click, then 

choose Properties from the context menu. The following properties apply to most annotation 

types: 

 Anchor point Annotation can be located with respect to the model (model 

coordinates), or to the window frame (frame coordinates). 

 Visibility The annotation can be made visible on all windows or just the current one. 

 Pen The pen used to draw lines or polygons can be selected from the pen library. Line 

thicknesses can be edited. The font used for text annotation can be modified by 

clicking on the Font button. 

 Name The identifying name of the annotation item. If no name is entered an 

automatic numeric identifier is allocated. 

Notes 

 By default the anchor point of all annotation is positioned in frame coordinates from 

the bottom left corner of the page. This enables the annotation to be positioned 

separately from the model. If negative values are specified for the anchor coordinates 

then the annotation is positioned from the top right corner of the page. 

 Annotation may be tied to the model by specifying the anchor point in model 

coordinates. 

 Annotation positioned in frame coordinates can be moved by selecting the annotation 

in the graphics window and dragging to the required location. 

 Annotation lines are used where 2D graphing results are to be recreated at defined 

locations. See Results on Sections Through a Model 

 Polygons are used when a section through a 3D model is to be recreated at a defined 

location. See Results on Sections Through A Model 

Saving a Model 

When a model is saved using the File> Save menu item all model properties, views and 

associated values are saved also. If a results file was open when the model was saved this is 

not re-opened automatically when the model is re-opened later. 

Customising the Environment 

Various user-definable settings and facilities allow the interface to be customised. 

 Window properties contain options relating to the current window. 

 Startup templates can be used to pre-load the Attributes Treeview of the interface 

with selected attributes for a particular analysis, set default mesh or material types, or 

define preferred colour schemes - to name just a few uses. 
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 Toolbars and toolbar buttons can be customised and user-defined toolbar 

buttons can added to the user-interface either to sit on a new toolbar group or 

alongside existing buttons in an existing group. 

Window Properties 

The Window Properties dialog shows options relating to the current window. Window 

properties may be displayed by double-clicking in a blank part of the graphics area (with no 

features selected), or by right-clicking a window in the  Treeview and then selecting 

Properties from the context menu. Window properties define basic view information. 

 General Show or hide the screen ruler, selection tolerance, and enables the window 

background and selection colours to be modified. 

 View Shows the view rotation vector and rotation increment. Provides isometric 

projection. Enables the scale and origin position to be set and allows the current view 

settings to be saved. 

 View axes Controls whether and at what position to visualise the coordinate system 

and provide control of the style. 

General 

 View name is the name of the current window 

 Show Rulers Shows, (or hides), the X,Y,Z axis rulers of the current window. 

 Selection tolerance Sets how close the cursor has to be to a feature to be able to select 

it.  

Colours 

LUSAS uses standard Microsoft Windows colours to define the screen colours by default. By 

deselecting the Use Windows colours option the following colours can be changed: 

 Background colour Sets the window background colour. 

 Selection Pen Sets the pen colour used to draw model feature when they are selected. 

 Selection memory Pen Sets the pen colour used to draw model features when they 

are in selection memory. 

View 

 Scale to fit window/page Option set by the resize button to ensure the model fits the 

screen area. 

 Scale  Option enables the model to be scaled 

 Origin position Defines the origin of the model 
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 Rotation Vector An equivalent eye position coordinate. Entering (0, 0, 1) views the 

model from the Z axis, and (1, 2, 3) gives a three-dimensional view. 

 Rotation increment Sets the rotation increment used for incremental rotation. 

 Triangle sort Defines the triangular sort algorithm to use when shading (GDI drivers 

only) 

 Save View Saves the current view, including the window properties, pen library, 

colour map and window layers. When a view is loaded into a window you have the 

choice of what to reload e.g. colours, layers, etc. 

View Axes 

 Visualise coordinate system Visualises the active coordinate system in the graphics 

area using the position and style specified. The active coordinate system may be set 

from the Geometry tab of the model properties dialog. 

 Anchor point Anchors the coordinate axes to either a model coordinate, or a frame 

(window) coordinate. 

 Styles Defines the style used to draw the coordinate axes and optionally sets the font 

used for axes labelling. 

Customise Startup Templates 

Startup templates can be used to pre-load the Attributes Treeview with selected attributes for 

a particular analysis, set default mesh or material types, or define preferred colour schemes - 

to name just a few uses. User-defined startup templates are created by recording the setting of 

a variety of selections and then associating the recording with a template name. 

Case Study. Creating a Startup Template 

In this example a startup template will be created to define a material type, set it as the 

default, and also set user-defined display colours for the Modeller graphics window. 

1. Run LUSAS and create a new blank model of any filename. 

2. Select File > Script > Start Recording and enter my_defaults as the filename. 

3. Select Attributes > Material > Material Library, choose Mild Steel and click 

OK. 

4. In the Attributes Treeview, right-click on Mild Steel Ungraded and select Set 

Default.  

5. In the Graphics Area, right-click and select Properties 

6. Deselect Use Windows colours, select a Black background colour, choose a 

Yellow selection pen and click OK when done. 

7. Select File > Script > Stop Recording 

8. Exit from LUSAS. 
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Case Study. Using the Startup Template 

1. Run LUSAS and on the New Model dialog select the  button adjacent to the 

Startup template drop-down list. 

2. On the Customise Startup Template dialog select the  button adjacent to the 

Script field. Enter My defaults into the Name field. Press the Add button to add the 

script and name to the table. Click OK. 

3. On the New Model dialog, select My defaults from the Startup template drop-down 

list and click OK. 

4. The startup template script will run setting all values to those previously chosen. 

 

Toolbars and Toolbar buttons 

The toolbars used on the Modeller user interface can be adjusted by using the View > 

Toolbars menu item. Toolbar groups can be turned on or off, new toolbar groups can be 

defined, customised toolbar groups can be created and user-defined toolbar buttons can added 

to the user-interface either to sit on a new toolbar group or to sit alongside existing buttons in 

an existing group. Toolbar manipulation is provided by a third-party and incorporated into 

LUSAS Modeller for general use.  

Turning toolbar groups on and off 

Toolbar groups are listed in the Toolbars dialog and may be turned on or off by checking each 

item in the list. The following options are also available: 

 Show Tooltips shows a temporary description of the toolbar button when the cursor is 

moved over the button. 

 Cool Look removes the raised button style to leave a 'flat' button. 

 Large Buttons are not implemented in LUSAS modeller 

Creating a new toolbar group 

Favourite toolbar buttons (and any user-defined toolbar buttons) can be grouped together into 

a new toolbar group.  

 Use the New button on the Toolbars dialog to create a new, named toolbar group such 

as 'Personal'. An empty 'Personal' button group will be added to the Modeller user 

interface. 
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Customising toolbar groups 

Toolbar buttons can be added to exiting toolbar groups or placed on new toolbar button 

groups. 

 Use the Customise tab to select a toolbar category and then, from the arrangement of 

buttons shown for that category, drag and drop a toolbar button into an empty part of 

the user interface. This can be repeated for as many buttons are necessary. As each 

button is added the button group will enlarge to accommodate it. Button groups can be 

'docked ' alongside other button groups on the user interface by dragging and dropping 

into place. 

 Buttons may be removed from toolbar groups by holding down the Alt key and then 

dragging the button into the View window. 

Creating user-defined toolbar button actions 

Nine user-definable toolbar buttons are provided for linking to a specified action. With the 

Customise tab selected these can be seen if the User entry is selected in the Categories list. 

Scripts can be recorded and specified to be played when a particular user-defined toolbar 

button is selected. 

 In Modeller, use File > Script > Start Recording to record an action to be taken 

(such as the adding a Contours layer to the Treeview and the selecting a particular 

entity such as Force / Moment, and a component such as Mz, for example). Then use 

File > Script Stop Recording to save the script with a name such as Bending.vbs to a 

folder. 

 Then use the User tab to define the action that a particular user-defined toolbar button 

should take when pressed. This involves inserting a text string to reference the script 

that was recorded. A typical entry would read: Fileopen 

"C:\LUSAS144\Projects\Bending.vbs" 
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Changing the user-defined toolbar button images 

The default numbered user button images as supplied are held on a single bitmap image that 

is144 pixels wide and 15 pixels high. Each toolbar button image is created in sequence and 

occupies a region that is 16 pixels wide and 15 pixels high. The bitmap is named 

userToolbar.bmp (case-sensitive) and can be found in <LUSAS Installation 

Folder>\Programs\Config folder.  

  

  

User toolbar button bitmap image as supplied 

  

Example of user-defined toolbar button bitmap image 

It is recommended that the supplied file is copied and renamed to userToolbar_supplied.bmp 

prior to making any changes to this supplied file. Changes made to the button images will be 

seen when LUSAS Modeller is next run. 
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Chapter 3 : File 

Types 

  

LUSAS File Types 

LUSAS uses a significant number of different file types for a varied range of purposes. The 

file types covered are summarised below. 

 Model Files (.mdl) are created by LUSAS Modeller and are used to store all model 

definition information. 

 Analysis Data Files (.dat) are created by LUSAS Modeller during the tabulation 

phase. They contain the data required by LUSAS Solver to perform an analysis. 

 Solver Output Files(.out) are text files which are created by LUSAS Solver. They 

contain an echo of the input data, details of any errors or warnings which have 

occurred during the analysis and tabulated results if requested.  

 Solver Results Files (.mys) are created by LUSAS Solver and contain all of the 

analysis results for access by LUSAS Modeller. Results files are also referred to as 

plot files. 

 Modeller Results Files (.mrs) are created by LUSAS Modeller and are used to store 

the results cache when the model is saved. These files save assembled results and 

speed up the results processing of combinations. If necessary mrs files may be deleted 

to save disk space. 

 History Files(.his) are created by LUSAS Solver and contain specified analysis 

results for access by LUSAS Modeller. 

 Script Files (.vbs) contain a collection of LUSAS Modeller commands so that, when 

they are replayed, a sequence of operations may be carried out automatically. Script 

files can be recorded by LUSAS Modeller or edited directly using a text editor. 

 Session Files (.ses) are created automatically every time LUSAS Modeller is run. 

They contain a record of all commands issued during a session. 

 Interface Files (.dxf, .igs, .stp, .stl, .def, .nf) allow graphical structural information to 

be exchanged between LUSAS Modeller and external packages. 
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 Command Files (*.cmd) are used to import and export models from and to version 13 

of LUSAS Modeller where only geometry features supported by version 13 Modeller 

will be exported. 

 Picture Files (.pic, .bmp, .jpg, .wmf) allow contents of the Graphics Area to be saved 

in a standard file format. Picture files are used to subsequently display the information 

or, in conjunction with the LUSAS Expose program, to create files which may be 

printed or plotted. In addition to LUSAS picture files, screen content can be saved in 

BMP, JPG or WMF file formats. 

Tip. All file types assume the default extensions that are given in brackets. When specifying 

filenames it is good practice to simply supply the filename without the file extension. LUSAS 

will then supply the correct extension for the file type being written which will ensure that 

existing files are not inadvertently overwritten by specification of the wrong file type. 

Model Files 

Model files contain all the information regarding the current database and settings. The 

information is stored in an binary form and may only be accessed using LUSAS Modeller. A 

model file is not saved automatically, LUSAS Modeller prompts on exit as a reminder to save 

changes to a model file. 

 New accessed from the File> New menu item, prompts to close an existing model file, 

and creates a new model file. 

 Save or Save As accessed from the File menu, saves the current model to disk at any 

time. Save As allows specification of an alternative filename. 

 Open Previously saved model files may be opened by choosing the required model 

file using the File Open dialog. Modeller will prompt for confirmation before the 

currently loaded model is closed. 

 Close Closes the currently open file. 

Notes 

 When using version 14 of Modeller, old version 13 models may be read but this may 

take longer than usual as the files are converted. 

 When saving a model, disk space may be saved by deleting the mesh and faceting data 

using the Advanced button on the File> Save As menu item. This data will be 

regenerated when the model is reloaded. 

Analysis Data Files 

In order to perform an analysis, the model must be tabulated into a LUSAS Solver data file. 

The Solver data file has a .dat extension. 

Writing the LUSAS data file is controlled using the File> LUSAS Datafile menu 

item. This produces a data file in readable ASCII text format. If necessary, the file may be 
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modified with a standard text editor. The format of the analysis data file is described fully in 

the Solver Reference Manual 

The File> LUSAS Datafile menu item allows the following options to be set in order to 

control the analysis process from within LUSAS Modeller: 

Process 

This controls the parts of the model for which data is tabulated. 

 All items (default) 

 Visible Items 

Solve Now 

If this is set LUSAS Solver will run immediately after the data file is tabulated (default). If 

this is not set a data file is tabulated but not solved.  

When the Solve now option is set the Options button is enabled. This displays a dialog which 

allows the following parameters to be set. 

 Wait for solution - If set Modeller cannot be used while the solution is progressing 

(default). 

 Load results - If set Modeller automatically loads the results file over the model file 

when the solution has successfully completed. (default). 

 Load output file - If set Modeller loads the output file created during the solution 

process. 

Notes 

 During the tabulation process progress will be reported to the Text Window. If 

problems are encountered warnings and/or error messages will be displayed in the 

same window. Such warnings and errors can be caused by inconsistencies in the 

model data which may produce erroneous analysis data files. These errors should be 

acted on before continuing with an analysis. 

 LUSAS is configured to run the majority of analyses without the need to adjust the 

system parameters. In some circumstances however it may be necessary to adjust one 

or more of these parameters. System parameters may be modified from within the 

File> Model Properties using the System Variables tab. Modified parameters will 

be tabulated in a SYSTEM chapter at the start of the LUSAS Solver data file.  

Advanced Solution Options 

The analysis is controlled from the Advanced Solution Options dialog activated using the 

Advanced button.  
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Datafile Type 

 General analysis should be used for all analysis types except influence line analyses 

(default). 

 Influence Lines produces a data file as above with additional files describing 

influence line and search area information. 

Type 

  Structural Carries out a structural analysis. 

  Thermal Carries out a thermal/field analysis. 

  Coupled - Carries out a coupled analysis. 

Controlling Content of LUSAS Solver Output File 

By default no results are written to the LUSAS output file. Results can however be written to 

the output file for all elements and nodes or for those in the current Selection or the Selection 

Memory. The following options allow the results written to the output file to be specified. 

 Element results such as stress and strain (as controlled by the LUSAS Solver options 

set from the File> Model Properties menu item) can be written to the output file at 

Node and/or Gauss points and also written to a history file if required. 

 Node displacements and reactions can be written to the output file and a history file 

can also be written if required. 

 Generate plot file If selected configures the LUSAS Solver data file to create a plot 

file (mys). (default) 

 Generate restart file If selected configures the LUSAS Solver data file to create a 

restart file (rst). 

Solver Output Files 

When an analysis is performed by LUSAS Solver it creates a text output file which has an 

echo of the input data, details of all errors diagnostics and warnings and tabulated results. 

  

Solver Results Files 

When an analysis is performed by LUSAS Solver it will create a LUSAS results file. The 

LUSAS results file, or plot file as it is sometimes referred to, has a .mys extension.  

For transient and nonlinear analyses the frequency that LUSAS Solver writes results to the 

results file is specified when defining the analysis control. If this is not specified results are 

saved in the results file on every time step or load increment. 
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The information in a Solver results file is stored in a compressed binary format and may only 

be accessed using LUSAS Modeller. The results file will contain the results of the analysis 

and sufficient model information to process the results. Full details of the finite element mesh 

(nodes and elements), material and geometric property numbers, support positions and 

equivalent nodal loads are stored in the results file so that results processing can be carried 

out without a model file if desired. 

To access results from the LUSAS analysis, results files can be opened in a similar way to 

model files.  

Modeller Results Files 

A Modeller results file contains loadcase combination and envelope component results that 

are calculated by LUSAS Modeller. Modeller results files have a .mrs extension and are 

saved whenever the model is saved.  

A Modeller results file speeds-up the assembly of the selected results within LUSAS 

Modeller since the component results are only calculated once for the selected combination 

and envelope results components. This means that when setting each combination or envelope 

active for viewing results the software does not have to re-calculate the results for that results 

component. However, selecting a combination or envelope result component that is not pre-

calculated will cause the results for all envelopes of envelopes and combinations to be re-

calculated.  

The information in a Modeller results file is stored in a compressed binary format and may 

only be accessed using LUSAS Modeller.  

History Files 

History files are used to output the named variables, and selected node and element results 

from LUSAS Solver in an ASCII format. Specification of the node and element numbers to 

be output to this file is defined from the File> LUSAS Datafile menu item. The output 

frequency for incremental analyses is controlled using analysis control. The results stored in 

the time history file can be accessed for graphing. 

The history file format consists of a header section with a title, list of named variables, type of 

nodal results and type of element results, followed by the results for each time/increment 

number. The format is shown below. Note. Due to space limitations, the number format has 

been adjusted. Standard history files will contain accuracy to machine precision. 

The named variables, selected nodal results and selected element Gauss point results will be 

output for each time step or increment as specified in the analysis control. 

Script Files 

Script file may be created and used to store a sequence of commands for later playback. 

Script files are created in Visual Basic Script (.VBS) format and are particularly useful for 

storing combinations of commands which are used frequently. Uses include consistent 

reproduction of screen images for use in reports and use with startup templates to pre-load 

the Attributes Treeview with selected attributes for a particular analysis, set default mesh or 

material types, or define preferred colour schemes.  
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Scripts are normally run by opening the file in a file browser but user-defined toolbar 

buttons can be set-up to run scripts. 

Script file manipulation is controlled from the Files> Script menu item. The following 

functionality is available: 

 Run Script An existing script file is replayed by choosing it from the Open 

dialog. 

 Start Recording creates a script file. If a non-default file extension is specified or if 

the file already exists you will be prompted for confirmation before proceeding. 

Existing script files can be appended to if required. While recording all attempted 

commands are logged to the script file using the LUSAS scripting language. 

 Stop Recording closes the script file. 

Session and Recovery Files 

Each time Modeller is run or the model is saved a new recovery file is created in the current 

working folder. This recovery file is named after the model name with the .rcv extension. 

Every attempted command, whether entered from the user interface or via the command line, 

is logged in this file using the scripting language. When the model is saved or the user exits 

Modeller the recovery file is renamed to a session file with an incrementing version number.  

Picture Files 

About Picture Files 

LUSAS picture files may be used for storing graphical information for subsequent conversion 

to an alternative file format using the LUSAS picture file utility program, Expose.  

LUSAS picture files are stored in readable ASCII text format. The individual picture file 

records use the following general format: 

code, r1, r2, r3, r4, i1, i2, i3 

The information is stored in packets of data as defined in the following table. 
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Code 
   

Function 
   

Parameters 
   

Description 

1 
  

Move 
  

r1, r2 
  

Moves to the drawing location specified by the x (r1) and y (r2) 
coordinate (mm). 

2 
  

Draw 
  

r1, r2 
  

Draws a line from the current position to the drawing location 
specified by the x (r1) and y (r2) coordinate (mm). 

3 
  

Symbol 
  

r1, r2, r3, r4, 
i1 

  
Plots a LUSAS built-in symbol at a specified screen position. (0-
Square,1- Circle, 2-Triangle, 3-Double Triangle, 4-Diamond, 5-
Cross, 6-Boxed Cross, 7-Asterisk, 8-Horizontal Arrow (origin at 
apex), 9-Horizontal Arrow (origin at base), 10-Vertical Arrow, 11-
Vertical Line, 12-X, 13-Y, 14-Z, 15-Barred X  

4 
  

Character 
  

r1, r2, r3, r4, 
i1 

  
Plots an ASCII character at a specified screen position with: x 
coordinate (r1), y coordinate (r2), rotation angle in degrees (r3), 
character height in mm (r4) and ASCII character code (i1). 

5 
  

Colour 
  

r1, r2, r3 
  

Percentage colour content with: red % (r1), green % (r2) and blue % 
(r3). 

9 
  

  
  

r1, r2, r3, r4, 
i1 

  
Starts a colour-filled multi-sided polygon with: number of vertices 
(i1). Real numbers (r1-r4) are not used. 

0 
  

  
  

r1, r2 
  

Creates a polygon vertex with: x and y coordinate (r1-r2). Must be 
used in conjunction with and appear immediately after code 8 or 9 
above. 

10 
  

Clipping 
Rectangle 

  
r1, r2, r3, r4 

  
Sets current clipping rectangle x1-r1, y1-r2, x2-r3, y2-r4 

20 
  

Multi-Line 
Text 

  
r1, r2, r3 ,r4 
,i1 ,i2 

  
Defines mutli-line text located at x-r1, y-r2, rotation-r3 (degrees), 
size-r4 (mm), alignment-i1 (0-top left, 2-top right, 6-top centre, 8-
bottom left, 10-bottom right, 14-bottom centre, 16-middle left, 18-
middle right, 22-middle centre, 24-baseline left, 26-baseline right, 30-
baseline centre), nLines-i2 (number of subsequent lines of text) 

Saving Picture Files 

 Pictures may be saved using the File> Picture Save menu item. 

 Note that views of a LUSAS model can also be saved for use in other applications as 

BMP, JPEG, or WMF files using the File> Picture Save menu item. For more 

information see Printing and Saving Pictures 

Print Files 

When using the print result wizard the output may be re-directed to a Print File. A print file 

has a .prn extension. The opening and closing of print files is controlled using the Files> 

Print File menu item. The following facilities are available: 
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 File> Print File> Open The print file is opened by specifying a valid filename. 

LUSAS will prompt for confirmation to proceed if the specified file already exists or 

if a non-default file extension is used.  

 File> Print File> Close The print file may be closed at any time. With no print file 

open, printed output will be directed to a text output display window. 

Notes 

 Output to the text window can be directed to a log file. See Text Window for more 

details. 

Interface Files 

Interface files are used to transfer external modelling or material data into and out of LUSAS 

Modeller. The full model or a selected portion of a model can, dependent upon the file format 

chosen, be exported to an interface file format. 

The currently supported list of interface file formats is: 

 CMD (.cmd) Format for import of LUSAS Modeller model files saved as command 

(CMD) files in previous versions of LUSAS. 

 Solver Data Files (.dat) LUSAS Solver data files (used to import or node and 

element data) 

 DXF (.dxf) AutoCAD Drawing eXchange Format.  

 IGES (.igs) Initial Graphics Exchange Specification. Format for import and export of 

geometry data. 

 LMS CADA-X  (.nf) Model description and modal data exported to a file that can be 

read by the LMS software. 

 NASTRAN Bulk Data files (.bdf, .dat) (used to import node and element data) 

 ANSYS cdb files (.cdb) (used to import node and element data) 

 Abaqus input files (.inp) (used to import node and element data) 

 PATRAN (.def) Neutral file format for inputting phase I geometry information and 

outputting phase II mesh information 

 STEP (.stp) STandard for the Exchange of Product data. 

 STL (.stl) Stereolithography data files. 

In addition to these interface files, search area topology files (.inf) can be imported into 

LUSAS for graphical cross-checking. These files, which contain details of search areas used 

by Autoloader, are converted into geometric line and surface data in LUSAS 

 Search area topography (.inf) Autoloader generated search areas. 
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Summary of Interface File Import / Export Capability 

Interface file name and extension Import file into LUSAS? Export file from LUSAS? 

CMD (.cmd) YES YES 

SOLVER Data File (.dat) YES NO 

DXF (.dxf) YES YES 

IGES (.igs) YES YES 

LMS CADA-X (.nf) YES YES 

NASTRAN Bulk Data Files (.bdf, .dat) YES NO 

ANSYS (cdb) YES NO 

ABAQUS (.input) YES NO 

PATRAN (.def) YES NO 

STEP (.step, .stp) YES YES 

STL (.stl) YES YES 

Notes 

 See Importing Geometry Data for details of how to import interface files. 

 See Importing Mesh Data for details of how to import finite element data files created 

either by the prior running of an analysis in LUSAS or by importing interface files 

from other supported third-party software applications 

 DXF, IGES and STEP files often contain much more detailed information than is 

required to create a finite element model, so a certain amount of model tidying should 

be expected after carrying out an import.  

File Import 

Geometry data from interface files can be imported using the File> Import... menu item. 

When a file is selected the Advanced button can be used to specify import parameters. After 

all feature entities have been imported, a feature merge will be carried out according to the 

merge setting defined under Model properties.  

Mesh data from supported interface files can be imported using the File> Import Mesh... 

menu item. 

File Import Options (Advanced) 

Only those options applicable to the file being imported will be available for selection. 
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Option Description Default 

Translate 
annotation type 
geometry entities 

Include entities marked as annotation. 
  

False 

Translate blanked 
entities 

Include entities marked as blank. 
  

False 

Merge trimming 
lines 

Attempts to merge the trimming lines of trimmed surface 
entities. 

False 

Delete dependent 
geometry 

Will delete geometry objects created from entities marked 
as dependent. 

True 

Delete points not 
defining lines 

All points not connected to a line are removed. True 

Delete lines not 
defining surfaces  

All lines not connected to a surface are removed. True 

Delete unconnected 
lines 

Deletes unconnected lines that do not define any surfaces. True 

Use domain space 
trimming curves 

Use domain space trimming curves in preference to model 
spacing trimming curves. 

False 

Lock the mesh post 
import 

Locks the mesh following import to ensure it is not changed 
unintentionally. 

False 

Model is solid 
volumes 

If selected, fills in any missing data to create a solid 
volume. 

False 

Coalese volumes Removes similar surfaces from adjoining volumes to 
simplify the model. 

True 

Create material 
groups 

Create named groups for features in the data file having the 
same material property 

False 

Maximum number 
of groups 

Maximum number of groups permitted to be created from 
material property types 

500 

Merge geometry 
post import 

Merges geometry within the general specified merge 
tolerance. 

True 

Minimum line length Facets containing lines of less than this specified length will 
be ignored. 

False 

Minimum angle 
degrees 

Facets containing lines of less than this specified length will 
be ignored. 

False 

Pre-translation 
scale 

Scaling factor applied to all entities before translation. 1.0 

Radius of curvature 
to length ratio 

Minimum allowable radius of curvature to line length ratio in 
surface trimming. 

1% 

Parsing error limit Import terminate after specified number of error (0 indicates 
no limit). 

2 

Entity types to 
exclude 

List of entity type numbers to ignore (if checked), entities of 
these type numbers will not be translated unless they 
define entities that are to be translated.  

Ignore 106 
(copious data) 
and 108 (plane 
surface)  
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Drawing layers to 
process 

Allows selection of named layers when importing DXF or 
IGES data. 

None 

Importing Mesh Data 

Mesh-only models can be created by importing finite element data files created either by the 

prior running of an analysis in LUSAS or, more usually, by importing data files from other 

supported third-party software applications. Use the File > Import Mesh menu item to do 

this. When a file is selected the Advanced button can be used to specify import parameters. 

During the mesh import process, Modeller creates separate Groups for each element type 

encountered. For models created from LUSAS data file these will be familiar LUSAS 

element names. For models created from other software they will be the names used within 

that system, whatever they may be. See Mesh-only models for more information. 

After import the vertical axis for the model may need to be defined to ensure correct 

isometric viewing and loading of the model. See Mesh-only models for more information. 

File Import Mesh options (Advanced) 

Only those options applicable to the file being imported will be available for selection. 

Option Description Default 

Create 
material 
groups 

Create named groups for elements in the data file having the same material 
property. A maximum number of groups can be specified and if more groups 
are created the number specified only the most common element groups in 
the model will be created. This option is for use with LUSAS Solver data files 
and Nastran bulk data files only. 
  

False 

Exporting Model Data 

Model data can be exported to a chosen interface file format by using the File> Export menu 

item.  

Depending upon the export file format chosen the following export options may be available: 

 Current window 

 All 

 Visible   

And the following features may be exported: 

 Geometry and Mesh (excluding volumes) 

 Geometry and Mesh (including volumes) 

 Geometry Only 

 Mesh only (excluding volumes) 

 Mesh only (including volumes) 

 Nodes Only 
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DXF Interface Files 

The AutoCAD Drawing eXchange Format or DXF file, as it is more commonly known, can 

be used to import and export data to and from LUSAS. 

DXF Import 

DXF files are imported using the File> Import...  menu item. 

DXF entities supported by the LUSAS DXF import facility are listed in the table below. 

DXF Entity 
   

Imported as LUSAS Feature 

POINT 
  

Point. 

LINE 
  

Straight Line. 

3DLINE 
  

Straight Line. 

ARC 
  

Arc Line. 

CIRCLE 
  

Two arc Lines. 

POLYLINE 
  

Spline Line. 

SOLID 
  

Straight-edged Surface. 

3DFACE 
  

Straight-edged Surface. 

TRACE 
  

Straight-edged Surface. 

POLYGON MESH 
  

Multiple straight-edged Surface. 

POLYFACE MESH 
  

Bicubic Surface. 

EXTENDED ENTITIES 

  
  

Not supported. 

Tip. Units and entity orientation can be modified by defining a local coordinate and making 

this active before importing. For example, the units may be changed from mm to m during 

conversion by defining a scale local coordinate with X, Y and Z scale factors of 1e-3. The 

entity orientation may be changed from landscape to portrait with the aid of an XY rotation 

local coordinate with an angle of 90 degrees. 

Notes 

 The amount of information which may be transferred via the DXF file is limited due 

to limitations in the DXF file format (for example, a volume cannot be expressed in 

standard DXF data). 
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 AutoCAD version 13 uses DXF extended entities for some items. LUSAS does not 

support import of extended entities and will warn to this effect if an AutoCAD version 

13 DXF file is detected. 

 Closed surfaces are not translated by LUSAS. 

 Closed polylines and three-sided polygon meshes are not translated. 

DXF Export 

A DXF interface file may be created from LUSAS for use in an external program using the 

File> Export... menu item. 

 LUSAS attributes are converted into their equivalent DXF entity. Control over the amount of 

information exported is provided, i.e. All or Visible features and/or mesh may be specified. 

This is valid for both pre-processing model files and results files. The following parameter is 

available on the export dialog to control creation of DXF files: 

 Level Indicator indicates whether Geometry Only, Mesh Only or 

Geometry and Mesh are to be exported. The level indicator is only required when a 

model file is open and features are active. When no model is loaded, such as during 

post-processing, only the mesh is exported. Additional options are available to include 

Volume mesh entities in the export process. Only element faces are exported when 

exporting Volume feature mesh records. 

LUSAS feature types supported by the DXF export facility are listed in the table below: 
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LUSAS Feature/Mesh 
   

Exported as DXF Entity 

Feature LINE (straight) 
  

3DLINE 

Feature LINE (arc) 
  

ARC 

Feature LINE (spline) 
  

POLYLINE 

Feature SURFACE (straight-edged) 
  

3DFACE 

Feature SURFACE (general curved) 
  

3DLINE/ARC/POLYLINE 

Mesh LINE (linear or quadratic edge) 
  

3DLINE 

Mesh SURFACE (linear or quadratic face) 
  

POLYFACE MESH 

Mesh VOLUME (linear or quadratic face) 

  
  

PLOYFACE MESH 

Notes 

 The exporting of models generates DXF files containing structural information only. 

This facility is not intended for exchanging graphical information, for this purpose 

picture files should be used. 

 Only the element faces are exported when exporting volume feature mesh records 

 For further information on the DXF file format, users are referred to the AutoCAD © 

Reference Manual. 

IGES Import / Export 

IGES files are imported from the File> Import... menu item. When a file is selected the 

import process may be controlled from the Advanced button by specifying import 

parameters.  

LUSAS Model geometry may be exported to IGES using the File> Export... menu item. 

Notes: 

 IGES data is made up of a number of discrete surfaces. These need to be merged 

together to create volumes which can then be meshed. 

 When IGES import is used the option to crate hollow volumes is automatically 

invoked. 

 Any active local coordinates will be ignored.  
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 All IGES annotation lines and font data is ignored.  

 The IGES interface only supports fixed length ASCII IGES files.  

 All curve and surface geometric type entities are translated into LUSAS Modeller.  

Supported IGES Entities: 

Entity Description 

100 circular arc 

102 composite curve 

104  conic arc 

106 copious data 

108 plane surface 

110 straight line 

112 parametric spline curve 

114 parametric spline surface 

116  point 

118  ruled surface 

120  surface of revolution 

122 tabulated cylinder 

124 transformation matrix 

126  rational B-spline curve 

128  rational B-spline surface 

130  offset curve 

140  offset surface 

141  trimming line of bounded surface 

142  trimming line of parametric surface 

143 trimmed bounded surface  

144  trimmed parametric surface 

186 B-rep volume 

Note. Only those found in the selected IGES file are displayed in the exclusions list. 

LMS CADA-X Files 

This data format is used to export data from LUSAS Modeller to the LMS Modal Analysis 

Suite of Software. 
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 When exporting modal data or element matrices, a check for a results file is made. If 

no results are available, the moddat parameter is deselected. The modes for export 

dialog is only displayed if modal data is requested. 

 The mode shapes input dialog will expect the mode shape numbers to be entered in 

the same manner as the SET MODAL MODES command.  

The format is: resultfileID:mode1;mode2;mode-aTmode-bIincrement ... etc. 

 Additional system parameters are required to deal with problems encountered when 

reading the neutral file into LMS. These variables should be set as shown below in the 

Modeller start-up file. The variables are defined as follows: 

 LMSTKV when set forces the THICKV element property keyword to accept the 

#NO_DEF purpose code to describe the property type instead of MEMBRANE, 

PLANESTRAIN, SHELL, PLATE and SHEAR. This is due to an error in the LMS 

parser. 

LMSTKV should be set to 1 to have #NO_DEF output to the neutral file. 

LMSTKV should be unset to have normal codes output to the neutral file. 

The default setting is 0. 

 LMSDMP forces the export routines to only output SPRING and MASS elements 

and properties for joints instead of SPRING, MASS and DAMPER elements and 

properties. This is to work around a limitation in the LMS parser which will not 

interpret the DAMP or DAMPER keywords. 

LMSDMP should be set to 3 to have 3 properties/elements per joint output. 

LMSDMP should not be set to have 2 properties/elements per joint output. 

The default setting of LMSDMP is 2 (2 properties/elements per joint). 

 LMSPRC allows the user to specify single or double precision real number output in 

the neutral file. Using this parameter can reduce the size of the neutral file. The 

differences between the two types of precision is as follows: 

Single precision: +n.nnnnnnE+ee 

Double precision: +n.nnnnnnnnnnnnnE+ee 

Currently LMSPRC can take the following values: 

LMSPRC = 1 Single precision format (default) 

LMSPRC = 2 Double precision format 

LMSPRC = 3 Double precision format on a single precision machine. 

LMS Export 

 Option 290 must be set before tabulating a model to ensure element matrices are 

transferred from LUSAS. 

 Option 290 allows you to instruct LUSAS to output the element STIFFNESS and 

MASS matrices to the .mys plot file. The volume of data transferred can be substantial 

so this option is turned off by default.  

 Nodal Freedoms LMS supports only six degrees of freedom: X, Y, Z, Rx, Ry and Rz. 

If unsupported freedoms are encountered a warning message is issued. If this section 
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is not present it will not affect the translation of the neutral file into LMS as long as 

no node statement contains a reference to a #Frnnn freedom label. 

 Node Coordinates The node co-ordinates are written with the co-ordinate system 

omitted implying the use of the global co-ordinate system. The Modeller node 

labelling scheme is preserved during the export process. 

 Material Properties (mdl file) Isotropic, 2D Anisotropic and 2D Orthotropic 

materials are supported. 3D material properties are exported as ANISO3D, however 

the values are read but not used by LMS. Joint properties are output in the element 

property section of the neutral file. 

 Material Properties (mys file) Material properties are transferred from LUSAS to 

Modeller. If no material properties are detected in the LUSAS mys file, then dummy 

material properties are set-up and a warning is issued. Materials can be used in LMS 

to group common elements together. The dummy properties allow the other model 

description entities (element topology) to be read by the LMS parser. 

 Element Properties (mdl file) The LMS element properties supported are PBAR, 

STIFF, PMASS, BEAMG and THICKV. The corresponding Modeller geometric 

properties are mapped into the expected LMS format. Supported Modeller property 

types are as follows: Bar/Link, Beam, Membrane/Plate/Shell. Beam and joint 

eccentricities are ignored. Checks for unsupported element properties are made and a 

warning is issued if any are found. Unsupported element properties are not output. 

 Element Properties (mys file) Modeller geometric properties from the mys file are 

transferred and output into the LMS neutral file. The same constraints as for the mdl 

file apply. 

 Element Topology Elements are output in element type order. Material properties 

must be specified for all elements, but LMS element properties for solid elements are 

optional. Checks for unsupported elements are made and a warning is issued with the 

unsupported elements not written to the neutral file. Beam elements which have end 

freedoms released are output to the neutral file, but the node freedoms are not 

transferred as they may not be valid for all connections to a node. Supported elements 

are shown in the table below. 

 Eigenvectors and Frequencies Node displacements for all nodes specified in the 

model description are output to the neutral file in the global co-ordinate system. When 

mode shapes are read by LMS, the mode shape numbers will not necessarily be the 

same unless all eigenvectors are exported. Modeller mode shape numbers are 

preserved during an export, but are not preserved when read into the LMS software. 

 Element Matrices The element matrices (stiffness and mass) are output in element 

type order. There are three sections required to define a matrix. These are MATSHP, 

MATVAL and MATDEF.  

By definition elements of the same type have the same matrix shape, therefore for each 

element type there is only one MATSHP keyword. However, each element matrix contains 

different values and hence gives rise to one MATVAL and MATDEF statement per element 

matrix. To reduce the amount of matrix data output to the neutral file, and to keep its size to a 

minimum, only the non-zero (active) columns of the element matrices are processed. 
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Supported Elements 

The following elements are supported by LMS. 

Bars Beams Plates, Shells, Membranes Solids Joints 

    
Triangular Quadrilateral Tetra Penta Hexa   

BAR2 BEAM TPM3 QPM4 TH4 PN6 HX8 JF3 
BAR3 BMS3 TPM6 QPM4M TH4E PN6E HX8M JPH3 
BRS2 BRP2 TPM3E QPM4E TH15 PN15 HX20 JRP3 
BRS3 GRIL   QM8       JNT3 
    TF3 QF4       JNT4 
    TTF6 QSC4         
    TRP3 QTF8         
      RPI4         
                
    TS3 QSI4         
    TTS3 QTS4         
    TTS6 QTS8         
                
    TSM3 SMI4         

NASTRAN BDF and DAT Import 

Data from NASTRAN Bulk Data Files (.BDF) or DAT (,dat) files can be imported to create a 

feature-based geometry model using the File> Import... menu item or a mesh-only model by 

using the File > Import Mesh menu item. When a file is selected the Advanced button can 

be used to specify import parameters. See Model Types for more information. 

ABAQUS Input File Import 

Data from Abaqus Input Files (.inp) can be imported to create a feature-based geometry 

model using the File> Import... menu item or a mesh-only model by using the File > Import 

Mesh menu item. When a file is selected the Advanced button can be used to specify import 

parameters. See Model Types for more information. 

ANSYS CDB File Import 

Data from ANSYS CDB Files (.CDB) can be imported to create a feature-based geometry 

model using the File> Import... menu item or a mesh-only model by using the File> Import 

Mesh menu item. When a file is selected the Advanced button can be used to specify import 

parameters. See Model Types for more information. 

PATRAN Interface Files 

About PATRAN 

The PATRAN neutral file contains the full finite element model information. The Neutral file 

is split into two data categories: Phase I contains the definition of the geometric entities, and 

Phase II contains all of the finite element (node and element) information. 



  Chapter 3 

    

67 

PATRAN Import 

PATRAN files are imported using the File> Import... menu item.  

Phase I data (geometric entities) is read from the PATRAN neutral file. Phase II data is 

ignored. The following table shows the supported Neutral file packet types for import into 

LUSAS: 

Packet 
   

Title 
   

LUSAS Equivalent 

25 
  

Title 
  

Used for information purposes only. 

26 
  

Time/Date/Version 
  

Used for information purposes only. 

31 
  

grid 
  

Point. 

32 
  

line 
  

Spline Line defined by 2 Points. 

33 
  

patch 
  

Bicubic Surface defined by 4 spline Lines. 

34 
  

hyperpatch 
  

Volume. 

47 
  

trimmed surface 
  

Bicubic Surface and spline Lines defining the trimmed regions. 

Tip. Imported PATRAN data is particularly suited to tidying, since all defined geometry is 

spline data. See Tidying Imported Lines and Surfaces for more details. 

PATRAN Export 

Export of LUSAS data to PATRAN was last supported in LUSAS V14.3 

Solver DAT Import 

Solver DAT files are created by LUSAS Modeller during the tabulation phase. They contain 

the data required by LUSAS Solver to perform an analysis. Both Geometry and Mesh data 

from Solver DAT files may be imported into Modeller. 

Point, Line, Surface and Volume geometry data from Solver DAT files can be imported using 

the File> Import... menu item. When a file is selected the  Advanced button can be used to 

specify import parameters.  

STEP Import / Export 

STandard for the Exchange of Product data (STEP) files are imported according to Part 42 of 

the Geometric and Topological Representation by using the File> Import... menu item. 

When a file is selected the import process may be controlled by clicking the Advanced button 

and specifying appropriate parameters.  

LUSAS model geometry cannot currently be exported to a STEP file. 
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STL Import / Export 

STL files are used by Stereolithography software. They hold information needed to produce 

3D models on Stereolithography machines. 

STL files are imported using the File> Import... menu item. When a file is selected the 

import process may be controlled from the Advanced button by specify the parameters.  

LUSAS Model geometry may be exported to STL format from the File> Export... menu 

item. 

Notes: 

 STL data defines vertices of triangles that define the shape of a surface. 
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Chapter 4 : Model 

Geometry 

  

Introduction 

There are four geometric feature types in LUSAS. 

 Points define the vertices of the finite element model. 

 Lines define the edges of the finite element model. (Combined Lines define edges 

built from a series of continuous lines). 

 Surfaces define external faces or internal construction surfaces of a model. 

 Volumes define simple solid components of a model. 

Features are defined hierarchically , i.e. Points define Lines, Lines define Surfaces, Surfaces 

define Volumes. 

If higher order features are created using techniques which do not involve lower order 

features, for example, by specifying coordinates, Modeller will automatically generate the 

lower order features from which to define them. Furthermore, due to feature associativity, 

when a lower order feature, for example a point, is moved, the higher order features defined 

by it, for example a line, is also moved. 

Features may be deleted from the model provided they are not referenced by a higher order 

feature. For example, a Line may not be deleted if it is used in a Surface definition. 

Notes 

 Attributes are assigned on a feature basis, therefore the positions of geometric and 

material discontinuities, supports and loads must be carefully considered when 

defining the features. 

 By default, coordinates are expressed in terms of a global Cartesian axis system. Local 

coordinates may be used by setting a pre-defined local coordinate active. This is 

achieved by defining a local coordinate and choosing the Set Active command on the 

context menu. See Local Coordinate Systems. 

 Geometry can be imported from other systems. See File Import. 
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Visualising Geometry 

There are a number of ways to visualise geometry all of which are controlled from the 

Geometry  layer properties activated from the Geometry layer context menu. The 

Geometry layer controls the display of all geometry. If the Geometry layer does not exist or is 

hidden by another layer the geometry will not be drawn.  

Show Geometry 

The Geometry layer properties may be set to not show certain geometry types. To aid 

visualisation Points, Lines, Combined Lines, Surfaces and Volumes can all be independently 

not shown as required.  

Note. Not showing a geometry type is not the same as making all items of that type invisible 

as the presence of that geometry will affect the visibility of lower order features. (i.e. A Line 

can not be made invisible if a Surface using that line is not shown (visible but not drawn) 

because the drawing of Surfaces has been suppressed in the Geometry layer properties). 

Display Style 

Geometry can be displayed in a number of styles. By default Geometry is viewed in 

wireframe mode with hidden parts shown but a wide variety of styles can be obtained by 

mixing the options for wireframe with and without hidden line and solid plots. Some 

examples follow: 

 
Default wireframe geometry visualisation 

 
Wireframe with hidden Parts removed 
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Wireframe with hidden parts draw dashed 

 

Solid fill with wireframe and hidden parts removed 

 
Solid fill with wireframe (hidden parts removed) and Points hidden 

Facet Density 

By default lines and surfaces are assigned a facet density which is used in visualisation. Facet 

density effectively controls how smooth a line or surface will look when drawn to the screen. 

Straight lines, arcs and splines are all drawn using facets of a particular line length. Surfaces 

are drawn using facets that are triangular. The default facet density may be changed prior to 

geometry definition from the Geometry tab of the Model Properties dialog or after 

geometry definition by selecting the appropriate Lines and Surfaces and modifying the facet 

density from the  Geometry> Surface> Facet density or Geometry> Line> Facet density 

menu items. 
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The facet density may be specified either as: 

 Maximum facet length (in model units). 

 Maximum deviation d (in model units). 

or for Lines as: 

 Minimum adjacent angle (in degrees). 

 Minimum number of facets for straight line, full arc line and 

spline line. 

or for Surfaces as 

 Minimum number of facets for planar surface, surface with 

seam and other surfaces. 

Note that facet density only affects the display of the geometric 

feature and not the actual geometric accuracy of the model. 

 

Notes  

 The display speed is inversely proportion to the number of facets used to define the 

geometry. 

 The facet density can be visualised by selecting the Facet option on the Geometry 

Layer properties dialog. The facet density display can be restricted to only selected 

Lines and Surfaces using the Facet only if selected option. 

Using Colour For Geometry 

The colour in which geometry is drawn may be specified in many ways.  

From the Geometry layer properties specify Colour by: 

 Own colour An individual feature may be drawn in a pen different from the default 

geometry type pen. The pen is specified on the properties dialog. Select the single 

feature and right click then choose Properties to display the feature properties. Until a 

pen is set for an individual feature, that feature will be drawn using the default pen. 

 Normals Surfaces are coloured according to whether they are orientated showing the 

top or bottom of the surface. 

 Assignment Features are coloured according to which attribute is assigned to them. 

Features with no attribute assigned are drawn in grey. The picture below shows an 

example of this 

 Group Features are coloured according to which group they are in. Features not in a 

group are drawn in grey 
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 Type Each geometry type has a default pen, associated with it. This option causes all 

geometry to be drawn in that pen. The colours may be set from the Model Properties. 

By default the settings are red for Points, magenta for Lines, orange for Combined 

lines, green for Surfaces, blue for Volumes. 

 Line / Surface Connectivity Features are drawn in colours according to the number 

of higher order features connected to them and areas of the model that have not been 

merged together correctly after import are highlighted by being drawn in a different 

colour. One example of use is for checking models created from the import of 

3D CAD data where the use of this option would enable any surfaces that were not 

correctly forming volumes to be seen. Use of the merge facility would correct any 

unmerged and isolated features. 

 

Orientation Axes 

Orientation axes may be viewed as a local axis set for Lines, Surfaces and Volumes . The 

local x, y and z axes are shown, with a double arrowhead on the x axis and a single arrowhead 

on the y axis and no arrow head on the z axis.  

When features are meshed, the orientation of the feature determines the orientation and 

spacing of the elements. Therefore the orientation of Lines, Surfaces and Volumes can be 

changed by reversing or cycling the features. See Changing Geometry Orientation for more 

details. 

In all of the following illustrations the local axes are orthogonal. 

 Line directions can be drawn to 

indicate the local x direction of Line 

or axes can be displayed.  
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 Surface axes or surface normals can 

be displayed. Axes are positioned 

adjacent to the first Line in the 

Surface definition. In the example 

shown the axes are orthogonal but 

viewed from an angle to show the z 

axis orientation. 

 

 Volume axes can be displayed. The 

origin or the axis is closest to the 

first point in the first Surface of the 

Volume definition. 

 

Tip: To aid axes visualisation on larger models choose the Orientations only if selected 

option. This will display axes only on selected features. 

Labels 

Labels can be added to the view of a model from the View> Insert Layer> Labels menu 

item, or from the window context menu. The label options are controlled from the labels 

property dialog. 

Labels may be added to geometry features as follows: 

 Name 

 Position 

 Mesh 

 Geometry 

 Material 

 Supports 

 Loading 

 Transformed freedoms 

 Composite 

 Slideline 

 Constraints 

 Thermal surfaces 

 Retained freedoms 

 Damping  

 Activate 

 Deactivate 

 Equivalence 

 Search area 

 Influence 

 Age 

 Tendon 
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Node, element and Gauss point labels may also be displayed. 

Notes 

 Line labels for standard Lines are drawn at 3/4 distance from the start of the line. This 

can be a useful indication of the line orientation.  

 If a Line is used as part of a Combined Line definition, the Line label is located at 

8/10 distance and the corresponding Combined Line label is located at 6/10 distance 

along the Line segment. This is to avoid the labels overwriting each other. 

 For complex models labels may be displayed only on selected features by choosing 

the Label selected items only option on the label properties dialog. 

Points 

Points define the vertices of the model. Point definition commands are found under the 

Geometry> Points menu item. Points can be defined in the following ways. 

 Coordinates Defines a Point by entering the X, Y and Z coordinates (Z is optional). If 

a non-Cartesian local coordinate system is in use the coordinates are specified in the 

coordinate system of that local coordinate set. The dialog box labels will be updated to 

reflect the required coordinate input. 

 Cursor Allows definition of a series of Points on the screen with the cursor. The 

Points can snap to a grid in the XY, YZ or XZ plane. The out of plane ordinate can be 

specified as non-zero if desired. This facility is useful for positioning Points on Lines 

or Surfaces which will be used for splitting that feature later. 

 From Mesh Defines a Point at the position of every node of the selected mesh.  See 

Geometry From Mesh. This is useful for defining a Point feature to which loads or 

supports can be subsequently assigned. The Point must be equivalenced with the 

underlying meshed feature in order for the Point's assigned attributes to be transferred 

to the underlying nodes. Subsequent re-meshing of the structure with different mesh 

spacing characteristics may result in movement of the 

underlying nodal positions.  

 By Intersection Defines a Point or a number of Points at the 

intersections of two or more selected Lines. When the Lines 

selected do not physically intersect Points may be created at 

the nearest intersections. These nearest intersections are 

controlled by the following options.  

 All point pairs creates Points at all possible intersections. 

 Nearest point pair only creates a Point on each line where the projection of 

the Lines is at its nearest. 
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 Nearest pair to reference position defines Points on each line at the 

intersection nearest to the defined reference Point. 

 Limit distance between points only creates Points at intersections that are 

within a specified distance 

 Allow extended lines will create Points at the intersection of the extension of 

the selected Lines. 

 By Projection Defines a Point at the (perpendicular) 

projection of a selected Point onto a selected Line or 

Surface. 

 By Extension Defines a point at the extension of a selected 

Line. The extension may be defined as a parametric or actual 

length. 

 Make Planar moves the selected points onto a plane 

defined either as an offset from an orthogonal plane, or onto 

a plane defined by 3 coordinates, or as a best fit to the selected points. A local 

coordinate may be used to define the orthogonal axes if required. 

  

Case Study. Editing Point Properties 

By selecting a single Point, then right-clicking to display the context menu, properties 

relating to that Point can be displayed. From an individual Point‟s properties the 

coordinates can be altered, and attribute assignments may be manipulated.  

  

Lines 

Lines define the edges of the model. They are stored in the database by referring to their 

lower order Point features and in some cases a map which defines their internal shape. The 

line types available are: 

 Line defined by two Points. 

 Arc/Circle defined by two Points and a Line map. 

 Spline defined by two or more Points. 

 Lines may also be created by Splitting lines. 

Additionally, these other lines may, during the modelling process, be created as a result of 

editing the geometry: 

 Elliptical Arc/Ellipse 

 Composition Line defined by a Line and Surface map. 

 Intersection defined by two Surface maps. 

 Isoparametric 

Line geometry is defined from the Geometry> Line menu item. 
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General Line Definition 

 Coordinates Defines a Line by entering the X, Y and Z coordinates. Entering more 

than two coordinates will define linked Lines. If a non-Cartesian local coordinate 

system is in use the coordinates are specified in the coordinate system of that local 

coordinate. 

 Cursor Allows definition of a series of straight Lines on the screen with the cursor. 

The Lines can snap to a grid in the XY, YZ or XZ plane. The out of plane ordinate can 

be specified as non-zero if desired. 

 PointsDefines a Line from selected Points. A dialog is displayed to specify the Line 

type as either Straight Line(s), Arc, or Spline. 

 Tangent Point to Line Defines a 

Line between a selected Point and the 

tangent to a selected Arc. An error 

will occur if no tangent is possible. In 

this example Line 2 is created by 

specifying Line 1 and Point 4. Point 5 

is automatically created. 

 

 Line between Arcs Defines a Line 

which is tangent to two coplanar 

Arcs. The new Line can be defined as 

an inside or outside tangent. Options 

are available to split the Arcs at the 

new Points, and then delete the 

original Arcs. 
 

 By Sweeping Defines a Line by 

sweeping a Point through a 

transformation (translation, rotation, 

mirror or scale). Multiple 

transformations can be specified to 

act as one complete transformation. In 

this example Line 1 is created by 

sweeping Point 1 in a translation in X 

and Y. 

 

 By Offsetting Defines a Line which 

is offset parallel to a selected Line. 

An additional Point may be selected 

to define the plane in which the new 

Line is to be defined. If multiple 

Lines are selected the outside fillets 

may be created with arcs or straight 

Lines. 
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 By Joining Defines a number of 

Lines by joining two sets of Points. 

The Points in selection memory 

define the start of each Line, the 

Points in selection define the end of 

each Line. The Points should pair up 

equally. Lines are joined according to 

the order in which the Points were 

selected, (or Point number when 

boxing a selection), i.e. first point in 

selection memory joins to first point 

in the selection, etc. In this example 

Lines 1 to 3 were defined, by first 

adding Points 1 to 3 to selection 

memory, then selecting Points 4 to 6, 

and then using this command. 
 

 By Intersection Lines may be 

defined by intersecting two or more 

Surfaces. Intersects all Surfaces 

within a single selection with all other 

Surfaces within that selection. If no 

intersection is found a warning will be 

issued. 

 

 By Manifolding (via projection) 

Existing Lines may be projected or 

laid onto an existing Surface. A 

Surface to be projected onto is 

selected, followed by the Line to be 

projected and the Geometry> Line> 

By Manifolding menu item is used to 

create the new manifolded Line. The 

new Line is created normal to the 

selected item and will lie on the map 

of the underlying Surface.  

 

 By Manifolding (via Point creation) 

Lines can also be created directly onto 

a Surface by creating points lying on 

a surface (use the Geometry> Point> 

Surface menu item) prior to using the 

Geometry> Line> By Manifolding  
menu item to create the manifolded 
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line. Points created prior to choosing 

the command can be, but do not have 

to be, on the boundary of the Surface. 

In this example Points 7 and 8 lie 

within the Surface boundary, while 

Points 13 and 14 lie on the boundary. 

Arc and Circle Definition 

Arcs and circles are defined from the Geometry> Line> Arc/Circle menu item. 

  From Coords/Points Coordinates can be entered manually or taken from selected 

Points. The coordinates define the arc in one of three ways: 

 Start Point, Bulge Point and 

End Point Defines an Arc or 

 Circle which passes through 

three coordinate points. In this 

example Line 1 is defined by 

selecting Points 1, 2, 3 and 

specifying Point 2 as the 

„bulge‟ point. Next, Line 2 is 

defined by selecting P4 and 

P5, then entering the 

coordinates to define a „bulge‟ 

Point, P6 (which is not 

actually created) 

 

 Start Point, Directional 

Point, End Point, and 

Radius Defines an Arc or 

Circle between two coordinate 

points, to a specified radius. A 

third coordinate point is 

required to indicate the 

direction in which the arc or 

circle bulges. In this example 

arcs are created from Point 1 

to Point 2 with a radius of R, 

using Direction Point 3. 

Choosing Minor Arc creates 

Line 1, while choosing Major 

Arc creates Line 2. A Major 

Arc subtends an angle greater 

than 180 degrees at the arc 

centre, while a Minor Arc 
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subtends an angle less than 

180 degrees. 

 Start Point, Centre Point 

and End Point Defines an 

Arc or Circle between two 

coordinates, with a third 

coordinate defining the centre 

of the arc or circle. The centre 

must be equidistant from the 

start and end points. In this 

example arcs are created by 

selecting Points 2, 3, 4 with 

Point 3 as the arc centre. 

Choosing Minor Arc defines 

Line 1. Choosing Major Arc 

defines Line 2 (dotted line for 

clarity). 

 

 Tangent to Lines Inserts an Arc or 

Circle with a specified radius, tangent 

to two selected Lines. The selected 

lines must be straight Lines or Arcs. 

In this example Line 3 is created by 

selecting Lines 1 and 2, then 

specifying a radius and Minor Arc. 

Alternatively, Line 4 is created by 

selecting Lines 1 and 2, then 

specifying a different radius and 

Major Arc. 

 

 By Sweeping Points Defines Arcs by 

sweeping selected Points through a 

specified rotation. In this example 

Point 1 is swept into Line 1 using a 

rotational transformation and 

choosing the Minor Arc option. 
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Spline Definition 

Spline Lines are defined from the Geometry> Line> Spline menu item. 

 By Points Defines a spline from three or more selected Points. 

 Points and End Tangents Defines a 

Spline passing through two or more 

selected Points. The end directions are 

defined by entering end tangent 

vectors. In this example Line 1 is 

defined by specifying Points 1;2 and 

inputting start and end tangents by 

vectors (1, 0, 0) and (0, -1, 0) 

respectively. Both the direction and 

length of the end tangents control the 

spline shape. In this example, a 

different shape of spline would be 

defined, passing through the same 

Points, if the end tangents were 

changed to (3, 0, 0) and (0, -0.5, 0) 

respectively. 

 

 Tangent to Lines Defines a Spline 

passing through two or more selected 

Points. The Spline end vectors are 

taken from the directions of two 

selected Lines. The tangent Lines do 

not have to connect with the Spline. 

In this example Line 3 is defined by 

selecting Points 2, 3, 4, 5 to define the 

path, and Lines 1 and 2 as end 

tangents.  

Splitting Lines 

Lines may be split at a Point, or split into a number of equal or unequal divisions to form new 

Lines. Only straight Lines and arcs can be split using these methods. The splitting Lines 

command dialogs contain options to automatically split and delete the original Lines, and to 

replace the split Lines with Combined Lines. When splitting Lines the original Line may be 

deleted, but only if it did not define any Surfaces, or if such surfaces are modified to use the 

new Lines via the "Use in dependent Surfaces" option. As a further option a combined line 

may be created. This is useful if a regular mesh is required. 

Any attributes assigned to a feature that is split will be automatically assigned to the new 

features created. 

Line splitting commands are accessed from the Geometry> Line> Splitting menu item. 
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 At a Point Splits an existing Line into 

two new Lines at a selected Point on 

the Line. Arcs can only be split using 

a Point on the arc. Split Lines 

defining a Surface may be deleted and 

replaced by a Combined Line. A 

splitting tolerance can be set to 

increase the allowable distance 

between a Point and the Line being 

split. In the example here Line 3 is 

split at Point 5 into 2 new component 

Lines defining Combined Line 5. 

Line 3 is also replaced in the 

definition of Surface 1. 

 

 In Equal Divisions Splits an existing 

Line into a specified number of equal 

divisions. A new Line is defined at 

each division. In the example shown 

Line 1 is split into 4 new Lines of 

equal length, and the original Line is 

deleted. 

 

 At Parametric Distances Splits an 

existing Line into a number of 

divisions based on specification of 

parametric distance values along the 

Line. The direction of the existing 

line is used to calculate the splitting 

positions. A new line is created at 

each division. In this example Line 1 

is split at a parametric distance of 

0.75. Line 2 is created at 3/4 of the 

original length and Line 3 at 1/4. 

Specification of a parametric 

divisions list as 0.1;0.5;0.75 will split 

a line at 1/10, 1/2 and 3/4 distance 

into 4 new lines. 

 

Combined Lines 

A Combined Line is a Line which is composed of several continuous individual Lines. 

Combined Lines may be used in exactly the same was as other Lines to allow Surfaces, to be 
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meshed using regular mesh patterns. This is especially useful for meshing surfaces defined by 

more than four Lines. 

Combined Lines are defined from the Geometry> Line> Combined Line menu item.  

 Lines Defines a Combined Line 

from two or more selected Lines 

that are continuous but do not 

form a closed loop. Any number 

and type of existing Lines can be 

used to define a Combined Line. 

In the example here Lines 3 and 

4 are used to define Combined 

Line 6. Lines 3 and 4 are 

replaced in the definition of 

Surface 1. 

 

Notes  

 Automatic numbering uses the next highest available number for Lines or Combined 

Lines. 

 Mesh attributes may not be assigned to Combined Lines, but must be assigned to the 

Lines defining the Combined Line. 

 Using Combined Lines in the definition of Surfaces provides an additional means of 

producing transition meshes. 
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Case Study. Using Combined Lines 

Combined lines may be used in a surface definition in order to use a regular mesh. 

1. Define a Surface using the New Surface button , and enter the coordinates 

(0,0,0), (100,0,0), (120,20,0),  (100,100,0) and (0,100,0). 

2. Define a Line mesh attribute (using Attributes> Mesh> Line) with of element 

type None with mesh divisions of 1 and assign it to the shorter Line on the left 

hand side of the surface. 

3. Define a Line mesh attribute (using Attributes> Mesh> Line) with of element 

type None with mesh divisions of 3 and assign it to the longer Line on the left 

hand side of the surface. 

4. Define a Surface mesh attribute using (using Attributes> Mesh> Surface)  with 

Plane Stress, Quadrilateral, Linear elements and assign it to the surface. This will 

automatically select an irregular mesh for a five-sided Surface as shown below.  

5. Now define a Combined Line by selecting the Lines on the left hand side of the 

model and press the  button from the Line menu item. 

6. Since the Surface definition has been altered the Surface will be remeshed. A 

regular mesh will now be adopted because the line divisions on the Combined 

Line match those on the opposite Line.  

  

Irregular Mesh 

A regular Surface mesh using Plane Stress, 

Quadrilateral, Linear elements is assigned to 

the Surface with the resulting mesh shown. 

(An irregular mesh is used as surface does 

not have 3 or 4 sides). 

 

Regular Mesh Using Combined Lines 

The lines on the right hand side are used 

to define a Combined Line. A remesh 

occurs because the surface has been 

redefined and a regular mesh is generated 

because the surface is now defined with 

3 Lines and 1 Combined Line. 
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Surfaces 

Surfaces define the faces of the model. The Surface types are: 

 Regular defined by 3 or 4 Lines. 

 Irregular defined by 5 or more Lines. 

Note. For meshing purposes an irregular surface can be considered to be a regular surface 

using Combined Lines. 

Surface Definition Commands 

The following commands are for defining Surfaces directly: 

 By Coordinates Defines a Surface by entering a list of X, Y and Z coordinates (Z is 

optional). If a non-Cartesian local coordinate system is in use the coordinates are 

specified in the coordinate system of that local coordinate. Coordinates can be entered 

using global (default) or local coordinate systems. 

 By Cursor Allows definition of a series of flat rectangular Surfaces on the screen 

with the cursor. The Surfaces can snap to a grid in the XY, YZ or XZ plane. The out 

of plane ordinate can be specified as non-zero if desired. 

 By Points Defines a Surface from three or more selected Points. A Surface can be 

defined from any number of Points. 

 By Lines Defines a Surface from the selected Lines. When defining Surfaces in this 

way, any number of Lines may be specified in any order and a Surface will be formed 

from the greatest number of lines that form a closed loop. If a number of disconnected 

Lines are selected a Lofted Surface will be created. A lofted Surface is defined as 

Surface with a smooth transition between 2 or more Lines. 

   
Surfaces generated from selected Lines 
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Lofted Surface generated from selected Lines 

Note: The direction in which the Surface is defined is used to define the Surface orientation, 

The surface orientation is used at a later stage to define element normals and local loading 

directions. 

Coalescing Surfaces  

Two or more surfaces can be reduced to one surface defined by lines or combined lines if the 

surfaces share a common line. 

Holes in Surfaces 

 Create Defines a hole or number or holes in a Surface. Closed loop(s) of Lines or the 

Surface(s) representing the hole(s) and the Surface to be holed should be selected 

prior to choosing this menu option. 

 Move Moves or modifies selected hole(s) within a Surface. To move a hole select the 

Lines and/or Points forming the perimeter of the hole. If only some Lines or Points are 

selected the hole will be stretched by only moving the selected features. Note. Moving 

a hole actually deletes the original hole and recreates a new hole. This means the 

feature numbers of the Points and Lines will not be maintained. 

 Copy Creates multiple holes within a Surface. 

 Delete Deletes the selected hole(s). The hole boundary lines may be deleted, retained 

as Lines or used to create new Surfaces. 

 Delete All Deletes all holes from a selected Surface. The hole boundary lines may be 

deleted, retained as Lines or used to create new Surfaces. 
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Case Study. Creating a Surface with Holes 

It is often convenient to create a Surface with embedded holes rather than create a 

number of Surfaces around a hole. To create a single Surface with a number of holes 

follow the following steps: 

1. Create the outer Surface and a separate Surface for each hole. 

2. Select all Surfaces. 

3. Use the Geometry> Surface> Holes> Create menu item to create a single 

Surface with holes. Select the Delete geometry defining holes option to 

remove the Surfaces defining the holes. Note, when creating models with 

holes for section property calculation purposes the Delete geometry defining 

holes option should be de-selected to retain the original surface representing 

the hole(s) otherwise incorrect section properties may be calculated. 

 

Redefine Perimeter 

A Surface perimeter may be modified by selecting the Surface and the new boundary Lines. 

The new Surface perimeter will be created from a closed loop of Lines formed from the old 

Surface perimeter and the new boundary Lines. The perimeter of the Surface will be defined 

from the closed loop of Lines with the maximum number of segments. If two possible loops 

of Lines have the same number of segments a additional Line from the existing Surface 

boundary should be selected to resolve the ambiguity.  
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Case Study. Redefine Surface 

Perimeter 

To redefine the perimeter of a Surface use the 

following steps. 

1. Create a Rectangular Surface. 

2. Define the new perimeter with Lines 

which start and finish at existing Points on 

the Surface. 

3. Select the Surface and the new perimeter 

Lines.  

4. Use the Geometry> Surface> Redefine 

Perimeter>Redefine menu item to define 

the new Surface perimeter.  

 

Sweeping Surfaces 

 By Sweeping Defines a Surface by sweeping a selected Line through a transformation 

(translation, rotation, mirror or scale). 

Line 1 is swept using an X and Y translation 

to create Surface 1: 

A cylindrical Surface is defined by sweeping 

Line 1 through a rotation: 
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Offsetting 

 By Offsetting Defines a Surface at a 

specified distance normal to a 

selected Surface. The positive offset 

direction is defined by the Surface 

normal unless an additional Point is 

selected. 

 

Splitting Surfaces 

Surfaces may be defined by splitting an existing surface in a number of ways using the menu 

items under Geometry> Surface> Splitting. Surface splitting commands contain an option to 

automatically delete the old Surfaces and Lines which have been split. Attributes assigned to 

the split feature will automatically be assigned to features of the same type created during the 

split process. The following splitting methods are supported. 

 By Line Splits a selected Surface at 

an existing Line. The end Points of 

the Line must lie on different 

boundary Lines of the Surface. It is 

advisable to split curved Surfaces 

using Lines that are manifolded 

over the Surface. In the example 

shown here, the original Surface is 

split at Line 5. Points 5 and 6, 

defining Line 5, must lie on the 

original Surface boundary Lines. 
 

 By Points Splits a selected Surface 

at two boundary positions indicated 

by Points. A new Line will be 

manifolded onto the existing 

Surface and the Surface will be split 

at this Line. In the example shown, 

Surfaces 2 and 3 are created in the 

parametric space of the original 

Surface using the Points on the 

boundary. The new Line is 

manifolded onto the original 

Surface. 
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 At a Point Splits a selected Surface 

at a single Point defined on the 

surface inside the boundary. Four 

new Surfaces are created by 

manifolding straight Lines or arcs 

onto the existing Surface using the 

relative position of the splitting 

Point. In this example, the original 

Surface is split at Point 5. The 

resulting Surfaces (2-5), use 

parametric space to calculate 

boundary Point positions. 
 

 In Equal Divisions Splits a selected 

Surface into separate Surfaces at a 

specified number of equal divisions. 

The direction of the split is 

expressed using local Surface axes. 

In the example shown here, the 

original Surface is split in its local x 

direction into equal divisions 

forming 3 new Surfaces. 

 

 At Parametric Distances Splits a 

selected Surface into separate 

Surfaces at specified parametric 

divisions. For example, specifying 

the parametric distances as 0.25 and 

0.75 will split a Surface at the 1/4 

and 3/4 position in parametric space 

in the specified local direction. In 

this example, the original Surface is 

split in its local y direction at 

parametric divisions 0.25;0.75. 
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Joining 

 By Joining Defines a number of Surfaces 

by joining two sets of selected Points or 

Lines. 

The first set of Lines should be added to 

selection memory, the second set should 

be selected. The Lines should pair up 

equally. Surfaces are joined according to 

the order in which the Lines were 

selected, i.e. first Line in selection 

memory joins to first Line in selection, 

etc.  

 

In the example shown Surfaces 1 and 2 are defined by first selecting Lines 1 and 2, 

then adding them to selection memory, then selecting Lines 3 and 4 and using the 

Surface by joining command.  

Intersection 

 By Intersection Defines a Surface at the intersection of two selected Volumes. 

Manifolding 

Manifolding is the process of creating geometry which lies on the surface map of an existing 

Surface. 

 By Manifolding Existing Surfaces may be projected or laid onto an existing Surface. 

A Surface to be projected onto is placed into Selection Memory and the Surface to be 

projected is then selected prior to choosing the Geometry> Surface > By 

Manifolding menu item. The new Surface is created normal to the selected item (in 

selection memory) and will lie on the map of the underlying Surface. 

 Manifold by Lines Defines a 

Surface positioned on an existing 

underlying Surface with its 

boundary specified by edges or 

vertices. In this example a Surface 

is created by Joining any 

combination of the Points and Lines 

shown. Any new Lines created will 

automatically be manifolded onto 

the underlying Surface. 
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Extrusion 

 By Extrusion Defines Surface by 

extruding selected Lines a specified 

distance. The positive direction may 

be defined by an additional Point if 

selected. For Arcs the default 

direction is assumed to lie in the 

plane of the Arc.  

Volumes 

About Volume Features 

Volumes define the solid geometry of the model and come in two forms.  

 Solid Volumes are defined by a number of connected Surfaces. These are recognised 

by the geometry engine which allows Boolean operations to be performed. Solid 

Volumes are the default form of Volume and are created when geometry is defined in 

Modeller.  

 Hollow Volumes are defined by a number of disconnected Surfaces. These are not 

recognised by the geometry engine. Hollow Volumes are usually only of use when the 

geometry has been imported from CAD. 

For meshing purposes volumes may be split into the following categories. 

 Regular volumes may be defined as Tetrahedral (4 sided volume with all faces 

defined by triangular surfaces), Pentahedral (5 sided prism with top and bottom faces 

defined by triangular surfaces and side faces defined by quadrilateral surfaces), 

Hexahedral (6 sided cuboid with all faces defined by quadrilateral surfaces). 

 Swept Irregular are defined by 2 identical irregular Surfaces joined at equivalent 

positions on the boundaries by quadrilateral Surfaces. The Lines joining the two 

irregular Surfaces must be either straight Lines or arcs with a common centre. 

 Irregular are defined by any number and type of surface but can only be meshed with 

tetrahedral elements. 

Defining Volumes 

The following commands are for defining Volumes directly: 

 By using the Shape Wizard to create regular volumes. 

 By selecting Surfaces to define a Volume from four or more selected connected 

Surfaces. The Surfaces may be entered in any order. When defining Volumes in this 

way any number of Surfaces may be selected to define a Volume. Duplicate and 

unconnected Surfaces will be filtered out.  
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 By Sweeping to define a Volume by sweeping a selected Surface through a 

transformation (translation, rotation, mirror or scale).  

  

A Surface is swept through a translation to create a 

Hexahedral: 

A Surface is swept through a rotation to create a 

Volume: 

 By Splitting Splits a selected Volume by a selected Surface. 

 By Joining Joins two selected features to form a Volume, either a Point to a Surface, 

or a Line to a Surface, or two Surfaces. The features are joined by straight lines. 

 
  

Surface 1 is joined to Point 4 to 

form a pentahedral.  

Surface 1 joined to Line 5.  Surface 1 is joined to Surface 2 

to form a hexahedral. Two 

triangular Surfaces joined this 

way would form a pentahedral. 

Groups of Volumes may be defined by joining two sets of selected Surfaces. The first set of 

Surfaces should be added to selection memory and the second set of surfaces should be 

selected. The Surfaces will pair up equally. i.e. Volumes will be joined according to the order 

in which the Surfaces were selected. The first set of Surfaces in selection memory joins to the 

first set of  Surfaces in selection etc. 
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 By Extrusion Enables a Volume 

to be defined by extruding a 

specified distance normal to a 

selected Surface. The positive 

direction is defined by the Surface 

normal unless an additional Point 

is selected. Extrusion can be 

towards or away from the 

specified reference Point. 
 

Coalescing Volumes 

The internal Surfaces from a Volume model may be removed by coalescing Volumes. This 

will result in a model with fewer Volumes which may be meshed using Tetrahedral elements.  

  

Case Study. Coalesce Volumes 

Sometimes a results file exists without a corresponding model file. The coalesce Volumes 

feature allows the results mesh to be converted to a Volume model so it can be modified 

and used in a subsequent analysis. 

1. Open results file and use the File> Save As menu item to save it as .mdl file. 

2. Use Control-A to select the mesh and convert it to Volumes using the 

Geometry> Volume> From Mesh menu item and select the Coalesce Volumes 

option. 

3. Create a loadcase. 

Delete Holes 

When geometry is imported from CAD it may have small holes defined which are of no 

significance in the analysis. These holes may be removed using the Geometry> Volume> 

Delete Holes menu item. 

Delete Voids 

Voids are cavities in a Volume which do not penetrate the defining surfaces. Voids are 

removed using the Geometry> Volume> Delete Voids menu item. 
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Orientating Volume Axes 

In some analysis types the Volume axes is used to define the material direction. The Volume 

axis may be orientated by the following methods: 

 Axis to Surface  

 Cycle Axes  

 Cycle Relative 

Hollow Volumes 

Hollow volumes, just like normal solid volumes, are defined by a set of surfaces. However, 

unlike normal solid volumes, the defining lines and points of those surfaces do not need to be 

perfectly merged together. Hollow volumes are mainly used when geometry has been 

imported from CAD systems, when such merging may be difficult or impossible. Once 

defined, hollow volumes behave in almost exactly the same way as normal solid volumes. For 

example, they may be meshed and have attributes assigned and deassigned in the usual way. 

The main difference is that in a geometric Boolean operation a hollow volume will behave 

like a set of surfaces, hence the name.  

Hollow volumes may be open or closed. To understand the 

difference consider just one defining edge of the volume 

between two defining surfaces. If that edge consists of 

exactly one line, or exactly two lines of very similar length 

and shape, then those lines can be considered a matching 

pair. If all the defining edges of the volume can be matched 

in this way, the volume is said to be closed. However, if 

one or more edges of the volume cannot be matched in this 

way then the volume is said to be open. 

For the example shown most of the lines form matching 

pairs. However, one of the defining surfaces has an edge 

that is defined by two lines, with a point in the middle. This 

pair of lines cannot be matched to the corresponding single 

line on the adjacent surface, and so this volume is open. 

 

The distinction between open and closed hollow volumes is only important when it comes to 

meshing. A closed hollow volume can be meshed in exactly the same way as a normal solid 

volume. However, a regular mesh cannot be assigned to an open hollow volume, and so these 

must be meshed using an irregular mesh. 

The user interface to enable the creation of hollow volumes may be invoked from the 

Advanced Dialog of the Geometry Properties dialog. This option is automatically invoked 

when geometry is imported from CAD. When this option is chosen the volume definition 

tools will try to automatically create a solid volume as normal. However, if this process fails, 

a further attempt will be made to create a closed hollow volume from the selected surfaces 

using the defined closure tolerance. 
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Open hollow Volumes can only be created via the Geometry> Volume> Hollow Volume> 

Create menu item. Surfaces may be added or removed from an open hollow volume 

definition using the Geometry> Volume> Hollow Volume> Add and Geometry> Volume> 

Hollow Volume> Remove menu items. 

Once a hollow volume has been defined its status (open or closed) can be determined from its 

properties dialog. In some cases an open hollow volume may be changed to a closed hollow 

volume by simply increasing the closure tolerance on the volume properties dialog. When 

meshing a closed hollow volume, any nodes closer together than the volume‟s node merge 

tolerance (defined on the volume properties dialog) are merged. For closed hollow volumes 

this defaults to the volume closure tolerance. 

Shape Wizard 

The shape wizard defines analytical shapes which may orientated with a local coordinate 

system and positioned by a user defined origin. If a point is selected the selected shape's 

origin will default to the coordinates of the selected point. Shapes may be defined using 

Lines, Surfaces or Volumes. 

The following shapes are supported; cube, cuboid, cylinder, and cone. The origin of each 

shape is indicated by the axes. 
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Notes.  

 Specifying a negative length or height results in that dimension being defined along 

the negative axis direction. 

 For the cylindrical shape there is an option to create the cylinder with a seam which 

effectively creates a cylinder using only one surface rather than the default two 

surfaces. 

Boolean Geometry Construction 

Boolean operations allow complex geometry to be defined by combining, subtracting or 

intersecting existing Surfaces or Volumes. 

  

 Union (with simplify internal geometry) enables a 

Surface or Volume to be defined by union of any 

number of selected Surfaces or Volumes. 

 Union (without simplify internal geometry) enables 

a number of Surfaces or Volumes to be defined by 

union of any number of selected Surfaces or Volumes. 

 Subtraction enables a Surface or Volume to be 

defined by subtracting one Surface or Volume from 

another Surface or Volume. 

 Intersection enables a Surface or Volume to be 

defined as the intersection of two selected Surfaces or 

Volumes. 

 Slice Enables a selected Volume to be sliced by a 

plane and the resulting geometry to be deleted either 

side of the slice if required. The slice plane may be 

defined in any global or local plane which may be 

visualised prior to the slice operation. A Surface of 

any shape may be used to slice a Volume by 

Subtracting the Surface from the Volume. 

  

  

 

Separate (unconnected) 

cube and cylinder =  

2 volumes 
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Union of cube and cylinder 

(simplify internal 

geometry) =  

1 volume 

Union of cube and cylinder 

(no simplify internal 

geometry) =  

4 volumes 

Subtraction of cylinder 

from cube =  

1 volume 

Intersection 

of cube and 

cylinder =  

1 volume 

Geometry From Mesh 

An existing finite element mesh defined in a Solver results model file (.mys) file can be 

converted into features such that each element is converted into a single feature. Use of this 

facility will produce a similar model to that created by the use of the File > Import menu 

item which permits the import of a Solver data file(.dat) to create a model.  

In using the Geometry from Mesh facilities, lower order features are automatically created, 

and the command describes the highest order of feature type that is to be created. For 

example, if a Line convert command is used on a single HX8 solid element mesh, then 8 

Points would be defined at the node positions and 12 Lines would be defined from the edges 

of the HX8. As a result, be warned that very large models can be produced . 

The currently selected elements are converted using the Geometry> Point> From Mesh, 

Geometry> Line> From Mesh, Geometry> Surface> From Mesh, Geometry> Volume> 

From Mesh menu items. 

 Point creates Points from nodes. 

 Line creates Points from nodes and Lines from beam elements, surface and volume 

element edges.  

 Surface creates Points from nodes, Lines from beam elements and Surfaces from 

surface elements and volume element faces.  



  Chapter 4 

    

99 

 Volume creates Points from nodes, Lines from beam elements, Surfaces from surface 

elements and Volumes from volume elements. 

To convert from mesh the results database must be saved as an model file with access for 

writing prior to conversion. Firstly open the .mys using the menu item File> Open, then save 

as a model file using File> Save As. Select the elements you wish to convert to geometry and 

pick the appropriate From Mesh menu item. 

Notes 

 No attributes will be converted. 

 When converting to Volumes to resulting Volumes may be coalesced by removing the 

internal Surfaces. 

 The conversion commands always create new features and cannot be used to edit 

existing features. 

 Quadratic element edges with 3 nodes are converted to spline Lines with an exact 

match using the end node positions. A Point is defined at the mid-side node position 

but is not used in the Line definition. 

Moving and Copying Geometry 

Geometry may be moved or copied to new positions using transformations. Compound 

transformations may be used in which a series of transformations are carried out in a specified 

order. When a feature is moved or copied, features will be merged as defined by the current 

merge status. See Merging and Unmerging Features. 

  

 Move When a feature is moved to a 

new location its lower order features 

will also be moved and its higher 

order features will be updated.. In the 

example shown here, Point 3 is moved 

using an X and Y translation. Due to 

feature associativity the definition of 

Lines 2 and 3 and of Surface 1 is 

automatically updated. Moving can be 

used to separate features on a 

temporary basis to assist in the 

manipulation of features, for example 

when defining slidelines or joints.  

Note: When moving holes the Surface is 

actually deleted and recreated so the feature 

numbers will not be maintained. 
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 Copy Features may be copied any 

number of times. When a feature is 

copied its lower order features will 

also be copied using the same 

transformations. Copied features will 

inherit the same attribute assignments 

as the original features. In the example 

shown here the Line at the bottom is 

copied 4 times using a transformation 

in the X and Y direction. 

  

 

Sweeping Geometry 

New geometry can be created by sweeping lower order geometry into higher order geometry 

using a transformation, as for example, by sweeping a Point into a Line, or a Surface into a 

Volume. To do so a transformation or sweep type needs to be specified. 

Transformations 

Transformations are used in two ways: 

 When moving, copying or sweeping geometry a transformation is specified, and may 

be saved if required. 

 For special applications such as to orient discrete point and patch loads, or to define a 

reflective mirror plane for thermal analyses. 

Transformation attributes are defined using the Utilities> Transformation menu item, as 

well as from a move, copy or sweep dialog. Certain transformations can be defined by adding 

two or three geometric Points to selection memory before initiating the transformation 

command.  

 

The following transformation types are available: 

 Translation Linear translation along 

a specified vector coordinate. The 

vector coordinate will use the active 

coordinate set. Two Points added to 

selection memory can be used to 

define the vector coordinates. In this 

example, the translation is defined 

using Points 1 and 2, which stores a 

translation of X and Y. This is then 

used to copy the Surface shown. 
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 Rotation (in a global plane) A 

specified angular rotation in either the 

XY, YZ, or ZX global plane at a 

specified origin. 

 

In this example Surface 1 is copied 

about the global origin through 

positive 90 degrees. A right hand 

corkscrew rule is used for rotations. 

Local coordinate systems can be used 

to rotate about non-global axes. 
 

 Mirror A mirror plane may be 

defined by specifying three points in 

space to define an arbitrary plane, or 

two points to define a plane parallel 

to either the Z, Y, or X axis. Three 

Points added to selection memory can 

be used to define an arbitrary mirror 

plane, and two Points added to 

selection memory can be used to 

define a mirror line in the XY plane 

(not the YZ or ZX planes) 

 

Note:.Care should be taken when 

mirroring Lines and Surfaces as their 

orientations may be reversed so some 

Surfaces may effectively be turned 

upside down. Lines may also point in 

the opposite direction. See Changing 

Geometry Orientation to resolve 

any problems. 
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 Scale A scale factor and the origin 

point of the scale is specified . 

 

 Matrix rotation A direction cosine 

either specified directly, or using two 

or three Points added to selection 

memory. Points in selection memory 

define a plane, the rotation of the 

global XY plane to this new plane 

defines the transformation. Note. If 

the determinant of the matrix is not 

unity then the effects may not be as 

desired. 

 

This example defines a rotation by 

defining a plane relative to the global 

Cartesian axis set by indicating three 

Points: at the origin (P1), along the 

local x axis (P2) and defining the 

local xy plane (P3). The resulting 

transformation is a rotation of 90 

degrees about the global axes. 

 

Notes 

 In a transformation dialog, (including the move, copy, or sweep commands), click on 

the Use button to use a transformation defined from Points in selection memory.  

 A transformation is not updated when the points defining it are changed. 
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Compound Transformations 

Saved transformations may be used together to create a compound transformation, i.e. two or 

more transformations can be performed on selected geometry at once. To carry out a 

compound transformation (firstly from the Utilities> Transformation menu item) define the 

required transformations and save them with suitable names. Then when copying, moving or 

sweeping select the Compound option and specify which transformations to use by adding 

them to the right side box. Single transformations may be used more than once if required. 

The order in which the transformation is performed is significant, therefore click the up and 

down buttons to get the correct order, starting from the top. 

Merging and Unmerging Features 

When a new feature is generated, if its position coincides with an identical feature then by 

default the two features will be merged (removing one of the features) provided the merge 

characteristics are satisfied. 

In addition to the automatic merging carried out during feature generation, any combination 

of features can be merged at any time. Care should be taken to merge from the lower order 

features upwards, as higher order features can only merge if defined by the same lower order 

features. 

Merge/Unmerge Commands 

The following merge/unmerge commands are available from the Geometry menu, under each 

feature type. 

 Merge Merges all mergable features currently selected subject to the current merge 

characteristics and tolerance. Lower order features must be merged first. for example 

two Lines cannot be merged until the Points defining the Lines are themselves 

merged. When selected at the same time, LUSAS merges lower order features before 

higher order features. 

 Make Mergable/Unmergable Sets the merge status of selected features. Merging can 

happen unintentionally in the normal course of events when additional features are 

defined in the same position as existing features. Using this command, it is possible to 

prevent two coincident features being merged by making one of the features 

unmergable. The merge status of an individual feature may be viewed, and altered, by 

displaying the properties of the selected feature, (right-click button), on the Hierarchy 

tab. 

 Unmerge Duplicates or retracts selected features into higher order features which 

reference them in their definition. When a feature is unmerged from its higher order 

features, any new features defined are automatically set to be unmergable.  

Merge Options 

Several merge settings can be set from the Geometry tab on the Model Properties dialog. 
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 Ask for Confirmation Configures Modeller to prompt for confirmation before 

selected features are merged. (Confirmation tab). 

 Merge Tolerance Controls the distance within which Point features must lie before 

they will be considered for merging. (Geometry tab). 

 Make New Features Unmergable Sets the merge status of all new features to 

Unmergable. (Geometry tab). 

 Merge Characteristics Controls the criteria that must be satisfied before features 

sharing a common definition will be merged. (Geometry tab). See below. 

Merge Characteristics 

Features will be merged only if they share common lower order features, in addition feature 

merging is dependent upon attribute assignments. By default, identical assignments must be 

found on two features, for those features to be merged. The merge type parameter controls 

how LUSAS handles feature merging. The following merge types are supported: 

 Off where no merging is carried out. 

 Exact where features are merged only if all assignments are identical. This is the 

default. 

 Wild where features are merged if feature assignments of the same type for both 

features match. The assignments of both features are retained where the assignment 

type is unique to one feature. 

 Ignore Assignments ignores the assignments when deciding if two objects should 

merge (this is the opposite of "Exact" where the two objects must have the same 

assignments to merge). The assignments of the feature merged out will be transferred 

to the feature retained unless the retained feature already has that particular 

assignment. 

Notes 

 If several features are merged with merge status set to ignore assignments and the 

assignments are indeed different, the remaining feature will inherit the assignment of 

the lowest numbered deleted feature. 

 If two coincident features are not merged, two sets of coincident nodes will be 

generated when they are meshed and the finite element mesh will be unconnected at 

the feature discontinuity. This may be corrected at the meshing stage by merging the 

nodes using the equivalence facility. 
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Using the Merge (and Unmerge) Commands 

 Merge Point Coordinates of Points to be 

merged must lie within the merge tolerance. By 

default assignments must be exactly the same 

for a Point to be merged. 

 

  
  

 Merge Line Lower order features must be 

common for merging to take place. By default 

assignments must be exactly the same for a 

Line to be merged. 

 

  
  

 Merge Surface Lower order features must be 

common for merging to take place. By default 

assignments must be exactly the same for a 

Surface to be merged. 
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Merge Case Study 1 

Merging Lines with different non-zero assignments. Wild and Ignore Assignments will merge 

Lines successfully. 
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Merge Case Study 2 

Merging Lines with additional material assignment on Line 2. Material assignments differ, 

therefore only Ignore assignments will merge successfully. 

 

Using the Unmerge Commands 

To unmerge a feature from a higher order feature (i.e. a point from a line) select both the 

feature to be unmerged and the higher order feature from which to unmerge it. In the 

following examples red represents "New" and green "Modified" geometry. 
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 Unmerge Point in LineUnmerge 

Point 2 in Line 2. A new Point 4 is 

copied from Point 2 and Line 2 is 

redefined using Point 4. Points 2 and 

4 are coincident. Point 4 is 

unmergable. 

 

 Unmerge Point in SurfaceUnmerge 

Point 5 in Surface 2. A new Point 8 

is copied from Point 5, a new Line 9 

is defined and Line 6 is redefined 

using Point 8. New features are set to 

be unmergable. Point 5 and Point 8 

are coincident. 
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 Unmerge Point in VolumeUnmerge 

Point 1 in Volume 1. A new Point, 2 

new Lines and a new Surface are 

defined and affected Surfaces and the 

Volume are redefined. The new 

Point is coincident with Point 1. 

 

 Unmerge Line in SurfaceUnmerge 

Line 5 in Surface 2. A copy of Line 5 

is defined which replaces Line 5 in 

the definition of Surface 2. Points are 

unaffected. 
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 Unmerge Line in VolumeUnmerge 

Line 1 in Volume 2. A copy of Line 

1 is defined joining the same end 

Points The new Line replaces Line 1 

in the definition of the affected 

Surfaces in Volume 2 

 

 Unmerge Surface in 

VolumeUnmerge Surface 1 in 

Volume 2. A copy of Surface 1 is 

defined which replaces Surface 1 in 

the definition of Volume 2. 
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Case Study. Forcing Features to Merge 

Sometimes when creating the geometry duplicate features are created. If these have 

different assignments the default merge setting will prevent coincident features from 

merging. In this case it is useful to request the merge settings to ignore assignments. 

LUSAS can be forced to merge duplicate features in the following way: 

1. Set the merge status to ignore assignments by choosing the File> Model 

Properties dialog box, Geometry tab and pick Ignore assignments for the 

Merge action. 

2. Select the whole model using Edit> Select All. Then merge the model features 

using the Merge Features button  on the Advanced Define toolbar and pick 

the option to merge defining geometry. 

3. Reset the merge status to Exact. 

Note: If some features have been previously unmerged these must first have their merge 

status reset to Mergable using Geometry> Feature type> Make Mergable. 

Changing Geometry / Element Orientation 

For feature-based models the orientation of the Geometry is used to define the local axes of 

the elements. For mesh-only models the local axes of the elements will be the same initially 

as those defined in the data file that was used to create the model.  

The following commands enable the local axes of Lines, Surfaces and Volumes (and 

Elements for a mesh-only model) to be re-oriented. First, the feature or element to be used as 

a basis for the re-orientation to be carried out must be selected (followed by the selection of 

any additional features to which the re-orientation of the first feature or element should apply) 

and then a menu item based upon Geometry > (Feature) > (Command)  

 Reverse Lines, Combined Lines and Surfaces can have their direction reversed. 

This example the effect of a Line 

reversal. The local x axes of all 

elements on this Line will be 

reversed. 
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In the Surface example the local x 

axis remains along the first Line in 

the Surface definition, but the Surface 

normal is reversed. Elements meshed 

on this Surface will be inverted.  

 

 Axes to Surface Volumes may have their local z direction set from a selected 

Surface. Volume axes are defined by the direction of the axes on the first Surface in 

their definition. This command reorders the Surfaces defining the Volume such that 

the first Surface in the definition is the selected Surface. The local x and y axes may 

then be changed using the Cycle surface command. 

 Cycle Surfaces (or surface/solid elements in a mesh-only model) may have their 

definition order cycled, and Volumes may have the definition of the first Surface in 

the Volume definition cycled (and for mesh-only models, Elements may have the 

definition of the first Face in the Element definition cycled). In this example, the 

original Surface defined by Lines 1, 2, 3 and 4 is shown in grey. Cycling by changes 

Surface definition to Lines 2, 3, 4, 1. Cycling again defines the Surface as Lines 3, 

4, 1, 2 . Surface normal directions remain consistent throughout. 

 

 Cycle Relative Cycles the definition order relative to the first feature of the same 

type in the current selection. Surfaces and Volumes (or surface/solid elements in a 

mesh-only model) may be reoriented in this way. In this example Surfaces 2, 3 and 

4 are cycled using Surface 1 (shown greyed) as the reference orientation. 

 

 Cycle to Neighbours (Mesh-only models) Cycles the element axes of all 
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neighbouring and selected elements relative to the first element in the current 

selection. Whilst similar in effect to the Cycle Relative option for the example 

shown above (which would obtain the same result for that particular example), it 

caters for the case where, for certain orientations of elements, the cycle relative 

option would not be applicable. The example below shows one such example. 

  

 
Cycle to Neighbours (correctly aligns element axes of the selected elements with initially selected neighbouring 

element) 

  

 
Cycle Relative (only aligns element axes of the selected elements to best angle with respect to initially selected 

neighbouring element) 

  

 Cycle to Faces (Mesh-only models) Solid elements may have their local z direction 

set from a selected Face. Element axes are defined by the direction of the axes on 

the first Face in their definition. This command reorders the Faces defining the 

Element such that the first Face in the definition is the selected Face. The local x and 

y axes of the element itself may then be changed using the Cycle command. 
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Notes 

 When cycling Surfaces it is not the Lines that change, but the order of the Lines in the 

Surface definition. Since the Surface local x axis lies along the first Line in the 

Surface definition the orientation of the Surface changes.  

 When cycling Volumes the cycle command only changes the order of Surfaces in the 

Volume definition. Since the Volume axes are determine by the orientation of the 

Lines defining the first Surface in the Volume the orientation of the Volume changes. 

Case Study. Changing Element Orientation 

When it is necessary for the local axes of Lines and Surfaces to be consistent this can be 

achieved by reversing and cycling the features. Consistent axes for underlying Lines, 

Surfaces and Volumes ensure that their elements also have consistent axes. 

1. Draw the orientation axes for the features which are required to be consistent 

(Geometry Layer Properties). It may be useful to draw just Surface normals. 

2. In the case of lines, reverse any lines whose orientation is to be changed. 

3. In the case of Surfaces, reverse Surface normals (local z axis) and cycle Surfaces 

xy axes until all axes are consistent. Surfaces can be cycled relative to a reference 

Surface if required. 

4. In the case of Volumes, set up the Volume local z axis and cycle xy axes by 

cycling the first Surface in the Volume definition until all axes are consistent. 

Volumes can be cycled relative to a reference Volume. 

CAD Interfacing 

CAD interfacing is the process of importing or exporting the geometry and other data from 

and to a CAD package.  

When importing from CAD, only the relevant data should be exchanged. Annotation and 

construction lines should not be included as these will then be converted into LUSAS 

geometry. Control over the data imported into LUSAS is achieved using the Advanced 

button accessed from the File> Import Geometry menu item. Similarly, control over what is 

exported is achieved by options on the Export dialog accessed from the File> Export menu 

item. For more information see Interface Files 

 

 



  Chapter 5 

    

115 

Chapter 5 : Model 

Attributes 

  

Introduction 

Attributes are used to describe the properties of the model. Attributes are assigned to 

geometry features (or to mesh objects in a mesh-only model) and are not lost when the 

geometry is edited, or the model is re-meshed. Attribute assignments are inherited when 

geometry features are copied and are retained when geometry features are moved. The 

attribute types are: 

General Attributes 

 Mesh describes the element type and discretisation on the geometry. 

 Geometric specifies any relevant geometrical information that is not inherent in the 

feature geometry, for example section properties or thickness. 

 Material defines the behaviour of the element material, including linear, plasticity, 

creep and damage effects. 

 Support specifies how the structure is restrained. Applicable to structural, pore water 

and thermal analyses. 

 Loading specifies how the structure is loaded. 

Specific Attributes 

 Local Coordinate provides a transformation for loads and supports, and an 

alternative to the global coordinate system. 

 Composite defines the lay-up properties of composite materials in the model. 

 Slideline slidelines control the interaction between disconnected meshes. 

 Constraint Equation provides the ability to constrain the mesh to deform in certain 

pre-defined ways. 

 Thermal Surface defines thermal surfaces, which are required for modelling thermal 

effects. 
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 Retained Freedom specifies the master nodes used in a Guyan reduction or 

superelement analysis. 

 Damping defines the damping properties for use in dynamic analyses. 

 Birth and Death allows elements to be added (birth) and removed (death) throughout 

an analysis, e.g. in a tunnelling process or a staged construction. 

 Equivalence allows nodes which are close to each other but on different features to be 

merged into one according to defined tolerances. 

 Influence parameters define the type of behaviour of the structure at and around an 

influence point 

 Age defines the time between creation and activation of features in the model.  

 Search Area restricts discrete (point and patch) loads to only apply over certain areas 

of the model. 

 Crack tip define a crack tip attribute to allow a crack tip location to be defined at a 

point or line in a model. 

 Design strength define strength data for use in conjunction with Design Factor Plots 

Manipulating Attributes 

Attributes are defined from the Attributes menu. Defined attributes are shown in the  

Treeview and can be assigned to selected geometry features (or to mesh objects in a mesh-

only model) by dragging and dropping them onto the model or assigning them from their 

context menu.  

Attribute symbols explained 

A symbol adjacent to each attribute name in the  Treeview shows the status of each 

attribute present. 

  A coloured attribute image shows an attribute has been assigned to the model or used in 

the definition of another attribute. 

 A greyed-out attribute image shows an attribute has yet to be assigned to the model or 

used in the definition of another attribute. 

 A coloured or greyed-out attribute with a surrounding red box indicates an attribute that 

has been set as default, meaning it will automatically be assigned to features of the model as 

they are generated. 
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Attribute manipulation 

Attributes are manipulated using the context menu in the  Treeview (accessed by clicking 

the right mouse button on the attribute), with the following commands: 

 Copy Enables the attribute to be copied and assigned to a selected group or window 

using paste. 

 Rename Attributes can be given meaningful names, for example, 'Steel' to describe a 

material, or 'Beam - Four Divisions' to describe a Line mesh. 

 Delete Existing attributes may be deleted. 

 Edit Attribute Allows the properties of the attribute to be modified. If a new name is 

given a new attribute is created and the original attribute is left unchanged. 

 Visible Makes visible all features to which the selected attribute is assigned. 

 Invisible Makes invisible all features to which the selected attribute is assigned. 

 Set As Only Visible Sets the whole model invisible and then makes visible only those 

features to which the selected attribute is assigned. 
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 Advanced Visibility Provides fine control over the visibility of features to which the 

selected attribute is assigned. 

 Results Plots permits results for selected attributes to be selectively plotted. 

 Select Assignments Selects the features that have the selected attribute assignment.  

 Deselect Assignments Deselects the features that have the selected attribute 

assignment.  

 Visualise Assignments Switches on and off the visualisation of features that have the 

selected attribute assignment in the chosen style.  

 Update from library Updates any attribute data held in the model for the selected 

attribute if a section library item or material has been updated since first used. 

 Assign Assigns the selected attribute to the selected features. The attribute will only 

be assigned to features for which the assignment would be valid. Some attributes 

require further information in order to be assigned and in these cases a dialog is 

displayed. For attributes that can only be assigned once to a feature, assigning another 

attribute will overwrite any previous assignment of that attribute type. 

 Deassign Deassigns the selected attribute. Choose From All or From Selection. 

 Set Default Automatically assigns the selected attribute to all new features as they are 

created. 

Visualising Attribute Assignments 

Attribute assignments can be visualised using: 

 Attributes layer The Attributes layer is a window layer in the  Treeview that is 

normally added during the initial start-up of Modeller. The Attributes layer properties 

define the styles by which assigned attributes are visualised. The attributes layer 

properties may be edited directly by double clicking the layer name in the  

Treeview. Attributes can also be visualised individually by selecting an attribute name 

in the  Treeview and clicking the right mouse button to choose Select Assignments 

or Visualise Assignments from the context menu. This is the easiest way to 

interrogate the assignment of a single attribute. 

 Contour layer (materials/geometry/loading attributes only) Allows the model to be 

contoured with a specified value obtained from the material, geometric or loading 

attribute assignments. This is especially useful when an attribute value changes across 

the model. e.g. when defined using a variation. To use (with nothing selected), click 

the right mouse button in the graphics area. Choose Contours from the context menu. 

Select either Loading (model), Geometry (model) or Materials (model). 

 Colour by attribute (Accessed from the properties dialog of the Geometry layer) 

colours the geometry according to which attributes are assigned to which features. A 

key is generated to identify the colours. 

 The options Combine assignments using loadcase history and Show only 

assignments in the active loadcase (Accessed from the properties dialog of the 

Attribute layer for supports/activate attributes only) allows load dependent attributes 
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to be visualised from the accumulated load history or from only those attributes 

assigned to the active loadcase.  

In addition to the above, toolbar buttons for Supports  and Loading  can be used to 

turn-on and turn-off the display of any supports or loadings that are assigned to a particular 

loadcase. 

 See Geometric Properties for the visualisation of beam cross sections and surface 

thickness (fleshing). 

 See Composites for visualising composites materials. 

Deassigning Attributes 

Attributes may be deassigned from all or selected features by selecting the attribute in the  

Treeview  with the right hand mouse button and picking the Deassign entry from the context 

menu. The menu item entries From Selection or From All may then be chosen to deassign 

from the items in the current selection or from all the features in the model. Unassigned 

attributes will be denoted with a greyed-out bitmap . 

Drawing Attribute Labels 

Labels are a layer in the  Treeview. To display attribute labels:  

1. With nothing selected, click the right mouse button in the graphics area and choose 

Labels from the context menu.  

2. Switch on labels for the chosen attribute type. 

Set Default Assignment 

Certain attributes, (mesh, geometric, material, composite), can be assigned automatically to 

all newly created features. Default attributes are set by right-clicking the attribute in the  

Treeview , then choosing the Set Default entry from the context menu. This is useful for 

models with similar materials or thickness throughout, or where the same element is to be 

applied to all features. Attributes that are set as default are displayed with a red box around 

them  in the  Treeview . 

Meshing a Model 

Feature-based geometry models are defined in terms of geometry features which are sub-

divided into finite elements for analysis. This process is called meshing. Mesh attributes 

contain information about: 



Modeller Reference Manual   

    

120 

 Element Type Specifies the element type to be used in a Line, Surface or Volume 

mesh attributes may be selected either by describing the generic element type, or 

naming the specific element. See Element Selection. 

 Element Discretisation Controls the density of the mesh, by specifying the element 

length or the number of mesh divisions, spacing values and ratios. 

 Mesh Type Controls the mesh type e.g. regular, transition or irregular. 

 

Mesh attributes are defined from the Attributes> Mesh menu item for a particular feature 

type i.e. Point, Line, Surface or Volume. The mesh attributes are then assigned to the required 

features. Various techniques exist for meshing different types of models and are described 

below. 

For feature-based geometry models, mesh attributes are defined from the Attributes> Mesh 

menu item for a particular feature type i.e. Point, Line, Surface or Volume. The mesh 

attributes are then assigned to the required features. The orientation of the model Geometry is 

used to define the local axes of the elements. See Changing Geometry / Element 

Orientation if element axes need to be changed.  

Mesh-only models 

Mesh-only models are comprised of nodes and elements and do not contain any geometric 

feature types, or indeed any geometric data at all. The number and shapes of the elements of a 

mesh-only model are fixed. The type of element may be changed and this is done by use of 

the Change Element Type option on the context menu on the element group name. In doing 

so, the number of nodes defining the element topology may be reduced but not increased. For 

instance, an 8-noded brick elements may be defined for use on previously defined 20-noded 

brick elements. See Changing Geometry / Element Orientation if element axes need to be 

changed.  

 

Mesh Types 

Various mesh patterns can be generated: 

 Regular Only used on regular Surfaces and Volumes. Any element shape may be 

selected for regular meshing. Options exist to automatically allow transition or 

irregular meshes to be generated when regular meshing is not possible. 

 Irregular Used for Surfaces and Volumes. An irregular Surface mesh may consist of 

triangular or quadrilateral elements. A irregular Volume mesh must consist of 

tetrahedral elements. Irregular Volume meshes will only be generated if specified as 

acceptable in the mesh attribute. 

 Interface Meshes Only applicable to joint and interface elements 
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Mesh Visualisation 

The Mesh layer properties control how the mesh is displayed in the current Window. The 

same controls are available for the undeformed mesh and the deformed mesh, but since they 

are different layers in the  Treeview, different properties can be applied to each layer.  

Style 

 Wireframe Displays the mesh as a wireframe using the pen specified. Only the 

visible mesh lines are drawn. Click on Hidden parts to draw the hidden mesh also 

(using the pen specified). 

 Solid Displays the mesh as solid panels using the colour specified. Click on the 

coloured square to change the colour used. 

 Outline only Draws only the outline of the mesh. This is also useful for spotting 

cracks or discontinuities in the mesh due to features not being merged or equivalenced 

correctly. 

Mesh 

 Show nodes Draws the mesh nodes. Nodes define the vertices of elements. 

 Show normals (undeformed mesh only) Displays the element normal for Surface 

elements. 

 Show element axes (undeformed mesh only) Displays the element axes as a local 

axis set.  

 Orientations only if selected Displays the surface normal or element axes only if the 

element is selected. 

 Show activated only All elements are active unless they have a Deactivate attribute 

assigned to them. 

 Show quadratic effects Draws quadratic elements with curved edges where 

appropriate, otherwise straight edges are drawn. 

 % of elements remaining Shrinks the elements to the percentage specified. 

 Colour by Enables the mesh colour to be changed. 

 Mesh colour - colours elements in default mesh colour. 

 Group - colours elements by group. 

 Connectivity - colours element edges by number of neighbours. 

 Element Type - colours elements by element type. 

 Normals - colours elements by surface normal direction. 
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Note. The arrow sizes used for element axes and normals are defined on the Default tab of 

the Model Properties. 

Visualise 

 Joint elements Marks any joint elements in the model with a symbol. 

 Active mesh Marks the active elements with a symbol. 

 Beam end releases Draws the beam end release for elements that use end releases. 

Meshing Points  

Point mesh attributes are used to assign non-structural point mass elements, joint elements 

and mesh spacing parameters to the model. Point mass and spacing attributes are assigned to 

a single Point whereas joint attributes are assigned to pairs of Points. The first Point is 

referred to as the Master, the second is the Slave. Joint property assignments should be made 

to the Master Point. 

Meshing Lines 

Line meshing is carried out by defining a Line mesh attribute and assigning this to a selected 

Line. Line mesh attributes are defined from the Attributes> Mesh> Line menu item. The 

number of elements can be specified using either element length or number of divisions.  

Note that when modelling varying cross sections with constant section beam elements care 

should be taken to ensure that sufficient elements have been assigned. Greater than 8 

elements should be used for small variations in cross section along the length of the geometry 

to which the section has been assigned, and considerably more elements should be used for 

larger variations. 

Line Mesh Spacing 

By default elements are evenly spaced but this can be user defined. Non-uniform spacing is 

specified by clicking on the Spacing button from the Line mesh dialog then using one of the 

following methods: 

 Uniform Spacing 
 

 Uniform Transition Specify a ratio of the first to 

last mesh division length. The spacing ratios are 

assigned in the direction of the line to which they are 

applied. This example uses a ratio of 4 which is the 

ratio of the length of the first element to the last. To 

reverse the mesh spacing the ratio could be specified 

as 0.25 (or the Line could be reversed). 
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 General Spacing Enter a grid of numbers which 

defines the individual segment length ratios 

explicitly. They are specified in the form: 

 Number Defines the number of elements at 

this ratio, (from the start of the line as 

defined by the line direction). The numbers 

must add up to the number of divisions 

specified, e.g. for the example below 2+2 = 4 

divisions. 

 Ratio Defines the spacing ratio of the 

elements in the 1st column to the total 

number of elements.  

This example uses general spacing 2@2, 2@4 

(spacing ratios are applied in the direction of the 

Line). 

 

When specifying spacing the Line direction is important as the spacing is defined from the 

start to the end of the line. If the spacing appears to be in the incorrect direction the line may 

be reversed by selecting the Line and using the Geometry> Line> Reverse menu item.  

If desired, the element spacing can also be defined using a background grid mesh. The use 

of a background mesh is specified when the mesh attribute is assigned to the Line. 

Line Element Axis Orientation 

The element x axis always runs along the Line. Orientation of the local y and z axes of 3D 

beam elements may be defined using a beta angle or a local coordinate when the Line mesh 

attribute is assigned to the Line. By default the element z axis coincides with the global Z axis 

and the element y axis forms a right hand set. Elements may also be orientated using a local 

coordinate which is assigned to the geometry. 

End Releases for Beam Elements 

Freedoms at the ends of a Line can be freed to rotate 

or translate using an element with end releases. See 

the Element Library for more information on these 

element types. When defining a Line mesh attribute, 

with a valid element selected, click on the End 

Release button. Releasing beam element end 

freedoms can be used as an alternative to using a 

joint element, for example when defining a pin 

between two beams. 

 



Modeller Reference Manual   

    

124 

Meshing Surfaces 

Regular Surface Meshing 

Regular meshing is used to generate a set pattern of elements on Surfaces and Volumes. Only 

surfaces which are regular (defined by 3 or 4 lines) can be meshed using a regular mesh 

pattern. 

 In order to generate a regular grid mesh 

pattern the number of mesh divisions on 

opposite sides of the Surface must match. 

If they do not match transition patterns 

will be used (if allowed in the mesh attribute definition). The examples shown here 

mesh triangular and quadrilateral Surfaces using both triangular and quadrilateral 

elements.  

  

 The Surface mesh may be graded using 

mesh spacing parameters in 'None' 

element Line meshes assigned to the 

boundary Lines. In the examples shown 

here mesh spacing has been used to bias the elements into the apex of the triangle or 

one corner of the rectangle. 

Irregular Surface Meshing 

Irregular meshing is used to generate elements on any arbitrary Surface. 

 Element Size specifying the required approximate element edge length. 

Meshing Volumes 

Volumes are meshed using regular mesh patterns, transition mesh patterns, or irregular 

tetrahedral meshing.  
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Tetrahedral Volumes 

Tetrahedral Elements Pentahedral/Tetrahedral Elements  

  

Pentahedral Volumes 

  

Pentahedral Elements Hexahedral/Pentahedral Elements 

  

 

Hexahedral Volumes 

Pentahedral Elements Hexahedral Elements Hexahedral/Pentahedral Elements 

   

The mesh density for volumes is taken from the boundary surface mesh density. 
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Regular Volume Meshing 

In order to generate a regular mesh pattern the number of mesh divisions on opposite faces of 

the volume must match. If they do not match then transition patterns will be used. 

Pentahedral/tetrahedral elements will automatically be inserted in the appropriate positions of 

a transition mesh. 

Extruded Irregular Mesh 

Volumes defined by sweeping an irregular Surface may be 

meshed with a regular Volume mesh attribute. The 

interconnecting Lines between the irregular end Surfaces must all 

be straight, or all minor or major arcs with a common axis of 

rotation. The side Surfaces must all be defined by four Lines so 

they can be meshed with a regular grid of quadrilateral faces. The 

irregular opposite Surfaces must not share any common boundary 

lines therefore wedge-shaped Volumes cannot be meshed as 

extruded irregular Volumes.  
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Case Study: Meshing Volumes by Extruding Irregular Surfaces 

It is possible to mesh an irregular volume with hexahedral or pentahedral elements if the 

volume has been formed by sweeping an irregular surface. 

1. Define an irregular Surface with more than 4 sides. 

2. Define a Volume by sweeping the irregular surface. 

3. Define a Volume mesh attribute with Hexahedral or Pentahedral elements, use a 

regular mesh with automatic divisions to ensure an equal number of divisions on the 

swept edges. 

4. Assign the Volume mesh attribute to the Volume. 

Irregular Tetrahedral Meshing 

Arbitrary shaped irregular Volumes defined by 

any number of Surfaces may be meshed with 

tetrahedral elements. The element size may be 

specified on the mesh attribute, taken from the 

defining geometry or interpolated from a 

background grid. The mesh may be refined around 

small features and stress concentration using 

'None' Surface and Line mesh attributes. By 

default the maximum angle around an arc 

subtended by a single element is 90 degrees. This 

may be adjusted on the Meshing tab of the Model 

Properties dialog.  

 

Notes 

 A good initial mesh is usually obtained by specifying the element size as 

approximately1/50th of the diagonal model size. Specifying too small an element size 

will cause too many elements to be generated and may result in LUSAS using up all 

the available memory. Specifying too large an element size will cause the meshing 

algorithm to fail. 

 The success of tetrahedral meshing is dependent on the quality of the Surface mesh. If 

the meshing algorithm fails, invoke edge collapsing or set the Volume mesh to "From 

defining geometry" and adjust the element size using Line and Surfaces mesh 

attributes of type None. If the meshing still fails try breaking the Volume into a 

number of smaller Volumes. 
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Edge Collapsing 

The quality of the mesh may be improved using edge collapsing. Edge collapsing removes 

elements with very short sides or acute angles by merging them with neighbouring elements. 

This is particularly useful when generating tetrahedral elements on imported CAD models 

where very short lines are present. Edge collapsing is invoked from the Advanced button on 

the Meshing tab of the Model Properties dialog. 

  

 
 

Mesh before edge collapsing Mesh after edge collapsing (short edge removed) 

  

Mesh before edge collapsing Mesh after edge collapsing  
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(Elements with small subtended angles removed) 

Controlling the Mesh Density  

The simplest way to define the mesh density is to define the number of divisions to be used in 

the mesh attribute. This method should only be used for simple models because changing the 

mesh density when multiple mesh attributes have been defined is both time consuming and 

prone to error. For most model the mesh density should be controlled using boundary 

discretisation. 

Boundary Discretisation 

In the case of Surface or Volume meshing, the number of mesh divisions may either be 

specified directly in the Surface or Volume mesh attribute, or using Line or Surface mesh 

attributes of element type „None‟. In many realistic problems, where several Surfaces or 

Volumes exist, using attributes with an elements of type 'None' is the most convenient way to 

define the mesh density. For Lines the spacing is specified using either element length or 

number of divisions and for Surfaces the mesh size is specified as the element edge length.  

Notes  

 If the element size is specified differently in the Line and Surface mesh attribute the 

Line element size will be used. 

 If the element size has not been specified the default number of mesh divisions will 

be used. 

  

 Regular Surface Meshing The applied boundary discretisation (left) produces the 

irregular mesh pattern on the Surface (right). 
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 Irregular Surface Meshing The applied boundary discretisation (top) produces 

the irregular mesh pattern on the Surface (bottom). 

 

  

Default Number of Mesh Divisions  

If the discretisation has not been specified in the mesh attribute, or by using a Line mesh of 

element type „None‟ the Line will be sub-divided according to the default number of mesh 

divisions. This is specified on Meshing tab of the File> Model Properties dialog. 
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Background Grid Meshing 

Background grid meshing is a method of controlling the size of elements generated during 

automatic meshing. It is generally only used when specification of spacing and stretching 

parameters at Points is required to grade the mesh pattern locally when irregular surface 

meshing. 

A background grid is a collection of triangular or tetrahedral shapes which completely 

encompasses the features to be meshed. A Line, Surface or Volume mesh is used to define the 

element type in the usual way and point meshes assigned to the points of the background grid 

are used to control the element size in the vicinity of each point. Finer control is achieved by 

using more Points in the background grid definition or by using Line mesh assignments to 

override the mesh size on specific edges. 

The background grid may be specified explicitly from Points at each vertex or generated 

automatically. Any mesh distortion required may be entered using the point mesh stretching 

parameters. If generated automatically, tetrahedral shapes will always be used.  
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Constant Mesh Spacing 

Same spacing parameters (Point meshes) 

are assigned to all Points in background 

grid. 

   
Varied Mesh Spacing 

Different spacing parameters (Point 

meshes) are assigned to the top Points 

(spacing=7) and the bottom Points 

(spacing=1) in the background grid. 

 

  

 

Notes 

 Background grid meshing requires all Points defining the background grid to have a 

point mesh assignment. 

 To remove a background grid delete the Background Grid from the  Treeview. 
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Case Study. Using Background Grid Meshing 

1. With a Surface or Volume already drawn and selected, define a background grid 

by selecting the Utilities> Background Grids menu item and choosing Enclose 

Selection. Define 1 element in each direction and give the background grid a 

name. 

2. Define Point mesh attributes from the Attributes> Mesh> Point menu item with 

the desired element sizes for use at assigned points on the background grid. For 

example Point mesh spacing attributes of 0.5 and 2.5 might be used for opposing 

corners of the grid, and a spacing of 2.0 might be used for the remaining points. 

3. Assign the Point mesh attributes to the appropriate Points on the Background 

Grid. All points must be assigned a point mesh attribute. 

4. Define a Surface or Volume mesh attribute with an Irregular mesh type, leaving 

the element size blank. 

5. Select the Surface or Volume and assign the Surface or Volume mesh attribute to 

the model selecting the From background grid in the mesh assignment dialog. 

The mesh generated will be based upon the governing point mesh values defined 

for the background grid. 
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Composite Material Assignment 

When a Volume feature with a composite material assignment is meshed  the nodes are 

moved onto the composite layer boundaries. This ensures an exact number of layers in each 

element. 

 

  

Connecting Beam and Shells 

Beam Shell Connectivity 

Extend the beams along the edge of the 

shell indicated by thick lines. 

   
Beam Solid Connectivity 

Extend the beams along the edge of the solid 

elements indicated by thick lines. Torsion is 

restrained using out of plane beams. 
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Shell Solid Connectivity 

Extend the shells over a portion of the 

solids indicated by the dark shaded area. 

  
  

 

  
  

  

Case Study: Connecting Shells and Solids 

Solid and shell elements may be connected but the procedure is not as straightforward as 

it first may appear. Solids and shells have different sets of nodal freedoms and the 

rotational freedom present in the shells can only be passed through to the solid elements 

by extending the shell around the side of the solid, thus passing through the rotation via 

combined translation effects. This form of connection stops rotation relative to a solid 

which only has translational degrees of freedom. 

The following procedure outlines the general method of fixing shells to solids: 

1. Define the Surfaces and Volumes. 

2. Define suitable mesh attributes, for example define linear hexahedral elements 

and linear quadrilateral shell elements and assign these to the Volume and Surface 

parts of the model. 

3. Now assign the surface mesh attribute to a surface that forms part of the solid 

elements and which shares a common edge with the shell Surface that is being 

fixed to the solid part of the model. Do not forget to assign material and geometric 

attributes to the surface attached to the solid.  

Note: It is advisable to make a connection such as this reasonably distant from the main 

area of interest as it may affect the quality of the results locally. 
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Fixing Mesh Problems 

When meshing, any features which failed to mesh are noted in the text window. These can be 

identified using the Identify Object dialog invoked by double clicking on the error message in 

the text window. Alternatively, a group can be created containing all the features that failed 

to mesh. Only features that are not part of meshed higher order features will be added to the 

group. To activate this facility choose the check box Create a group of features that failed 

to mesh invoked from the Advanced button on the Meshing tab of the Model Properties 

dialog.  

When importing CAD models meshing errors can sometimes occur due to very short lines 

and small surface slivers in the model. These problems can be alleviated in the meshing 

process by using edge collapsing. 

When meshing open hollow volumes with tetrahedral elements the edges with nodes which 

have failed to merge are displayed automatically. 

  

Unmerged nodes on volumes which failed to mesh. Mesh with nodes merged by adjusting node 

merge tolerance 

Notes 

 Unmerged nodes are most easily seen when meshed using solid fill. 

 Nodes which have failed to merge may be forced to merge by adjusting the node 

merge tolerance on the volume properties dialog or by assigning a suitable line mesh 

of type None to the lines. 

Mesh Utilities  

Mesh utilities provide the means to query distances between nodes; to control the meshing 

and re-meshing of all or parts of a model and to use a defromed mesh as a starting point for a 

further analysis. Mesh utilities are accessed from the Utility > Mesh menu item 

 Distance Between Nodes - displays in the Text Output window the relative distance 

between any selected nodes. 



  Chapter 6 

    

137 

 Show Closest Nodes - displays in the Text Output window the distance between the 

closest nodes of any of those selected. 

To control changes being made to a mesh the following menu items can be used in various 

inter-related ways. 

 Mesh Lock - Disables automatic remeshing of a model and prevents any changes to a 

mesh being made. LUSAS automatically locks the mesh on a model when a results 

file is loaded because any subsequent mesh changes may lead to the assembly of 

results in a misleading fashion. Mesh changes involve renumbering or reorientation of 

elements and results are associated with node and element numbers.. Therefore results 

requested after a remesh (without the mesh being locked) may appear in the wrong 

location and in the wrong order in the structure.You can unlock the mesh using the 

menu item Utilities > Mesh > (uncheck) Mesh Lock and Utilities > Mesh > Mesh 

reset 

 Mesh Reset - Deletes the current mesh and forces a complete re-mesh of the whole 

model using the assigned mesh attributes. If Mesh Lock is 'on' this will not occur. 

 Mesh Now - meshes the whole model regardless of any Mesh Lock being set. 

 Mesh Selected Items - meshes only those features selected. 

 Use Deformations - uses the deformed mesh caused by one analysis to be used as the 

starting point for a further analysis. The mesh may be tabulated with node coordinates 

computed from the deformations in the active loadcase multiplied by a specified 

factor. To do so, a model file and its results file must be loaded with the required 

results loadcase set active.  

Joint and Interface Elements 

 Joint elements are used to connect two or more nodes with springs having 

translational and rotational stiffness. They may have initial gaps, contact properties, 

an associated mass and damping, and other nonlinear behaviour.  

 Interface elements are used for modelling interface delamination in composite 

materials. 

Both joint and interface elements may be inserted between pairs of corresponding nodes and 

features. 

Defining and Assigning Joints 

A Joint element is defined as a Point, Line or Surface mesh attribute using the Attributes > 

Mesh menu and specifying the structural element type to be used. Once defined, it is assigned 

to the model in one of two ways: 

 To a single pair of features This requires two points or lines or surfaces to be 

selected. The first selected feature becomes the master. The second selected feature 

becomes the slave. 
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 To multiple pairs of features This uses selection memory to define a set of slave 

features prior to selecting a set of master features. 

Defining and Assigning a Joint to a Single Pair of 

Features 

To model a single joint element between a pair of features (two points, two lines or two 

surfaces): 

1. Define a Joint mesh attribute with the chosen joint element. 

2. Select the first (master) feature. 

3. Add the second (slave) feature to the selection. 

4. Assign the Joint mesh to the two features. Options exist to allow definition of the local 

axes of the joint element. 

Defining and Assigning a Joint to Multiple Pairs of 

Features 

To define joint elements between multiple pairs of features (two or more sets of points, lines 

or surfaces: 

1. Define a Point, Line or Surface mesh attribute with the chosen joint element. 

2. Select the slave features and add them to selection memory. 

3. Select the master features. 

4. Assign the joint mesh. 

As the same joint mesh attribute is assigned to both master and slave features, a mesh pattern 

is created between the two features, with the mesh definition determining the number of joints 

generated in the joint interface mesh. When using interface meshing the joint elements are 

automatically created, joining all nodes on the master and slave features, and each joint 

stiffness is automatically computed from the representative length or area of the elements on 

the master/slave features.  

Notes.   

 Joint meshes require Joint material properties to be assigned to them. 

 For joints with rotational degrees of freedom an eccentricity must be specified. An 

eccentricity of zero may be specified. 

 The Joint symbol is drawn at the quarter-point along the joint nearest to the Master 

feature. 

 Joint properties should be defined per unit length when assigned to Lines and per unit 

area when assigned to Surfaces. 
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 Master features hold the mesh assignment data. A point can only hold one joint 

assignment so if multiple joints are to be assigned to a single point that point must be 

designated the Slave by ensuring it is the second point in the selection. 

 Joints defining spring supports act relative to the initial, unstressed configuration 

rather than that on any previous loadcase. This means that to introduce a stiffness to a 

support in a loadcase during a staged nonlinear analysis, relative to the stressed state 

on the previous analysis, you will need to use joints and activate them on this 

loadcase. 

Examples of Assigned Joints 

 

  
Joint between two points Joint between two lines Joint between two surfaces 

Joint Local Axis Direction 

The joint local axis direction is defined when the mesh is assigned. Three options are 

available: 

 Follow point axes (Default selection) Adopt the axes assigned from the Local 

Coordinate (if any) assigned to the point. Any Local Coordinate that has been 

assigned to a feature can, additionally, be chosen to be ignored as a separate option. 

 By point in selection memory - A Point previously added to selection memory is 

used to define the xy-plane.  

 By specified local coordinates The element axes are defined using a previously 

defined Local Coordinate. 

For Joint element assignments only, the order of the features selected determines the Master 

and Slave. Joint elements are orientated from the Master to the Slave. To swap the Master and 

the Slave deselect the Mesh from Master to Slave option. 
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Case Study. Joint/Interface Mesh 

(2D) 

In this example Line 2 is placed in selection 

memory (Slave) and a Line joint mesh 

attribute with 6 divisions is assigned to Line 

1 (Master). Joints are created automatically 

to tie the Lines together with an interface joint mesh. 

Note. The unmerge facility allows coincident features to be created from a single feature 

and also allows a feature to be set as Unmergable, so it will not be accidentally merged 

back with another coincident feature. See Merging and Unmerging for more details. 

  

Case Study. Cylindrical 

Joint/Interface Mesh (3D) 

In this example, a Surface joint mesh is 

assigned to Surfaces between two concentric 

cylinders. Cylindrical axes are defined for 

the joint properties using a local coordinate. 

Joint local x axes will then coincide with the 

cylinder radial direction. 

Joint Material and Geometric Properties 

Joint material and geometric properties are assigned to the master feature. 

 Joint Material Properties Joint meshes require joint properties to be assigned to 

them. These are defined from the Attributes> Material> Joint menu item.  

 Joint Geometric Properties For joints with rotational degrees of freedom an 

eccentricity must be specified using the Attributes> Geometric> Joint menu item. 

Non-Structural Mass Elements 

Non-structural mass elements are used to define a lumped mass at a Point, or a distributed 

mass along a Line or over a Surface. Variations may be used to vary the mass along the Line 

or over the Surface.  

Defining and Assigning Non-Structural Mass Elements 

A non-structural mass element is defined as a mesh attribute using the Attributes> Mesh 

menu item and specifying the structural element type to be used. Once defined it is assigned 

to selected features using the standard drag and drop technique.  
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Non-structural mass elements also require material properties to be assigned to them. Use the 

Attributes> Material menu item to create the required mass for assignment. 

Note. Mass properties should be defined per unit length when assigned to Lines and per unit 

area when assigned to Surfaces. 

Examples of Assigned Non-Structural Mass Elements 

  

 
  

Lumped mass at a point Distributed mass along a line Distributed mass over a surface 

Non-Structural Mass Local Axis Direction 

Since the mass can be used to model hydrodynamic effects it is defined in local directions. In 

the case of a line, the direction may need to be normal to the line or in the case of a surface, 

normal to that surface. When carrying out large deformation analyses these directions are 

continually updated as the solution progresses. The element axis direction can be defined 

when the mesh is assigned. Three axis orientation options are available: 

 Follow point axes (Default selection) Adopt the axes assigned from the Local 

Coordinate (if any) assigned to the point. Any Local Coordinate that has been 

assigned to a feature can, additionally, be chosen to be ignored as a separate option. 

 By point in selection memory - A Point previously added to selection memory is 

used to define the xy-plane.  

 By specified local coordinates The element axes are defined using a previously 

defined Local Coordinate. 

Delamination Interface Elements 

Interface elements may be used at planes of potential delamination to model inter laminar 

failure, and crack initiation and propagation. 

If the strength exceeds the strength threshold value in the opening or shearing directions the 

material properties of the interface element are reduced linearly as defined by the material 

parameters and complete failure is assumed to have occurred when the fracture energy is 

exceeded. No initial crack is inserted so the interface elements can be placed in the model at 

potential delamination areas where they lie dormant until failure occurs. 
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Fracture Modes 

Three fracture modes exist: open, shear, and tear (orthogonal shear for 3D models). The 

number of fracture modes corresponds to the number of dimensions of the model. The 

diagram below illustrates the three modes. 

 
Mode 1 - Open 

  
 
Mode 2 - Shear 

  
Mode 3 - Tear  
(orthogonal shear to mode 2) 

 

 

  
 

 

  
 

 

The interface elements are used to model delamination in an incremental nonlinear analysis. 

These elements have no geometric properties and are assumed to have no thickness. 

Interface elements are defined as Line or Surface mesh attributes using the Attribute> Mesh 

menu item.  

Interface Material Properties 

The interface material properties are defined from the Attribute> Material> Specialised 

menu item and then assigned to the same geometry as the interface mesh. 
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Material Parameters 

 Fracture energy Measured values for each fracture mode depending on the material 

being used, e.g. carbon fibre, glass fibre. 

 Initiation Stress The tension threshold /interface strength is the stress at which 

delamination is initiated. This should be a good estimate of the actual delamination 

tensile strength but, for many problems, the precise value has little effect on the 

computed response. If convergence difficulties arise it may be necessary to reduce the 

threshold values to obtain a solution. 

 Relative displacement The maximum relative displacement is used to define the 

stiffness of the interface before failure. Provided it is sufficiently small to simulate an 

initially very stiff interface it will have little effect. 

Coupling Model 

 Coupled/mixed interface damage - Recommended method. 

 Uncoupled /reversible - Unloading is reversible along the loading path. 

 Uncoupled /origin - Unloading is directly towards the origin ignoring the loading 

path. 

Notes 

 It is recommended that automatic nonlinear incrementation is used with the arc length 

procedure option set to root with the lowest residual norm, when defining loadcase 

control. 

 It is recommended that fine integration is selected for the parent elements from the 

Solution tab of the Model Properties dialog. 

 The nonlinear convergence criteria should be set to converge on the residual norm. 

 Choose Continue solution if more than one negative pivot occurs from the Model 

properties, Solution tab, Nonlinear options dialog and set option 252 to suppress pivot 

warning messages from the solution process. 

 The non symmetric solver is run automatically when mixed mode delamination is 

specified. 

 Although the solution is largely independent of the mesh discretisation, to avoid 

convergence difficulties it is recommended that a least two elements are placed in the 

process zone. 
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Element Selection 

About LUSAS Elements 

Elements are classified into groups according to their function. The element groups are listed 

below.  

 See also Joint Element Meshes, and Interface Elements (for composite 

delamination). 

 For full details of all elements refer to the Element Reference Manual. 

 For full details of the element formulations refer to the LUSAS Theory Manual. 

Point Element Selection 

Non structural mass and Joint elements are defined at or between points.  

Generic Element Types 2D 3D 

Non structural mass 
Joint (no rotational stiffness)  
Joint (for beams) 
Joint (for grillages) 
Joint (for axisymmetric solids) 
Joint (for axisymmetric shells) 

PM2 
JNT3 
JPH3 
JF3 
JAX3 
JXS3 

PM3 
JNT4 
JSH4 
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Line Element Selection 

The following table lists the elements available for Line meshing by type and by name. The 

first column matches the option list in the Line mesh dialog box.  

Generic  
Element Types 

2D  
2 noded 

2D  
3 noded 

3D  
2 noded 

3D  
3 noded 

’None’  
Bar  
Thin beam  
Thick beam 
Thick beam (nonlinear) 
Engineering grillage Cross-section beam  
Semiloof beam  
Axisymmetric membrane  
Joint (no rotational stiffness)  
Joint (for beams) 
Joint (for grillages) 
Joint (for axisymmetric solids) 
Joint (for axisymmetric shells) 
Thermal bar  
Axisymmetric thermal membrane  
Thermal link 
Interface  

- 
BAR2 
- 
BEAM 
- 
GRIL 
- 
- 
BXM2 
JNT3 
JPH3 
JF3 
JAX3 
JXS3 
BFD2 
BFX2 
LFD2 
- 

- 
BAR3 
BM3 
- 
- 
- 
BMX3 
- 
BXM3 
- 
- 
- 
- 
- 
BFD3 
BFX3 
- 
IPN6 

- 
BRS2 
- 
BMS3BTS3 
- 
- 
- 
- 
JNT4 
JSH4 
- 
- 
- 
BFS2 
 
LFS2 
- 

- 
BRS3 
BS4 
- 
- 
- 
BSX4 
BSL4 
- 
- 
- 
- 
- 
- 
BFS3 
 
- 
- 

Notes 

 Quadratic elements are curved with a mid-side node. 

 For some beam elements rotational freedoms at the ends of a Line can be made free 

to rotate by using an element with moment release end conditions. 

 No check is made in LUSAS Modeller as to whether the element type is valid for the 

analysis being performed, however LUSAS Solver will stop the analysis if the 

element is unsuitable. 

 This list is a guide as to which elements to use. Not all elements are listed here. See 

the Element Reference Manual for full details of all elements. 

 Elements in bold text are only available if your licence includes the Plus option. 
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Surface Element Selection 

The following table lists the elements available for surface meshing by type and by name. 

The first column matches the option list in the Surface mesh dialog box.  

Generic  
Element Types 

Triangle 
3 noded  

Quadrilateral 
4 noded 

Triangle 
6 noded 

Quadrilateral 
8 noded 

Plane stress 
Plane strain 
Axisymmetric solid 
Thin plate 
Thick plateThin shell 
Thick shell 
Membrane 
Fourier 
Plane field (thermal) 
Axisymmetric solid field 
Explicit dynamic - plane stress 
Explicit dynamic - plane strain 
Explicit dynamic - axisymmetric 
Interface 

TPM3 
TPN3 
TAX3 
TF3 
- 
TS3 
TTS3 
TSM3 
TAX3F 
TFD3 
TXF3 
TPM3E 
TPN3E 
TAX3E 
- 

QPM4M 
QPN4M 
QAX4M 
QF4 
QSC4 
QSI4 
QTS4 
SMI4 
QAX4F 
QFD4 
QXF4 
QPM4E 
QPN4E 
QAX4E 
- 

TPM6 
TPN6 
TAX6 
- 
TTF6 
TSL6 
TTS6 
- 
TAX6F 
TFD6 
TXF3 
- 
- 
- 
- 

QPM8 
QPN8 
QAX8 
- 
QTF8 
QSL8 
QTS8 
- 
QAX8 
QFD8 
QXF8 
- 
- 
- 
IS16 

Notes 

 Elements in bold text are only available if your licence includes the Plus option. 

 No check is made in LUSAS Modeller as to whether the element type is valid for the 

analysis being performed, however LUSAS Solver will stop the analysis if the 

element is unsuitable. 

 This list is a guide as to which elements to use. Not all elements are listed here. See 

the Element Reference Manual for full details of all elements. 

Volume Element Selection 

The following table lists the elements available for volume meshing by type and by name. 

The first column matches the option list in the Volume mesh dialog box.  

  Tetrahedral Pentahedral 

Generic 
Element Types 

4  
noded 

10  
noded  

6  
noded 

12  
noded 

15  
noded  

Stress 
Thermal 
Explicit dynamic 
Stress composite 
Thermal composite 

TH4 
TF4 
TH4E 
- 

TH10 
TF10 
- 
- 

PN6 
PF6 
PN6E 
PN6L 
PF6C 

  
 
 
PN12L 
PF12C 

PN15 
PF15 
 
PN15L 
PF15C 
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  Hexahedral 

Generic Element  
Types 

8  
noded 

16  
noded  

20  
noded 

Stress 
Thermal 
Explicit Dynamic 
Stress Composite 
Thermal Composite 

HX8M 
HF8 
HX8E 
HX8L 
HF8C 

  
 
 
HX16L 
HF16C 

HX20 
HF20 
 
HX20L 
HF20C 

Notes 

 No check is made in LUSAS Modeller as to whether the element type is valid for the 

analysis being performed, however LUSAS Solver will stop the analysis if the 

element is unsuitable. 

 This list is a guide as to which elements to use. Not all elements are listed here.  

 Elements in bold text are only available if your licence includes the Plus option.  

Geometric Properties 

Geometric properties which have not already been defined by the feature geometry need to be 

specified using geometric attributes. Geometric properties are element dependent and are 

defined for an element family such as bars, beams, shells, joints etc. Geometric attributes are 

defined for each feature type using the Attributes> Geometric menu item and then assigned 

to the required feature (or to an appropriate mesh object in a mesh-only model). Geometric 

properties can be defined for: 

 Lines 

 Surfaces 

 Joints 

Geometric Line Properties 

Geometric line properties such as cross-sectional area, second moments of area etc for 

bar/link, grillage,and thin/thick beam elements can be defined either by: 

 Using the Attributes> Geometric> Section Library menu item to access supplied 

and user-created items in the section library, or, less commonly, by 

 Using the Attributes> Geometric> Line menu item to enter section properties 

directly on the Geometric Line dialog. 

 Using the Attributes> Geometric> Tapering Section menu item to access the 

geometric line tapering section dialog directly. 
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 Using the Attributes> Geometric> Multiple Varying Section menu item to create a 

geometric line attribute that contains details of any number of cross-sections held in 

section libraries that are to be assigned to a line or a whole series or path of lines at 

specified distances. See Multiple Varying Sections for details. 

The following options are available when defining geometric line properties: 

 Visualise Cross-sectional shapes for standard library items and for library items 

created by the standard and arbitrary section property calculators will be automatically 

visualised. Beam sections defined by using the Attributes > Geometric > Line menu 

item, requiring general properties to be entered by hand, will require cross-section 

properties to be defined manually in order for geometric visualisation to take place. 

The orientation of the visualised section is based upon the vertical axis defined for the 

model. In LUSAS, 2D models are assumed to be drawn in the XY plane with the Y 

axis vertical. 3D models normally have the Z axis set to be vertical. 

 Tapering... / Non-Tapering... Tapering beam sections can be defined by specifying 

section properties for each end of the beam. For complex sections this would normally 

be done by drawing selected cross sections for key locations along a model and using 

the arbitrary section property calculator in Modeller to calculate and save the 

properties to a library prior to using this dialog. Where both ends of a beam have been 

defined using either a LUSAS supplied standard library item or one of the LUSAS 

standard section calculators an 'exact' calculation can be made to arrive at intermediate 

section properties based upon the known shapes at either end of the beam. In cases 

where one or both ends of a beam section have been defined using the arbitrary 

section calculator (and this includes section properties calculated from the precast 

section range) a choice of interpolation method is provided. When the tapering option 

is chosen, the vertical and horizontal alignment of one end of the beam section from 

the other can be specified. Tapered beams would normally use the same section shape 

at either end, but differing sections can be accommodated. Offsets (eccentricities of 

beam ends from nodal positions) can also be defined. When modelling varying cross 

sections with constant section beam elements care should be taken to ensure that 

sufficient elements have been assigned. See Notes for details. 

 Cross-section... information is used to define a series of 

quadrilateral shapes that define the true cross-sectional shape 

of the bar/grillage/beam element. It generally only needs to 

be defined if a beam's properties have been defined manually 

and it is required that the beam's shape is subsequently 

visualised using the fleshing  option. For most other 

cases cross-sectional information is automatically provided 

or created by LUSAS. In defining the cross-section shape the 

coordinate of each quadrilateral must be defined in local zy 

cross-section coordinate pairs at each node, z1, y1, z2, y2, 

z3, y3, z4, y4. When defining a cross-section by this method 
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the centroid of the section must reside at 0,0. For Cross 

Section Beam elements (for advanced use only) the number 

of integration points (also known as gauss points) can also be 

set. 

 Fibre locations define positions on the beam cross-

section at which stresses can be plotted when 

visualising results. Standard sections, precast beam 

sections, and box sections added to a library will 

have their cross-sectional geometry pre-defined. 

They also have default fibre locations stored for each 

section. Sections drawn by users and added to the 

local (user) or server (all users) libraries using the 

arbitrary section property calculator have fibre 

definitions calculated automatically. 

 Plastic properties... geometric properties are required for beams when using the 

stress resultant material model (model 29).  

Ap - Plastic area (= elastic area) 

Zyyp - Plastic modulus for bending about y axis 

Zzzp - Plastic modulus for bending about z axis 

Zyp - Plastic modulus for torsion about y axis 

Zzp - Plastic modulus for torsion about z axis 

Sp - Plastic area for shear (Sp=0) 

The actual parameters required depend on the chosen beam element. See the Element 

Reference Manual for further details. 

Once defined, the geometric section properties are added to the  Treeview using the OK or 

Apply button. The geometric properties can then be assigned to the required Line(s) in the 

model.  

Offsets 

 Thick beam elements accommodate 

Offsets which are measured from the 

bending plane to the nodal line in the 

local element direction. When offsets 

are defined the beam section 

properties are input relative to the 

beam axis. 

 When sections are defined at either 

ends of a tapering beam the offset of 

one section to the other to achieve the vertical and horizontal alignment setting 
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specified is automatically calculated. Subsequent entering of an offset value for the 

'master' end in the Value field will automatically offset and update the value for the 

other 'follower' end by an equivalent amount to ensure the beam ends are moved 

equally from their nodal positions. If a vertical or horizontal alignment offset is stated 

in the Alignment panel of the dialog that value will only affect the 'follower' end. 

 For thin beam elements eccentricity may be incorporated within the geometric 

properties. In this case the properties are input relative to the nodal line. This type of 

eccentricity is used when elements share the nodal line as can occur in the analysis of 

stiffened shells. 

Notes 

 The orientation of the beam axes and hence the orientation of the visualised section is 

governed by the vertical global axis stated on the Direction Definition dialog. 

 The orientation of the beam axes and hence the orientation of the visualised section is 

governed by the vertical global axis stated on the Direction Definition dialog. 

 If a thick beam's properties with offsets defined is assigned to a thin beam the 1st and 

2nd moments of area will be updated to accommodate the offset as an eccentricity. 

 For beams defined using the same standard section (rectangular, rectangular hollow 

section, circular, circular hollow section etc) at each beam end the standard LUSAS 

section property calculator is used to accurately calculate all section property values. 

 For beams defined using arbitrary sections of the same section shape at each beam end 

the standard LUSAS section property calculator is used to calculate the values of A, 

Iyy, Izz and Iyz. By default the enhanced interpolation method is used to calculate the 

values of J, Asy and Asz, but the linear interpolation method is also available. The 

Enhanced interpolation method has been proven to generally produce more accurate 

section property values than the Linear method. 

 For beams defined using arbitrary sections with different section shapes at each beam 

end, by default the Enhanced method is used to calculate all values but the linear 

interpolation method is also available.  

 The visualisation of tapering sections on the Geometric Line dialog is for information 

only. Only by selecting the Visualise button will a correct representation of the 

relative arrangement of both sections be seen, incorporating any alignment options 

specified on the main dialog. 

 When modelling varying cross sections with constant section beam elements care 

should be taken to ensure that sufficient elements have been assigned. Greater than 8 

elements should be used for small variations in cross section along the length of the 

geometry to which the section has been assigned, and considerably more elements 

should be used for larger variations. 
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 More complex tapering can be achieved using the Multiple Varying Section facility. 

 Models created prior to version 14.2 will not have any fibre locations data stored for 

each beam. However, the relevant fibre location data can be added automatically for 

these models by double-clicking on each Geometric line entry in the  Treeview and 

re-selecting the same section size from the appropriate sections library. 

 Double-clicking on a geometric line attribute name in the  Treeview allows editing 

of beam section information. 

Geometric Surface Properties 

Geometric attributes are defined for surfaces 

using the Attributes> Geometric> Surface 

menu item. 

  Structures modelled using plate, 

membrane or shell elements require a 

Thickness to be defined for each 

surface.  

Eccentricity 

 Optionally an Eccentricity can be 

specified for certain element types. 

Eccentricity is measured from the 

bending plane to the nodal line in the 

local element z direction. 

 

Geometric Joint Properties 

Geometric attributes are defined for joints using the Attributes> Geometric> Joint menu 

item. For certain joint elements eccentricity (in the local z direction) is an optional 
geometric property that can be defined. See the Solver Reference Manual for details. 

Setting Geometric Attributes for Default Use 

A geometric attribute may be designated as the default assignment using Set Default on the 

context menu. When done, default attributes are automatically assigned to new geometry as it 

is defined. 

Visualising Geometric Properties (Fleshing) 

Beams of standard or arbitrary cross-section (that are held in section libraries), surface 

thicknesses and offsets can be visualised on the geometry model using the fleshing button 

 or from the Attributes Layer  properties Geometric tab. From the geometric settings 

dialog or from the context menu of the fleshing button the cross-section may be exaggerated 
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in size and shrunk in from the ends of the assigned Line to aid visualisation at the 

connections. When processing results the deformed cross-section shape may also be 

visualised by selecting the Deform option on the geometric properties dialog. 

  
Visualisation of Attributes Without Fleshing Visualisation of Attributes With Fleshing 

Notes 

 Geometric properties can be varied along a line using a tapered section definition or 

by using the multiple varying section facility. 

 Geometric properties can be varied over a surface by using a variation. See Variations 

for more details. 

 Geometric attributes are not required for plane strain, axisymmetric solid or 3D solid 

elements. 

 The geometric attributes are specified in a generic form for all elements and only the 

properties required for the intended element need be specified. For example 

eccentricity is reported as a error if assigned to semi-loof shell elements which do not 

use it in their formulation. 

 For more details on the properties required for a specific elements refer to the Element 

Reference Manual 

Section Library 

The section library is available from the Attributes> Geometric> Section Library menu 

item.  

Standard section libraries are currently available for the following: 

 Australia steel sections 

 Canada steel sections 
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 China steel sections 

 EU steel sections 

 KS steel sections - Korean Rail Sections 

 UK steel sections 

 US steel sections 

In addition, user-created section properties can be saved in the following libraries: 

 User (local) - for use inside the current project only 

 User (server) - for use across all projects 

Sections selected from a library are added to the  Treeview. From there they can be 

assigned to selected line features on a model.  For more details on the use of section library 

items see the Geometric Properties section. 

Adding Additional Sections to the Section Library 

In addition to sections provided in the geometric beam section library, other sections can be 

added to the library by using Section Property Calculator facilities. These are accessed from 

the Utilities > Section Property Calculator menu. Facilities exist to calculate the properties 

of standard sections, precast beam sections (with or without a top slab), simple and complex 

box sections, and user-defined arbitrary sections that are created in LUSAS Modeller.  

Multiple Varying Sections 

The multiple varying section dialog is accessed using the Attributes > Geometric 

> Multiple Varying Section menu item. It enables pre-defined cross-sections to be specified 

at distances for subsequent assignment to a single line, or to a series of lines with reference to 

a pre-defined reference path. A table is built up specifying the section shapes which define 

the varying section, the interpolation method to be used in order to describe the change of 

section shape between sections, and the alignment method to be used to set-out each section 

with respect to another.  

 Usage Selects the element type for which the varying section properties will be 

defined. 

 Specify shape interpolation Allows selection of an interpolation type. If unchecked, 

a smoothed option is used. 

 Distance interpretation settings specify the method of spacing the sections. 

Section selection 

In the section selection table the sections that will be used to generate a varying cross section 

along a line or path of lines are each added to the table and an interpolation method and a 

distance from a starting point is specified for each. User-defined sections need to be saved to 

the local or server libraries prior to using this facility. 
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 Section Clicking on the launch dialog button   in this cell allows a pre-defined 

section to be chosen from the section library. 

 Shape Interpolation Clicking on the drop-list button  in this cell permits the 

definition of a smoothed, linear, quadratic or a function-based interpolation setting. 

The shape interpolation setting defines the shape between adjacent pairs of defined 

sections. This is only available for second and subsequent entries in the table. 

 Distance specifies a value for a chosen distance type. 

Distance type 

 Scaled to fit each line individually Values must be entered in the Distance cells of 

the table to represent the locations along a line that the sections will apply. Values are 

entered either as proportional distances along a line (for example entering 0, 10 and 20 

would specify a section at either end and at a mid-point of any line that was selected 

and assigned this geometric line attribute). Distances are mapped to the actual line 

length so entering 0, 0.5, and 1, in three separate cells would produce the same result. 

Note that a section does not necessarily have to be defined to start at a distance of 0, 

so entering 0.5, 10.5, and 20.5, in three separate cells would produce the same result. 

This latter example would be of particular use in creating preliminary models for 

eventual staged construction uses. 

 Along reference path For this option, the actual distances must be entered at which 

each section will be positioned along a reference path. For bridge engineering use this 

equates to entering 'chainage' values. Values are entered as absolute and not relative 

distances. Note that a section does not necessarily have to be defined to start at a 

distance of 0. If a model is defined local to an origin of 0,0,0, the reference path origin 

(the 'Value of distance at start of path' in the Path Definition dialog) can be defined to 

start at, say, 100, and then entering 100, 105 and 110 with reference to the path 

assignment would position sections at the start of, and incrementally along, the lines 

selected. 

Examples are provided of distance types. See Distance Types and Methods of Assignment. 

Table related buttons 

 The Symmetric section check box copies any rows above the last defined entry and 

reverses them to create a symmetric odd-numbered arrangement.  

 Edit, Insert and Delete buttons provide the means to select sections from the library, 

create new rows above a selected row, and to delete rows from the table.  
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Alignment  

 Align all sections to section (number) - align all sections with respect to the 

specified 'master' section number. Use in conjunction with the section visualisation 

panel. 

 Vertical and horizontal alignments - these govern how tops, centres, bottoms and 

sides of adjacent beam sections are set out relative to the 'master' section. An option to 

enter user-defined individual offsets is also provided and enables more advanced 

alignment to be achieved. Use the vertical alignment options in conjunction with the 

section visualisation panel. 

Section offsets explained 

When sections are specified to define a multiple varying section beam it is important to 

remember that the 'master' section is the one to which all 'follower' sections are aligned to. 

The offset of each 'follower' section to achieve the desired vertical and horizontal alignment 

with respect to the 'master' is automatically calculated for each section. The offset values seen 

for 'follower' sections are made up of a value corresponding to the automatically calculated 

offset required to achieve correct alignment to the master section plus any additional user-

defined individual offset that may have been defined for the 'master' section.  

Subsequent updating of an offset value for a 'master' section (by clicking the launch dialog 

button  in the Section cell of the table and entering an offset value on the Enter section 

dialog) when Top to top, Centre to centre, or Side to side alignment options are selected 

will automatically update the offset values for all of the 'follower' sections by an equivalent 

amount to ensure the sections are moved equally to re-align with the master section. 

Note that for thick beam elements the offsets are measured from the bending plane of the 

section to the nodal line in the local element direction. This can result in both positive and 

negative offset values depending upon the size of the 'master' and 'follower' sections.  

 To move a multiple varying section beam up or down from its nodal line position only the 

offset for the 'master' section need be modified because all other sections will have their 

offset values updated automatically to be moved by the same amount. 
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Whilst not commonly used, user-defined individual offsets can be entered for selected 

sections by selecting the Individual offsets menu item from either the Vertical or Horizontal 

Alignment drop-down menu, then accessing a section's properties by clicking the launch 

dialog button   in this cell and entering an offset value on the Enter section dialog. When 

individual offsets are specified on a 'follower' section any connection with the 'master' section 

is broken and any offsets specified on a 'master' section will no longer update the offsets on a 

'follower' section. 

Interpolation of section properties 

Where all sections have been defined using either a LUSAS supplied standard library item or 

one of the LUSAS standard section generators an 'exact' calculation is made to arrive at 

intermediate section properties based upon the defined shape (see Shape Interpolation 

above) between the sections.  

If the shape of the cross-section cannot be interpolated (because one of the sections has been 

defined using the arbitrary section calculator, or if sections are of completely different 

shapes) the engineering properties at locations along the multiple varying section can be 

calculated in two different ways: 

 Enhanced interpolation uses proprietary LUSAS equations to calculate best-estimate 

cross-section properties for locations along a beam from the cross-sectional area (A) 

and Moment of Inertia (I) values of the sections defined at each beam end. See the 

Theory Manual for more details. 

 Linear interpolation calculates cross-section properties for locations along the beam 

by linearly interpolating the cross-sectional area (A) and Moment of Inertia (I) values 

of the sections defined at each beam end. This method has generally known 

limitations for particular section types. 

Note that when modelling varying cross sections with constant section beam elements care 

should be taken to ensure that sufficient elements have been assigned. Greater than 8 

elements should be used for small variations in cross section along the length of the geometry 

to which the section has been assigned, and considerably more elements should be used for 

larger variations. 

Attribute name 

The full name of the geometric line attribute added to the  Treeview will include the 

Attribute name followed by an automatically created name based upon the number of section 

library items used. If section properties of this geometric line are manually edited the 

automatically added part of the attribute name in the  Treeview is removed. The 

automatically created part of the name is uneditable if a rename is carried out. 

Once defined, the geometric section properties are added to the  Treeview using the OK or 

Apply button. The section is then available for assigning to the appropriate lines on the 

model. Assigned beam section properties may be fleshed using the fleshing button  or 

from the  Attributes Treeview. 
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Section visualisation 

As the multiple varying section is built-up in the table, a visualisation of the longitudinal and 

vertical alignment and of the cross-section shapes used is displayed on the dialog. 

Longitudinal section visualisation only takes place once all required data has been entered 

and only for sections that are compatible. The visualisation can be inspected by zooming and 

panning in the display panel. A changing cursor image indicates whether the facility is 

enabled or not. If necessary click in the panel to activate this facility. Use the mouse wheel to 

zoom in and out. Click and hold-down the left mouse button, or click and hold-down the 

mouse wheel to pan.  

Multiple varying sections would normally be defined to use the same section shape having 

the same set of fibre definitions throughout, but differing sections can be accommodated. In 

situations where the varying sections are too different to be connected together section 

visualisation on the dialog and fleshing of any assigned attributes on the model is not 

possible. 

Incompatible section types 

Checking for incompatible section types is, and can only be, carried-out when the OK button 

is clicked. 

Multiple Varying Section Distance Types and Methods of 

Assignment 

A multiple varying section geometric line attribute can be defined for assignment to either: 

 A single line - where section spacing distances are scaled to fit each line individually 

 A series of lines - where section spacing distances are defined for use with a pre-

defined reference path 
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Varying section distances defined for assignment of the line 

attribute to a single line. 

Varying section distances defined for assignment to 

multiple lines with reference to a path. 

The values entered in the distance cell of the multiple varying section dialog depend upon the 

intended assignment. Examples of each type follow. 

Scaled to fit each line individually 

In their simplest form, multiple varying sections can be defined for assigning to single 

selected lines on a model. Values are entered that will be mapped to the actual line length 

when the multiple varying section line attribute is assigned to a line or lines on a model. For 

example, entering 0, 0.333, and 1, or 0, 1 and 3 in three separate cells would specify a section 

at either end and at a third-point of a selected line that was selected and assigned this 

geometric line attribute. Note that a section does not necessarily have to be defined to start at 

a distance of 0, so entering 0.5, 1.5, and 3.5, in three separate cells would produce the same 

result. This latter example would be of particular use in creating preliminary models for 

eventual staged construction uses. 
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Single line beam assigned a single multiple varying section line attribute 

(for clarity beam line has been visualised at top of section) 

Along reference path 

For assignment of multiple varying sections to multiple lines a reference path method is used. 

For this option, values are entered which define the distances at which a defined section is to 

be positioned along a set of selected lines with reference to a pre-defined reference path. Note 

that a section does not necessarily have to be defined to start at a distance of 0. A path can be 

specified to start at a particular distance.  

 

  

Multiple line beams assigned a single multiple varying section line attribute with reference to a path 

(for clarity beam line has been visualised at top of section) 
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Line mesh density 

Note that when modelling varying cross sections with constant section beam elements care 

should be taken to ensure that sufficient elements have been assigned. Greater than 8 

elements should be used for small variations in cross section along the length of the geometry 

to which the section has been assigned, and considerably more elements should be used for 

larger variations. 

Using specified distances from a start of a path 

Specified distances from a start of a path are used when it is desired to define a whole series 

of similar sections for either a complete structure or for a particular length of a structure and 

assign them all to a series of lines on a model with reference to a path. This most powerful of 

methods can produce models very quickly. 

As an example, if a model is defined local to an origin of 0,0,0, the reference path origin can 

be defined to start at, say, 100, and then by entering distances of 106, 112 and 127 with 

reference to a path assignment, sections would be positioned at those distances along the lines 

selected. 

 

  

Multiple line beams assigned a single multiple varying section line attribute with reference to a path with starting 

distance specified 

(for clarity beam line has been visualised at top of section) 

When defined section distances do not map exactly to 

lines on a model 

In defining distances at which sections will apply and then assigning geometric line attributes 

containing those sections to lines on a model (with reference to a path) there may be 

occasions where the set of defined sections are too short for the assigned line (or lines) or too 

long. 
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 If a set of defined sections are too short for the assigned line (or lines) the geometric 

line attribute will stay assigned to all line (or lines) selected but no visualisation 

(fleshing) will take place on any line in a set of lines that does not have a complete 

line attribute assigned. Any attempt to solve a model containing such assignments will 

also produce tabulation errors. 

  If a set of defined sections are too long for the assigned line (or lines) fleshing of the 

section shape will take place but only for the length of line (or lines) that was selected 

and no tabulation errors will occur as a result when solving the model. 

Modelling examples 

Use of the multiple varying section facility enables simple prototype and assessment models 

of bridges formed of tapered box sections to be created in a very straightforward manner. 

When combined with the reference path facility more detailed modelling can be done. 

 

  

Varying section line attributes assigned to single lines on a model 

Use of the multiple varying section with the reference path facility enables detailed models of 

bridges formed of tapered box sections to be created in a very straightforward manner. If 

necessary, one geometric multiple varying section line attribute can be defined for a series of 

multiple varying sections at specified distances that define the complete end-to-end run of 

cross-sections for a bridge. Subsequent assignment of solid or diaphragm sections at supports 

or mid span can be made to override any previously assigned 'temporary' assignments of 

voided sections that may have been previously made. An example of this follows. 
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Varying section line attributes (shown selected) assigned to multiple lines on a model with reference to a path 

Material Properties 

Every part of a finite element model must be assigned a material property attribute. Material 

attributes are defined from the Attributes> Materials menu item and then assigned to the 

required geometry feature (or mesh object in a mesh-only model). Note that not all elements 

accept all material property types. Refer to the Element Reference Manual for full details of 

valid element/material combinations. 

Linear and Nonlinear Material Properties 

 Isotropic/Orthotropic Defines linear elastic or nonlinear material properties with 

options for plasticity, hardening, creep, damage (continuum or composite, viscosity 

and two-phase materials. 

 Anisotropic Different material properties are specified in arbitrary (non-orthotropic) 

directions by direct specification of the modulus matrix.  

 Rigidities Allows direct specification of the material rigidity matrix. In-plane and 

bending rigidities are defined from prior explicit integration through the element 

thickness. 

 Thermal Applicable to thermal (field) elements only. Whenever thermal elements 

have been used in a model thermal material properties should be defined and assigned 

to the relevant parts of the model. 

 Joint Linear and nonlinear joint material models for contact and impact analyses 

using joint elements. 
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Specialised Material Properties 

 Rubber Defines materials with hyper-elastic or rubber-like mechanical behaviour. 

 Crushing A volumetric crushing model such as would be used for crushable foam-

filled composite structures. 

 Generic PolymerDefines a material model consisting of a number of parallel 

Maxwell units, an Eyring dashpot and a non-linear spring which can incorporate 

damage to represent the behaviour of polymer like materials..  

 CEB-FIP (1990) Concrete Shrinkage and Creep Defines a material to predict the 

mean behaviour of a concrete section due to creep effects 

 Elasto Plastic Interface Defines a material to represent the friction-contact 

relationship within planes of weakness between two discrete bodies 

 Delaminationmodels for use with the composite delamination interface elements.  

 Mass material models for specifying mass in structure using non-structural mass 

elements. 

 Nonlinear User A user defined constitutive model defining the stress from strain.   

 Resultant User A user defined constitutive model defining the stress resultants from 

strain. 

Editing of Material Properties  

Editing of pre-defined material data (such as that provided in the material library) allows 

users to view both the original material definition input data, as well as modify the values 

used. Editing of user-defined material properties only permits viewing and editing of the 

values used. 

Material properties added to the Attributes Treeview have context menu entries named Edit 

Definition and Edit Attribute.   

 Selecting the Edit Definition... menu entry or double clicking the attribute displays 

the original definition dialog with all the original input data intact.  

 Selecting the Edit Attribute...menu entry displays values that can be modified. For 

materials added from the material library, these values may be changed but this breaks 

the link to the original definition dialog and a warning message will be displayed. 

Notes 

 Material property attributes can be formed into a composite lay-up using the 

composite attribute facility. 

 Once assigned to geometry, material directions can be visualised using the Attributes 

layer in the  Treeview 

 Rubber, crushing, and plastic material attributes cannot be combined. 
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Material Library 

The more commonly used structural material properties are defined in the material library 

which is located under the Attributes> Material> Material Library menu item. 

The units will default to those chosen on model startup but may be changed if desired. Pick 

the material required from the drop down list and click OK or Apply to add the material 

properties to the  Treeview. The material properties may then be assigned to the model in 

the usual way. 

Composite Library 

The more commonly used structural composite material properties are defined in the 

composite library which is located under the Attributes> Material> Composite Library 

menu item. 

The units will default to those chosen on model startup but may be changed if desired. Pick 

the composite material required from the drop down list and click OK or Apply to add the 

properties to the  Treeview. The composite material properties may then be used to define 

a composite stack or be assigned to the model in the usual way. 

Isotropic/Orthotropic Material 

Isotropic and orthotropic material attributes can be used to specify the following material 

properties. 

 Elastic is used to specify linear elastic material properties including Young‟s 

modulus, Poisson‟s ratio, mass density. Orthotropic material orientation is specified as 

global, relative to a local coordinate system or relative to the feature local axis system. 

Optional thermal expansion and dynamic constants can be specified. Note that not all 

elements accept all the orthotropic models. Refer to the Element Reference Manual for 

full details of valid element/material combinations. Orthotropic models are Plane 

stress, Plane strain, Thick, Axisymmetric, Solid. 

 Thermal is used to specify properties for general thermal and heat of hydration 

analysis. For general thermal analysis phase change state, thermal conductivity, 

specific heat coefficient, and enthalpy values can be set. For concrete heat of 

hydration analysis, where internal heat is generated by the chemical reaction between 

cement and water as concrete hardens, additional thermal options such as exotherm 

type, cement type and timescale units can be specified. 

 Plastic Used to model ductile yielding of nonlinear elasto-plastic materials such as 

metals, concrete, soils/rocks/sand. 

 Hardening Used to model a nonlinear hardening curve data. Hardening is defined as 

part of the plastic properties. Isotropic, Kinematic and Granular sub-types are 

available. Isotropic hardening can be input in three ways. 
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 Creep Used to model the inelastic behaviour that occurs when the relationship 

between stress and strain is time dependent. 

 Damage Used to model the initiation and growth of cavities and micro-cracks. 

 Shrinkage Used to define the shrinkage properties of a material as a piecewise linear 

curve.  

 Viscosity Used to model viscoelastic behaviour. Coupling of the viscoelastic with 

nonlinear elasto-plastic materials enables hysteresis effects to be modelled. 

 Two-phase Required when performing an analysis in which two-phase elements 
are used to define the drained and undrained state for soil. 

Plastic Material Models - Isotropic 

The following are Isotropic models available from the Attributes> Material> Isotropic 

menu item by choosing the Plastic check box on the material attribute dialog. 

 Stress Potential(von Mises) Nonlinear material properties applicable to a general 

multi-axial stress state requiring the specification of yield stresses in each direction of 

the stress space. Incorporates hardening, yield stress and heat fraction. The modified 

von Mises model allows pressure dependent plasticity to be defined. 

 Optimised von Mises(Model 75) Represents ductile behaviour of materials which 

exhibit little volumetric strain (for example, metals). Especially for explicit dynamics. 

 Tresca (Model 61) Represents ductile behaviour of materials which exhibit little 

volumetric strain (for example, metals). Incorporates isotropic hardening. 

 Mohr-Coulomb (Model 65) The non- associated Mohr Coulomb model represents 

dilatant frictional materials which exhibit increasing shear strength with increasing 

confining stress (for example, granular materials such as rock and soils). The model 

incorporates isotropic hardening and dilatancy. 

 Drucker-Prager (Model 64) Represents ductile behaviour of materials which exhibit 

volumetric plastic strain (for example, granular materials such as concrete, rock and 

soils). Incorporates isotropic hardening. 

 Concrete (Model 94) A two and three-dimensional concrete material model that 

accounts for non-linear behaviour in both tension and compression. It is able to model 

both cracking and crushing behaviour. 

 Stress Resultant (Model 29) May be used for certain beams and shells. The model 

is formulated directly with the beam or shell stress resultants plus geometric 

properties, therefore it is computationally cheaper. 

Plastic Material Models - Orthotropic 

 Stress Potential (Hill and Hoffman models) These models are available from the 

Attributes> Material> Orthotropic menu item by choosing the Plastic check box on 

the material attribute dialog. 
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The stress potential model defines nonlinear material properties applicable to a general multi-

axial stress state requiring the specification of yield stresses in each direction of the stress 

space. Incorporates hardening, yield stress and Heat fraction. Hoffman is a pressure 

dependent material model allowing for different properties in tension and compression. 

Rigidity 

The linear rigidity model is used to define the in-plane and bending rigidities from prior 

explicit integration through the element thickness. 

Notes 

 Angle of orthotropy is relative to the reference axis (degrees). 

 The element reference axes may be local or global (see Local Axes in the Element 

Reference Manual for the proposed element type). If the angle of orthotropy is set to 

zero, the anisotropy coincides with the reference axes. 

See the Solver Reference Manual for further details. 

Thermal Material  

Thermal material properties are used to define the thermal behaviour of a material when using 

Thermal (Field) elements. The thermal properties describe the way in which heat flows. Heat 

may be transferred through conduction, convection or radiation. For linear steady state heat 

transfer problems only the conductivity needs to be specified.  

For materials in which the conductivity is constant in all directions isotropic material input 

should be used. When the conductivity varies in different directions orthotropic material input 

should be used. The direction of orthotropy is defined relative to any local coordinate 

systems. 

For transient thermal analysis the specific heat capacity is also required. It should be noted 

that within LUSAS a specific heat coefficient is used. The specific heat coefficient is 

computed by multiplying the specific heat capacity by the density. 

If phase change is to be modelled the enthalpy must be specified. Two phase changes models 

are available . When carrying out a phase change it is recommended that lumped specific heat 

(OPTION 105) is used. This is specified in the Model Properties> Solution> Element 

Options dialog by choosing the lumped mass option.  

For heat of hydration analysis, where internal heat is generated by the chemical reaction 

between cement and water as concrete hardens, additional thermal options such as exotherm 

type, cement type and timescale units can be set.  

LUSAS Solver can model temperature dependent properties but this needs to be defined in 

the Solver datafile. See the Solver Reference Manual for further details. 
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Stress Potential (von-Mises, Hill, Hoffman) 

The use of nonlinear material properties applicable to a general multi-axial stress state 

requires the specification of yield stresses in each direction of the stress space when defining 

the yield surface (see the LUSAS Theory Manual).  

Notes 

 The yield surface must be defined in full, irrespective of the type of analysis 

undertaken. This means that none of the stresses defining the yield surface can be set 

to zero. For example, in a plane stress analysis, the out of plane direct stress, zz, 

must be given a value which physically represents the model to be analysed. 

 The stresses defining the yield surface in both tension and compression for the 

Hoffman potential must be positive. 

Material Properties 

 Yield stress The level of stress at which a material is said to start unrecoverable or 

plastic behaviour. 

 Heat fraction The fraction of plastic work that is converted into heat energy. Only 

applicable to temperature dependent materials and coupled analyses where the heat 

produced due to the rate of generation of plastic work is of interest. The value should 

be between 0 and 1. 

Hardening Properties 

There are three methods for defining nonlinear hardening. Hardening curves can be defined in 

terms of either the hardening gradient, the plastic strain or the total strain as follows: 

 Hardening gradient vs. Effective plastic strain Requires specification of gradient 

and limiting strain values for successive straight line approximations to the stress vs. 

effective plastic strain curve.  

In this case hardening gradient data will be input as (C1, ep1), (C2, ep2) for each 

straight line segment. LUSAS extrapolates the curve past the last specified point. 
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 Uniaxial yield stress vs. Effective plastic strain Requires input of coordinates at the 

ends of straight line approximations to the uniaxial yield stress vs. effective plastic 

strain curve.  

For the curve shown here the plastic properties will contain the yield stress (sy) and 

the hardening data will be input as (s1, ep1), (s2, ep2), etc. LUSAS extrapolates the 

curve past the last specified point. 

 

 Uniaxial yield stress vs. Total Strain Requires input of coordinates at the ends of 

straight line approximations to the stress strain curve.  

Linear properties specify the slope of the stress strain curve up to yield in terms of a 

Young's modulus. Plastic properties specify the yield stress (sy) and the hardening 

data is input as a series of coordinates, for example (s1, e1), (s2, e2), etc. LUSAS 

extrapolates the curve past the last specified point. 

 

Optimised von Mises (Model 75) 

This model represents ductile behaviour of materials that exhibit little volumetric strain (for 

example, metals). It is especially suitable for explicit dynamics. 

Material Parameters 

 Yield stress The level of stress at which a material is said to start unrecoverable or 

plastic behaviour. 

 Heat fraction The fraction of plastic work that is converted into heat energy. Only 

applicable to temperature dependent materials and coupled analyses where the heat 
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produced due to the rate of generation of plastic work is of interest. The value should 

be between 0 and 1. 

Hardening (von Mises) 

 Kinematic hardening Plasticity hardening formulation associated with translation, as 

opposed to expansion, of the yield surface. 

In the optimised implicit model the direction of plastic flow is evaluated from the stress return 

path. The implicit method allows the proper definition of a tangent stiffness matrix which 

maintains the quadratic convergence of the Newton-Raphson iteration scheme otherwise lost 

with the explicit method. This allows larger load steps to be taken with faster convergence. 

For most applications, the implicit method should be preferred to the explicit method. 

The model incorporates linear isotropic and kinematic hardening. 

 

Nonlinear Hardening Curve for the von Mises Yield Model (Model 75) 

Tresca (Model 61) 

Material Parameters 

 Yield stress The level of stress at which a material is said to start unrecoverable or 

plastic behaviour. 

 Heat fraction The fraction of plastic work that is converted into heat energy. Only 

applicable to temperature dependent materials and coupled analyses where the heat 

produced due to the rate of generation of plastic work is of interest. The value should 

be between 0 and 1. 

 Slope of Yield Stress The slope of the uniaxial yield stress against equivalent plastic 

strain. 

 Plastic strain The limit of equivalent plastic strain up to which the hardening curve is 

valid. 
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 Hardening Curve Definition for the Tresca Yield Model 

Non Associated Mohr-Coulomb (Model 65) 

The non-associated Mohr-Coulomb elasto-plastic model may be used to represent dilatant 

frictional materials that exhibit increasing shear strength with increasing confining stress (for 

example, granular soils or rocks). The model incorporates isotropic hardening and dilatancy. 

Material Properties 

 Initial Cohesion defining the degree of granular bond and a measure of the shear 

strength. 

 Friction Angle defining angle of shearing resistance 

 Dilation Angle defining magnitude of plastic volume strains. 

 

 Cohesion Definition for the Non-Associated Mohr-Coulomb Model (Model 65) 
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 Friction Angle Definition for the Non-Associated Mohr-Coulomb Model (Model 65) 

Drucker-Prager (Model 64) 

The Drucker-Prager elasto-plastic model (see figures below) may be used to represent the 

ductile behaviour of materials which exhibit volumetric plastic strain (for example, granular 

materials such as concrete, rock and soils). The model incorporates isotropic hardening. 

Material Properties 

 Initial Cohesion A material property of granular materials, such as soils or rocks, 

describing the degree of granular bond and a measure of the shear strength. Setting the 

initial cohesion to zero is not recommended as this could cause numerical instability 

under certain loading conditions. 

 Initial Friction angle A material property of granular materials, such as cohesive 

soils and rocks. 

 Heat fraction The fraction of plastic work that is converted into heat energy. Only 

applicable to temperature dependent materials and coupled analyses where the heat 

produced due to the rate of generation of plastic work is of interest. The value should 

be between 0 and 1. 

 Slope of Yield Stress The slope of the uniaxial yield stress against equivalent plastic 

strain. 

 Plastic strain The limit of equivalent plastic strain up to which the hardening curve is 

valid. 
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 Cohesion Definition for the Drucker-Prager Yield Model (Model 64) 

  

 
 Friction Angle Definition for the Drucker-Prager Yield Model (Model 64) 

Multi Crack Concrete (Model 94) 

The multi-crack concrete model is a plastic-damage-contact model in which damage planes 

form according to a principal stress criterion and then develop as embedded rough contact 

planes. The basic softening curve used in the model may be controlled via a fixed softening 

curve or a fracture-energy controlled softening curve that depends on the element size. The 

former, a distributed fracture model, is applicable to reinforced concrete applications, while 

the latter localised fracture model is applicable to un-reinforced cases. 

Material Properties 

 Uniaxial compressive strength (fc) e.g. 40 N/mm
2
. 

 Uniaxial tensile strength (ft) e.g. 3 N/mm
2
. 

 Strain at peak uniaxial compression ( c) e.g. 0.0022. 

 Strain at effective end of softening curve for distributed fracture ( o) e.g. 0.035 or 0 if 

Gf>0. 

 Fracture energy per unit area (Gf) e.g. 0.1 or 0 if e0>0. 

 Biaxial to uniaxial peak principal stress ratio ( r) e.g. 1.15. 
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 Initial relative position of yield surface (Zo) e.g. 0.6. 

 Dilatancy factor giving plastic potential slope relative to that of yield surface  e.g. 
-0.1 

 Constant in interlock state function (mg) e.g. 0.425 

 Contact multiplier on o  for 1st opening stage (mhi) e.g. 0.5. 

 Final contact multiplier on o (mful) e.g. 5. 

 Shear intercept to tensile strength ratio for local damage surface (r ) e.g. 1.25. 

 Slope of friction asymptote for local damage surface ( ) e.g. 1. 

 Angular limit between crack planes (radians) e.g.1. 

Explanations for some of these suggested values are stated in the notes that follow. 

Notes 

 The model can be used with 2D and 3D continuum elements, 2D and 3D explicit 

dynamics elements, solid composite elements and semiloof or thick shell elements. 

 If no data for the strain at peak compressive stress is available it can be estimated see 

Solver Reference Manual for details. As a guide, a reasonable value for most 

concretes is 0.0022. 

 It is important that the initial Young‟s modulus, E, is consistent with the strain at peak 

compressive stress, ec. A reasonable check is to ensure that  E > 1.2 fc/ c 

 For concrete that contains reinforcement, distributed fracture will be the dominant 

fracture state. In this case a value for the strain at the end of the tensile softening 

curve, o, should be entered and Gf set to zero. If no data is available then a value for 

o of 0.0035 is reasonable to use for most concretes. 

 For unreinforced concrete the strains will tend to localise in crack zones, leading to 

localised fracture. The value for o must be set to 0.0 and the fracture energy per unit 

area, Gf, given a positive value. Gf varies with aggregate size but not so much with 

concrete strength. Typical values for various maximum coarse aggregate sizes are:  

16 mm aggregate: Gf = 0.1 N/mm;  

20 mm aggregate: Gf = 0.13 N/mm;  

32 mm aggregate: Gf = 0.16 N/mm;  
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Damage Evolution Function (Softening Curve) 

 If the effective end of the softening curve parameter, 0 , is set to zero, it will be 

calculated from e0 ~ 5Gf / Wc ft where Wc is a characteristic length for the element; 

if a finite value is given for e0 , Gf will be ignored. 

 The initial position of the yield surface is governed by the value of Z0. For most 

situations in which the degree of triaxial confinement is relatively low, a value of 

between 0.5 and 0.6 is considered appropriate for Z0 however, for higher 

confinements a lower value of 0.25 is better. 

 The parameter  is used to control the degree of dilatancy. Associated plastic flow is 

achieved if =1, but it has been found that  values in the range -0.1 to –0.3 were 

required to match experimental results. Generally  is set to –0.1, but for high degrees 

of triaxial confinement –0.3 provides a better match to experimental data. 

 The constant mg can be obtained from experimental data from tests in which shear is 

applied to an open crack. The default value for mg is taken as 0.425 but it is 

considered that a reasonable range for mg for normal strength concrete is between 0.3 

and 0.6. However, it was found that a low value of 0.3 could lead to second cracks 

forming at shallow angles to the first, due to the development of relatively large shear 

forces. 

 It is assumed that there is a crack opening strain beyond which no further contact can 

take place in shear, eful, where eful is a multiple of 0, i.e. eful=mful 0. Trials suggest 

that when concrete contains relatively large coarse aggregate, i.e. 20 to 30mm, a value 

of mful in the range 10-20 is appropriate, whereas for concrete with relatively small 

coarse aggregate, i.e. 5 to 8mm, a lower value is appropriate, in the range 3 to 5. This 

variation is necessary because the relative displacement at the end of a tension-

softening curve (related via the characteristic dimension to e0) is not in direct 

proportion to the coarse aggregate size, whereas the clearance displacement is roughly 

in proportion to the coarse aggregate size. Thus eful is not in a fixed ratio to 0. 
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 A plane of degradation (POD) is formed when the principal stress reaches the fracture 

stress (ft); the POD is formed normal to the major principal axis. Thereafter, it is 

assumed that damage on the plane can occur with both shear and normal strains. 

 
POD Local and Global Coordinate Systems 

 
Local Damage Surface 

The constants r  and   are the strain equivalents of the material input parameters r  

and . The relative shear stress intercept to tensile strength ratio r = c / ft  where c is 

the shear stress intercept. 

 Fine integration and the non-symmetric solver are always set by default with this 

material model. 

 It is recommended that the following LUSAS options are used with this model:  

252 Suppress pivot warnings. 

62 Allow negative pivots. 

See the Solver Reference Manual and Theory Manual for further details. 
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Stress Resultant (Model 29) 

The model is formulated directly with the beam or shell stress resultants plus geometric 

properties, therefore it is computationally cheaper. Consult the Element Reference Manual the 

check which elements are valid for this material model.  

Material Parameters 

 Yield stress The level of stress at which a material is said to start unrecoverable or 

plastic behaviour. 

 Section shape Match the section type to the element being used. 

See the Solver Reference Manual for further details. 

Creep 

Creep is the inelastic behaviour that occurs when the relationship between stress and strain is 

time dependent. The creep response is usually a function of the stress, strain, time and 

temperature history. Unlike time independent plasticity where a limited set of yield criteria 

may be applied to many materials, the creep response differs greatly for different materials.  

Creep Properties 

Power, exponential and eight parameter uniaxial creep laws are available and a time 

hardening form is available for each. The power creep law is also available in a strain 

hardening form. Fully 3D creep strains are computed using the differential of the von Mises 

or Hill stress potential. A user-definable creep interface is also available which allows a 

programmable uniaxial creep law.  

Stress Potential 

The definition of creep properties requires that the shape of the yield surface is defined. The 

stresses defining the yield surface are specified using the Stress Potential material model.  

If a Stress Potential model is used in the Plastic definition then this will override the Creep 

stress potential and will apply to both the plastic properties and the creep properties. The 

Creep stress potential is only required when defining linear materials. If a stress potential type 

is not specified then von Mises is set as default. 

None of the stresses defining the stress potential may be set to zero. For example, in a plane 

stress analysis, the out of plane direct stress must be given a value which physically 

represents the model to be analysed. 

User Supplied Creep Properties 

The user creep facility allows user supplied creep laws to be used. This facility provides 

completely general access to the LUSAS Solver property data input and provides controlled 

access to the pre- and post-solution constitutive processing and nonlinear state variable 

output.  
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Notes 

 The user-supplied routine must return the increment in creep strain. Further, if implicit 

integration is to be used then the variation of the creep strain increment with respect to 

the equivalent stress, and also with respect to the creep strain increment, must be 

defined. 

 If the function involves time dependent state variables they must be integrated in the 

user-supplied routine. 

 If both plasticity and creep are defined for a material, the creep strains will be 

processed during the plastic strain update. Stresses in the user routine may therefore 

exceed the yield stress. 

 User-supplied creep laws may be used as part of a composite element material 

assembly. 

See the Solver Reference Manual and the Theory Manual for further details. 

Damage 

Damage is assumed to occur in a material by the initiation and growth of cavities and micro-

cracks. The damage models allow parameters to be defined which control the initiation of 

damage and post-damage behaviour. Damage models are available for continuum and 

composite elements. 

Continuum Damage Models 

In LUSAS a scalar damage variable is used in the degradation of the elastic modulus matrix. 

This means that the effect of damage is considered to be non-directional or isotropic. Two 

LUSAS damage models are available (Simo and Oliver) together with a facility for a user-

supplied model. 

A damage analysis can be carried out using any of the elastic material models and the 

following nonlinear models: 

 von Mises 

 Hill 

 Hoffman 

Note. Creep material properties may be included in a damage analysis. See the Solver 

Reference Manual for further details. 

Composite Matrix Failure Model 

The composite matrix failure model simulates matrix failure using the Hashin damage 

criteria. The model can only be used with composite solid elements. It is defined under the 

Damage tab on the Material Orthotropic attribute dialog.  
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Material Properties 

 Ply tensile strength in fibre direction 

 Ply compressive strength in fibre direction 

 Ply shear strength measured from a cross ply laminate 

 Ply transverse tensile strength (normal to fibre direction) 

 Ply transverse compressive strength 

See the Solver Reference Manual for further details. 

Viscoelastic 

Viscoelasticity can be coupled with the linear elastic and non-linear plasticity, (isotropic or 

orthotropic), creep and damage models available in LUSAS. The model restricts the 

viscoelastic effects to the deviatoric component of the material response. This enables the 

viscoelastic material behaviour to be represented by a shear modulus Gv and a decay constant 

. Viscoelasticity imposed in this way acts like a spring-damper in parallel with the elastic-

plastic, damage and creep response. Coupling of the viscoelastic and the existing nonlinear 

material behaviour enables hysteresis effects to be modelled. 

User Supplied Visco Elastic Properties 

The user supplied viscoelastic properties facility enables routines for implementing a user 

supplied viscoelastic model to be invoked. This facility provides completely general access to 

the LUSAS Solver property data input via this data section and provides controlled access to 

the pre- and post-solution constitutive processing and nonlinear state variable output via these 

user supplied routines.  

Notes 

 When viscoelastic properties are coupled with a nonlinear material model it is 

assumed that the resulting viscoelastic stresses play no part in causing the material to 

yield and no part in any damage or creep calculations. Consequently the viscoelastic 

stresses are stored separately and deducted from the total stress vector at each iteration 

prior to any plasticity, creep or damage computations. Note that this applies to both 

implicit and explicit integration of the creep equations. 

 Nonlinear Control must always be specified when viscoelastic properties are assigned. 

In addition Dynamic or Viscous Control must also be specified to provide a time step 

increment for use in the viscoelastic constitutive equations. If no time control is used 

the viscoelastic properties will be ignored. 

See Solver Reference Manual for further details. 
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Shrinkage Properties  

The cure of concrete and thermoset resins is accompanied by isotropic shrinkage which in the 

case of concrete depends on time, temperature and other environmental factors whilst for 

thermoset resins the shrinkage is normally described with respect to the degree of cure.  

The shrinkage implementation in LUSAS allows an irreversible reduction in volume with 

time to be modelled. The shrinkage of concrete is accommodated using the equations defined 

in the design code CEB-FIP90 and also using a more general routine in which shrinkage is 

defined using a piecewise linear curve. In the general case, shrinkage can be defined as a 

function of time or degree of cure. A user facility is also available if required.  

See the Solver Reference Manual for further details. 

Two-Phase 

Two-phase material properties are required when performing an analysis in which two-phase 

elements are used to define a drained and undrained state for soil. 

Notes 

 Usually, the value of Bulk modulus of solid phase is quite large compared to Bulk 

modulus of fluid phase and not readily available to the user. If Bulk modulus of solid 

phase is input as 0, LUSAS assumes an incompressible solid phase. Bulk modulus of 

fluid phase is more obtainable, e.g. for water Bulk modulus of fluid phase = 2200 

MPa [N1]. 

 Two-phase material properties can only be assigned to two phase elements. 

 When performing a linear consolidation analysis transient control must be specified. 

 Two-phase material properties may be combined with any other material properties 

together with creep, damage and viscoelastic properties if required. 

See Solver Reference Manual for further details. 

Rubber  

Rubber materials maintain a linear relationship 

between stress and strain up to very large strains 

(typically 0.1 - 0.2). The behaviour after the 

proportional limit is exceeded depends on the 

type of rubber (see diagram below). Some kinds 

of soft rubber continue to stretch enormously 

without failure. The material eventually offers 

increasing resistance to the load, however, and 

the stress-strain curve turns markedly upward 

prior to failure. Rubber is, therefore, an 

exceptional material in that it remains elastic far beyond the proportional limit. 
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Rubber materials are also practically incompressible, that is, they retain their original volume 

under deformation. This is equivalent to specifying a Poisson's ratio approaching 0.5. 

The strain measure used in LUSAS to model rubber deformation is termed a stretch and is 

measured in general terms as: 

 = dnew/dold 

where: 

dnew is the current length of a fibre. 

dold is the original length of a fibre. 

  

Several representations of the mechanical behaviour for hyper-elastic or rubber-like materials 

can be used for practical applications. Within LUSAS, the usual way of defining hyper-

elasticity, i.e. to associate the hyper-elastic material to the existence of a strain energy 

function that represents this material, is employed. There are currently four rubber material 

models available: 

 Ogden 

 Mooney-Rivlin 

 Neo-Hookean 

 Hencky 

The rubber constants (used for Ogden, Mooney-Rivlin and Neo-Hookean) are obtained from 

experimental testing or may be estimated from a stress-strain curve for the material together 

with a subsequent curve fitting exercise. 

The Neo-Hookean and Mooney-Rivlin material models can be regarded as special cases of 

the more general Ogden material model. In LUSAS these models can be reformulated in 

terms of the Ogden model. 

The strain energy functions used in these models includes both the deviatoric and volumetric 

parts and are, therefore, suitable to analyse rubber materials where some degree of 

compressibility is allowed. To enforce strict incompressibility (where the volumetric ratio 

equals unity), the bulk modulus tends to infinity and the resulting strain energy function only 

represents the deviatoric portion. This is particularly useful when the material is applied in 

plane stress problems where full incompressibility is assumed. However, such an assumption 

cannot be used in plane strain or 3D analyses because numerical difficulties can occur if a 

very high bulk modulus is used. In these cases, a small compressibility is mandatory but this 

should not cause concern since only near incompressibility needs to be ensured for most of 

the rubber like materials. 

Using Rubber Material 

Rubber is applicable for use with the following element types currently: 

 2D Continuum QPM4M, QPN4M 
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 3D Continuum HX8M 

 2D Membrane BXM2 

Notes 

 For membrane and plane stress analyses, the bulk modulus is ignored because the 

formulation assumes full incompressibility. The bulk modulus has to be specified if 

any other 2D or 3D continuum element is used. 

 Ogden, Mooney-Rivlin and Neo-Hookean material models must be run with 

geometric nonlinearity using either the total Lagrangian formulation (for membrane 

elements) or the co-rotational formulation (for continuum elements). The Hencky 

material model is only available for continuum elements and must be run using the co-

rotational formulation. The large strain formulation is required in order to include the 

incompressibility constraints into the material definition. 

 Option 39 can be specified for smoothing of stresses. This is particularly useful when 

the rubber model is used to analyse highly compressed plane strain or 3D continuum 

problems where oscillatory stresses may result in a "patchwork quilt" stress pattern. 

This option averages the Gauss point stresses to obtain a mean value for the element. 

 When rubber materials are utilised, the value of det F or J (the volume ratio) is output 

at each Gauss point. The closeness of this value to 1.0 indicates the degree of 

incompressibility of the rubber model used. For totally incompressible materials 

J=1.0. However, this is difficult to obtain due to numerical problems when a very high 

bulk modulus is introduced for plane strain and 3D analyses. 

 Subsequent selection of state variables for displaying will include the variable PL1 

which corresponds to the volume ratio. 

 Rubber material models are not applicable for use with the axisymmetric solid 

element QAX4M since this element does not support the co-rotational geometric 

nonlinear formulation. The use of total Lagrangian would not be advised as an 

alternative. 

 There are no associated triangular, tetrahedral or pentahedral elements for use with the 

rubber material models. 

 The rubber material models are inherently nonlinear and, hence, must be used in 

conjunction with nonlinear control command. 

 The rubber material models may be used in conjunction with any of the other LUSAS 

material models. However, it is not possible to combine rubber with any other 

nonlinear material model within the same material attribute. 
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Volumetric Crushing (Model 81) 

Material behaviour can generally be described in terms of deviatoric and volumetric 

behaviour which combine to give the overall material response. The crushable foam material 

model accounts for both of these responses. The model defines the volumetric behaviour of 

the material by means of a piece-wise linear curve of pressure versus the logarithm of relative 

volume. An example of such a curve is shown in the diagram below, where relative volume is 

denoted by V/V0. 

 
  Pressure - Logarithm of Relative Volume Curve 

From this figure, it can also be seen that the material model permits two different unloading 

characteristics volumetrically. 

 Unloading may be in a nonlinear elastic manner in which loading and unloading take 

place along the same nonlinear curve. 

 Volumetric crushing may be included (by clicking in the volumetric crushing check 

box) in which case unloading takes place along a straight line defined by the 

unloading/tensile bulk modulus K which is, in general, different from the initial 

compressive bulk modulus defined by the initial slope of the curve. 

In both cases, however, there is a maximum (or cut-off) tensile stress, (cut-off pressure), that 

is employed to limit the amount of stress the material may sustain in tension. 

The deviatoric behaviour of the material is assumed to be elastic-perfectly plastic. The 

plasticity is governed by a yield criterion that is dependent upon the volumetric pressure 

(compared with the classical von Mises yield stress dependency on equivalent plastic strain) 

and is defined as: 

 

where p is the volumetric pressure,  is the deviatoric stress and a0, a1, a2 are pressure 

dependent yield stress constants. Note that, if a1 = a2 = 0 and a0 = (syld2)/3, then classical 

von Mises yield criterion is obtained. 
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 Yield Surface Representation For Different Pressure Dependent Yield Stress Values 

Notes 

 Bulk modulus used in tension and unloading (see 1st figure). The relationship 

between the elastic bulk (or volumetric) modulus, K, and tensile modulus, E, is given 

by:  

 Shear modulus The relationship between the elastic modulus values in shear, G, and 

tension, E, assuming small strain conditions, is given by:  

 Heat fraction coefficient Represents the fraction of plastic work which is converted 

to heat and takes a value between 0 and 1. 

 Cut-off pressure Should be negative (i.e. a tensile value). 

 Pressure dependent yield stresses (a0, a1, a2) (Should be positive). The yield 

surface defined is quadratic with respect to the pressure variable. Therefore it can take 

on different conical forms (see 2nd figure), either elliptic (a2<0), parabolic (a2=0) or 

hyperbolic (a2>0). The parabolic form is comparable to the modified von Mises 

material model while the elliptic form can be considered to be a simplification of 

critical state soil and clay material behaviour. 

 The volumetric crushing indicator effectively defines the unloading behaviour of the 

material. If there is no volumetric crushing, the same pressure-logarithm of relative 

volume curve is used in loading and unloading and if volumetric crushing takes place 

the alternative unloading/reloading curve is used (see 1st figure). 

 Log relative volume Natural logarithm (loge, not log10) of relative volume 

coordinate for ith point on the pressure-logarithm of relative volume curve (see 1st 

figure) 

 The pressure-logarithm of relative volume curve is defined in the compression 

regime hence logarithms of relative volume must all be zero or negative and the 

pressure coordinates must all be zero or positive. 
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Generic Polymer with Damage (Model 89) 

The Generic Polymer with Damage model appears under the Attributes> Material> 

Specialised menu item. The model accounts for strain rate behaviour and irrecoverable 

damage in the modelling of polymers and other materials. The model consists of a set of 

Maxwell dampers which are used to model visco-elasticity, an Eyring dashpot which is used 

to model viscoplasticity and a linear spring. These components are placed in series. The 

Properties of the Maxwell elements, Eyring dashpot and linear spring can be different in 

tension and compression.  

Material Properties 

 Eyring damper activation energy. 

 Eyring damper activation volume. 

 Mass density. 

 Linear Spring stiffness. 

 Bulk Modulus. 

 Maxwell element spring constant. 

 Maxwell element Newtonian dashpot viscous parameter. 

 Damage properties. 

See the Theory Manual for further details. 

Concrete Creep and Shrinkage CEB-FIP (Model 86) 

Concrete material properties to CEB-FIP Model Code 90 are defined from the Attributes> 

Material> Specialised menu item. This model uses a simplified linear approach to represent 

creep. This assumption assumes that the service stresses in the concrete will not be exceeded 

and hence may not predict the effects of unloading or load cycling accurately. 

Material Properties 

The following material parameters are required: 

 Young’s Modulus at 28 days 

 Poisson’s Ratio 

 Mass density 

 Coefficient of thermal expansion 

 Mean compressive strength at 28 days 

 Cement type 

 Relative humidity 

 Nominal size 
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Notes 

 The CEB-FIP Code states that the modulus of elasticity at 28 days may be estimated 

from  

 

 The cement type can be Slow Hardening , Normal or Rapid Hardening or Rapid 

Hardening High Strength. Normal or Rapid Hardening is the default option.  

 The Nominal Size is computed as 2A/u where A is the area of the cross section and u 

is the length of the perimeter of the cross section that is in contact with the 

atmosphere. Nominal Size should be compatible with the units chosen for the model 

as an automatic data conversion will be performed based on the units in use. 

 CEB-FIP Model Code 90 is only strictly applicable to beams, however, in LUSAS the 

creep equations have been extended to 2D and 3D stress states. It must be noted that it 

may be difficult to establish an appropriate value of "nominal size" for anything other 

than beam elements. 

 The CEB-FIP creep and shrinkage model must be run in a transient nonlinear analysis 

in which the time step and total response time are specified in days. An option exists 

in the advanced time step options to use an exponent to increase the time step as the 

analysis progresses. 

 The age of concrete at the time an element is introduced to the analysis may be 

defined using the Age attribute. 

See the Solver Reference Manual and the Theory Manual for further details. 

Elasto-Plastic Interface (Model 26, 27)  

An elasto-plastic model for representing the friction-contact relationship between two discrete 

bodies. The model is embedded in the plane membrane, plane strain and solid elements to 

reproduce the nonlinear response of a system containing planes of weakness using Mohr 

Coulomb type laws. 

See the Theory Manual for further details. 

Delamination Interface (Model 25) 

Delamination properties are assigned to interface elements to model delamination between 

elements. The model behaves linearly until the threshold strength is exceeded. Linear strain 

softening behaviour then occurs until the fracture energy is exceeded. Once the fracture 

energy is exceeded further straining occurs without resistance. 
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Fracture Modes 

A 2D model has two fracture modes, a 3D model has three. The fracture modes are: 

 Mode 1 Opening 

 Mode 2 Shearing 

 Mode 3 Tearing (Shear orthogonal to mode 2) 

Material Parameters 

 Fracture energy Measured values for each fracture mode depending on the material 

being used, i.e. carbon fibre, glass fibre. 

 Initiation Stress The tension threshold /interface strength is the stress at which 

delamination is initiated. This should be a good estimate of the actual delamination 

tensile strength but, for many problems, the precise value has little effect on the 

computed response. If convergence difficulties arise it may be necessary to reduce the 

threshold values to obtain a solution. 

 Relative displacement The maximum relative displacement is used to define the 

stiffness of the interface before failure. Provided it is sufficiently small to simulate an 

initially very stiff interface it will have little effect. 

 Coupled The model used for coupling the failure modes (Coupled, Uncoupled 

Reversible, Uncoupled Origin). 

See the Theory Manual for more details. 

Mass 

Mass material models are used in conjunction with non-structural mass elements to define 

mass in a structure. Mass Properties are input for element nodes in the element local 

translational (x, y or z) directions or relative to the local coordinate system assigned to the 

feature. 

See the Element Reference Manual for further information. 

Resultant User 

Used to specify user material parameters for the user defined nonlinear resultant model. 

See the Solver Reference Manual for further details. 

Nonlinear User 

Used to specify user material parameters for the user defined nonlinear material model. 

See the Solver Reference Manual for further details. 
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Joint Properties 

Joint material models are used in conjunction with joint elements to define the material 

properties for linear and nonlinear joint models. See Joint and Interface Elements for 

information about using joints. The following joint models are available: 

Linear Joint Models 

 Spring stiffness only corresponding to each local freedom. These local directions are 

defined for each joint element in the Element Reference Manual. 

 General Properties full joint properties of spring stiffness, mass, coefficient of linear 

expansion and damping factor. 

Nonlinear Joint Models 

 Elasto-Plastic uniform tension and compression with isotropic hardening. Equal 

tension and compression yield conditions are assumed. 

 Elasto-Plastic General with isotropic hardening. Unequal tension and compression 

yield conditions are assumed. 

 Smooth Contact with an initial gap. See notes below. 

 Frictional Contact with an initial gap. See notes below. 

 Nonlinear user-defined joint model. 

Seismic Isolator Joint Models 

 Viscous dampers - Kelvin and Four Parameter Solid modules available. 

 Lead Rubber Bearings with plastic yield and biaxial hysteric behaviour. 

 Friction Pendulum System with pressure and velocity dependent friction coefficient 

and biaxial hysteretic behaviour. 
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Elasto-Plastic Joint Models 
 
  

Smooth Contact 

 

  

 

Frictional Contact 1 
  

Frictional Contact 2 

 

  

 



  Chapter 6 

    

189 

Frictional Contact 3 
  

Viscoelastic Damper Joint Model 

 

  

 

Lead Rubber Bearing Joint   Friction Pendulum System Joint 

 

  

 

Notes 

 For a full description of the joint material input parameters required for these joint 

models please refer to the Solver Reference Manual. 

 When defining joint properties for single joint elements the total stiffness or yield 

force should be defined. When using interface joint meshing the stiffness and yield 

force defined in the joint properties should be defined per unit length when using 

interface joints assigned to lines or per unit area when using interface joints assigned 

to surfaces. 

 Initial gaps are measured in units of length for translational freedoms and in radians 

for rotational freedoms.  
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 Smooth Contact. If an initial gap is used in a spring, then the positive local axis for 

this spring must go from node 1 to 2. If nodes 1 and 2 are coincident the relative 

displacement of the nodes in a local direction (d2­ d1) must be negative to close an 

initial gap in that direction. 

 Frictional Contact If an initial gap is used in a spring, then the positive local x axis 

for this spring must go from node 1 to 2. If nodes 1 and 2 are coincident the relative 

displacement of the nodes in the local x direction ( x2­ x1) must be negative to 

close an initial gap. 

 Both Smooth Contact and Frictional Contact joints can be used for lift-off or hook 

contact by using appropriate stiffnesses, gap and yield force. 

Support Conditions 

General 

Support conditions describe the way in which the model is restrained. A support attribute 

contains information about the restraints to be applied to each degree of freedom. There are 

three valid support conditions: 

 Free (F) the degree of freedom is completely free to move. This is the default. 

 Fixed (R) the degree of freedom is completely restrained from movement. 

 Spring Stiffness (S) the degree of freedom is subjected to a specified spring stiffness. 

Spring stiffness values can be applied uniformly to All nodes meshed on the assigned 

feature or their values may vary over a feature by applying a variation. Alternatively, 

per unit length or per unit area values can be applied. 

The degrees of freedom which may be restrained for any analysis depend on the chosen 

element type. Those applicable for each element are defined in the Element Reference 

Manual. 

 For structural problems: Translation in X, Y, Z and rotation about X, Y, Z refer to 

freedoms along and about the global axes unless a local coordinate is assigned in 

which cases the axis directions refer to local directions x, y, z. 

 A hinge (loof) rotation is a local freedom which refers to rotation about the side of an 

element. Pore pressure is a special freedom type used in two phase elements. 

 For thermal (field) problems there is only one freedom type, temperature (or the field 

variable). 

Using Support Conditions 

Support attributes are defined from the Attributes menu and  assigned in the same way as 

other attributes, by dragging a defined attribute from the  Treeview onto previously 
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selected geometric features (or to mesh objects in a mesh-only model). For linear static 

analyses all support conditions are assigned to the first loadcase. For a nonlinear or transient 

analysis, in which the support conditions change, the loadcase is specified when carrying out 

the assignment.  

 

Notes 

 On the common feature where support assignments meet, the support condition 

applied is additive.  

 Support assignments on lower order features override those on higher order features. 

 Support conditions cannot be changed for different loadcases in a linear analysis. 

 Support conditions may only be reassigned on a new increment of a nonlinear 

problem or a new time step of a transient problem. All supports assignments from 

previous increments or time steps which are not reassigned will remain unchanged. 

 Ensure that nodes are not free to rotate when 

attached to beam elements with free ends. For 

example, node 1 in the diagram shown must be 

restrained against rotation as well as displacement 

otherwise the element will be free to rotate as a rigid body. 

 Support conditions may be omitted for eigenvalue analyses provided a shift is used in 

the eigenvalue control. 

 Assigning a local coordinate to a feature changes the freedom directions of the 

underlying element nodal freedoms and will hence also affect any global loads applied 

to that feature. 

Tip. Supports which act in tension, but not in compression, may be modelled using joints or 

interface meshes. 
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Visualising Support Conditions 

For a support condition to be visualised the model must have been meshed. Support 

conditions can be visualised in three ways: 

 Arrows Visualises restraints as straight arrows representing translational freedoms, 

and circular arrows for rotational freedoms. Spring supports are visualised as spring 

representations. Hinge freedoms are not visualised. 

 Symbols Places a symbol on each supported node. 

 Codes Writes a code next to each supported node representing the type of support 

assigned. The code uses F = Free, R = Restrained (Fixed), S = Spring. For example, a 

code RRSFFF represents a six degree of freedom node that is restrained in X and Y 

directions, supported with a spring in Z direction and free in all three rotational 

freedoms. 

Notes 

 For nonlinear and transient problems, by default, supports are visualised for the active 

loadcase by combining the assignment in the loadcase history. To view the supports 

assigned to the active loadcase only, select the Show only assignments in the active 

loadcase option on the support visualisation dialog accessed from the attributes layer 

properties. 

 Support visualisation may be drawn using the parent feature colour by selecting the 

Colour support by geometry option on the  support visualisation dialog accessed 

from the attributes layer properties. This is useful to identifying which feature type a 

support attribute is assigned to. 

 Support visualisation can be toggled on and off using the support visualisation button 

. 
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Example: Translational Fixed and Spring 
Supports 

This 3D structure is restrained from any lateral 
movement at the base of all legs. The same points 
are also sprung vertically to represent a non-rigid 
base support. 

 
  

   
Example: Translational Supports 

This 2D structure is restrained horizontally and 
vertically at the left edge with a single restraint in 
both in-plane translational directions. This rigidly 
fixes the body along the edge shown while allowing 
the rest of the model to move. 

 

 

Example: Symmetry 

Only the right half of this structure is modelled 
using shell elements but the full structure is 
represented by assuming symmetry at the centre-
line. Symmetry assumes the same behaviour for 
both sides of the model therefore a translational 
restraint is applied to stop movement across the 
symmetry boundary and a rotational restraint is 
applied to force zero rotation at the boundary. 

  
Example: Symmetry 

This quarter plate membrane model uses symmetry 
restraints to effectively model the whole plate. 
Supports are positioned in order to prevent any 
movement at lines of symmetry. 
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Loading Attributes 

Loading attributes describe the external influences to which the model is subjected. Structural 

and Thermal loading options are provided on separate menu options according to the user 

interface in use. A summary of the loading types is given here: 

 Structural Concentrated, body force, distributed, face, temperature, stress/strain, and 

beam loads. 

 Prescribed used to specify initial displacements, velocity or acceleration at a node. 

(Note that you can also specify prescribed temperatures). 

 Discrete loads are used to distribute a given loading pattern (such as for a type of 

vehicle) over full or partial areas of the model, independent of the model geometry. 

Point and Patch loads are discrete loads - also known as general loads. Compound 

discrete loads permit sets of point and patch (and compound loads) to be defined. 

 Thermal loads to describe the temperature or heat input to a thermal analysis. 

Structural, Prescribed and Thermal loads are feature based loads that are assigned to the 

model geometry and are effective over the whole of the feature to which they are assigned. 

Discrete loads are feature independent. Further control over how discrete loads are applied is 

available by using a Search area. 

Assigning Loading 

Loads are assigned in the same way as other attributes, by dragging a defined attribute from 

the  Treeview onto previously selected features (or to mesh objects in a mesh-only 

model). When a load is assigned, a loadcase and a factor may be specified. If a load factor is 

entered the loadcase name will include this load factor. If the load is to be assigned to a new 

loadcase the new loadcase name may be entered into the loadcase combo and the new 

loadcase may be set active if required using the checkbox provided. Additional options are 

available when applying discrete loads see Assigning Discrete Loads. 

Some loads act in global directions, others in local element directions. The defined loading 

value will be assigned as a constant value to all of the nodes/elements in the feature unless a 

variation is applied. Variations can be applied to all feature load types except for Beam 

Distributed loads that have a variation built into the definition.  

Tip. If the required loading directions of a global load do not lie in the global axes then a 

local coordinate may be assigned to the feature to transform the loads to local coordinate 

directions. 

Notes 

 Load visualisation can be toggled on and off using the  load visualisation button. 

 Load factors of assigned loads can be changed by selecting the Change load factor 

menu item accessed from the loading name context menu.   
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 In nonlinear and transient analysis feature based loads can be factored using load 

curves.  

 Consult the Element Reference Manual in order to check that the required loading is 

available for that particular element 

Structural Loads 

Structural loading is feature based and hence it is assigned to the model geometry (or to mesh 

objects in a mesh-only model). Variations in loading on a feature can be specified using a 

previously defined variation. For information on which load types can be applied to which 

element types, see the Element Reference Manual. 

Concentrated Load (CL) 

A Concentrated Load defines concentrated 

force and moment loads in global (or 

transformed) directions.  

A Concentrated Load is applied per node of 

the underlying feature onto which the load 

attribute is assigned. A Concentrated Load is 

therefore normally only used to assign a load 

to a point as the total applied load would 

otherwise be dependent on the mesh density 

of each feature assigned to. 

Concentrated loads are defined relative to 

the nodal coordinate system. If the required 

loading directions of a global load do not lie in the global axes then a local coordinate may 

be assigned to the feature to transform the loads to local coordinate directions. 

Concentrated loads can be applied in cylindrical coordinates for Fourier elements by setting 

the option on the Attributes tab of the Model Properties dialog. 

Body Force (CBF) 

A Body Force defines an acceleration or 

force per unit volume loading in global 

directions. A typical example of body force 

loading is self weight, which requires the 

specification of gravitational acceleration 

and mass density (in the material properties).  

By default, Body Forces define 

accelerations, but an option on the 

Attributes tab of the Model Properties 

dialog, can be set so that Body Forces define a force per unit volume.  
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Note that gravity loading can be defined either by directly specifying a constant body force 

load or by defining its existence as a property of a structural loadcase. 

Global Distributed Load (CL) 

Defines concentrated force or moment loads in global (or transformed nodal) axis directions. 

Concentrated force loads are applied to all nodes underlying the feature onto which the load 

attribute is assigned. Nodal freedoms can be transformed using local coordinate sets. The 

following sub-types are supported: 

 Total applies nodal load values calculated according to contributions from 

surrounding elements and to element nodal weighting values, e.g. loads are weighted 

with ratios 1:4:1 at nodes along the edge of a quadratic shell in such a way as to make 

the shell strain equally. 

 Line (per unit length) applies nodal loads using the specified values per unit length 

loads. Must be assigned to Lines. 

 Surface (per unit area) applies nodal loads using the specified values per unit area 

loads. Must be assigned to Surfaces. 

Face Load (FLD) 

Defines face traction values and normal 

loading applied in local element face 

directions. Face loads are applied to the 

edges of plane elements or the faces of solid 

elements. This type of loading is applicable 

to 2D and 3D continuum elements, and 

certain shell, membrane and thermal 

elements.  

In the example shown, a local y direction 

structural face load is assigned to the 

Surface boundary Lines. Note the direction 

of the axes of the local element faces.  

Where a loaded Line or Surface feature is common to two or more higher order features, it is 

possible to specify to which higher order feature elements the load is assigned.  

See the Element Reference Manual for details of element face directions. 

Local Distributed Load (UDL)  

Defines a load per unit length or area for line or surface elements in the local element 

directions. Typically, local distributed loading is applied to beam elements and shell faces. 

An example of a local distributed load is internal pressure loading. For beam elements, when 

the element type permits, uniformly Distributed Load will be written to the LUSAS data file 

as Beam Element Loading (ELDS). 
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Temperature Load (TEMP, TMPE) 

Nodal and Element temperatures define the LUSAS Solver TEMP and TMPE load types 

respectively. These loads apply temperature differences on a nodal and element basis. 

Temperature gradients in X, Y and Z directions may also be input. This load type can be used 

in conjunction with temperature dependent material properties to activate a different set of 

properties at a specified point in the analysis. The thermal expansion coefficient is normally 

set to zero in this case.  

Notes 

 Nodal temperatures apply to all elements connected to that node, except joints, in 

which temperature loading is invoked using Option 119. 

 Elemental temperature is only applied to the node of the element specified. 

 For step by step problems, the (initial) temperature values need only be specified on 

the first load step. 

 The Temperature load may be used to provide a temperature field for computing 

initial material properties in a nonlinear analysis. To initialise the temperature field in 

a nonlinear field analysis, the temperature loading must be applied using a manual 

loading increment. 
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Case Study. Temperature 

Gradient Through Slab Thickness 

Nodal and element temperature values accept 

gradient values for some element types. This 

gradient applies a differential thermal load 

across the top and bottom surfaces of a 

Surface element. The effect of this gradient is 

to cause bending in the structure. See the 

Element Reference Manual for temperature 

load input variations on an element basis. 

In this example (which assumes no slab 

eccentricity) a 0.5m thick concrete slab is at 20 degrees Celcius. The top surface is 

subjected to a temperature of 50 degrees Celsius and the bottom surface remains at 20 

degrees Celsius. 

 To model this enter the following on the structural temperature loading dialog: 

 The final slab mid-surface temperature of (50+20)/2 should be entered in the 

Final temperature field 

 The temperature gradient through the slab of dT/dZ should be entered as (50-

20)/0.5 in the Final Z temperature gradient field 

 The initial slab mid-surface temperature of 20 is entered in the Initial 

temperature field 

When the analysis is run, LUSAS will multiply the temperature gradient by the thermal 

coefficient of expansion specified in the material property attribute to calculate the 

thermal bending strain.  

This method assumes a linear temperature distribution through the depth of the slab. If a 

known nonlinear variation is required, solid elements must be used with a variation 

defining the nonlinear through-thickness behaviour. 

Stress and Strain (SSI, SSR) 

The input values that are required in order to define stress and strain loading for particular 

elements can be seen by selecting the either the element description or by entering the 

element name in the Stress and Strain loading dialog.  

 Initial defines an element initial stress/strain state in local directions. Initial stresses 

and strains are applied as the first loadcase and subsequently included into the 

incremental solution scheme for nonlinear problems. Initial stresses and strains are 

only applicable to numerically integrated elements. 

 Residual defines element residual stress levels in local directions. This can only be 

done for elements with a nonlinear capability. Residual stresses (unlike initial 
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stresses) are assumed to be in equilibrium with the undeformed geometry and are not 

treated as a loadcase as such. They are considered as a starting position for stress for a 

nonlinear analysis. Failure to ensure that the residual stresses are in equilibrium will 

result in an incorrect solution. There is no concept of residual strains and therefore 

when the residual button is chosen a reduced number of components are presented. 

Refer to the individual element descriptions in the Element Reference Manual for full details 

of the initial stress and strain, and residual stress components. 

LUSAS Modeller will automatically write an appropriate initial stress and strain, or residual 

stress type to the datafile when a solve is requested. See the Solver Manual for more detailed 

information regarding the tabulation of initial stresses and strains, and residual stresses in 

LUSAS datafiles. 

Internal Beam Loads (ELDS)  

The Internal Beam Point load is a point load applied to 

lines in the local or global direction. The distance may be 

defined as either parametric (0 to 1) or actual distance. 

The distance from the start of the line to the point load is 

defined along with the point load values. Several point 

loads may be defined in one load attribute if required. 

 

The Internal Beam Distributed load is a 

distributed load applied to lines in the local, 

global or projected direction. For local and global 

loading the distance maybe defined as either 

parametric (0 to 1) or actual distance. Only actual 

distance is permissible for projected loading. The 

distance from the start of the line to the start of the distributed loading, and the distance from 

the start of the line to the end of the distributed loading are defined along with the load 

component and the start and end load values. Several distributed loads may be defined in one 

load attribute if required. 

See the Element Reference Manual for details of internal beam loading (ELDS) and elements 

which support this loading type. 

Initial Velocity / Initial Acceleration (VELO/ACCE) 

In dynamic analyses, velocities or accelerations at a nodal variable can be defined. These 

values can be used to specify an initial starting condition or they may be prescribed for the 

whole analysis. If values are to be prescribed throughout the analysis load curves must be 

used and the appropriate freedoms must be restrained. 
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Prescribed Loads 

For information on which load types can be applied to which element types, see the LUSAS 

Element Library. 

Prescribed Displacement 

A Prescribed Displacement defines a nodal 

movement by either a Total or Incremental 

prescribed distance in global (or 

transformed) axis directions. Freedoms 

which are assigned a non-zero prescribed 

value will automatically be restrained. 

This example shows two methods of 

applying prescribed displacement. 

Incremental loading adds displacements to a 

previous increment, whereas total requires 

the full displacement to be specified on each increment.  

Notes 

 For linear analyses with multiple loadcases an automatic restraint is only assigned if 

the prescribed displacement is applied in the first loadcase. If a prescribed 

displacement is not assigned in the first loadcase but is assigned in subsequent 

loadcases a restraint must be assigned manually. 

 Total and incremental prescribed displacements should not be used in the same 

analysis. 

 It is recommended that total prescribed displacements are used with load curves. 

 Prescribed rotations should be specified in radians. 

Prescribed Velocity and Acceleration 

In dynamic analyses, velocities and accelerations may be defined for any nodal variable. 

These values can be used to specify an initial starting condition or prescribed for the whole 

analysis.  

 A prescribed, or initial, Velocity defines a velocity loading in global (or transformed) 

directions. 

 A prescribed, or initial, Acceleration defines an acceleration loading in global (or 

transformed) directions. If acceleration loads are required, the density must be 

specified in the material properties. Initial accelerations are only valid for implicit 

dynamic analyses. 
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Notes 

 If the values are to be prescribed throughout the analysis load curves must be used, 

see Load Curve Definition. 

 Initial velocities and accelerations should only be applied to the first loadcase. 

 In general, load curves should be used to prescribe velocities and accelerations in an 

analysis. However, initial values may be defined without using load curves if no other 

load type is controlled by a load curve. 

 If velocities and accelerations are prescribed for the same variable at the same point in 

time in an analysis, the acceleration will overwrite the velocity and a warning will be 

output. An exception to this rule occurs for implicit dynamic analyses where an initial 

velocity and acceleration may be used to define an initial condition for the same 

variable. 

 If initial conditions are to be applied, refer to Transient Dynamic Analysis for details 

on how to compute the data input required for the appropriate integration scheme. 

Discrete Loads 

Discrete loads are defined in relation to their own local coordinate system, the origin of 

which is given by the coordinates of the Point feature to which the load is assigned. Note that 

discrete loads are always assigned to Points. Discrete loads differ from feature-based loads in 

that they are not limited to application over whole features, and may be effective over full or 

partial areas of the model. Discrete loads may be projected over an area, onto Lines or into 

Volumes. Examples of discrete loads that are created automatically by LUSAS include those 

created for vehicle and lane loading, and equivalent nodal loading defined as a result of using 

a Prestress Wizard. Separate discrete loads may be applied to a model as a set or load train 

using the Compound load option. To identify critical vehicle loading patterns on bridges 

vehicle load optimisation is available for Bridge and Civil & Structural software products 

only. See Application Manual (Bridge, Civil & Structural) for details 

Discrete loads are useful for applying a load 

that does not correspond to the features 

underlying the mesh. A patch may be spread 

or skewed across several features. LUSAS 

automatically calculates the nodal 

distribution of forces that is equivalent to the 

total patch load. This example shows a 

typical set of point loads assigned to a 

grillage model. A single point, a group of 6 

and a group of 16 point loads are shown. 

The coordinates of the vertices defining the patch are relative to the Point to which the patch 

load is assigned, i.e. a load definition is defined in a local coordinate system, the origin of 

which is given by the coordinates of the Point to which the load is assigned. The Point does 
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not have to lie on the Surface to which the load will be applied as the patch load is projected 

in a specified direction.  

Using Search Areas with Discrete Loads 

A discrete load is distributed onto the elements over which the load lies. A Search Area is a 

way of controlling the load distribution onto these elements. If no search area is specified 

when assigning the load, then all of the underlying elements will be eligible for load 

distribution. 

Notes 

 While projecting the loads into the search area a check is made for multiple 

intersections of the load and the search area. Multiple intersections indicate an 

ambiguity in the location of the load. This ambiguity may be resolved with a more 

specific search area.  

 The distribution of load to the nodes follows the shape functions of the particular 

element. In quadratic elements, this distribution can appear at first unlikely. For 

example, a unit positive load at the centre of an 8-noded quadratic element, results in 

negative 0.25 loads at the corners and positive 0.5 loads at the mid-side nodes. 

 Search areas are automatically created and used by the prestress wizards to define 

the target to be loaded. 

Discrete Load Types 

A discrete load consists of coordinates defining the local x, y and z position and a load 

intensity.  Any Points selected when the Discrete loading dialog is initiated are entered as 

coordinates. Discrete load types available are Point load, Patch load and Compound load. 

Point Load  

Defines a general set of discrete loads in 3D space. Each individual load can have a separate 

load value. Point loads can be defined via Arbitrary input or by specifying a Grid input. 

This example uses 16 distinct load values. The loads are applied to the model as distinct 

loads. 
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Patch Load  

The number of coordinates given dictates the shape of the patch. 

 2 specified coordinates indicates a straight line load. 

 3 specified coordinates indicates a curved line load. 

 4 specified coordinates indicates a straight sided quadrilateral 

 8 specified coordinates indicates a curved sided quadrilateral 

The following examples show patch loads assigned to Point 1. Once assigned, the load origin 

is located at Point 1. 

Example 1.  

A straight line load defined using 2 coordinates. 
   

Example 2.  

A curved line load is defined using 3 coordinates. 

 

  

 

Example 3.  

A straight sided quadrilateral defined using 4 
coordinates.  

  
Example 4.  

A curved sided quadrilateral defined using 8 
coordinates.  
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Note that the mid-side nodes for a curved line load and for a curved sided quadrilateral load 

must lie with +/- 10% of the overall distance between the corner nodes. 

Compound load  

Compound loads may be created to simplify the definition and assignment of more complex 

loads. Compound loads form a set, or load train, of previously defined discrete loads that are 

subsequently assigned to a model as one loading. A compound discrete load may be defined 

from any combination of existing point, patch and compound discrete loads. For example a 

patch load representing a truck may be included in a compound load twice and by specifying 

the distance between the trucks a simple load train is created. Additionally, the same load 

may also be used any number of times to define the same compound load. x, y, z offsets and a 

translation can be specified to locate the compound loading from away from an assigned 

point. When created, compound discrete loads are held in the Loading section of the 

Attributes Treeview in their own section named Compound. 

Defining Discrete Point and Patch Loads 

Coordinates and magnitude 

 For a point load each attribute defines multiple loads, one concentrated load at each 

given vertex. 

 For patch loads the vertices combine to specify the shape of a line or patch load. The 

load is specified at each vertex allowing the load intensity to be varied. Patch load 

types include 8 node, 4 node, straight line and curve. 

Projection Vector 

 Projection Vector is used to work out which features 

are actually loaded. The vector is followed (in both 

directions) and any features intersected by the 

assigned discrete load vertices projected in the 

direction of the projection vector are loaded in the 

direction specified by the untransformed load 

direction. For patch loads defined by 4 or 8 vertices 

the projection vector is always perpendicular to the 

patch. 

 

This example shows a typical 3D patch load where 

the patch is defined in space and projected onto the 

model. 
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  (Untransformed) Load Direction defines the 

direction of the loads in the patch before any 

transformation is carried out at the assignment 

stage. Options are: X, Y, Z or Surface normal. 

 

In this example, loads are projected onto a 

model normal to the patch definition. The 

projection vector is denoted by a double-headed 

arrow on a visualised patch. The direction of 

the load applied to the model is defined using 

the untransformed load direction. 

This example shows a typical 3D patch load where the 

patch is defined in space and projected onto the mode 

 

 Patch load divisions specifies the numbers of 

divisions in the local x and y directions of the 

patch being assigned. The divisions are used to 

split the applied patch into individual 

component loads before they are in turn used to 

calculate equivalent nodal loads on the model. 

By default, the patch load division are based 

upon the values set in the   Patch divisions 

object which is created when a discrete loading 

is added to the Attributes Treeview. Again by 

default,10 patch load divisions are used in the 

local x direction and the aspect ratio of the patch is used to calculate the divisions in 

the y direction. When creating a patch ideally at least one division should be used per 

element division. The more individual loads a patch is split into, the more accurate the 

solution obtained. Patch load divisions can also be explicity defiend on the main patch 

loading dialog as a number in x and a number in y. In this case if X=0 and Y=10 is 

entered the number in the x direction will be calculated proportionally to the patch 

shape. Equivalent weighting values are used to calculate the portion of each discrete 

load that is applied to each corner of the element that it lies within. The load is then 

applied as Concentrated Loads. These weighting values are based on element shape 

functions and may vary with element type. 



Modeller Reference Manual   

    

206 

Assigning Discrete Loads 

Discrete loads are independent of features therefore their application can be more flexible. 

The load assignment parameters are explained below: 

 Patch Transformation Changes the patch 

orientation. For example, a patch load may be 

skewed by applying a rotation transformation 

when assigning the load.  

 

In the example shown right the Point load 

defined about local xy axes is assigned to Point 1 

subject to a patch direction transformation using 

a 30 degree xy rotation about the global origin. 

Note that the local origin of the patch load is 

rotated and repositioned as well as the patch 

itself.  

 

To rotate a patch about its centre, define the patch with its local origin at its centre 

 Load transformation Changes the load orientation from the (untransformed) 

direction given in the load definition. The transformation applies to the direction of 

the individual load components rather that to the patch as a whole. For example, it can 

be used to model braking loads on a 3D model that have horizontal and vertical 

components by specifying a transformation that will rotate the loads out of the vertical 

direction and into an inclined plane in the direction of vehicle travel. 

 Search area A search area restricts loading to a specified portion of the model. If a 

search area is not specified, the load is projected onto the whole model. For 2D 

models it is usually acceptable to default to the whole model, but for 3D models 

where multiple intersections of the load projection onto the model may occur it is 

safer to restrict the loading to the required face using a search area. In either case the 

time taken to assemble the loads is significantly improved by using a search area to 

restrict the number of elements tested for intersection with the load. Search areas are 

automatically created and used by the prestress wizards to define the target to be 

loaded. 

In addition, the discrete load can be specified to: 

 Project onto line This option is used to project discrete loads onto 2D line beam 

structures and frame models. Discrete loading is applied to the beam as corresponding 

forces and moments along the beam. 

 Project over area This option is used to project discrete loads over an area. The area 

may be defined by a grid of beam elements (a grillage), a plate or shell structure 

(slabs), or the face of a solid model. 

 Project into volume This option is used to project discrete loads into volumes (solid 

models) and is primarily for use with tendon loading. 
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Loads that extend beyond a search can be included or excluded using: 

 Options for loads outside search area Loads that fall outside the search area can be 

moved into the search area or be excluded entirely using a variety of options. See 

 Processing Loads Outside Search Area. 

General loadcase information that can be entered includes: 

 Loadcase specifies in which loadcase the loading is to be applied. Loadcases can 

themselves be manipulated. See Loadcase Management for more details. 

 Load factor specifies a factor by which the loading is multiplied before the equivalent 

nodal loads are calculated. 

Editing of Discrete Loading Data 

Editing of pre-defined discrete loading data (such as that used for supplied vehicle loads) 

allows users to view both the original vehicle definition input data, as well as the actual 

loading applied (the vehicle load converted into a discrete load format), for any and all 

vehicles within LUSAS. Editing of user-defined discrete loading data only permits viewing 

and editing of the discrete loading data. 

So, for the case of creating a vehicle load from a pre-defined vehicle, the resulting attribute in 

the Attributes Treeview has context menu entries named Edit Definition... and Edit 

Attribute... These menus can be seen by right clicking on the attribute.  

 Selecting the Edit Definition... menu entry or double clicking the attribute displays 

the original definition dialog with all the original input data intact. The user can 

change these inputs that may be either loading parameters such as width, length and 

intensity etc or even the type of vehicle, at any time. For each modification, the name 

of the attribute and the equivalent discrete load values are modified. Although the 

name of the attribute is altered, the attribute itself is merely modified and so the 

assignment links between the bridge structure and the load will not be lost.  

 Selecting the Edit Attribute...menu entry displays the equivalent discrete loads. 

These values may be changed but this breaks the link to the original definition dialog 

and a warning message will be displayed. 

Editing of automatically generated discrete loading data (such as that created by the use of the 

prestress wizards ) is not permitted.  

Editing patch load divisions  

 When the first discrete load type is added to the Attributes Treeview, a  Patch 

divisions object is also created. Double-clicking on this object displays a dialog which 

allows the type and default number of patch divisions used on discrete patch loading 

to be edited. 
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Case Study. Hydrostatic Loading 

In this example, a discrete patch load will be used to apply a hydrostatic load to the side-wall of an 

underground box culvert. 

1. The box culvert wall is defined using a Surface in the global XZ plane with corners at 

coordinates (0,0,0), (5,0,0), (5,0,3) and (0,0,3). Define a Surface using the New Surface 

button at the specified corner positions. 

2. Rotate the view using the Dynamic Rotate button until the Surface can be visualised in 

3D. 

3. Using Attributes> Mesh> Surface, define a mesh using Thick Shell, Quadrilateral, 

Linear elements. Specify the spacing as 15 divisions in the local x and 9 divisions in the 

local y directions. Since only one Surface is present in the model, the divisions for the mesh 

can be entered directly onto the Surface mesh dialog. 

4. With the cursor in normal mode, assign the mesh to the Surface by dragging the 

attribute from the  Treeview onto the selected Surface.  

5. To define a patch load that is coincident with the side-wall Surface, first select the four Points 

defining the Surface in the order they were defined. Choose the Attributes> Loading menu 

item and pick the Discrete Patch option. Note that LUSAS has selected a 4 node patch and 

filled the Point coordinates into the dialog.  

6. The load direction coincides with the global Y axis direction so select Y from the 

Untransformed Load Direction. Specify patch corner load intensity values of -3, -3, -1, -1 

respectively. 

7. The patch definition uses a coordinate system that is coincident to the global Cartesian axis 

system, so the load can be assigned to the Point at the origin (Point 1). Assign the load to 

Point 1 (0,0,0) leaving all dialog entries as default and press OK to assign the load. Note that 

the patch is drawn as discrete point loads. This is because the patch load is automatically split 

into point loads. 

8. The number of discrete loads in each direction is dependent on the numbers of divisions 

entered in the Assign Loading dialog. In this case, the default number of divisions (10) is 

insufficient as there are insufficient loads to apply at least one load per element along the 

culvert. To improve the load application accuracy, deassign the load from the Point, and 

reassign using 15 divisions in the local X direction. Leave the Y divisions field blank. Note 

that LUSAS has automatically used the aspect ratio of the patch load to calculate a suitable 
number of divisions in local Y. 
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Hydrostatic Patch Load 

Default number of divisions showing insufficient 
discrete point loads. 

 

Hydrostatic Patch Load 

Increased number of divisions on assignment. The 
double arrow vector indicating patch orientation. 

 

    

Search Areas 

Search areas may be used to restrict the area of application of discrete loads (point and 

patch). This is useful for several reasons: 

 Improved Control of Load Application. The search area will effectively limit the 

area over which the load is applied so that the effect of loads on certain features may 

be removed from the analysis. For 3D models it is possible that a chosen projected 

direction will cross a model in several locations. A search area is therefore used to 

limit the application of load to one of these multiple intersections. Restricting the area 

of application of discrete loads allows the same load attributes to be used to apply 

loads to different parts of the model. 

 Speed Improvement the speed of calculation of equivalent nodal loads will be 

increased by cutting down the number of features considered in the calculation. 

Search areas are automatically created and used by the prestress wizards to define the target 

to be loaded. 

  



Modeller Reference Manual   

    

210 

In the example shown, a multiple span grillage 

structure is defined with Span 1 as the search area. 

A discrete Patch load, indicated by the grey shaded 

region in the upper diagram, is applied across the 

whole structure, Span 1 and 2. The area of the 

structure coinciding with both the Search Area and 

the patch load will take the load as shown in the 

lower diagram. 

  

Tip. Search areas should be used if the model is 

three dimensional and discrete loads are applied, 

as, for example, for box-section or cellular 

construction decks. 

 

Defining and Assigning Search Areas 

Search areas are defined from the Attributes menu then assigned to the required Lines or 

Surfaces. Control of loads lying outside the search area is available when the load is 

assigned, see Assigning Discrete Loads. If a search area is not specified when the load is 

assigned, all of the highest order features, excluding volumes, in the model will be used as a 

default search area. Valid search area configurations are shown below. 

Note: The default maximum number of elements that can be used with search areas per 

grillage bay (each four-sided framing of a section of slab) is 30. In the unlikely event that a 

higher number is required this can be changed by setting a user-defined option in Modeller. 

Contact LUSAS technical support if you wish to do this. 

Rules for Creating Search Areas for Grillages 

The following general guidelines should be noted when assigning a search area to a grillage 

model. 

  

Overhanging elements defined such that only one side 

of a cell is missing are included in the search area, as 

shown. 

In these cases LUSAS automatically 'closes' the cell. 
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Elements cannot be included in the search area when 

they overhang from the same node, as shown. 

In this case, a dummy Line can be added manually 

between the 2 overhanging points to close the bay to 

make the search area valid. When closing the bay in this 

way note that a single null-line mesh should be used 

having one mesh division.  

 

 

Cells of more than four edges are automatically 

subdivided into triangles, but overhanging elements are 

only included if divided by no more than one edge.  

In this case, a dummy Line can be added manually 

between the 2 overhanging points to close the bay to 

make the search area valid. When closing the bay in this 

way note that a single null-line mesh should be used 

having one mesh division. 

For the invalid region shown, a dummy Line can be 

added manually between the 2 overhanging points to 

close the bay and make the search area valid. When 

closing the bay in this way note that a single null-line 

element, having one mesh division should be assigned. 

If done, the resulting cell of five edges will be 

subdivided into 4 triangles. 

 

 

 

There is no limit to the number of edges that may hang 

over the main body if the overhanging members are 

only separated by one edge (right). 

In these cases LUSAS automatically 'closes' the cell and 

either sub-divides the resulting cells into triangles or 

uses a quadrilateral as appropriate. 
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Processing Loads Outside a Search Area 

For point and patch loads any load outside a search area can either be excluded from the 

search area, or be projected to be included into the search area.  

Discrete loads on lines 

When discrete loads of patch or point loading are assigned onto Lines with an assigned 

Search Area the individual load components are projected onto the line, normal to the local x 

axis of the Line, and their effective loading is calculated and applied to the line as forces and 

moments along the line.   

Options available when assigning onto Lines are:  

 Exclude All Load beyond the end of the Line (default)patch load components 

beyond the end of line will be disregarded and all load components within the search 

area will be applied to the line with an appropriate force and moment to represent the 

positions of the loads. 

 Include Full Load all load components within the search area will be applied to 

theline with an appropriate force and moment to represent the positions of the loads. 

Patch load components beyond the end of line will be applied to the point at the end of 

the line with an appropriate force and moment to represent the actual position of the 

loads. 

Note that when a search area is assigned to a line the search area extends for the length of the 

line and for an infinite distance perpendicular to the line direction. See the diagram that 

follows or details. 

 

Patch Load onto Line 

Patch loads not lying on a line but within an assigned search 
area will be applied to the line as effective forces and moments. 
Loads outside the search area can be either included or 
excluded. If included, the applied moments will be computed by 
using the actual location of the defined loads 
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Discrete loads over areas 

When discrete patch loads are assigned over an area the projection path(s) is/are defined by 

the local x and y axes of the loading patch. Each patch load component is 'moved' along a 

specified local x or y direction and added to the first loading positions found inside the patch 

in that projected direction. See the diagram that follows which illustrate the various options. 

Options available when assigning onto areas are:  

 Exclude All Load (default) 

 Include Local X Projected Load 

 Include Local Y Projected Load 

 Include Local X and Y Projected Loads 

 Include Non-Projected Load 

 Include Full Local X Load 

 Include Full Local Y Load 

 Include Full Load 

Notes 

 Loads will not be moved to the edge of the search area if the entire patch load lies 

outside the search area.  

 Loads inside the search area are not moved. 

 Discrete patch loads assigned over areas are not work equivalent as the discrete points 

are simply lumped at the nearest node. 

 Patch loads outside the search area are lumped onto the nearest edge of the search 

area. 
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Patch Load Divisions 

Number of divisions in local x (div x) and y (div y) 
are specified at load assignment. The load intensity 
is then split into individual load components with an 
associated area of application. 

   
Patch Load Local Coordinates 

The local coordinate set is dependent on the order 
in which the coordinates of the patch vertices are 
defined. 

 

  

 

Local X Projected Load 

Loads in the local y projected region (dark area) 
are lumped at nearest loading positions within the 
search area (light area). 

  
Local Y Projected Load 

Loads in the local y projected region (dark area) 
are lumped at nearest loading positions within the 
search area (light area). 
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Local X and Y Projected Loads 

Loads in the local x and y projected regions (dark 
area) are lumped at nearest loading positions within 
the search area (light area). 

  
Non-Projected Load 

Loads not in the local x and y projected regions 
(dark area) are lumped at nearest loading positions 
within the search area (light area). 

 

  

 

Full Local X Load 

Loads in the full local x region of the patch (dark 
area) are lumped at nearest loading positions within 
the search area (light area). 

  
Full Local Y Load 

Loads in the full local y region of the patch (dark 
area) are lumped at nearest loading positions within 
the search area (light area). 
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Full Load 

All patch loads lying outside the search area (dark 
area) are lumped at nearest loading positions within 
the search area (light area). 

    

 

  
  

Discrete point loads over areas 

When discrete point loads are defined by specifying a grid of points they can either be 

excluded from the search area, or be projected to be included into the search area in exactly 

the same way as for discrete patch loads. If discrete point loads are defined by the Arbitrary 

option, and if the points are defined in an identifiable grid format, then the loading is applied 

as per the patch loading (that is, the loading components can be projected along the columns 

and rows of the patch load grid into the search area), otherwise the loading is applied to the 

nearest load location in the search area. 

Discrete point loads into volumes 

When discrete point loads are projected into volumes (by being assigned to a particular point 

on, or within the volume) the applied discrete loads are extrapolated within the elements to 

create equivalent concentrated nodal loads. When search areas are assigned to volumes the 

following options are available: 

 Exclude All Load (default) - patch load components outside the volume will be 

disregarded and all load components within the search area will be extrapolated within 

the elements to create equivalent concentrated nodal loads.  

 Include Full Load - patch load components outside the search area will be 

applied to the nearest elements in the volume. 
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Thermal Loading 

 Thermal loading is feature based and hence it is assigned to the model geometry. Variations 

in loading on a feature can be specified using a previously defined variation. For information 

on which load types can be applied to which element types, see the Element Reference 

Manual. 

Thermal loading is accessed via the Attributes > Loading > Thermal menu item. This menu 

item is only displayed if a Thermal or Coupled user interface is chosen on the New Model 

dialog when creating a new model, or when a Thermal or Coupled user interface is 

subsequently chosen on the Model Properties dialog. 

Flux (CL) 

 A Flux loading produces the LUSAS CL load type which in a field analysis applies a 

rate of internal heat generation (Q). Positive Q defines heat input. 

 A total flux, a flux per unit length or a flux per unit area can be specified. 

 Flux is defined relative to the nodal coordinate system. If the required loading 

directions of a global load do not lie in the global axes then a local coordinate may be 

assigned to the feature to transform the loads to local coordinate directions. 

Distributed Flux (FLD) 

 A Distributed Flux loading produces the LUSAS FLD load type which in a field 

analysis applies a rate of flux. 

Internal Heat Generation (CBF/RIHG)  

Defines the internal heat generation for an element. Positive loading values indicate heat 

generation and negative values indicate heat loss. 

 The temperature dependent internal heat loading (RIHG) defines the rate of internal 

heat generation. This load attribute requires a reference temperature for each set of 

properties. 

 Defining temperature dependent properties turns a linear thermal field problem into a 

nonlinear thermal problem. 

Notes 

 Load curves can be used to maintain or increment the RIHG as a nonlinear analysis 

progresses. 

 Automatic load incrementation under Nonlinear Control cannot be used with RIHG 

loading. 
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Prescribed Temperature (PDSP/TPDSP) 

Defines a prescribed temperature for an element. 

 The Incremental prescribed load type adds to any temperatures present from a 

previous increment. 

 The Total prescribed load type defines the total temperature at a given node at a 

specified increment. 

Environmental Temperature (ENVT/TDET) 

Models external fluid temperature and associated convection and radiation heat transfer 

coefficients. If an element face does not have an environmental temperature assigned it is 

assumed to be perfectly insulated. 

 The temperature dependent environmental temperature loading (TDET) models 

properties that vary with nodal temperature. This load attribute requires a reference 

temperature for each set of properties. 

 Defining temperature dependent properties will turn a linear thermal field problem 

into a nonlinear thermal problem. 

Notes 

 If heat transfer coefficients vary on a specified face the values will be interpolated 

using the shape functions to the Gauss points. 

 If a non-zero radiation heat transfer coefficient is specified, the problem is nonlinear 

and Nonlinear Control must be used. 

 Load curves can be used to maintain or increment the environmental temperature as a 

nonlinear analysis progresses.  

 Automatic load incrementation within the Nonlinear Control can be used to 

increment ENVT loading. 

Internal Heat User   

Allows user-defined input of internal heat generation for an element for use with user-written 

software programs. Values can be entered in multi-column format. Positive loading values 

indicate heat generation and negative values indicate heat loss. 

Concrete Heat of Hydration   

Concrete heat of hydration is defined as a part of the material model to be used. See 

Isotropic/Orthotropic Material 
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Case Study. Temperature Dependent Loading 

Temperature dependent environmental loading can be useful to model experimentally 

determined correlation for convective coefficients. For example, if the convective 

coefficient may be given by C [deltat] to the power one third where C is a constant, 

deltat is the temperature difference between the surface and the environment. To specify 

this loading in LUSAS you would define the convective coefficient at as many reference 

points as are required to give a good piece-wise linear approximation of the function. 

Each reference temperature point is defined in a loading attribute and collectively these 

attributes define a single loading table. The loading table is then assigned to the features 

as required. 

1. Define a row of Surface features. 

2. Use an incremental prescribed loading to fix the temperatures at one end of the 

model. 

3. Define a convective coefficient function using environmental loading 

(temperature dependent). 

4. Assign the loading and solve. 

5. Since the problem is one-dimensional the solution may be checked to ensure that 

the convection coefficient has been correctly interpolated. 

  

Retained Freedoms 

Retained freedoms are used to manually define the master freedoms for use in the following 

analyses: 

 Guyan reduction eigenvalue analysis 

 Superelement analysis 

Retained freedoms are defined from the Attributes menu. They contain the definition of the 

master (retained) and slave (condensed) degrees of freedom and are assigned to the features 

designated as the master nodes. 
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Full Subspace Iteration    20 Masters 

 

  

 

15 Masters   10 Masters 

 

  

 

5 Masters     

 

    

Equivalencing 

The equivalence facility is used to merge coincident nodes on otherwise unconnected 

features. If an equivalence attribute is assigned to any features the nodes will automatically be 

equivalenced after meshing has been carried out. 

There are several ways equivalencing can be set up to work: 

 By assigning equivalence tolerances to certain features - only these features will be 

equivalenced, all others are ignored. 

 By switching on the automatic tolerancing, and accepting the default tolerance - all 

features are equivalenced according to the default tolerance. 
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 By switching on the automatic tolerancing, and assigning other equivalence tolerances 

to certain features - all features are equivalenced according to either an assigned 

tolerance or the default tolerance. 

  

Example  

In this example, Surfaces 1 and 2 do not share a common 
boundary Line, therefore the nodes created on their common 
boundaries will not be joined and must be equivalenced. Node 2 
will merge with node 1 if it lies within the equivalence tolerance.  

  

 

Using Equivalencing 

Equivalence attributes are defined from the Attributes menu. They are defined as a tolerance, 

which is used to determine whether nodes are considered to be coincident.  

The equivalence attribute is assigned to the features that are to be checked for coincident 

nodes. When an equivalence dataset is assigned to a lower order feature it will search through 

all higher order features for nodes to be checked. For example, in order to equivalence two 

Volumes at their boundaries, it is more efficient to assign the equivalence to the Surfaces on 

the boundaries, as a smaller number of nodes need to be checked. 

Automatic Equivalencing 

Automatic equivalencing can be activated from the Meshing tab of the Model Properties 

dialog. This will equivalence all features in the model on meshing if they are within the 

default equivalence tolerance, or within an assigned tolerance. Note. Remeshing occurs each 

time a relevant command is issued, but a forced remesh is possible using the Utilities> 

Mesh> Mesh Reset menu item. Automatic equivalencing can be time consuming for models 

with a large number of nodes. 
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Visualising Equivalences 

Displays the features which have a specified equivalence assigned to 

them in a chosen colour and line style. 

In this example different equivalence tolerances are assigned to 

different parts of a model to merge more coarsely or finely as 

required. Using visualisation, the lines to which the equivalence is 

assigned can be highlighted. Equivalenced nodes can also be 

visualised as they are removed. In this diagram they are shown using 

the square symbol. 

 

Summary 

 More than one equivalence attribute may be defined in order to rationalise more than 

one section of the model independently. 

 More than one equivalence attribute can be assigned to a feature to equivalence it 

within a different subset of the model. 

 A check for unconnected elements and nodes can be performed using an outline mesh 

plot (Mesh layer properties), or by checking for duplicate node numbers using the 

View > Browse selection menu item and box-selecting around selected points to see if 

more than one point appears in the list shown. 

 The equivalence tolerance must be less than the smallest distance between two nodes 

on the same feature, otherwise the equivalencing operation will fail.  

 Equivalencing may be used to position a point load or support at a node (which is not 

at a defining feature Point). A Point must be created, the load or support assigned, and 

the Point and meshed feature equivalenced. 

 Equivalencing may be used to merge nodes on the constituent Lines of combined 

Lines i.e. the nodes on an entire combined Line may be equivalenced, including the 

Lines forming it. 

Age 

Age attributes define the age in days between creation and activation of features in the model 

and are used in conjunction with the CEB-FIP Concrete Material Model. When assigned to 

a feature all elements created by that feature are assigned the specified age. Age attributes are 

defined from the Attributes> Age menu item. 

See Solver Reference Manual for further details. 
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Damping 

Damping is used to define the frequency dependent Rayleigh damping parameters for 

elements which contribute to the damping of the structure. Viscous (modal) and structural 

(hysteretic) damping can be specified. If no damping attributes are specified the properties are 

taken from the material properties (click on dynamic properties on the elastic page of the 

material attribute dialog). 

Damping is usually specified when distributed viscous and/or structural damping factors are 

required for modal damping control. A modal damping analysis is performed as part of an 

eigenvalue analysis.  

Defining Damping 

Structural or viscous damping is defined from the Attributes> Damping menu item and 

assigned to features in the usual way. Mass and stiffness Rayleigh damping parameters are 

linked with the corresponding reference circular frequency value at which they apply in a 

damping attribute. If more than one set of damping values is defined linear interpolation is 

used to calculate damping values at intervening frequencies. 

Birth and Death (Activation/Deactivation of Elements) 

Birth and death enables the modelling of a staged construction process (e.g. tunnelling or 

bridge construction), whereby selected elements are activated and deactivated as the 

simulation process requires. Birth and death attributes are defined from the Attributes menu 

and are assigned and manipulated in the same way as other attributes. 

All elements to be used in the model are defined at the start of the analysis. To model the 

absence of a part of the model, it is assigned a deactivate attribute. In structural analyses, the 

underlying elements have their stiffness matrix reduced in magnitude, while for field analysis 

the conductivity matrix (or other analogous quantity) is reduced. This ensures the deactivated 

elements have a negligible effect on the behaviour of the remaining model. The element 

stresses and strains, fluxes and gradients and other analogous quantities are all set to zero. 

To model the addition of a part to the model an activate attribute is assigned. In structural 

analyses, an unmodified stiffness matrix is computed for the underlying elements and these 

 activated elements are introduced in a stress/strain free state, except for any initial stresses or 

strains that have been defined. Strains are incremented from the point of activation and the 

current geometry is used to define the activated element‟s initial geometry. In a field analyses 

activation works in the same manner, except that the quantities affected are the conductivity 

matrix (or other analogous quantity), the fluxes and the gradients. 

By setting LUSAS Solver option 385, however, loads applied to deactivated elements are 

preserved to enable reapplication if and when the elements are re-activated. 

Percent to Redistribute 

The deactivate command provides control over the way in which these internal forces are 

processed by specifying how much of the internal forces should be redistributed: 
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 Zero Redistribution 0% of the internal forces in a deactivated element may be 

redistributed in the system (if this is prescribed in a static analysis, and the load 

remains constant, the stress, displacements etc. in the other elements will remain 

unchanged). 

 Full Redistribution 100% of the internal forces in a deactivated element may be 

redistributed in the system (this has the same effect as re-assigning very weak material 

properties to the element). 

 Fractional Redistribution A percentage of the internal force to be redistributed is 

specified. Provides a solution which is part way between the two extremes. 

Any remaining internal equilibrating force associated with a deactivated element is 

maintained in the system until the element is subsequently activated. When an element is 

activated it is assumed that the element has just been introduced to the model (although all 

elements must be defined at the outset). The current (deformed) geometry for that element is 

taken as the initial geometry and the element is assumed to be in a stress/strain free state 

(unless initial stresses or strains are defined). All internal forces that exist in the element are 

redistributed and the computed strains are incremented from the time at which the element 

becomes active. 

Excavation Stage 1 

Top layer of soil deactivated and lining activated. 
Lining and soil elements duplicated in the model. 

Tunnel Excavation Stage 2 

Second layer deactivated as soil excavated. 
Surrounding lining elements activated 
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Tunnel Excavation Stage 3 

Remaining second layer soil elements 
deactivated. 

Tunnel Excavation Stage 4 

Supporting soil pillar removed and top lining 
activated. 

  

Tunnel Excavation Stage 5 

Final central soil column removed. 

  

 

  

  

Using Birth and Death Attributes 

Activate and deactivate attributes are defined from the Attributes menu. The attributes are 

assigned on a feature basis to control the history of the underlying elements throughout the 

analysis. The loadcase is specified during assignment to indicate at what point the elements 

are added or removed. 

Notes 

 Elements cannot be activated and deactivated in the following circumstances: 

 Explicit dynamics analyses. 
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 Fourier analyses. 

 When using updated Lagrangian or Eulerian geometric nonlinearity. 

 When they are adjacent to slidelines.. 

 Activation and deactivation can only be carried out within a nonlinear analysis. 

 Deactivation and activation can take place over several increments if convergence 

difficulties are encountered.  

 Deactivated elements remain in the solution but with a scaled down stiffness so that 

they have little effect on the residual structure. The stiffness is scaled down by a 

parameter which can be changed by you. In a dynamic analysis the mass and damping 

matrices are also scaled down by the same factor. 

 When an element is deactivated, all loads associated with that element are removed 

from the system and will not be re-applied if an element is subsequently re-activated. 

This includes concentrated nodal loads unless the load is applied at a boundary with 

an active element. The only exception to this rule is a prescribed displacement which 

may be applied to a node on deactivated elements. Accelerations and velocities may 

also be prescribed in a dynamic analysis but this is not recommended. 

 If required, initial stresses/strains and residual stresses may be defined for an element 

at the re-activation stage. 

 The activation of an element which is currently active results in an initialisation of 

stresses/strains to zero, an update of the initial geometry to the current geometry and 

the element is considered to have just become active. The internal equilibrating forces 

which currently exist in the element will immediately be redistributed throughout the 

mesh. This provides a simplified approach in some cases.  

 The direction of local element axes can change during an analysis when elements are 

deactivated and reactivated. In particular, 3-noded beam elements that use the central 

node to define the local axes should be avoided as this can lead to confusion. For such 

elements the sign convention for bending moments for a particular element may 

change after re-activation (e.g. it is recommended that BSL4 should be preferred to 

BSL3 so that the 4th node is used to define the local axes and not the initial element 

curvature). 

 Care should be taken when deactivating elements in a geometrically nonlinear 

analysis, especially if large displacements are present. It may be necessary to apply 

prescribed displacements to deactivated elements in order to attain a required 

configuration for reactivation. 

 It should be noted that the internal forces in the elements will not balance the applied 

loading until all residual forces in activated/deactivated elements have been 

redistributed. 
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Thermal Surfaces and Heat Transfer 

The thermal surface facility allows thermal gaps, contact and diffuse radiation to be modelled. 

Thermal surfaces are used to model the thermal interaction of two distinct bodies, or two 

different parts of the same body through a fluid medium.  

 Thermal Gaps are used to model gaps between structures that are relatively close 

together. 

 Contact is used in a thermo-mechanical coupled analysis where contact takes place 

and the contact pressure effects are then included in the analysis. 

 Diffuse Radiation is the process of heat transfer from a radiation surface to the 

environment or to another thermal surface defining the same radiation surface. 

Radiation is modelled by specifying radiative properties for thermal surfaces. 

Thermal surfaces 

Thermal Surfaces are the thermal equivalent of structural slidelines. They are defined from 

the Attributes> Thermal Surface menu item and are assigned to features of the model and 

manipulated in the same way as all other attributes. A thermal surface must be defined before 

thermal gap or radiation properties can be specified. 

 Radiation properties are required when defining a radiation surface for heat transfer 

by radiation exchange.  

 Environment properties are required when thermal environment properties exist. 

Used for heat transfer to the environment (convection and conduction).  

Thermal Surfaces work in conjunction with Thermal Gaps and RadiationSurfaces. See 

below for details. 

Heat Transfer 

Thermal gap and radiation surface properties are used to dictate the type of heat transfer that 

can take place between Thermal Surfaces. They are defined from the Utilities> Heat 

Transfer...  menu item. As utilities they cannot be assigned directly to features of the model 

as Thermal Surfaces can.  A thermal surface must have been defined prior to specifying any 

thermal gap or radiation properties. The process of thermal surface / heat transfer definition is 

summarised in the following diagram. 
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 Thermal Gaps Thermal gaps are used 

to model heat transfer across a gap and 

heat transfer by contact when a gap is 

deemed to have closed. If these effects 

are required, the thermal surfaces 

defining the gap must be specified on 

the Thermal Gap properties dialog. 

 Radiation Surfaces Diffuse radiation 

exchange may be modelled with a 

radiation surface that is defined by any 

number of thermal surfaces. Planes of 

symmetry that cut through the radiation 

enclosures may be defined so that it is 

not necessary to model the whole 

structure. Radiation surfaces allow for 

the calculation of diffuse view factors. 

These view factors may be output to a 

print file 

Specifying thermal surfaces 

defining a gap 

Pre-defined thermal surfaces can be selected on 

the Thermal Gap properties dialog in order to 

define a gap. The gap can be defined as active 

or inactive initially and be set to change 

according to loadcase. 

 

Choosing Thermal Properties 

The following flowchart guides the decision making process for choosing thermal properties. 

The process is simplified if the analysis only considers a single body, when only 

environmental thermal properties are required. For analyses where discrete (multiple) bodies 

are considered, factors such as body proximity and whether the bodies are touching, or are 

likely to touch during the analysis, become important and the choice of thermal properties 

changes. Follow a route through the flowchart below and define your thermal surfaces using 

the properties given in the shaded box. 
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Environmental Nodes (LUSAS analysis data file) 

Environmental nodes may be used to represent the medium which separates the thermal 

surfaces between which heat is flowing. As the length of a link directly connecting two 

surfaces increases, the validity of the assumed flow becomes more tenuous. Alternatively, 

instead of forming a link, heat could flow directly to the surroundings, but in this case, the 

heat is lost from the solution. This, in some cases, is a poor approximation to reality, 

particularly when the thermal surfaces form an enclosure. In this instance an environmental 

node can be used to model the intervening medium, with all nodal areas which are not 

directly linked to other areas linked to the environmental node. The environmental node then 

re-distributes heat from the hotter surfaces of the enclosure to the cooler ones without 

defining the exact process of the transfer. 

Note. Environmental nodes cannot be defined in LUSAS Modeller, and must be edited 

directly into the LUSAS analysis data file if required. See the Solver Reference Manual for 

further information. 

Radiation Options 

Radiation options are set from the Model Properties dialog. Available options are: 

 Suppress Recalculation of View Factors in Coupled Analysis  (Model properties, 

Solution tab, Thermal options). Turns on/off the view factor recalculation. The option 

should be turned on when the radiation surface geometry is unchanged by the 
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structural analysis. This stops recalculation of the view factors. LUSAS Solver option 

256. 

Constraint Equations 

A constraint can be defined to constrain the movement of a geometric or nodal freedom. 

Constraint equations allow linear relationships between nodal freedoms to be set up. 

Constraint equations can be used to allow plane surfaces to remain plane while they may 

translate and/or rotate in space. Similarly straight lines can be constrained to remain straight, 

and different parts of a model can be connected so as to behave as if connected by rigid links. 

These geometric constraints are only valid for small displacements. Constraint equations can 

also be used to model cyclic symmetry, for example a single blade from a complete rotor may 

be modelled and then constrained to behave as if it were part of the complete model. As 

constraint equations refer to transformed nodal freedoms, any local coordinate assigned to the 

features are taken into account during tabulation when the constraint equations are 

assembled. 

Several different types of Constraint Equations can be defined from the Attributes> 

Constraint Equation menu item. Constraints are grouped under the following types: 

Displacement Control 

 Specified Variable a nodal freedom takes a 

specified value across all the nodes in the assigned 

features, In this example, a specified variable 

constraint of Displacement in the X direction with 

value 1.0 is assigned to Point 1. The underlying 

node is then allowed to displace only by the 

specified distance in the specified X direction. 

 Constant Variable used where a nodal freedom 

value is constant but unknown across all the nodes 

in the assigned features. 

In this example, a constant variable constraint of 

displacement in the X direction is assigned to Line 

1. The underlying nodes move a constant amount 

in that direction. 
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 Vector Path The nodes in the assigned features may 

be constrained to move along a specified vector 

defined by 2 Points or by 2 sets of X, Y and Z 

coordinates. 

 

In this example, vertical and horizontal vectors are 

used to restrict movement in those directions. Note that 

the vectors are used purely to define a direction. Nodes 

can travel along a vector in either direction. 

Geometric 

 Rigid Displacements The nodes in the assigned 

features may be constrained to be rigid, the group 

of nodes may translate and/or rotate but their 

positions relative to one another remain constant. 

Only translational displacements can be 

constrained using this type of constraint. This type 

of constraint is only valid for small displacements.  

Assigning a constraint of this type to Lines on 

either side of a gap, as in the example shown, 

maintains the underlying undeformed node positions relative to each other as if a rigid 

block were in place between the structures. 

  

 Rigid Links  Each rigid link attribute can be used at one 

location, to create a rigid fixity between features that it is 

assigned to. It is similar to the Rigid Displacements 

constraint type, except that rotational freedoms are also 

constrained to be rigid. In the example shown here, the 

end of a beam is rigidly linked to the shell edges around 

a cylinder. The plane containing beam and cylinder end 

will remain plane throughout the analysis. 
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 Planar Surface A surface may be constrained to remain 

plane, the surface may translate and/or rotate but 

remains plane. Nodal positions may vary relative to 

other nodes on the surface. This type of constraint is 

only valid for small displacements. In this example, a 

planar Surface constraint is assigned to the top Surface 

to force the underlying nodes to remain planar during 

loading. Constrained nodes may move relative to each 

other as long as they remain in plane. 

 Straight Line A straight line may be constrained to 

remain straight, the line may translate and/or rotate but 

will remain straight. Nodal positions may vary relative 

to other nodes along the line. This constraint type is 

only valid for small displacements. In the example 

shown, a straight Line constraint is assigned to Line 3 to 

force underlying nodes to remain in a straight line 

relative to each other during loading. Constrained nodes 

may move relative to each other as long as they remain 

in a straight line. 

Cyclic 

 Cyclic Rotation Cyclic rotational symmetry may 

be used to model a section from a continuous ring. 

The mesh on the two planes of symmetry may be 

different. In the example shown, the radial Lines 

are defined as a Master and Slave pair maintaining 

cyclic symmetry around the structure. Meshes on 

the Master and Slave Lines need not match. 

 Cyclic Translation Cyclic translational 

symmetry may be used to model a 

section from a continuous strip. The 

mesh on the two planes of symmetry 

may be different. In the example shown 

here, Master and Slave Surfaces define 

start and finish positions of repeating 

sections. Meshes on Master and Slave need not match. 
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Tied Mesh 

 Specified Constraint Tied meshes may be used to 

force two sets of assigned features to move 

together in a similar manner to tied slidelines. The 

meshes are tied along Master and Slave Lines to 

restrict relative movement. The mesh on the two 

sets of features need not match. A search direction 

vector is defined to limit the mesh to which it is 

tied. A vector defines the direction in which the 

constraint is applied. 

 Normal Constraint Meshes tied along Master and 

Slave Lines to restrict relative movement. The 

underlying nodes maintain their original relative 

positions under loading. Meshes on Master/Slave 

need not match. This form of tied mesh constraint 

uses a search direction normal to the Master/Slave 

surfaces to detect the mesh to which it is tied. 

 

Case Study. Using Constraint Equations 

Differing meshes may be constrained to displace together in a similar way to a tied 

slideline. 

1. Define two Surfaces separated by a small gap using Geometry> Surface> 

Coordinates. 

2. Mesh the Surfaces with Linear Plane Strain elements using different mesh spacing 

on each Surface using the Attributes> Mesh> Surface menu item. 

3. Define and assign a valid Material to the Surfaces and define and assign Supports 

and Load attributes so that the Surfaces are being forced towards each other. 

4. Define a normal tied mesh Constraint using the Attributes> Constraint 

Equation> Tied Mesh menu item. Assign it to the Lines on either side of the gap. 

One Line must be selected as a master and the opposing Surface as a slave. If 

meshes on tied Lines have different spacing, choose the Line containing the finer 

mesh as the master. 

5. Run Solver  and view the deformed mesh. The constraint equations will have 

prevented one surface from passing through the other. 
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Crack tip attributes 

A crack tip attribute allows a crack tip location to be defined at a point in a surface model and 

at either a point or line in a volume model. Crack tip attributes are defined from the 

Attributes > Crack tip menu item and are only for use with 2D and 3D quadratic continuum 

elements. After assignment the mid-point nodes of elements adjacent to the crack tip 

assignment are automatically moved to the nearest quarter point position within the element 

and the continuum elements adjacent to the crack tip assignment are automatically replaced 

with an equivalent crack tip element. When assigned to a point, the crack tip always occurs at 

a corner node of an element. When assigned to a line (volume models only), the crack tip 

occurs all along the line. Assigned crack tip attributes can be visualised using symbols 

displayed on the nodes of the assigned feature and at the mid-side nodes of the adjacent 

elements that have been moved towards the assigned feature. 

 

 
Crack tip attribute assigned to a point in a 2D model Crack tip attribute assigned to a line in a 3D model 

Slidelines 

Slidelines are attributes which can be used to model contact and impact problems, or to tie 

dissimilar meshes together. They can be used as an alternative to joint elements or constraint 

equations, and have advantages when there is no prior knowledge of the contact point. 

Slideline applications range from projectile impact, vehicle crash worthiness, the containment 

of failed components such as turbine blades, to interference fits, rock joints and bolt/plate 

connections.  

Slideline properties are defined from the Attributes> Slideline menu item. 

The properties of a slideline are used to model the contact interaction between master and 

slave features, such as the contact stiffness, friction coefficient, temperature dependency etc. 

The figure below shows a contact application in which a frictional slideline is defined 

between two bodies and where tied slidelines are used to join dissimilar meshes. The latter 

avoids the need for stepped mesh refinements between different mesh densities. 
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Slidelines are assigned to pairs or groups of features in a model, with one pair/group termed 

master and the second pair/group termed slave. An element face that lies on a slideline is 

called a slideline segment. 

When one slideline surface is much stiffer than the other it can be defined as a rigid slideline 

surface. This approximation can improve the convergence rate and hence reduce the solution 

time. If the rigid surface is not part of the model, rigid elements should be assigned to the 

features. 

Note. Except for tied slidelines, the slideline contact facility is inherently nonlinear and must 

be used in a nonlinear analysis. 

Table of Elements for use with Slidelines 

The following table gives a list of elements valid for use with slidelines: 

Element type    LUSAS elements 

Thick shells   TTS3, QTS4 

Plane stress 
continuum 

  TPM3, TPM3E, TPK6, TPM6, QPM4, QPM4E, QPM4M, QPK8, QPM8 

Plane strain 
continuum 

  TNK6, TPN3, TPN3E, TPN6, QNK8, QPN4, QPN4E, QPN4L, QPN4M, QPN8 

Axisymmetric solid 
continuum 

  TAX3, TAX3E, TAX6, TXK6, QAX4, QAX4E, QAX4L, QAX4M, QAX8, QXK8, 

Solid continuum    TH4, TH4E, TH10, TH10K, PN6, PN6E, PN6L, PN12, PN12L, PN15, PN15K, 
PN15L, HX8, HX8E, HX8L, HX8M, HX16, HX16L, HX20, HX20K, HX20L 

Continuum two-phase   TH10P, TPN6P, PN12P, PN15P, HX16P, HX20P, QPN8P 

 2D interface    IAX4, IAX6, IPN4, IPN6 

3D interface    IS6, IS8, IS16, IS12 

2D rigid surface   R2D2 

3D rigid surface   R3D3, R3D4 
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Slideline Types 

There are several different types of slideline: 

 Null The slideline attribute is ignored. Useful for performing a preliminary check on 

the model.  

 No Friction Used to model contact without friction.  

 Friction Used to model contact with friction. 

 Tied Used to tie different meshes together. 

 Sliding Used for problems where surfaces are kept in contact but which are free to 

slide relative to each other. The sliding behaviour is frictionless. 

The friction/no-friction slideline types model the finite relative deformation of contacting 

bodies in two or three dimensions where the contact is stationary or sliding, constant or 

intermittent. The sliding only option is similar but does not permit intermittent contact, i.e. 

the surfaces are kept in contact, allowing frictionless sliding contact without lift-off to be 

modelled. The tied slideline option allows meshes of differing degrees of refinement to be 

connected without the need of a transition zone between the meshes. 

Slideline Properties 

 Master/slave stiffness scale Controls the amount of inter penetration between the two 

surfaces. Increasing the scale factor will decrease the amount of penetration but may 

cause  ill-conditioning. Recommended values are: 

 Implicit/static solution 1.0 

 Explicit solution 0.1 

 Tied slidelines 100 to 1000 

Slideline stiffnesses are automatically scaled at the beginning of an analysis if the 

average master/slave stiffnesses differ by a factor greater than 100. This is to account 

for contact between bodies that have significantly different material properties. This 

facility can be suppressed via File > Model properties > Attributes and selecting 

„Suppress initial slide-surface stiffness check‟. 

 Coulomb friction coefficient Defines the coefficient of friction between contacting 

bodies for Coulomb‟s law. Only applicable for friction slidelines.. 

 Zonal contact detection parameter This defines the region around a node within 

which a search for contact is conducted. The size of the region is a factor of the size of 

the overall model – the model is projected onto the global x, y and z axes and the 

largest projection is used as a reference. For further information refer to the Theory 

Manual.  
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 The default value of the zonal contact detection parameter is 0.01, i.e. 1% of 

the model size. A smaller value may result in undetected inter-penetration. The 

value should be set to 1.0 if the contact search should consider the entire 

model (though only points on the adjacent slideline surface will be considered 

valid contacts). 

 Slideline extension A boundary of a slideline segment can be expanded by specifying 

a slideline extension. Points outside the segment but within the extended boundary are 

considered valid for contact. This is particularly useful near the edges of a slideline 

surface, where a node could be on a segment in one nonlinear iteration and off the 

segment in the next iteration – a form of chatter that can cause nonlinear convergence 

difficulties.  

 The extension parameter is an absolute number. 

 Close contact This defines a region above a slideline surface within which a soft 

spring is applied, but with no force. The stiffness of this spring is applied to all nodes 

that are above a surface but within the close-contact region. This softens the transition 

between in-contact and out-of-contact states. 

 The close contact facility helps stabilise solutions suffering from chatter in 

which nodes oscillate between in-contact and out-of-contact states. Chatter can 

cause a nonlinear analysis to experience convergence difficulties. 

 The size of the close contact region is a factor of the segment size. The 

stiffness of the close contact spring is 10-3 that of the slideline stiffness. It‟s 

stiffness is controlled by the Solver system parameter SLSTCC. 

 For analyses that continue to suffer from chatter, the size of the close contact 

region should be increased and the value for SLSTCC reduced accordingly. 

SLSTCC can be changed via File > Model properties > Solver system 

variables. 

 The close contact facility is not available for explicit dynamics. 

Temperature Dependency 

Choosing the Temperature dependent check box allows different sets of slideline properties to 

be specified at different temperatures, thus providing temperature dependence. With 

temperature dependency, the stiffness scale factors and the coefficient of friction are linearly 

interpolated across the reference temperatures. All other properties remain unchanged. 

Pre-contact 

Pre-contact is used to overcome problems encountered when applying an initial load (other 

than Prescribed Displacement) to a discrete body that, without the slideline, would undergo 

unrestrained rigid body motion. This is particularly the case when an initial gap exists 
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between the contacting surfaces and a load is applied to bring them into contact. Pre-contact 

is only applicable to static analyses. 

 

Pre-contact brings two bodies into initial contact by using interface forces that act between 

the slideline surfaces in order to avoid unrestrained rigid body motion. These forces act in a 

direction normal to each surface. One of the surfaces must be free to move as a rigid body and 

the direction of movement is dictated by the interface forces, applied loading and support 

conditions. The facility allows a gap to exist between the surfaces. In the example above pre-

contact is defined for slideline 1 but not for slideline 2. 

Warning. Incorrect use of this procedure could lead to initial straining in the bodies or to an 

undesirable starting configuration. By selecting specific slidelines for the pre-contact process 

(i.e. slidelines where initial contact is expected) minimum initial straining will occur and 

more control over the direction of rigid body movement can be exercised. 

Contact Cushioning 

Contact cushioning can be used when convergence difficulties related to in-contact/out-of-

contact chatter are experienced. The formulation applies a contact force and stiffness above a 

surface that increases exponentially as a node moves closer to the surface. This cushions the 

impact of a node with the surface and softens the transition between in-contact and out-of-

contact states. Contact cushioning can therefore help improve nonlinear convergence when 

chatter is encountered and the set of active contact nodes is continually changing. See Theory 

Manual for details. 

Initial slideline type 

The slideline type at the start of the analysis (as described earlier) 

Type changes during analysis 

Select this option if the slideline type is to change during the analysis. 

The slideline can be changed from one type to being any other type at any stage in the 

analysis. For example, the slideline can be tied to begin with and then released at a later stage. 

If this option is not selected, the initial slideline type is used throughout the analysis. 

Type after change 

The slideline type after change (e.g. Friction). 
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Changes at loadcase 

The loadcase at which the slideline type should change from the initial setting to the changed 

setting. (e.g. Tied to Friction). 

Rigid type 

To model contact with rigid bodies, rigid slideline surfaces are available. Rigid surfaces can 

be assigned to valid structural elements as well as to special rigid surface elements R2D2, 

R3D3 and R3D4. The latter are recommended for modelling rigid bodies, since they remove 

the need for defining structural elements and hence speed up the solution. All nodes on a rigid 

surface need to be completely restrained. Since rigid surfaces cannot contact each other only 

one slideline surface can be defined as rigid – master or slave. 

Number of passes 

Slidelines involve a two pass procedure in general, in which contact on both slideline surfaces 

is processed. With rigid surfaces, however, a one pass procedure is available that only checks 

the penetration of the deformable surface into the rigid surface. If the one pass procedure is 

selected, it is recommended that the deformable body should have the finer mesh.  

Geometric definition 

Slideline surfaces can be modelled using linear/bi-linear segments, or as curved contact 

surfaces using quadratic patches.  

 With quadratic patches the curved contact geometry is constructed from a patch of 

slideline segments. The contact forces are then distributed to the closest segment. 

 The quadratic patches and the curved geometry are set-up automatically within 

LUSAS Solver and no additional specification is required. The standard patch 

configuration consists of two linear segments in 2D and four bi-linear segments 

(quadrilateral or triangular) in 3D. Where a patch definition is not possible the 

standard linear/bi-linear definition is used instead.  

 The quadratic patch contact formulation has a non-symmetric tangent stiffness matrix. 

The non-symmetric solver is therefore set automatically. 

Assigning Slidelines 

Slideline surface pairs are created by assigning a slideline attribute to selected Lines or 

Surfaces.   

To assign a slideline: 

1. Select features that will form the master surface 

2. Assign the slideline attribute to these features 
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3. In the Assign Slideline dialog that appears, specify Master and the set of features to 

which it applies. The orientation is computed automatically but needs to be specified 

for shells (Top or Bottom) 

4. Select features that will form the slave surface 

5. Assign the slideline attribute to these features 

6. In the Assign Slideline dialog that appears, specify Slave and the set of features to 

which it applies. The orientation is computed automatically but needs to be specified 

for shells (Top or Bottom) 

Slideline Modelling Considerations 

 Except for tied slidelines, the slideline contact facility is inherently nonlinear and must 

be used in a nonlinear analysis 

 Only the expected region of contact should be defined as a slideline surface for tied 

slideline analyses. 

 Coarse mesh discretisation in the region of contact should be avoided. 

 Slidelines must be continuous and should not subtend an angle greater than 90 

degrees. Sharp corners are best described by two separate slidelines. 

 Large mesh bias should be avoided when using quadratic patches, to ensure a 

reasonable curved geometry is generated 

 The stiffness scale factors should be increased for rigid wall contact 

 The nodal constraint slideline (explicit tied slideline) treatment is more robust if the 

mesh with the greatest contact node density is designated the slave surface 

 The use of tied slidelines to eliminate transition meshes is recommended for areas 

removed from the point of interest in the structure 

 The use of a larger value for Young's modulus to simulate a rigid surface in a dynamic 

contact analysis is not advisable since this will increase the wave speed in that part of 

the model and give rise to a reduced time step. This practice significantly increases the 

computing time required. 

 Slidelines may be utilised with higher order elements (quadratic variation of 

displacements) but it is necessary to constrain the displacements of the slideline nodes 

so that they behave in a linear manner (LUSAS Modeller will do this automatically). 

The deformation of the slideline surface will therefore be compatible with the 

slideline algorithm. This may, however, lead to a stiffer solution 

 When defining slidelines for use in implicit dynamics or static analyses, low order 

continuum elements are recommended 

 Explicit dynamics elements only may be utilised to define a slideline surface in an 

explicit dynamics analysis 

 Do not converge on the residual norm with PDSP loading in a nonlinear analysis. This 

norm uses external forces to normalise which do not exist with PDSP loading. 

 Slidelines may be used with automatic solution procedures (e.g. arc-length methods). 

The line search and the step reduction algorithms are also applicable. 
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Slideline Options 

Options relating to slidelines are set from the Attributes tab of the Model Properties dialog. 

Slideline Example: Metal Forming Analysis 

 

Initial configuration. Deformed configuration. 

  

  

Composites 

Composite attributes allow previously defined materials to be collected together to define a 

laminate or composite lay-up. Layup definition methods allow for properties to be defined 

manually for use on solid and shell models and optionally include additional specific values 

for draping over model surfaces. Layup data can also be imported from a FiberSIM XML file, 

also for draping over selected model surfaces. 

Composite Layup Methods  

The following methods are available as a result of selecting the Attributes > Composite 

menu item: 

 Solids and Shells 

 Draped Solids and Shells 

 FiberSIM Solids and Shells 

 Simulayt Solids and Shells 
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Solids and Shells 

This method allows a manual definition of the composite lay-up where orientations and 

thicknesses for the plies can be specified by stacking layers of differing materials at various 

angles and thickness. The orientation angles can be applied with respect to the local element 

x-axis (in the x-y plane) or with respect to the x-axis of a predefined Cartesian set. The z-axis 

defines the direction of the lay-up with ply 1 located at the bottom of the stack. The lamina 

thickness specified depends upon the element types used. 

Notes 

 Only orthotropic plane stress (for semi-loof shell) or orthotropic solid (for thick shell) 

materials can be used for structural shell composite lay-ups. Structural solid 

composites models must use the orthotropic solid material model and thermal solid 

composites models must use the orthotropic solid field material model. Isotropic 

materials may be used within any composite lay-up. 

 For shell elements an appropriate plane stress nonlinear material model may be used 

whilst for solid elements a 3D nonlinear continuum model may be used (see the 

Element Reference Manual). 

 The lay-up sequence is from bottom to top. In the case of a shell this will be in the 

direction of the Surface normal. In the case of a solid this will be in the direction of 

the local z. 

 In cases where surface normals need correcting good use can be made of the cycling 

facility, where feature local axes can be cycled relative to a reference feature to ensure 

a consistent set of composite material axes. 

 Composite attributes may not include materials that contain variations. 

Draped Solids and Shells 

This method makes use of the native draping functionality in LUSAS. A start point (which 

should lie inside or on the boundary of the surface to be draped) can be defined for each ply 

and the start direction is defined by the x-axis of a predefined Cartesian set. Prior to assigning 

a composite attribute of this type to a model a draping surface must be selected or specified. 

The orientations of fibres following the drape are computed by LUSAS and are tabulated with 

respect to the x-axis of the local element axes. As with the Solids and Shells option, it is 

essential that the z-axis of the volumes to which the composite is to be assigned are 

consistently oriented. See Draping below. 

FiberSIM Solids and Shells and Simulayt Solids and 

Shells 

Composite stack details can be read in from an external FiberSIM XMLfile or Simulayt 

LAYUP file. A default fibre volume fraction can be specified and by default it is assumed 
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that all plies are of the same thickness but this can be modified. It is not necessary to select a 

draping surface or to define a start point when using this option.  

Notes 

 The coordinates of the ply data in the FiberSIM or Simulayt file must coincide with 

the coordinates of the drape surface. 

 Any XML file should only contain lay-up data relating to a single drape surface. For 

example, if a non-composite core is sandwiched between two composite skins then at 

least two XML files will be required. The volumes defining each skin must be 

selected in turn and the appropriate XML file assigned to it. 

 A draping grid can be extended by one grid row to ensure the edges of the component 

are fully enclosed. See Extending the draping grid. 

Draping in General 

Composite attributes may be orientated on a 

solid or shell model by specifying a start point 

and a local coordinate defining the drape 

direction of each lamina   

Draping assumes the thickness remains constant 

and hence the volume fraction (the amount of 

fabric to resin in a lamina) is adjusted when the 

fabric is distorted. After assignment of a 

composite attribute that contains draping data to 

a model, the skew angle and fibre volume 

fraction may be contoured and the fibre 

orientations may be visualised. 

  

Notes 

  The native draping functionality in LUSAS is controlled by Draping 

options.accessed via the File > Model Properties menu item (Solution tab). FibreSIM 

and Simulayt draping options can be specified at the xml file import stage (accessed 

via the Attributes > Composite menu item). 

 The Volume xy axes control the local element axes which must lie in the plane of the 

composite lamina. The local element axes may be visualised from the Mesh properties 

dialog. 

The local coordinate defining the drape direction must lie in the xy plane of the drape Surface 

at the start point. 

Defining Composite Layups 

Composite attributes require composite materials to be defined prior to defining composite 

layups. Composite attributes consist of a number of named layers where each layer contains 
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specified material properties, and for certain element types, the angle of fibres and layer 

thickness. Composite layers can be defined using a Normal or a Grid method. Once 

composite attributes have been defined, they are assigned to the model on a feature basis. 

For Solids and Shells and Draped Solids and Shells composites definition the procedure 

described below can be used to define a layup. For FiberSim Draped Solids and Shells 

definition the composite stack will already have been created using a default material and 

volume fraction for all laminae. If required, for this case, the Normal and Grid Tabs can be 

used to modify details for selected laminae. 

Procedure 

The procedure to define a composite layup using the Normal Tab is described, ending with 

details of how the Grid Tab can also be used to check or add layer data. 

1. Define the Layup 

Click on the New button to define a new layer. Enter a unique lamina name, select a 

composite material,and enter thickness and layup angle values. Note that a lay-up sequence is 

defined from bottom to top. The name may given a suitable prefix in the box provided. Click 

the OK button. 

2. Enter details for the next lamina. 

3. Repeat this process for each layer as required.  

If a symmetric layup sequence is to be defined check the Symmetric button. This duplicates 

and reverses the layup sequence previously entered. The Reverse button is used to upturn the 

defined stack so the uppermost layer becomes the bottom layer. The Insert button can be 

used to add layers between existing layers. 

4. Check the Layup sequence 

There are two ways to check the composite layup sequence: 

 Select the Visualise button to display a representation of the defined composite layup. 

If desired this image can be annotated to the screen by clicking on the Create 

Annotation button from the visualise dialog. 

 Select the Grid tab to display the layer properties in grid format. Data may also be 

created or edited using this option. Pressing the Tab key with the cursor sitting in the 

last row and cell of the grid creates a new row populated with the same data as the 

previous row. A right mouse click in a row opens a context menu that allows rows to 

be inserted or deleted. 

Defining Lamina Thicknesses   

The definition of lamina thickness depends upon the element types and model type used. 

 The lamina thicknesses for shell models that have been assigned a geometric thickness 

are relative, not absolute, and represent the proportion of the total thickness (as 

specified by geometric surface properties) apportioned to each lamina. 
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 When assigning a draped layup to a shell model the assignment of geometric thickness 

properties to the shell is not always of use. In these cases, if a geometric property is 

not assigned to the model then the thickness of the assigned laminates is used to 

calculate the corresponding element (and hence geometric) thickness at any point. So, 

in this case the lamina thicknesses would be absolute values. 

 The lamina thicknesses for solid models comprised of pentahedral and hexahedral 

composite elements are relative, not absolute, and represent the proportion of the total 

space that the elements of the volume represent apportioned to each lamina. For these 

models the number of laminate layers must correspond to, or exceed, the number of 

elements through the Volume. Element nodal positions will be moved to correspond 

with laminate boundary positions if the node/laminate layer positions do not coincide. 

 The lamina thicknesses for solid models comprised of tetrahedral composite elements 

are absolute values and represent the actual thickness of each lamina. For these 

models the total of all lamina thicknesses as measured from a tooling surface must 

exceed the space occupied by the tetrahedral elements. 

 For a 'mesh-only' model (a model that has been created by importing a LUSAS 

datafile) the actual thickness of each lamina would be entered, so in this case the 

lamina thickness is absolute. 

Visualisation of Composite Layup 

The orientations and thicknesses for each lamina can be viewed by clicking on the Visualise 

button of the Composites dialog for a particular chosen entry method. This will display a 

layered representation of the composite stack with annotations. This representation may be 

used to create a bitmap annotation by clicking on the Create Annotation button. 

 

Assigning Composite Properties  

The method of assigning composite properties to a model differs according to the type of 

composite definition method used: 
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For the Solids and Shells definition method: 

 The composite attribute created by this method is assigned to selected surfaces or 

volumes of a model by specifying the overall composite orientation. Options for 

orientation are: Local Coordinate, Local Element Axes, Axes From Surface. An angle 

of zero degrees aligns the laminate axis with the x axis from the orientation axes. 

For the Draped Solids and Shells definition method: 

 For solid and shell models the composite attribute needs to be assigned to a draping 

surface. This is done by selecting and placing the Surfaces defining the drape surface 

into selection memory and assigning the composite attribute to the model. 

For the FiberSIM Solids and Shells and Simulayt Solids and Shells definition methods: 

 No assignment to a draping surface is required because the layup data is already 

included and correctly positioned in the FibreSim or Simulayt XML files. However, 

the composite attribute must be assigned to the model to enable visualisation of other 

composite model data. 

If a model has been meshed prior to the assignment of composite properties 

Visualisation of Composites Properties 

To visualise assigned composites properties the surface or volume must be meshed. The 

following composite properties can be visualised: 

 Fibre (ply) directions 

 Draping grid 

 Lamina thickness, Skew angle, Offset layer, Fibre volume fraction 

Visualisation of Fibre (Ply) Directions 

Once assigned to features which have a mesh assigned, the fibre directions of assigned 

composite data can be examined graphically as follows: 

1. Right-click on the Attributes entry in the  Treeview and select Properties.  

2. On the Composite tab, click on Settings and select Visualise ply directions. The x 

and y axes define the warp and weft directions respectively; the item x&y displays 

both directions at the same time.  

Lamina directions can be plotted as an x, y, z or x&y axes at any layer. For solids the axes 

may be placed at the top/bottom or middle of the chosen layer, for shells the axes are placed 
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on the mid surface of the shell element. For details of how to choose a composite layer see 

Setting The Active Composite Layer. 

 Visualisation of Draping Grid  

The draping grid for individual lamina can be examined graphically as follows: 

1. Right-click on the Attributes entry in the  Treeview and select Properties.  

2. On the Composite tab, click on Settings and select Visualise ply directions. Then 

select Draping grid.  

If no mesh has been assigned to a model prior to selecting this option only the draping grid 

(and not the ply directions) will be visualised.  

For details of how to choose a composite layer see Setting The Active Composite Layer. 

Extending the draping grid 

LUSAS Draped Solids and Shells grids are automatically trimmed at Surface boundaries. 

FiberSIM and Simulayt generated grids are not. If required, the draping grid can be extended 

by one grid row to ensure the edges of the component are fully enclosed by the draping grid. 

For FiberSIM and Simulayt grids this is specified at the file import stage (accessed via the 

Attributes > Composite menu item). For LUSAS Draped Solids and Shells grids, this is done 

via the Draping options on the Model Properties dialog. 

 
 

Example of draping grid being  

extended by one row 

Example of draping grid being  

trimmed to a surface boundary 

Visualisation of Other Composite Model Data 

To view other composite model data such as lamina thickness, skew angles, offset layers and 

fibre volume fractions: 

1. With a Contours layer in the  Treeview right-click on Contours.  

2. On the Contour Results tab select the Composites (model) entity and select the 

composite attribute name in the right-hand panel. The fibre volume fraction and skew 

angle (and any other composite modelling options relevant for the model) will appear 

for selection in the Component combo box. 
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Setting the Active Composite Layer  

Composite shell and solid elements have multiple 

layers (laminae) of different materials though their 

thickness. The lamina or lamina name on which 

results or orientation axes are to be viewed is 

chosen by setting that lamina active. A lamina is 

set active by selecting the lamina with the right-

hand mouse button from the  Treeview and 

picking Set Lamina Active or Set Name Active 

from the context menu. A black dot next to a 

lamina indicates the active lamina.. 

If a lamina is set active only results or orientation axes for that lamina in that composite 

attribute will be displayed. If the lamina name is set active, results or orientation axes will be 

displayed for all laminae with that name across all composite attributes. 

When viewing results the material transformation should be used to display stresses on or off 

axis. 

Local Coordinates 

Local Coordinates define coordinate systems that differ from the default global Cartesian 

system. Local coordinates are defined from the Attributes> Local Coordinate menu item 

and have several uses: 

 Geometry Definition Geometry features may be defined in a local coordinate system 

by set the chosen local coordinate active. When a local coordinate is active, all dialog 

entries relating to global X, Y and Z coordinate input use the transformed axis set as a 

basis for input. 

 

 Transforming Nodal Freedoms When assigned to features the effect is to transform 

the degrees of freedom of the underlying element nodes. This has the effect of 

transforming the directions of applied global load and support conditions. In the 

example below, global freedoms are transformed to radial directions by assigning a 

cylindrical coordinate to the Lines around the hole. This method of transforming nodal 

freedoms is only valid for small deflections, since the freedom directions are not 

updated during analysis. 
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 Materials A local coordinate may be used to align orthotropic and anisotropic 

materials. 

 Variations Variations may be defined using functions in terms of a local coordinate. 

 Composites A local coordinate may be used to align composite attributes when they 

are assigned to the model. 

 Element Orientation A local coordinate may be used at the mesh assignment 

stage to orient beam and joint elements. 

 Results Transformation Results can be output relative to a local coordinate. For 

example, this is useful when looking at results on elements when the axes are not 

consistent. 

Local Coordinate Types 

Cartesian, cylindrical and spherical local coordinates are defined by indicating three positions 

in space defining a local xy plane (origin, x axis, xy plane). The type of coordinate chosen 

will dictate how the axes are defined. 

 Cartesian   - Based on standard x, y and z coordinates arbitrarily oriented in space. 

 Cylindrical  - Based on the axes of a cylinder - radius, angle and distance along the 

cylinder axis.  

 For a local cylindrical coordinate 

defined along the z axis a point is 

specified as (r, theta, z), where: 

r is the radius perpendicular to 

the local z axis 

theta is the angle in degrees 

measured from the positive x 

direction of the local xy plane, 

clockwise about the local z axis 

when looking in the positive z 

direction 

z is the distance along the z axis. 
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 For a local cylindrical coordinate 

defined along the y axis a point is 

specified as (r, y, theta), where: 

r is the radius perpendicular to the 

local y axis  

theta is the angle in degrees 

measured from the positive z 

direction of the local xz plane, 

clockwise about the local y axis 

when looking in the positive y 

direction  

y is the distance along the y axis 

 For a local cylindrical coordinate 

defined along the x axis a point is 

specified as (x, r, theta), where: 

r is the radius perpendicular to the 

local x axis. 

theta is the angle in degrees 

measured from the positive y 

direction of the local yz plane, 

clockwise about the local x axis 

when looking in the positive x 

direction 

x is the distance along the x axis 

 Spherical  Based on the axes of a sphere 

defined by a radius, tangential angle and 

angle around a meridian.  

Coordinates of a point are specified as (r, t, 

c), where: 

r is the radius of the sphere on which 

the point lies from the local origin 

t is the angle in degrees measured 

from the positive x direction of the 

local xz plane, clockwise about the 

local z axis when looking in the 

positive z direction  

c is the angle in degrees measured from the positive z axis to the radius line 

Warning. There is no equivalent spherical set in Solver, therefore freedoms cannot be 

transformed using this type of local coordinate system. 
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 Surface local coordinate systems define a local axes which has the x and y axes in the 

plane of the surface and a local z axis normal to the surface. This is useful for 

extruding a volume normal to a surface and assigning supports normal to a surface. 

Surface local coordinates can not be set active. 

Defining Local Coordinates 

Local coordinates are defined from the Attributes> Local Coordinate menu item by 

specifying the local coordinate type and, for Cartesian, cylindrical and spherical types an 

origin and either a rotation about a global plane or a rotation matrix.  

Note. Defining a new coordinate set does not automatically make it the active set, see Using 

Local Coordinates below. 

 Rotation about a global plane specifying angular rotations about the global planes, 

XY, YZ or XZ. When defining coordinate systems using this method, the local x axis 

is oriented parallel to the global X axis and rotated into position using the specified 

angle in the specified plane. 

 Rotation matrix specifying a direction cosine matrix. A Rotation matrix may be 

defined from selected Points by first selecting 3 Points (1st Point defines the origin, 

2nd Point defines the positive direction of the local x axis, 3rd Point defines the local 

xy plane) and clicking the Use button. 

Notes 

 Local coordinate set types cannot be modified. E.g. a Cartesian sets can not be 

changed to a cylindrical or spherical set. 

 Local cylindrical coordinates defined by matrix are always defined with the local z 

axis along the cylinder. 

Visualising Local Coordinates 

The active local coordinate system is defined from the Model Properties Geometry tab or 

from the local coordinate attribute context menu using the Set Active menu item. A black dot 

is shown next to a local coordinate attribute to indicate it is active. 

By default the active coordinate is visualised on the graphics area, this can be switched off 

from the Window properties. Click on the View Axes tab to change the view axes settings. 

Local coordinates assigned to features may be visualised in the same way as all attributes. 
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Loadcases 

Loadcase dependent assignments, analysis control, load 

combinations, envelopes, and loadcase results are displayed 

in the Loadcase Treeview . The active loadcase controls 

which loadcase dependent attributes are visualised in the 

graphics window and which results are displayed. A 

loadcase is set active using its context menu. At least one 

loadcase will always exist in the Treeview. 

Load curves 

For analyses in which the load varies with time (or increment number) load curves may be 

used. When using load curves all loads must be assigned to a load curve instead of a loadcase. 

All other loadcase dependent attributes (support, slidelines etc.) and analysis control is 

assigned to loadcases in the usual way. The analysis control assigned to each loadcase 

determines the time over which the load is applied. The magnitude of the applied load is 

computed from the time dependent function defined within each load curve. Any number of 

loadcases and load curves may be specified within a single analysis. Each load curve is 

assumed to begin at the start of the analysis (t=0). If the input values stat from t=n the load 

curve is assumed to be zero when t<n. 

Results may be manipulated using combinations and envelopes, fatigue loadcases and IMD 

loadcases all of which are added to the  Treeview.  

Creating Loadcases 

New loadcases may be added to the   Treeview in the following ways: 

 By creating a Structural, Thermal, Envelope, Combination, Fatigue or IMDPlus 

loadcase from the Utilities menu. 

 By entering a loadcase name when a load attribute is assigned to a feature on a model.  

 By right-clicking on a Loadcases, Structural or Thermal entry in the   Treeview and 

selecting the New loadcase menu item. 

 By copying and pasting existing loadcases in the   Treeview. 

Adding Gravity Loading to a Structural Loadcase 

As an alternative to defining gravity by specifying and assigning a constant body force to all 

features on a model, gravity can also be added to a model as a property of a structural 

loadcase. This can be done in three ways: 
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 By selecting the the Automatically add gravity to this loadcase option on the dialog 

that is displayed when defining a new loadcase or displayed when editing the 

properties of an existing loadcase. 

 By selecting the Gravity menu item from the context menu for an individual 

loadcase. 

 By selecting the Add Gravity menu item from the context menu of the Structural 

folder in the Loadcase Treeview. This effectively sets gravity loading to be 'on' for all 

structural loadcases in the Treeview regardless of whether they previously had gravity 

loading added or not. For the special case of loadcases having nonlinear controls, 

gravity loading is only added to those loadcases defined with Manual incrementation 

and not to loadcases defined with Automatic incrementation because the latter inherit 

the properties of the preceding defined Manual increment. 

Note. Gravity loading is defined in accordance with the vertical axis direction that was 

specified either initially on the New Model dialog or subsequently on the Vertical Axis dialog 

accessed using the Utilities > Vertical Axis menu item. No visualisation of gravity loading 

on the model is provided for gravity defined as a property of a loadcase. However, the general 

loadcase icon will change to include a loading arrow symbol  to show that gravity is 

included for a particular loadcase. 

Manipulating Loadcases 

General loadcase editing commands are available from the context menu that is activated by 

right-clicking on a loadcase in the   Treeview. The following commands are available: 

 Copy Copies the selected loadcase (including all defined loadcase controls for 

eigenvalue, fourier or nonlinear and transient analysis) in readiness for a paste. 

 Paste Duplicates the copied loadcase and adds it to the bottom of the relevant section 

in the  Treeview. 

 Delete Attribute assignments must be deassigned before a loadcase can be deleted. At 

least one loadcase will always exist in the Treeview. 

 Rename Allow the loadcase title to be modified. Note that loadcases are tabulated in 

the order listed in the  Treeview. 

 Set Active Sets the active loadcase for the current window. 

 Close Results File closes the open results file 

 Deassign Deassigns attributes from the loadcase, by choosing from a list of attribute 

types. 

 Controls Allows the analysis control for a loadcase to be defined.  

Loadcases are solved in the order they appear in the  Treeview (from top to bottom). 

Loadcases may be reordered using drag and drop in the  Treeview. Loadcases can only be 

re-ordered when no results files are loaded. 
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Setting the Active Loadcase 

An important concept is the active loadcase in the current window. The active loadcase is a 

window property, and is the loadcase that all results and visualisations will be generated 

from. This speeds up the process of comparing results and visualising loads and supports as a 

different windows can be used for each loadcase. 

The active loadcase is set from the  Treeview using the context menu. A loadcase icon 

changes from being greyed-out to coloured when made the loadcase is set active. When 

modelling, the active loadcase is denoted by a coloured loading icon. When results are loaded 

the active loadcase is denoted by a coloured contoured results icon. 

Viewing the Assignments in a Loadcase 

Loadcase dependent attribute assignment are displayed in the  Treeview under the loadcase 

to which they have been assigned. The geometry to which an attribute has been assigned may 

be selected by picking Select Assignments from the context menu in the  Treeview. The 

attribute may be visualised for the active loadcase from the context menu using the Visualise 

Assignments item. 

Note: Within a linear analysis, with the exception of loading,  attributes assigned to the first 

loadcase apply to all loadcases in the analysis. For nonlinear and transient analysis many 

attributes may be modified as the analysis progresses. An attribute assigned in a loadcase will 

remain active until it is changed. This means a support assigned in the first loadcase will 

apply to all loadcases unless it is set free in a subsequent loadcase.  

Load Combinations or Envelopes  

Combinations and envelopes can be defined as part of the modelling process prior to carrying 

out an analysis, or after carrying out an analysis. For more details see Combinations and 

Envelopes in the Viewing the Results section. 

Load Curves 

Load curves can be used to describe the variation of the loading in nonlinear, transient and 

Fourier analyses. For example, in a transient problem the loading changes with time, in a 

nonlinear problem the loading level varies with load increment and in a Fourier analysis the 

loading varies with angle. 

Load curves are used to simplify the input of load data in situations where the variation of 

load is known with respect to a certain parameter. An example of this is the dynamic response 

of a pipe to an increase of pressure over a given period. The load curve factor would then 

consist of the variation of pressure with time. 

Creating Load Curve Entries 

New load curve entries may be added to the   Treeview in the following ways: 

 By creating a load curve from the Utilities menu. 
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 By right-clicking on a Loadcases, Structural or Thermal entry in the   Treeview and 

selecting the New load curve menu item. 

 By copying and pasting an existing load curve in the   Treeview. 

Defining Load Curves 

A load curve is defined either using a user defined time vs factor curve, a standard sine, 

cosine or square wave curve, or a variation. 

 Time vs Factor specify values for both in a table on the load curve dialog. 

 Sine, cosine, square wave input values for peak (amplitude), frequency and phase 

angle must be defined along with activation and termination points. 

 Variation A line interpolation variation may be defined from the Utilities> 

Variation> Line menu item. The dependent variable in the variation will represent 

time (or increment number) depending on the type of analysis. The value of the 

variation will be the factor by which to scale the values in the assigned loading 

attribute.  

Load curves scale all loads assigned to them. Therefore, if loads have a different variation of 

load factor with time, several load curves should be used. 

Manipulating Load Curves 

General load curve editing commands are available from the context menu that is activated by 

right-clicking on a load curve in the  Treeview. The following commands are available: 

 Copy Copies the selected load curve (including all defined load curve data) in 

readiness for a paste. 

 Paste Duplicates the copied load curve and adds it beneath any current load curves in 

the  Treeview. 

 Delete Deletes a load curve. Attribute assignments must be deassigned before a 

loadcase can be deleted. At least one loadcase will always exist in the Treeview. 

 Rename modifies the load curve name. 

 Edit changes previously entered load curve data. 

Notes 

 Load curves are only applicable to nonlinear, transient and Fourier analyses. 

 When defining load curves for transient (or nonlinear) analyses the time in all load 

curves must be defined from the start of the analysis. 

 For Fourier analysis the load must only be applied over an angular range of 0 to 360 

degrees. 
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 If the interpolation variable doesn't lie within that specified within the load curve a 

zero load factor will be applied. 

 Only line variations with distance type Actual can be used for defining load curves. 

Evaluating a Load Curve 

Load curves (and variations) may be viewed using the Graph Wizard. 

  

Case Study. Pressurisation of Tanks with Multiple Load Curves 

Two tanks are to be pressurised at different stages of a nonlinear dynamic analysis. This 

will be achieved using two different loadcases and two load curves to vary the loads 

individually. The following procedure outlines the steps required: 

1. Use the Utilities> Load Curve menu item to define two user defined load curves 

which give the correct pressure variation with time. Note that the time is always 

from the start of the analysis. 

2. Use the Attributes> Loading> Structural 

menu item to define a face load attribute 

containing a unit pressure load. Note that the 

pressure value in the load definition will be 

multiplied by the load factor used on the load 

curve associated with it. 

3. Assign the face load to the features in the model, 

selecting the appropriate load curves for each 

tank. The accompanying diagram shows a 

schematic of the tanks under internal pressure 

with their corresponding force versus time graphs. 

4. To set the size and number of time steps right click on Loadcase 1 and choose 

Controls> from the context menu. Pick Nonlinear and Transient and on the 

dialog switch on the Time Domain option and choose Implicit Dynamics from 

the combo. Set the initial time step and response time as required.  

Notes 

Supports should be assigned to the loadcase. If the support conditions are to be modified 

part way through the analysis the response time in the Nonlinear and Transient control 

should be set to terminate at the time the supports are to be modified and a second 

loadcase should be created to which the modified supports are assigned. A Nonlinear and 

Transient control should be then set on this loadcase which terminates at the end of the 

analysis or when a future support is to be modified. 
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Chapter 6 : Utilities 

  

About Model Utilities 

Model utilities differ from model attributes in that they are not intended for assignment to the 

model geometry. A utility, however, may be used in the definition of geometry or attributes, 

or to control an analysis, or to provide a particular functionality, such as to define a load 

combination or produce a report for example. 

Details of the features and use of many of the utilities listed below are provided in other 

relevant chapters of the manual. Annotation utilities, for example, are described in the 

Chapter 2: Using Modeller in the Annotating the Model section. The remainder are described 

in this chapter. 

The complete list of LUSAS utilities (accessed from the Utilities menu) is shown below. 

 Mesh - mesh node measurement, the controlling of automatic remeshing. and saving a 

deformed mesh for re-use in a new analysis 

 Annotation - adding of text, line, bitmap and border annotation to the view window 

 Transformation - moving, mirroring and copying of geometry 

 Heat transfer - specification of thermal gap properties and radiation surfaces 

 Variation- varying attributes over features  

 Reference Path - defines a path along which a set of multiple varying sections can be 

assigned. 

 Loadcase adds a new empty loadcase to the loadcase treeview 

 Load Curve - used to describe the variation of the loading in nonlinear, transient and 

Fourier analyses 

 Envelope - create an envelope of maximum and minimum effects 

 Combination - combine results from different loadcases with different load factors to 

get max and min effects 

 Fatigue - calculate fatigue life and number of cycles to failure 

 IMD Loadcase - create a loadcase for use with interactive modal dynamics 

 IMDPlus - the investigation of various dynamic responses using the results from an 

eigenvalue analysis 

 DesignFactors - assess the reserve strength capacity of a component or structure 
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 Set Fourier Angle - specify the angle around the circumference at which Fourier 

results are required 

 Background Grids - grade the mesh pattern locally when irregular surface meshing 

 Graph Wizard - plot results on x,y graphs 

 Animation Wizard - animate the mode shapes or load history of a structure 

 Section Through 3D - slice a model and plot results on the section defined 

 Slice Resultants Beams/Shells - etc 

 Graph Through 2D - slice a model and plot a graph based upon the intersection of 

the elements sliced.   

 Print  Results Wizard - printing of selected results to a grid or a file. 

 User Defined Results - create results components from user-defined expressions 

 Vertical Axis - sets the model X, Y,or Z direction to be the vertical axis. 

 Direction Definition - sets the vertical, longitudinal and transverse axes for a model 

to assist with model orientation and calculation of particular effects 

 Library Management - specify library locations and add and delete items from a 

library 

 Section Property Calculation - calculate cross sectional geometric properties for a 

range of sections 

 Report Generation - build reports containing model and results data and images from 

your model 

Some utilities, for example Heat transfer, are only listed if the appropriate user interface is in 

use. 

Variations 

Variations allow parameters in attributes to be varied over the assigned geometry by defining 

the manner in which the parameter will vary. If a variation is not specified, the parameters 

within an attribute will be constant over the geometry to which the attribute is assigned. 

Geometric section property variations along a beam are best defined using tapering or 

multiple varying section facilities. 

The different types of variation are available are: 

 Field allowing variations to be defined in terms of the global Cartesian coordinate 

system variables. This form of variation can be used for hydrostatic and wind loading 

and is applicable to all feature types except Points. Variations on volumes are 

limited to field variations. 

 Interpolation variations may be applied to Lines and Surfaces. The variation is 

defined by interpolating between values at specified local distances. The order of the 

interpolation may be specified as constant, linear, quadratic and cubic in either actual 

(local) or parametric distance. 
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 Function variations are expressed as symbolic functions in terms of the parametric 

coordinates of a feature. They can be applied to Lines and Surfaces. For Lines, the 

parametric distance is the distance along the Line (u), and for a Surface the distances 

are the local parametric u and v coordinates. 

 Boundary defines values by specifying variations around the Surface boundary Lines.  

 Grid defines a grid of values in Surface local x and y directions.  

Using Variations 

Variations are defined from the Utilities menu and are presented in the  Treeview. Once 

defined, a variation is used by clicking on the additional input button   in the appropriate 

edit box on the attribute dialogs. This allows each parameter within a single attribute to be 

varied independently. 

Notes 

 It is possible to vary all load types except General Point and Patch loads and Internal 

Beam Point and Internal Beam Distributed loads, which incorporate variable loading 

implicitly in their definition. Values of loads which are applied to elements will be 

evaluated at the element centroid.  

 Geometric attributes containing a variation are tabulated as multiple geometric 

properties. An additional parameter is added to the assignment to relate to the original 

defining attribute number for use in post-processing. 

 To vary geometric properties along bar or beam elements use the geometric beam 

tapering facility.  

 Variations in materials are limited to elastic material values and certain joint 

properties. Attributes containing a variation are tabulated as multiple material 

properties containing the material value calculated at the element centroid. An 

additional parameter is tabulated to the assignment data chapter in the data file to 

relate to the original defining attribute number for use in post-processing.  

 When defining supports the spring stiffness values can be varied but the spring 

stiffness values are not scaled when drawn in post-processing . 

 Checking of the assigned variations can be carried out by contouring the assigned data 

using an unsmoothed contour display. 

 Variations of the Rayleigh parameters cannot be contoured as they are calculated at 

element centroid positions. 

Field Variations 

Field variations allow a variation according to a mathematical expression in terms of 

coordinate variables in either the global Cartesian or a specified local coordinate. 

Coordinates may be Cartesian, cylindrical or spherical. The expression may be cutoff if 

desired. 
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Field variations are applicable to all Lines, Surfaces and Volumes. The value of the variation 

at any position on the structure will be calculated by substituting the values of the coordinate 

variables at that position. 

A field variation is defined by specifying a field expression and an optional local coordinate 

which will be used to specify a coordinate system other than the global Cartesian set. 

These examples show field 

variations expressed in terms of the 

global X coordinate displayed 

along a Line parallel to the global 

X axis. The typical field 

expressions used are shown in the 

boxes next to each diagram. 

For example, a field expression in 

Cartesian coordinates would 

typically be: 

-9.81*y 

and in cylindrical coordinates: 

10+r*tan(thetaz) 

Coordinate Systems in Field Variations 

The functions available in the definition of 

field expressions are listed below. The 

variables used in field expressions are 

limited to those used in the LPI language 

plus the Cartesian, cylindrical and spherical 

coordinate variable names. The coordinate 

variable names that should be used in a field 

expression are dependent on the type of 

coordinate systems in use. Definitions are 

given in the tables below.  

In this example, a field expression referring 

to the global axis coordinates (XY), is also 

used with a local coordinate axis set (indicated by xy) to create a variation relative to a rotated 

system. Cylindrical and spherical axis sets can also be used. 
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Variables 

Cartesian (global/local) Z Cylindrical (local) Z Spherical (local) 

x X ordinate r Radial distance r Radial 
distance 

y Y ordinate thetaz Angle about axis of cylinder thetaz Angle about z 
axis 

z Z ordinate z Distance along cylinder 
longitudinal axis 

thetac Second angle 

Operators 

+  -  *  /  ^ 

Functions 

Trigonometric functions Radians Degrees 

Sine of angle sin(angle) sind(angle) 

Cosine of angle cos(angle) cosd(angle) 

Tangent of angle tan(angle) tand(angle) 

Arcsine of a asin(a) asind(a) 

Arccosine of a acos(a) acosd(a) 

Arctangent of a atan(a) atand(a) 

Arctangent of the specified x- 
and y-coordinates. 

atan2(x,y)   

hyperbolic sine of a sinh(a)   

hyperbolic cosine of a cosh(a)   

hyperbolic tangent of a tanh(a)   
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Function return value   

e raised to the power of a. The constant e equals 2.71828182845904, the base of the natural 
logarithm. 

exp(a) 

natural logarithm of a  log(a) 

logarithm of a to base 10 log10(a) 

square root of a sqrt(a) 

a rounded up, away from zero, to the nearest integer ceil(a) 

a rounded down, towards zero, to the nearest integer floor(a) 

absolute value of a  abs(a) 

maximum value of a and b max(a,b) 

minimum value of a and b min(a,b) 

x to power y pow(x,y) 

remainder of a/b mod(a,b) 

  

Cylindrical and spherical field variation expressions can use radians (default) or degrees to 

specify angles. If trigonometric functions are used in a field expression, they will dictate what 

angular measure is used. For example, a function will use degrees if degree-based 

trigonometric functions, such as sind, cosd and tand are used.  

Notes 

 An expression may not mix radian and degree functions.  

 Any angle cut-off values will use the same units as the expression. 

Maximum and Minimum Cut-Off Values 

Maximum and minimum cut-off values may be 

specified for the chosen coordinate system. This allows 

the range of application of load to be limited, such as 

would be necessary to model a structure not wholly 

submerged in water. These examples (right) show field 

variations in terms of the global X ordinate displayed 

along a Line parallel to the global X axis. The typical 

field expressions used are shown in the boxes next to 

each diagram. All expressions are subject to a cut-off in 

minimum and maximum X at parametric distances of 0.25 and 0.75 respectively. 

This example shows a variation in terms of the global Z axis ordinate with minimum and 

maximum cut-offs at specified Z ordinate values. 
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Case Study. Applying Hydrostatic Loading 

A hydrostatic loading may be modelled using a combination of a field variation and a 

Structural Face Loading. The loading can be considered to be dependent on the depth 

varying as: water density*g*(h-y) where g is the acceleration due to gravity, h is the 

height of the water above the structure origin and y is the height of the structure. Use the 

following procedure: 

1. Define a simple 100 unit square Surface using 

the Geometry> Surface> By Coordinates 

menu item and entering the following 

coordinates (0,0,0), (100,0,0), (100,100,0) and 

(0,100,0).  

2. Define a simple thin shell mesh using the 

Attributes> Mesh> Surface menu item and 

Assign the mesh to the Surface. 

3. Define a field variation using the Utilities> 

Variation> Field menu item and specify a 

function of density*g*(h-y), where density is 

the water density (1000), g is acceleration due to gravity (9.81), h is the maximum 

height of the water above the structure origin (80) and y is the global Cartesian y 

ordinate. This will apply a hydrostatic loading down the depth of the Surface 

(global y axis). Enter 1000*9.81*(80-y) on the dialog.  

4. To model a water depth of 80 (and to avoid negative loading above the surface of 

the water), select a Cut-off in Maximum y at 80. Click on the Advanced button 

and set the maximum second coordinate to 80. Click the OK button. 

5. Name the variation Hydrostatic variation. Click the OK button. 

6. Using Attributes> Loading> Structural menu item, define a Local Distributed 

load entering the Z component as 1, notice that in doing so the additional input 

button   appears. Click on the button and select the variation Hydrostatic 

variation. This will factor a negative unit load using the variation defined in 1. 

Type Water load as the attribute title. Click the OK button. Assign the loading to 

the Surface. 

7. The applied loading with the variation is visualised as arrows on the model. Use 

dynamic rotate  to get a 3D view of the surface. If the load is not visualised, 

select the load attribute in the Treeview , right-click and choose Visualise from 

the context menu. Note. Visualising attribute assignment requires that the model 

is meshed. 
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Line Interpolation Variations 

Line interpolation variations allow values to be varied along a line at any number of 

distances. The distances may be equally or unequally spaced and the interpolation order my 

be constant, line, quadratic or cubic. Line interpolation variations are defined from the 

Utilities> Variations> Line menu item and selecting Type Interpolation. 

 By Equal Distances defines values at 

equal distances along a Line. The 

actual value used will be interpolated 

at the appropriate distance between 

these values using the interpolation 

method specified. 

 

 

 

 

 By Unequal Distances defines values 

at specified distances along a Line. 

The distances can be entered as actual 

or parametric values. The actual value 

used will be interpolated at the 

appropriate distance between these 

values using the interpolation method 

specified. 

The unequal distance examples below 

show user distances specified by 

actual or parametric values (indicated 

in square brackets) with a 

corresponding interpolation value at 

each position. Repeating a distance 

and specifying an additional 

associated interpolation value will 

allow a discontinuity in the variation 

to be defined.  

 

Linear variations require a minimum of two values. Quadratic variations require a minimum 

of three values and Cubic variations require a minimum of four values to be specified. Where 
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more values are specified multiple interpolation functions are used. i.e. if three values are 

specified for a linear variation, two straight line interpolations are used. 

Line Function Variations 

A Line function variation defines a variation by a series of functions specified at distances 

along a Line. The function is specified in terms of the parametric or actual coordinate along 

the Line. The interpolated value of the variation at any position along the Line is calculated 

by finding the interval in which the position occurs and then substituting the parametric or 

local distance into the function. Line function variations are defined from the Utilities> 

Variations> Line menu item and selecting Type Function. 

  

 By Equal Distances [in u] defines 

functions in terms of u, the 

parametric distance along the Line. 

In this example, the Line is split into 

a specified number of distances, each 

with an associated function. 

 By Unequal Distances [in u] defines 

a series of parametric or actual 

distances, and a set of functions. The 

distance specified is the starting position for the function associated with it. Each 

distance must have an associated function specified. To enter a maximum cut-off 

position, associate a zero function with it. In this example, a parametric distance of 0 

is associated with the value 0.0, a parametric distance of 0.33 is associated with u**2 

and a parametric distance of 0.92 is associated with the value 2.0 

Surface Variations 

On Surfaces, interpolation may be defined using a grid of values or a set of line variations 

applied to the boundary Lines. For interpolation by grid the interpolation order may be 

constant, linear, quadratic or cubic. 

 Surface By Grid defines a grid of values in Surface local x and y directions. Surface 

grid interpolation can only be used on 3 and 4 sided Surfaces.  
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 Quadratic vs Constant Surface 

variation 

The quadratic variation in the local x 

direction is specified with three 

interpolation points. The constant 

variation in the local y direction requires 

no additional points. A total of three 

values are required. 

 Cubic vs. Linear Surface grid variation 

The local x direction takes a cubic 

variation defined with four interpolation 

points and the local y direction takes a 

linear variation using three interpolation 

points. A total of twelve values are 

required. 

 Surface By Boundary defines values by specifying variations around the Surface 

boundary Lines. A variation must be specified for each Line in the Surface definition. 

If no variation is required along a Line, a constant order variation must be specified. 

Care must be taken to ensure that values at common points are common to both 

variations meeting at that point otherwise an error will occur. Variations are defined in 

the same direction on opposite sides of the Surface (see the following example) and 

use the Line order in the Surface definition on which to base the variation direction. 

Individual Line directions have no effect on variation directions. 

 Surface boundary interpolation using three Line interpolation variations. 

A discontinuous Line interpolation (1) is 

specified for first and third Lines using a 

Line by unequal distance variation. 

 

Note that the Line axes drawn here dictate 

the variation directions and the line 

directions on opposite sides of a surface 

must match as shown. Variations are 

applied in a positive surface normal 

direction. 

 

The second and fourth Lines in the Surface definition use constant interpolation 

variations. The variation sense is denoted by double and single arrows shown on 

boundary Lines. The variation along the local x axis (signified by the double arrow) is 

specified first. The Surface variation in this case is 1;3;1;2. 
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Surface Function Variations 

A Surface function variation consists of a single 

function in terms of the parametric coordinates of 

the Surface u and v. The value of the variation at 

any point on the Surface is given by finding the 

parametric coordinates of the point within the 

Surface and substituting them into the specified 

function. Surface function variations are only 

allowed for 3 and 4 sided Surfaces. 

The example shown here defines a variation 

using the function max(4,10*u) in terms of the 

local Surface x direction parametric distance. The 

max function takes two arguments and returns the maximum of both arguments. In this case, 

4 is the maximum value until u exceeds 0.4. 

Plotting Graphs of Line & Field Variations 

Line and Field variations can be evaluated along 

a specified Line and displayed using the Graph 

Wizard from the Utilities menu and Line 

variations can be evaluated alone. The number of 

points at which to sample the variation can be 

specified. A factor may be applied to the 

variation values before the ordinates are 

calculated. This example demonstrates the 

graphical visualisation of a discontinuous Line 

interpolation variation. 

Reference paths 

A reference path defines a route through the model that provides a concept of distance to each 

point in the model. Those distances can be used in the definition of a varying section, such 

that when the section is assigned to lines, the path is used to interpret which part of the 

section is appropriate to each line. Bridge engineers refer to this reference path concept as 

'chainage'.  

Once created, the data that defines the path can be viewed in the Utilities Treeview. Like 

other utilities, paths are not directly assignable to geometry and can only be edited by editing 

their properties via their context menu. 
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Uses 

Reference paths are primarily used for line beam models (such as those that are required for 

staged construction analysis) and for use with grid or grillage models where longitudinal and 

transverse beams are modelled with individual grillage or line beam elements. 

Defining paths 

Paths are created by using the Utilities> Reference Path menu item. 

In its simplest form a reference path can be defined as a line between two points (quite 

separate from the model data) if a straight path is to be considered, or be created from the 

model geometry itself and contain as many defining points as the lines from which it has been 

created. If the latter is done it is important to remember that the model geometry has been 

used to arrive at the points required to generate a reference path but no connection between 

the model geometry and reference path data exists. 

Reference paths are usually defined to be along and coincident with beam lines. For clarity it 

is also possible to define reference paths away from beam lines but if the beam lines are not 

straight (perhaps they curve on plan) the path should be defined above the beam lines rather 

than be defined in the same horizontal plane. 

Reference paths can be defined by: 

 Specifying the coordinates of each defining point.  

 Importing geometry and line segment information from a spreadsheet 

 By defining a path from lines, arcs and splines in LUSAS Modeller. 

The way that two adjacent and intersecting reference path lines will be shaped can be 

controlled by smoothing which involves adding a radius transition between two lines inside of 

their defined intersection point or adding a radius transition between two lines through their 

defined intersection point. 

Transverse direction settings control how line attributes containing multiple varying sections 

are assigned to more than one set of lines when using the same common reference path. One 

example of use is for straight or skewed grid or grillage line beam models. For this type of 

modelling a single reference path can be used in conjunction with a transition setting to offset 

multiple tapering section line attributes appropriately for each longitudinal beam member.  

'Value of distance at start of path' can be used specify the local x value at which the path 

should begin. For bridge engineering this equates to specifying a chainage value for a known 

setting-out point. This value is added to the distance value that can be displayed for each of 

the points defining the path. 

Reference paths for 3D line beam models 

For 3D line beam models consisting of multiple longitudinal lines a reference path can be 

used. This allows one multiple varying section geometric line attribute to be assigned to 

multiple lines. The number of line beams required to model the changing section depends 
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upon whether a staged construction analysis will be carried out. For the creation of simple 

models it is possible to assign a multiple varying section line attribute to a single line beam 

without the use of a reference path but for staged construction analysis (where individual 

lines need to be activated and deactivated) the multiple varying section line attribute can be 

assigned to multiple lines with reference to an associated path. See Distance types and 

methods of assignment for more information. 

 
Reference path showing multiple line beams assigned a single multiple varying section 

 (for clarity beam lines have been visualised at top of section) 

Reference paths for 3D grid/grillage-type models 

For grid/grillage models, longitudinal beams are comprised of separate line beams often 

grouped together (for ease of manipulation and assignment of properties etc). Because the 

actual profile of the set of grouped members as a whole may vary along the longitudinal 

beam's length a reference path is used to control the assignment of a multiple varying section 

line attribute to the set of lines. When assigning a geometric line attribute the following 

transverse direction settings are available: 

 Perpendicular to path - the plane of constant distance is normal to the path tangent 

in both local y and z directions 

 Skew angle - is defined as the horizontal angle between the orthogonal plane and the 

plane of equal distance. 

 Local coordinate - as skew angle, but where the skew angle is read from an existing 

local coordinate system. 
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 Perpendicular  Skew angle to path  

  

 
 Local coordinate 

Visualisation of reference paths 

By default, reference paths are drawn in red and points defining the path are labelled with 

their absolute distance along the path of lines. The display of path labels can be turned on and 

off by accessing the Utilities layer properties dialog. Direction arrows, at mid-points along 

each line segment, show the direction of the path. 

Each path entry in the Utilities treeview has a context menu enabling the following selections: 

 Rename changes the path name 

 Delete removes the path entry from the Utilities treeview but the menu item is only 

available if a path has not been associated with a geometric line assignment. 

 Edit Path displays the path definition dialog to enable changes to be made 

 Create geometry converts the path into points, lines, arcs and splines in the Geometry 

layer. 

 Visible turns the display of the reference path on, if off. 

 Invisible turns the display of the reference path off, if on. 

 Visualise at points shows what would happen if the path were associated with other 

lines on the model and requires explaining in more detail. See below. 
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Visualisation of reference path at points on the model 

The reference path context menu option Visualise at points shows the value of the reference 

path distance for other points in the model. It helps to show the validity of using the reference 

path for other lines in the model and in cases where path labels drawn on these other points 

did not match those of the reference path it would, for some situations, draw attention to an 

invalid transverse direction settings being used. Note that currently reference point labels do 

not update if the underlying geometry is updated. 

  
 Perpendicular (orthogonal) grid/grillage  Skewed grid/grillage 

 Examples of valid reference path points visualised on the model 

Influence Attributes 

Influence type, influence direction and displacement direction are used to define an influence 

attribute for use in an influence analysis. These parameters define the type of behaviour of 

the structure at and around an influence point. A Direction definition object containing 

information relating to setting the vertical, longitudinal and transverse axes for a model is 

added to the Influence entry in the Attributes  Treeview once the first influence attribute 

has been defined. 

 



Modeller Reference Manual   

    

272 

Defining Influence Attributes 

Influence attributes are defined from the Attributes > Influence menu item. The influence 

type may be a Shear force, a Reaction, a Moment or a Displacement. A shear or moment 

influence type is mesh dependent. For each influence type the influence direction and 

displacement directions need to be specified. The influence direction defines the axis to be 

used. Once created, an influence attribute is held in the Attributes  Treeview for 

assignment to mesh nodes or Points on a model using the standard select, then drag and drop 

method. 

Assigning Influence Attributes 

One or more nodes or Points on the model may be selected to make an influence point 

assignment. Assigned influences are stored in the Utilities  Treeview. When assigned to 

the model LUSAS automatically determines the break-away elements in each case. Influence 

type symbols may be drawn at each influence location to show the type of mesh break that is 

being used. If a model is re-meshed or has its geometry edited the influence points will 

remain visualised with those influence points still overlying a node or Point remaining 

marked with an appropriate 'break' symbol. Influence points that no longer lie on nodes or 

Points as a result of any modifications remain visualised on screen but with a 'not assigned' 

symbol alongside their name in the Utilities  Treeview. Models can be solved with 

unassigned influences present in the Utilities  Treeview. 

 

Manipulating Influence Attributes and Influence Point 

Assignments 

 Influence attributes are listed in the Attributes  Treeview and assigned influences are 

shown in the Utilities  Treeview. If influence assignments are visualised the whole model 

may be re-displayed after viewing selected influences by right-clicking in the Graphics 

Window and selecting the All Visible option. 
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Writing a Datafile with Influence Attributes 

Once all influence attributes have been assigned to a model, they can be tabulated to a data 

file using the menu option Files> LUSAS DataFile. LUSAS will automatically identify the 

datafile to be one that will require an Influence analysis as opposed to a general analysis and 

as such data file names will be generated from the specified file name and the influence 

number. For example, if the specified file name is bridge, then files bridge1.dat and 

bridge2.dat will be created for influence lines 1 and 2 respectively. An influence analysis can 

also be run from the Civil or Bridge product menu using the Run Influence Analysis option. 

Viewing Influence Surfaces 

After carrying out an influence analysis the deformed shape for each influence point may be 

viewed / checked by adding a deformed mesh layer to the Layers  Treeview and then, in 

the Loadcase  Treeview, setting each loadcase active in turn. 

See Vehicle Load Optimisation for details of how to generate the most adverse loading for 

defined influence surfaces for bridge loading. 

Vertical axis 

The vertical axis dialog is accessed from the Utilities> Vertical Axis  menu item. The 

vertical axis setting specifies whether the model X, Y,or Z direction is to be used as the 

vertical axis. It has the following uses: 

 It is used to determine the direction that gravity loading will be applied if added using 

the Bridge > or Civil > Gravity menu item. 

 It is also used to determine the direction that gravity loading will be applied if it has 

been specified as a property of a loadcase. 

  It is also used to define the initial vertical axis and orientation of element types and 

library items as displayed on the Geometric Line dialog prior to them being added to a 

model. 

 It also defines the model orientation that is viewed when using the isometric, dimetric 

and trimetric views.  

 Note that setting the vertical axis on the Vertical axis dialog will supercede any vertical axis 

setting defined on the Direction definition dialog. 

 Direction Definition 

Specifying a direction definition sets the vertical, longitudinal and transverse axes for a model 

to assist with model orientation and the calculation of particular effects. The Direction 

definition dialog is accessed from the Utilities> Direction Definition menu item. The options 

are: 
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Vertical 

 Global axis  This determines the direction that gravity loading will be applied if added 

using the Bridge > or Civil > Gravity menu item. It also defines the initial vertical 

axis and orientation of element types and library items as displayed on the Geometric 

Line dialog prior to them being added to a model. It also defines the model orientation 

viewed when using the isometric, dimetric and trimetric views.  

Note that setting the vertical axis on the Direction definition dialog will supercede any 

vertical axis setting defined on the Vertical Axis dialog. 

Longitudinal  

 Global axis For the majority of models this will simply be the global X-axis. However 

LUSAS allows generic input of any direction which may even be a complex path 

through or along a structure, such as that defined by a set of lines forming a continuous 

path. 

 Local axis Use a local coordinate set to define the direction. An example of use is for 

aligning influence attributes along a singly curved bridge deck. 

 Follow line path If a path of lines is to be used, selecting the lines to be used prior to 

selecting Utilities > Direction definition will cause the correct line path definition to 

be automatically inserted into the line path field. An example of use is for ensuring 

correct alignment of influence attributes along all spans of a bridge deck when those 

spans are formed of multiple straight lines, arcs or any combined sequence of these 

two feature types in order to describe the carriageway shape. 

Note that a longitudinal direction definition must always be correctly defined for influence 

analysis. 

Transverse  

This is assumed to be orthogonal to both longitudinal and vertical directions. This is currently 

only used for influence analysis. 

Section Property Calculation 

Cross-sectional geometric properties (for use with line beam models) can be calculated for: 

 Standard sections - a range of commonly used section shapes 

 Arbitrary sections - any user-defined cross-sections that are drawn in LUSAS 

Modeller 

 Precast beam sections with and without a concrete slab. 

 Box sections for both simple and complex box sections, with and without an internal 

void.   
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Standard Section Property Calculator 

Standard section property calculators are accessed from the Utilities> Section Property 

Calculator menu item. The following sections are supported: 

 Rectangular solid section - equal and unequal thickness 

 Rectangular hollow section - equal and unequal flange / web thicknesses 

 Circular solid section 

 Circular hollow section 

 I section - equal and unequal flanges, haunch section 

 T section 

 L section - single and double (back to back) 

 C section - lipped, unlipped, double (back to back), double (face to face), top hat 

 Z section - lipped right-angle, lipped inclined, unlipped 

  

Typical standard section property calculator dialog Section visualisation showing fibre 

locations 

Section properties for standard cross-sections are computed instantaneously once valid user-

defined dimensional data has been entered. The resulting section can be optionally visualised 

to check for correct values being entered and to see automatically defined fibre locations (as 

used when plotting stresses on fleshed beams); or be converted into model geometry if the 

section was to be modified in some way inside LUSAS Modeller before re-calculating the 

new section properties of the edited section using an Arbitrary Section Property Calculator; or 

be added to a local or server library for use on the current project or for re-use across other 

projects. 

 To use the computed section properties in a model the section must be saved to a local or 

server library. To add a library item to the Attributes  treeview select the Attributes> 
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Geometric> Section Library menu item, then select User Sections, then select Local or 

Server before choosing the section required from the list available.  

Arbitrary Section Property Calculator 

The arbitrary section property calculator is 

accessed from the Utilities> Section Property 

Calculator> Arbitrary Section menu item. It 

computes the section properties (area, moments 

of inertia and torsion constant) of any open or 

closed section and calculates extreme fibre 

positions for use when plotting stresses on 

fleshed beams. The torsion constant is 

computed using the soap bubble analogy which 

involves running a field analysis using LUSAS 

Solver. This process is carried out 

automatically.  

Cross-sections must be defined in the XY plane and can be created using points and lines, but 

the cross-section must ultimately only contain surfaces that define a single continuous shape. 

Individual surfaces separated by gaps do not form a valid cross-sectional shape for section 

property calculation purposes. Voids or holes in a section must be defined as separate 

surfaces. Any number of voids or holes can be included in a cross section but the section 

shape created must always be continuous. The use of the menu option 

Geometry> Surface> Holes> Create will effectively 'punch' a hole into an existing surface. 

A Boolean subtraction of a smaller surface from a larger surface would also produce the same 

result. Grouping all holes together into a group named Holes is optional for cases where a 

single surface contains one or more holes totally inside its boundaries. Grouping all holes 

together into a group named Holes is essential if a hole exists between two surfaces (See 

diagram). When present, the properties of a group called Holes are automatically deducted 

from the overall section property calculation. 

  

Surface defining a cross-section containing two 

holes 

Two surfaces defining a cross-section with a hole between 

surfaces 
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Automatic meshing is normally used to control the mesh density which in turn is used to 

calculate the section properties. The maximum elements to be assigned to any one line helps 

control the density of the automatic mesh used. 

To use the computed section properties in a model the section must be saved to a local or 

server library. To add a library item to the Attributes  treeview select the Attributes> 

Geometric> Section Library menu item, then select User Sections, then select Local or 

Server before choosing the section required from the list available. The geometric properties 

can then be assigned to the required Line(s) in the model. 

Notes 

 The mesh used to compute arbitrary section properties determines the accuracy of the 

section properties but also affects the computation time. It has been found that a 

reasonable result is achieved if at least two elements are used through thin sections of 

the model. If a finer mesh is required it is recommended that the problem is initially 

set up using the default mesh and then the Automatic Meshing option is switched off 

to allow the mesh to be adjusted. 

 For thin curved sections the shear areas calculations are approximate. 

 Sections constructed of two or more materials can be accommodated using the 

modular ratio approach. Firstly an isotropic field material property attribute is created 

with both the thermal conductivity and the specific heat set to unity and this attribute 

is assigned to surfaces made from the primary material. Further material property 

attributes are then defined for each secondary material with the thermal conductivity 

set to G1/G2 and the specific heat set to E1/E2. 

 

where: 

G1 is the shear module of the primary material.  

G2 is the shear modules of the secondary material. 

E1 is the Young‟s Modulus of the primary material.  

E2 is the Young‟s Modulus of the secondary material.  

 

These material attributes should be assigned to the appropriate surfaces before running 

the arbitrary section property calculator. 

 User-defined beam cross-sections need to have their fibre definitions defined 

manually in order for stress results plots to be created for fleshed beams. 

The use of the arbitrary section property calculator is described further in the worked 

example; Arbitrary Section Property Calculation and Use. See LUSAS Examples Manual. 

Precast Beam Section Generator 

The Precast Beam Section Generator is available for Bridge and Civil & Structural 

software products only. See Application Manual (Bridge, Civil & Structural) for details. 
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Box Section Property Calculator 

The Box Section Property Calculator is available for Bridge and Civil & Structural 

software products only. See Application Manual (Bridge, Civil & Structural) for details. 

Library Management 

Libraries are used to store standard section and materials properties. The location of the 

section and material libraries may be defined from the Utilities> Library Management> 

Library Locations menu item. The local section library is always located in the current 

working (project) directory while the server library may be located anywhere on the computer 

network. 

Add Section to Library 

Basic geometric section properties may be manually added to either the local or server section 

library from the Utilities> Library Management> Add Section menu item. This facility is 

intended primarily for entering section data of an unspecified cross-sectional shape. Section 

property calculators exist for calculating section properties of known cross-sectional shapes. 

Delete Section from Library 

Section properties may be deleted from either the local or server section library from the 

Utilities> Library Management> Delete Section menu item. 
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Chapter 7 : Running 

an Analysis 

  

Preparing the Model for Analysis 

By default, LUSAS will perform a linear static stress analysis. Any other type of analysis 

requires the analysis control to be specified. Analysis controls are properties of loadcases, 

and loadcases are displayed in the Loadcase Treeview . 

The model title and units are defined on the Model Startup dialog. Consistent units must be 

used for all analyses. 

The default solver is the standard frontal solver and is used unless the fast solver option has 

been licensed in which case the fast multi-frontal solver is used. An alternative solver may be 

set from the Solver Options dialog under the Model Properties> Solution tab. 

Solution Options may be set from the Element, Nonlinear and Coupling dialogs under the 

Model Properties> Solution tab.  

Frontal optimisation is not required for the fast multi-frontal solver and is off by default. 

When no optimiser is specified the Sloan optimiser will be used to optimise the front width 

for the standard frontal solver. An alternative optimiser may be selected from Optimiser 

Options dialog under the Model Properties> Solution tab. 

Analysis Types 

LUSAS may be used to numerically model a wide range of engineering problems. The 

following section briefly explains the analysis types available. 

 Linear Analysis is the most common analysis carried out by engineers and unless 

specified otherwise, LUSAS will perform a linear elastic, static analysis or steady 

state field analysis. In these types of analysis multiple loadcases can be 

accommodated but the model geometry and other boundary conditions cannot be 

altered. Linear analysis assumes that: 

 The loads are applied instantaneously and transient effects are ignored.  

 The loaded body instantaneously develops a state of internal stress so as to 

equilibrate the total applied loads.  
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 The structural response is linear, i.e. both the geometric and material response 

are assumed to be linear. 

For other analysis types control parameters must be specified as properties of the loadcase.  

 Nonlinear Analysis is used to model significant changes in geometry, material or 

boundary conditions. Significant geometry deformation may occur due to the applied 

loading. Changes in material may occur due to material yield. Changes in boundary 

conditions may occur due to the lift-off of supports or from changes in contact or 

frictional behaviour. Examples of nonlinear analyses include Creep Analysis and 

Impact Dynamics. 

 Transient analysis is used to carried out analyses over a period of time and is 

progressed in a step-by-step manner, giving results at each time-step. Both Transient 

Dynamic Analysis and Transient Thermal Analysis are available. 

 Eigenvalue Analysis is available to compute the Natural Frequencies of a structure 

or to carry out an Eigenvalue Buckling Analysis in order to estimate the maximum 

load that can be supported by a stiff structure prior to structural instability. 

Eigenvalue Stiffness may also be performed on the stiffness matrix at a selected stage 

of an analysis. This facility can be used in conjunction with a nonlinear analysis to 

predict structural instability or bifurcation points during a geometrically nonlinear 

analysis. 

 Fourier Analysis provides an extended form of axisymmetric analysis where applied 

loading can be considered to be non-axisymmetric when applied using a Fourier 

distribution around the circumference. 

 Thermo-Mechanical Coupled Analysis either performs the thermal and structural 

analyses simultaneously or one after the other with transfer of data between them via 

an additional data transfer file. 

The following analysis types are also possible but the tabulation of the analysis control is not 

fully supported by LUSAS Modeller: 

 Harmonic Response Analysis The behaviour of a structure subjected to vibrating 

loads can be analysed without the need for a full dynamic step-by-step analysis. See 

also Modal Response analysis. 

 Temperature dependent materials The definition of temperature dependent 

materials in a tabular form are supported by LUSAS Solver. See Solver Reference 

Manual for details. 

The following analysis type is also available: 

 Influence Analysis An influence line analysis produces a deformed shape which 

shows the variation of a chosen function (reaction, axial force, shear force, or bending 

moment) at any given point on a structure due to the application of a unit load at any 

point on the structure. In LUSAS the presence of assigned influence attributes on a 

model determines that an influence analysis will automatically be carried out. 
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About Nonlinear Analysis 

What is Nonlinear Analysis? 

Linear finite element analysis assumes that all materials are linear elastic in behaviour and 

that deformations are small enough to not significantly affect the overall behaviour of the 

structure. Obviously, this description applies to very few situations in the real world, but with 

a few restrictions and assumptions linear analysis will suffice for the majority of engineering 

applications.  

The following indicate that a nonlinear finite element analysis is required: 

 Gross changes in geometry 

 Permanent deformations 

 Structural cracks 

 Buckling 

 Stresses greater than the yield stress 

 Contact between component parts 

Three types of nonlinear analysis may be modelled using LUSAS: 

 Geometric Nonlinearity e.g. large deflection or rotation, large strain, non-

conservative loading. 

 Boundary Nonlinearity e.g. lift-off supports, general contact, compressional load 

transfer, dynamic impact. 

 Material Nonlinearity e.g. plasticity, fracture/cracking, damage, creep, volumetric 

crushing, rubber material. 

The LUSAS analysis types within which nonlinear geometric and material effects may be 

incorporated are shown in the following table: 
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Analysis Type 
   

Geometric Nonlinearity  
   

Material Nonlinearity  

Static 
  

yes 
  

yes 

Dynamic 
  

yes 
  

yes 

Thermo mechanical 
  

yes 
  

yes 

Creep 
  

yes 
  

yes 

Natural Frequency 
  

yes 
  

yes 

Eigenvalue Buckling 
      

  

Spectral Response 
  

  
  

  

Harmonic Response 
  

  
  

  

Fourier Analysis 
  

  
  

  

Field or Thermal       yes 

 

Geometrically Nonlinear Analysis 

Geometric nonlinearities arise from significant changes in 

the structural configuration during loading. Common 

examples of geometric nonlinearity are plate structures which 

develop membrane behaviour, or the geometric bifurcation 

of truss or shell structures. The changing application of loads 

or boundary conditions are also geometrically nonlinear 

effects. The figure below shows two simple structural 

examples which serve as good illustrations of geometrically 

nonlinear behaviour. 

For the simply supported beam (top) the linear solution would 

predict the familiar simply supported bending moment and 

zero axial force. In reality as the beam deforms its length 

increases and an axial component of force is introduced.  

For the loaded strut (bottom) the linear solution would fail to 

consider the progressive eccentricity of the vertical load on 

the bending moment diagram.  

In both these cases depending on how large the deflections 

were, serious errors could be introduced if the effects of nonlinear geometry were neglected. 
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In LUSAS geometric nonlinearity is accounted for using four basic formulations: 

 Total Lagrangian 

 Updated Lagrangian 

 Eulerian 

 Co-rotational 

These are defined from the Model Properties> Solution - Nonlinear Options tab. All four 

formulations are valid for arbitrary large deformations. In general, if rotational degrees of 

freedom are present, rotations must be small for Total Lagrangian. An exception to this rule is 

the Total Lagrangian formulation for thick shell elements where large rotations may be 

applied. Large rotations are allowed for Updated Lagrangian (provided that they are small 

within each load increment) or Eulerian. The co-rotational formulation is unconditionally 

valid for large rotations and results are generally independent of load step size. 

All formulations are valid for small strains. For some elements the Updated Lagrangian 

formulation is valid for moderately large strains. The Eulerian formulation is also generally 

valid for moderate strains. In general, the Total Lagrangian is a more robust formulation, 

which is usually able to cope with substantial load increments. The Updated Lagrangian, and 

particularly Eulerian, formulations generally require smaller load increments in order to avoid 

a divergent solution. 

Standard geometrically nonlinear formulations account for the change in position of the 

loading, but not the change in direction relative to the deformed configuration. Loading is 

always conservative for the Total Lagrangian geometrically nonlinear formulations (that is, 

the load is always applied in the same direction as was initially prescribed). Using an Updated 

Lagrangian formulation, the geometry is updated at the end of each increment and the applied 

loads may maintain the same relative orientation as to the original surface (depending on 

element and load types). Therefore non-conservative loading can be increment size 

dependent. True non-conservative loading may only be achieved by using the Eulerian and 

co-rotational formulations. 

The choice of particular formulations is both problem and element dependent (the element 

formulation determining which strain formulations are available). The availability of each 

formulation is given for each element in the Element Reference Manual. For further details 

regarding the geometrically nonlinear formulations refer to the Theory Manual. 
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Nonlinear Boundary Conditions 

Deformation dependent boundary condition models account for the 

modifications to the external restraints resulting from support lift-off, 

or smooth or frictional contact within an analysis. Within LUSAS node 

on node contact may be accounted for using joint elements and 

arbitrary contact may be accounted for using slidelines. 

Consider the simple example shown in the figure right in which the 

structure and its supporting surface can resist being pushed together, 

but not being pulled apart. The required contact condition may be 

imposed by using joint elements to connect between the structure and 

the rigid support, and specifying a nonlinear contact joint model 

incorporating large and zero local stiffness in compression and tension 

respectively. 

 

Materially Nonlinear Analysis 

Materially nonlinear effects arise from a nonlinear constitutive model (that is, progressively 

disproportionate stresses and strains). Common examples of nonlinear material behaviour are 

the plastic yielding of metals, the ductile fracture of granular composites such as concrete, or 

time-dependent behaviour such as creep. 

LUSAS incorporates a variety of nonlinear constitutive models, covering the behaviour of the 

more common engineering materials. Details of these material models and their applicability 

to each LUSAS element are described in About Material Properties which should be read in 

conjunction with the Element Reference Manual. 

Nonlinear Solution Procedures 

For nonlinear analysis, since it is 

no longer possible to directly 

obtain a stress distribution which 

equilibrates a given set of external 

loads, a solution procedure is 

usually adopted in which the total 

required load is applied in a 

number of increments. 

Within each increment a linear 

prediction of the nonlinear 

response is made, and subsequent 

iterative corrections are performed 

in order to restore equilibrium by 

the elimination of the residual or 

out of balance forces. 
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The iterative corrections are referred to some form of convergence criteria which indicates to 

what extent an equilibrium state has been achieved. Such a solution procedure is therefore 

commonly referred to as an incremental-iterative (or predictor-corrector) method shown 

in the figure above. In LUSAS, the nonlinear solution is based on the Newton-Raphson 

procedure. The details of the solution procedure are controlled using the nonlinear control 

properties assigned to loadcase. 

For the analysis of nonlinear problems, the solution procedure adopted may be of significance 

to the results obtained. In order to reduce this dependence, wherever possible, nonlinear 

control properties incorporate a series of generally applicable default settings, and 

automatically activated facilities. 

Iterative Procedures 

In LUSAS the incremental-iterative solution is based on Newton-Raphson iterations. In the 

Newton-Raphson procedure an initial prediction of the incremental solution is based on the 

tangent stiffness from which incremental displacements, and their iterative corrections may 

be derived. 

Standard Newton-Raphson Procedure 

In the standard Newton-Raphson procedure each iterative calculation is always based upon 

the current tangent stiffness. For finite element analysis, this involves the formation (and 

factorisation) of the tangent stiffness matrix at the start of each iteration. 

Although the standard Newton-Raphson method generally converges rapidly, the continual 

manipulation of the stiffness matrix is often expensive. The need for a robust yet inexpensive 

procedure therefore leads to the development of the family of modified Newton-Raphson 

methods. 

Iterative Acceleration (Line Searches) 

A slow convergence rate may be significantly improved by employing an iterative 

acceleration technique. In cases of severe and often localised nonlinearity, encountered 

typically in materially nonlinear or contact problems, some form of acceleration may be a 

prerequisite to convergence. 

In LUSAS, iterative acceleration may be performed by applying line searches. In essence, 

the line search procedure involves extra optimisation iterations in which the potential energy 

associated with the residual forces at each iterative step are minimised. Line search 

application is controlled via parameters on the Iteration section of the Nonlinear Control 

properties. 

The selection of line search parameters is problem dependent and largely a matter of 

experience. However, a maximum of 3 to 5 line search iterations with a tolerance of 0.3 to 0.8 

is usually sufficient (the closer the tolerance is to unity, the more slack the minimum energy 

requirement). 
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Separate Iterative Loops 

In problems where both material and contact nonlinearities are present, convergence 

difficulties can arise when evaluating material nonlinearities in configurations where the 

contact conditions are invalid because the solution is not in equilibrium. To avoid this 

situation contact equilibrium can be established using elastic properties from the previous 

load increment before the material nonlinearity is resolved. The option to define separate 

iterative loops is defined on advanced solution strategy dialog which can be found on the 

nonlinear control dialog. 

See the Theory Manual for further details. 

Incremental Procedures 

For the Newton-Raphson solution procedures it is assumed that a displacement solution may 

be found for a given load increment and that, within each load increment, the load level 

remains constant. Such methods are therefore often referred to as constant load level 

incrementation procedures. 

However, where limit points in the structural response are encountered (for example in the 

geometrically nonlinear case of snap-through failure) constant load level methods will, at 

best, fail to identify the load shedding portion of the curve and, at worst, fail to converge at all 

past the limit point. The solution of limit point problems therefore leads to the development 

of alternative methods, including displacement incrementation and constrained solution 

methods. 

Constrained Solution Methods (Arc-Length) 

Constrained methods differ from constant level methods in that the load level is not required 

to be constant within an increment. In fact the load and displacement levels are constrained to 

follow some pre-defined path. 

In LUSAS two forms of arc-length method have been implemented: 

 Crisfields modified arc-length procedure in which the solution is constrained to lie on 

a spherical surface defined in displacement space. For the one degree of freedom case 

this becomes a circular arc. 

 Rheinboldts arc-length algorithm which constrains the largest displacement 

increment (as defined by the predictor) to remain constant for that particular 

increment. 

The use of the arc-length method has the following advantages over constant load level 

methods 

 Improved convergence characteristics 

 Ability to detect and negotiate limit points 
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In LUSAS, control of arc-length solution procedures is via the Incrementation section of the 

Nonlinear Control properties. If required, the solution may be started under constant load 

control, and automatically switched to arc-length control based on a specified value of the 

current stiffness parameter (defined as the scaled inner product of displacements and loads). 

The required stiffness parameter for automatic conversion to arc-length control is input in the 

Incrementation section of Nonlinear Control properties. 

Where limit points are encountered LUSAS will automatically determine the sign of the next 

load increment by the sign of the determinant of the stiffness matrix. This is a reliable 

method in most cases, however, it will often fail in the vicinity of bifurcation points when 

negative eigenvalues may cause premature unloading. In such cases the load reversal criteria 

may be optionally changed to be dependent on the sign of the current stiffness parameter. 

This method is better at coping with bifurcation points, but will always fail when a snap-

back situation is encountered. 

Note. In certain circumstances, notably in the presence of strain-softening, the arc-length 

method may converge on alternative, unstable equilibrium paths. 

Bracketing Critical Points And Branch Switching 

Bracketing can be used to locate a limit or bifurcation point during a geometrically nonlinear 

analysis. The nonlinear analysis is executed and one of three methods is used to isolate the 

first critical point. 

 Bi-section 

 Interpolation 

 Riks semi-direct approach 

Two further options for the bracketing procedure exist depending on whether the material 

response is elastic (reversible) or plastic/path dependent (irreversible). Only the first critical 

point can be processed and a subsequent eigenvalue analysis must be invoked to determine 

whether the critical point encountered is a limit or bifurcation point. A limit point may be 

defined as the point at which load starts to decrease as displacements increase (e.g. the snap 

through of a shallow arch). In this instance the structure may not have failed completely and 

could subsequently still be capable of carrying more load. A bifurcation point indicates that 

the solution of the nonlinear differential equations has encountered an alternative unstable 

solution path or paths which may be followed instead of the stable equilibrium path. The 

branch switching procedure must then be undertaken if an unstable equilibrium path is to be 

followed. 

The branch switching procedure should only be carried out within a restart analysis after 

bracketing has been successfully completed. Two options exist for guiding the solution onto a 

secondary path. 

 Eigenmode injection 

 Artificial force and Rheinboldts arc 
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Incremental Loading 

Incrementation for nonlinear problems may be specified in four ways: 

 Manual Incrementation where the loading data in each load increment is specified 

separately. 

 Automatic Incrementation where a specified loadcase is factored using fixed or 

variable increments. 

 Mixed Incrementation Mixed manual and automatic incrementation. 

 Load Curves where the variation of one or more sets of loading data is specified as a 

graph of load factor vs. load increment or time step. 

The choice and level of incrementation will depend on the problem to be solved. 

Automatic Load Incrementation 

Two methods of automatic incrementation are available: 

 Uniform Incrementation By default, uniform incrementation will be applied. That is, 

for each increment the current load factor will be multiplied by the specified load 

components to generate the applied load.  

 Variable Incrementation Alternatively, variable incrementation may be requested. In 

this case the current load factor will be automatically varied according to the iterative 

performance of the solution. The variation is a function of the required number of 

iterations and a specified desired iterative performance. Thus, where the number of 

iterations taken is less than the desired value the incremented load factor will 

subsequently be increased, and conversely, if the number of iterations is greater than 

the desired value, it will be decreased. Variable incrementation may be used in 

conjunction with either constant load level or arc-length solution methods and is an 

effective way of automatically adapting the performance of the solution procedure to 

the degree of nonlinearity encountered. The overall effect is therefore to increase and 

decrease the numerical effort in the areas of most and least nonlinearity respectively. 

Mixing Manual And Automatic Incrementation 

If required, manual and automatic incrementation procedures may be mixed freely. When 

mixing manual and automatic incrementation the following rules apply: 

 Loadcases may be respecified as often as required. 

 If the automatic procedure is specified, it will continue until one of the termination 

criteria is satisfied. 

 In switching from manual to automatic control, any loading input under the manual 

control is remembered and held constant, while the automatic procedure is operating. 
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 In switching from automatic back to manual control, any loading accumulated under 

automatic control is forgotten and must be input as a manual loadcase if required. 

 If prescribed displacements are being used, then in any switching from one type of 

control to another, the effect of prescribed displacements will be remembered and will 

not need to be input again. 

Automatic Increment Reduction 

Where an increment has failed to converge within the specified maximum number of 

iterations it will be automatically reduced and re-applied. This will be repeated according to 

values specified in the step reduction section (Advanced Nonlinear Incrementation 

Parameters dialog) until the maximum number of reductions has been tried. In a final attempt 

to achieve a solution the load increment is then increased to try and step over a difficult point 

in the analysis. If after this the solution has still failed to converge the solution terminated. 

Solution Termination 

When using manual incrementation, the solution will automatically terminate following 

execution of one increment. With automatic incrementation, the solution progresses one 

Nonlinear Control chapter at a time. The finish of each Nonlinear Control chapter is 

controlled by its Termination parameters. 

Termination may be specified in 3 ways: 

 Limiting the maximum applied load factor. 

 Limiting the maximum number of applied increments. 

 Limiting the maximum value of a named freedom. 

Where more than one criteria is specified, termination will occur on the first criteria to be 

satisfied. 

Failure to converge within the specified maximum number of iterations will either result in a 

diagnostic message and termination of the solution or, if automatic incrementation is being 

used, a reduction of the applied load increment. If required, the solution may be continued 

from an unconverged increment (Option 16, 17), although the consequences of such an action 

should be appreciated. 

In addition, the solution will be terminated if, at the beginning of an increment, more than two 

negative pivots are encountered during the frontal elimination phase. 

Use of Load Curves 

Load curves are used to simplify the input of load data in situations where the variation of 

load is known with respect to a certain parameter. An example of this could be the dynamic 

response of a pipe to an increase of pressure over a given period. The load curve would 

consist of the definition of the load and its variation with time. 
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Nonlinear Solution Convergence Criteria 

The convergence criteria specifies to what extent the numerical iterative procedure has 

reached the true equilibrium state. The specification of convergence therefore involves two 

considerations: 

 Type of convergence criterion. 

 Convergence tolerance. 

The types of convergence criteria incorporated in LUSAS are as follows: 

 Absolute residual norm 

 Root mean square residual norm 

 Displacement norm 

 Residual force norm 

 External work norm 

 Incremental displacement norm 

The convergence tolerance for each criteria is specified in the Solution parameters and 

advanced solution parameters section of the Nonlinear Control properties. The selection of a 

convergence criteria, and the associated tolerance, is problem dependent. However, the 

following points should be considered: 

Clearly, the convergence criteria must not be too slack so as to yield an inaccurate solution, 

nor too tight so as to waste computer time performing unnecessary iterations. In general, 

sensitive geometrically nonlinear problems require a tight convergence criteria, whereas with 

predominantly materially nonlinear problems, larger local residuals may be tolerated. 

Where more than one criteria has been specified, convergence will be assumed only on the 

satisfaction of all specified tolerances. 

The following considerations apply to individual convergence parameters: 

 Absolute Residual Norm is of limited use owing to its dependence upon the units 

being used. It is a strict criteria and for some problems, especially those involving 

plasticity, it may be very difficult to reduce locally large residuals. However, in 

sensitive geometrically nonlinear problems near bifurcation points, it can sometimes 

be necessary to ensure that large residuals are completely eliminated. 

 Root Mean Square Residual Norm is the square root of the average of the squares of 

the residual forces and is generally more applicable than the above, but is still 

dependent upon the units being used. 

 Displacement Norm is the sum of the squares of all the iterative displacements as a 

percentage of the sum of the squares of the total displacements and is a useful measure 

of how much the structure has moved during an iteration. Being a scaled norm it is not 

affected by units but convergence is not guaranteed. Typical values of slack and tight 

norms are (5.0 - 1.0) and (0.1 - 0.001) respectively. 
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 Residual Force Norm is the sum of the squares of all the residual forces as a 

percentage of the sum of the squares of all the external forces. This is the most 

versatile of the five criteria. Typical slack and tight values are (10.0 - 5.0) and (0.1 - 

0.00001) respectively. 

 External Work Norm is the work done by all the residuals acting through the 

iterative displacements, as a percentage of the work done by the loads on iteration 

zero of the increment. Since all freedoms are considered it is very versatile (the 

default displacement and force norms consider only the translational freedoms). 

However, it should be noted that a minimum detected potential energy need not 

necessarily coincide with the equilibrate state. Typical values of slack and tight norms 

are (0.1 - 0.001) and (10-E6 - 10-E9) respectively. 

 Incremental Displacement Norm is the sum of the squares of all the iterative 

displacements as a percentage of the sum of the squares of the total displacements for 

the increment. This norm is an incremental form of the total displacement norm 

previously described and the same comments regarding usage apply. 

Nonlinear Output Control 

Nonlinear analyses may generate a vast amount of output. In addition to the normal nodal and 

element output controls, the frequency of nonlinear solution output may be restricted via the 

Output section in the Nonlinear Control properties. 

The restart output facility enables failed or terminated analyses to be restarted from the last 

saved restart output dump. This is particularly useful where the termination of the analysis 

was due to a failure of the solution process rather than that of the structure. In this way, the 

solution may be restarted from the last converged increment with a different or modified 

solution strategy. For example, a failed increment may be restarted under either constant load 

or arc-length control. Restarts are not supported by LUSAS Modeller and hence must be 

defined directly in a LUSAS Solver data file. 

The Nonlinear Logfile 

During the course of a nonlinear analysis, various information is output to the screen or 

logfile, so that you may assess the performance of the solution. For more information refer to 

the Solver Reference Manual. 

Creep/Viscoelastic Analysis  

Nonlinear viscous behaviour occurs when the relationship between stress and strain is time 

dependent. The viscous response is usually a function of the material properties, stress, strain 

and temperature history. Unlike time independent plasticity where a limited set of yield 

criteria may be applied to many materials, the viscous response differs greatly for different 

materials. 

A creep/viscoelastic analysis may be carried out using a linear or nonlinear material model 

within a nonlinear, transient dynamic or thermo-mechanically coupled analysis. When carried 

out in a nonlinear analysis inertia effects are neglected and the time component is introduced 
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using viscous control. When using viscous control, automatic time step calculations are only 

available when creep is included in the analysis. 

 Creep material properties are defined using the Attributes> Material> 

Isotropic/Orthotropic menu item. 

 Viscoelastic material properties are defined using the Attributes> Material> 

Isotropic/Orthotropic menu item. 

Eigenvalue Analysis 

An Eigenvalue extraction analysis is the extraction of the natural modes of vibration of a 

structure, or a natural frequency analysis. It can also be used to solve the following problems: 

 Buckling load analysis A linear analysis which may be applied to relatively „stiff‟ 

structures to estimate the maximum load that can be supported prior to structural 

instability or collapse. 

 Stiffness analysis Used to perform an eigenvalue analysis of the stiffness matrix at a 

selected stage of an analysis. This facility may be used in conjunction with a 

nonlinear analysis to predict structural instability or bifurcation points during a 

geometrically nonlinear analysis. 

 By including Modal Damping, the overall damping factors for each mode can also be 

printed as a table in the LUSAS Solver output file. These values may then be used in a 

dynamic or spectral (harmonic/IMD) analysis if desired. 

Solving an Eigenvalue Problem 

Solving an Eigenvalue problem requires setting the Eigenvalue control properties for a 

particular loadcase.  

In LUSAS, the following methods for eigenvalue extraction are available (described below): 

 Subspace Iteration (Jacobi and QL solvers) The objective of the subspace iteration 

algorithm is to solve for a specified number of the lowest or highest eigenvalues and 

corresponding eigenvectors.  

 A Guyan Reduction eigenvalue analysis may also be performed in conjunction with 

the subspace iteration method. 

 Inverse Iteration with Shifts The inverse iteration method allows the computation of 

the eigenvalues and corresponding eigenvectors within a specified eigenvalue range of 

interest.  

 Lanczos Derived from the same principles as the subspace iteration method, but 

significantly faster, although convergence is not guaranteed. As well as calculating an 

eigenvalue range, as with the inverse iteration method, it is also able to calculate the 

minimal and maximal eigenvalues.  
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Having calculated all the required eigenpairs, the solution is completed by calculating error 

estimates on the precision with which the eigenvalues and eigenvectors have been evaluated, 

and normalising the eigenvectors according to a user-specified criterion.  

For further details regarding the operation of the eigenvalue extraction facility, refer to the 

Theory Manual. 

Subspace Iteration 

The first step in the subspace iteration procedure is to establish the number of starting 

iteration vectors. This should be greater than the number of required eigenvalues to increase 

the rate of convergence. It is important to remember that the number of starting iteration 

vectors cannot exceed the number of degrees of freedom of the system. Experience suggests 

that the number of starting vectors should be determined from the expression: 

nivc = min (2*nroot, nroot+8, nvbz ) 

where  

nivc is the number of starting iteration vectors.  

nroot is the required number of eigenvalues.  

nvbz the number of degrees of freedom in the structure.  

Occasionally insufficient eigensolutions are computed in the initial eigenvalue analysis. The 

number of eigensolutions can be increased by using a restart and re-specifying the Eigenvalue 

control. This second eigenvalue analysis utilises the previous results in order to compute the 

extra eigensolutions thus saving on computational effort. Note that this option is not available 

with the Fast Lanczos solver, although repeated eigenvalue analyses may be performed 

during a run by re-specifying the eigenvalue control. 

Convergence Of Subspace Iteration 

As the procedure iterates it is necessary to refer the numerical solution to a criterion with 

which to measure its convergence. It is assumed that the eigensolution has converged on 

iteration k when: 

 

for all eigenvalues i. 

Starting Vectors for Subspace Iteration 

The first step of the subspace iteration method is the computation of the starting iteration 

vectors. Two methods of constructing these starting vectors are available in LUSAS. One 

method is based on the observation that the vectors should be constructed to excite the 

degrees of freedom associated with a large mass and a small stiffness. Alternatively, the 

starting iteration vectors can be obtained by using the solution from a Guyan reduction 

analysis. This method allows you greater freedom in selecting the starting iteration vectors. 

The starting vectors are defined by specifying master freedoms within the retained freedoms 
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(as for a Guyan reduction analysis). Then the eigenvalue control properties are used to control 

the eigenvalue extraction but a Guyan reduction analysis is carried out automatically prior to 

the subspace iteration algorithm which uses the approximate eigensolution from the Guyan 

reduction as the first estimate of the exact solution. 

By making the correct assumptions and approximations it can be shown that a Guyan 

reduction analysis produces the same results as the first iteration of the subspace method with 

the starting iteration vectors as constructed by the first method; details of this can be found in 

the Theory Manual. 

Using Eigenvalue Shifts 

An important procedure that may be used in eigenvalue extraction is shifting. If rigid body 

modes are present in the system, the stiffness matrix will be singular, hence causing 

numerical problems in the subspace iteration and the Guyan reduction algorithms. To 

overcome this a shift may be applied to form a modified stiffness matrix, of which the 

associated eigenvalues will all be positive. To obtain the actual eigenvalues the shift is 

automatically subtracted from the calculated eigenvalues. The eigenvectors for both systems 

are the same. 

The frequency shift enables the eigenvalues of unrestrained structures to be computed by 

removing the zero diagonal terms from the stiffness matrix. The convergence rate of the 

iterative eigenvalue solution procedure will increase with a smaller shift provided the shift is 

large enough to avoid numerical problems. 

Guyan-Reduced Eigenvalue Extraction 

Good finite element approximations to low frequency natural vibrations may often be 

obtained by considering only those freedoms whose contribution is of most significance to the 

oscillatory structural behaviour. This characteristic may be utilised in the condensation of the 

full discrete model to a reduced system, in which the remaining equations adequately 

encompass the required vibration modes. Such a procedure is often termed Guyan reduction, 

and may be used to significantly reduce the overall problem size. 

In a Guyan-reduced eigenvalue extraction, the stiffness contribution of those freedoms whose 

inertia effect is considered insignificant (designated the slave freedoms), are condensed from 

the system. The reduced equation system is therefore dependent on those freedoms remaining 

(designated the master freedoms). The resulting eigenvectors of the reduced problem are 

linear approximations to the true eigenvectors. 

Guyan-reduced eigenvalue extraction is specified from the advanced dialog of the eigenvalue 

control properties. 

Selecting The Master Freedoms 

Master freedoms may be specified in one of three ways: 

 Manually Using the attribute Retained Freedoms. 



  Chapter 7 

    

295 

 Automatically Alternatively, a specified number of master freedoms may be 

automatically generated by setting the Eigenvalue properties (Advanced button). The 

generated master freedoms will be automatically selected such that the highest 

stiffness to mass ratios of the associated structural freedoms are used. 

 Mixed manual and automatic Where manual and automatic master selection is 

combined, the specified number of automatic masters will be automatically selected 

from the available free equations. 

The effective selection of the master freedoms is central to the accuracy of the simulated 

structural response. In the selection of the master freedoms, the following points should be 

considered: 

 The master freedoms must accurately represent all the significant modes of vibration. 

 Master freedoms should exhibit high mass to stiffness ratios. Hence rotational 

freedoms are usually inappropriate masters. 

 Master freedoms should, where appropriate, be as evenly spaced throughout the 

structure as is appropriate. 

 The ratio of master to slave freedoms should generally be within the range 1:2 to 1:10. 

 Poor selection of the master freedoms will have a detrimental effect on the accuracy 

of the solution especially at higher frequencies. 

Sturm Sequence Check 

When extracting eigenvalues it is important to verify that the computed eigenvalues constitute 

a continuous set, and that intermediate eigenvalues are not missed. To do this the Sturm 

sequence check is invoked; this may be switched off by setting the appropriate parameter on 

the eigenvalue control properties. All eigensolutions present are searched for, unless you 

request a smaller number of solutions by specifying the number of eigenvalues (note that in 

this case, the eigenvalues returned will not necessarily be the lowest in the range, unless the 

Fast Lanczos solver is used). A number of shift points are set up from which the 

eigensolutions are computed. These are determined by the maximum number of 

eigensolutions (system parameter MEIGSH) that can be located from each shift point. Shift 

points may be altered automatically in order to improve the rate of convergence. 

Eigensolutions are computed from each shift point in turn until all eigensolutions have been 

located. 

Note. By including Modal Damping, the overall damping factors at the eigenmodes can also 

be output as a table in the LUSAS Solver output file. These values may then be used in a 

Dynamic analysis if desired. Modal damping is only applicable to a Frequency analysis. 

Inverse Iteration With Shifts 

Eigenvalue extraction by inverse iteration may be utilised when calculating an eigenvalue 

range or frequency range. 
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This method uses a series of shift points from which to extract the eigensolutions using the 

inverse iteration method. The convergence to each eigensolution is governed by the closeness 

of the eigenvalue to the shift point and the method is thus efficient for locating the 

eigensolutions within narrow bands. 

Convergence Of Inverse Iteration 

As the procedure iterates it is necessary to refer the numerical solution to a criterion with 

which to measure its convergence. For inverse iteration it is important that the eigenvectors as 

well as the eigenvalues are computed to some degree of accuracy. The convergence criteria 

for the inverse iteration scheme is therefore based upon the mass orthogonality tolerance: 

 i j  

for all eigenvectors i and global mass matrix M. 

Lanczos 

When convergence is achieved, the Lanczos eigenvalue solver is usually faster than the 

subspace or inverse iteration solvers, and can use significantly less physical memory and hard 

disk than subspace methods. For these reasons it is ideal for large numbers of requested 

eigenvalues, and for large problems, although convergence cannot be guaranteed. The 

maximum number of Lanczos steps to be taken is set to 100 by default, but can be altered, 

and should always be greater than the number of modes requested. 

Fast Lanczos 

The Fast Lanczos solver is both faster and much more robust than the original Lanczos 

solver, and is the recommended solver of choice for all eigenvalue analyses. 

Centripetal Stiffening Effects 

In rotating machinery, load correction terms that arise from the effects of rotation may 

significantly influence the natural frequencies of vibration. Within LUSAS the load 

correction terms due to centripetal acceleration can be considered. 

The load correction terms, due to Coriolis forces and angular acceleration, are currently 

ignored because they result in non-symmetric damping and stiffness matrices respectively. 

Notes 

 The relationship between the eigenvalue, , and the angular frequency, , is: 
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 An eigenvalue analysis of the stiffness matrix has no physical meaning except that a 

zero magnitude implies a critical point of some description. 

 An eigenvalue analysis in LUSAS will include the gyroscopic effects in the stiffness 

matrix (for certain elements; see Element Reference Manual) if you use a CBF load to 

simulate the angular velocities of the shafts (note that this requires a nonlinear 

analysis). Such a natural frequency analysis would give the frequencies of the lateral 

modes of vibration. The physical effect modelled by the centripetal stiffening facility 

for eigenvalue analyses is the stiffening that a rotating be as a result of radial 

expansion and the corresponding increase in hoop stresses. These stresses effectively 

stiffen the structure and can significantly increase the eigenvalues. See the Theory 

Manual for further information.. 

 Ensure that mass normalisation is chosen for the eigenvalue analysis if it is to be 

followed by a spectral or harmonic analysis. 

 It is possible to use constraint equations in both an eigenvalue and a harmonic 

response analysis in LUSAS. However, the Sturm sequence check may prove 

unreliable, unless the fast Lanczos solver is used. 

 Non-zero rigid body eigenvalues may be experienced when using QSI4 elements. This 

is due to the method used to obtain the lumped mass matrix for this element (a 

consistent mass matrix not being available). QSL8 and QTS4 elements give correct 

eigenvalues for both lumped and consistent mass matrices, forming the mass matrix 

using a shape function array. QSI4, however, forms the rotation terms explicitly 

without the use of these functions. Small inaccuracies in the lumping of the mass to 

the rotational degrees of freedom may thus be possible for certain mesh definitions. If 

these eigenvalues are significant, the analysis should be continued using another shell 

element type, such as QSL8 or QTS4 elemnts. 

 The magnitude of the eigenvalue shift required for an unsupported structure is usually 

taken as the expected fundamental eigenvalue. 

 The error norm for a given mode provides a relative measure of the accuracy of the 

computed modes. A high error norm will provoke a warning message, and signifies 

inaccuracy in either the eigenvalue or the eigenvector, or both. Warnings are not 

issued for computed modes which are close to zero, since they may approximate rigid 

body modes which are exactly zero, and are thus prone to incurring a large relative 

error. 

 For eigenvectors which are normalised to unity, the largest translational component 

will be set to one. Thus analyses containing rotational degrees of freedom, for 

example, may have eigenvectors normalised to unity that contain rotational 

components greater than one in magnitude. 

 If the original buckling problem is recast to a form where all eigenvalues are positive, 

the specified load must be close to the collapse load in order to obtain an accurate load 

factor. It should be noted that this procedure is not without its problems. Depending 
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on the structure and the load level considered the eigenvalues can be very closely 

spaced, causing convergence problems in the iterative solution. 

 When specifying the range within which Eigen solutions will be located Sturm 

sequence checks are carried out on the range limits in order to determine the number 

of eigen solutions that exist within the range. All solutions are then searched for 

(unless a smaller number of solutions has been specifyed). 

Eigenvalue Buckling Analysis 

A linear buckling analysis is a useful technique that can be applied to relatively stiff 

structures to estimate the maximum load that can be supported prior to structural instability or 

collapse. The assumptions used in linear buckling analysis are that the stiffness matrix does 

not change prior to buckling, and that the stress stiffness matrix is simply a multiple of its 

initial value. Accordingly, the technique can only be used to predict the load level at which a 

structure becomes unstable if the pre-buckling displacements and their effects are negligible. 

As this procedure involves assembly of the stress stiffness matrix, only elements with a 

geometric nonlinear capability can be used in a linear buckling analysis. 

The main objective of an eigenvalue buckling analysis is to obtain the critical buckling load, 

which is achieved by solving the associated eigenvalue problem. 

For buckling analyses involving constraint equations, the Fast Lanczos solver will only find 

eigenvalues either side of zero, i.e. in the range (- , 0) or (0, ). If a range of eigenvalues is 

required in an interval which contains zero, two separate analyses must be carried out, where 

the interval is divided into two sub-intervals either side of zero. 

Alternative Eigenvalue Buckling 

Occasionally the initial stress stiffness matrix may not be positive-definite, causing the 

eigensolution method to fail. To overcome this problem the original buckling problem may be 

recast into a form where all eigenvalues are positive except when the buckling load factor is 

less than unity. When using this technique the load level must be adjusted to ensure that all 

the load factors are greater than unity. In other words, the load applied should be below the 

lowest expected buckling mode of the structure. An accurate load factor will however only be 

obtained if the specified load is close to the collapse load.  

It should be noted that this procedure is not without its problems. Depending on the structure 

and the load level considered the eigenvalues can be very closely spaced, causing 

convergence problems in the iterative solution. 

Output From Buckling Analyses 

For a linear eigenvalue buckling analysis, the buckling load is obtained from the print results 

wizard. This buckling load is directly related to the eigenvalues extracted and will be in the 

following format 
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MODE 
   

EIGENVALUE 
   

LOAD FACTOR 
   

ERROR NORM 

1 
  

33.0456 
  

33.0456 
  

0.190087E-10 

2 
  

64.3432 
  

64.3432 
  

0.179595E-07 

3 
  

130.903 
  

130.903 
  

0.202128E-11 

The buckling load for a mode is obtained by multiplying the actual magnitude of the applied 

loading by the load factor (33.0456 in the case of the 1st mode). 

Absolute displacement output is not available from any eigenvalue analysis. It is available, 

however in a normalised state. For buckling analyses the eigenvectors (mode shapes) are 

normalised to unity, where the maximum translational degree of freedom is set to one (mass 

normalisation is not applicable to buckling analyses).The mode shapes are, therefore, accurate 

representations of the buckling deformation but do not quantitatively define the displacements 

of the structure at the buckling load. 

Reactions, stresses and strains represent the distribution at the buckling load, again their 

magnitude is not quantitative. 

Spectral Response Analysis 

To study the effects of ground motion excitation on structures it is necessary to input the 

intensity of the motion. One practical measure can be obtained from a knowledge of the 

response spectra. Spectral response analysis seeks to determine the response of a structure 

subjected to a specified support excitation using modal superposition. This can be achieved 

without recourse to direct integration of the model over the complete duration of an event. 

A spectral response analysis is available using the IMD loadcase. 

Starting Procedure 

Before specifying the spectral response data the eigenvalues and eigenvectors of the system 

are computed using an eigenvalue extraction analysis (note that the computed eigenvectors 

must have been normalised to the global mass). 

Spectral Response Data Input 

The spectral curve, spectral curve type and percentage damping are specified in the spectral 

curve which is part of the IMD loadcase definition. 

The spectral curve may be defined as: 

 Frequency or period vs displacement 

 Frequency or period vs velocity 

 Frequency or period vs acceleration 
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To compute the participation factors it is necessary to specify the direction of excitation. The 

excitation may be specified simultaneously in three directions. The factor specified in each 

direction is used to scale the spectrum intensity in that direction.  

For each mode the spectral displacement is determined from the frequency and this is 

multiplied by the participation factor and the excitation vector to determine the response.  

Damping may be specified for each mode of the structure or at known frequencies of 

vibration. If damping is only specified for the first Eigen mode this value is applied to all 

modes. When the percentage damping specified on the spectral curve differs from that 

specified in the viscous damping a correction is made to the spectral displacement based on 

the formula chosen when defining the spectral combination. Damping may also be described 

in terms of the Rayleigh damping parameters and transferred from LUSAS Solver.  

Normally the number of modes included should ensure the sum of the mass participation is 

not less than 90% in all significant excitation directions.  

To obtain the design values some form of combination may be used. Within LUSAS the 

following methods of combination are available: 

 Square root of the sum of the squares (SRSS) 

 Complete quadratic combination (CQC) 

 Absolute Sum 

Note: When zero damping is specified the CQC gives exactly the same results as the SRSS 

technique. 

Transient Dynamic Analysis 

Where loading may not reasonably be considered to be instantaneous, or where inertia or 

damping forces are to be considered, a transient dynamic analysis (sometimes referred to as 

step-by-step) may be carried out. A dynamic analysis is controlled using the nonlinear and 

transient loadcase control properties. 

Dynamic solution methods generally numerically integrate in the time domain. The solution 

is progressed through time in a step-by-step manner by assuming some variation of the 

displacements and velocities over small intervals of time. Within each time step the solution 

yields the displacements at the discrete time points representing the end of the current time 

step. For known initial conditions, successive application of this procedure furnishes the 

dynamic response of the structure.  

The following numerical integration schemes are available: 

 Central Difference 

 Hilber-Hughes-Taylor 

Implicit and Explicit Dynamics 

Dynamic analysis may be performed using two methods: 
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 Implicit Dynamics Implicit methods require the inversion of the stiffness matrix at 

every time step, and are therefore relatively expensive, but unconditionally stable. By 

default the Hilber-Hughes-Taylor is used. 

 Explicit Dynamics In contrast, explicit methods de-couple the equilibrium equations, 

hence removing the necessity for stiffness matrix inversion. Explicit methods are only 

stable for a range of time steps, determined by the problem being analysed, and the 

discretisation adopted. Explicit methods are automatically invoked by specifying 

explicit dynamic elements. In this instance the central difference scheme is mandatory 

and chosen by default. For explicit analysis lumped masses must be used. 

Starting procedure 

To start a dynamic analysis a knowledge of the initial conditions is required. The initial 

conditions for the Hilber-Hughes-Taylor integration scheme are: 

 

where: 

 are the velocities at time steps 0,1 

 are the accelerations at time steps 0,1 

 is the time step 

 is the Hilber-Hughes-Taylor integration constant gamma 

The initial velocity, , and initial acceleration, , can be defined in an implicit dynamics 

analysis. 

The starting conditions in explicit dynamics must be consistent with the central difference 

integration scheme: 

 

where: 

 are the velocities at times - t/2, t/2 

 is the acceleration at time 0 

Only the initial velocity, V, (actually relating to time -Dt/2) can be defined in an explicit 

dynamics analysis. The displacements, d, (relating to time zero) and accelerations, A, 

(relating to time -Dt) are assumed to be zero. Because of the nature of the central difference 

integration scheme, an initial velocity will generate accelerations at time zero. Accelerations 

relating to time zero are used to compute displacements at time Dt and will in fact be output 

at time t.  

In general, the values output at any time t will be: 
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, ,  

This means that in the output for any time step, the displacements will relate to the current 

response time while the accelerations effectively lag one time step behind the displacements. 

Impact Dynamics 

In addition to using nonlinear joint models to represent contact and impact, a specialised 

procedure is available for modelling impact in dynamic analysis. This procedure uses a 

slideline technique, and permits the surfaces of 2D, axisymmetric, and 3D structures to 

register and react to contact with one another. 

  

 
  

Coupled Analysis 

The flow of heat through a body and the corresponding distribution of temperature is 

described by the quasi-harmonic equation; the body geometry is assumed to remain constant. 

The displacements of the same body, subjected to various forces, is described by equations of 

static or dynamic equilibrium; the temperature distribution is assumed not to vary with 

displacement. To include the effect of the change in geometry in the thermal analysis, and the 

change of temperature in the static analysis, requires that this information is separately 

calculated by the appropriate analysis and then transferred. This process is known as thermo-

mechanical coupling. 

Thermo-mechanical coupling may be sub-divided into two classes depending on the nature of 

the problem. 

 Semi-coupled analysis 

 Fully coupled analysis 

In a semi coupled analysis, for instance, the structural response is influenced by the 

temperature field, but the thermal response is independent of the structural response, or vice-

versa. In such a case, the thermal analysis is performed prior to the structural analysis, and 
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either a single or series of nodal temperature tables are created. These are read during the 

structural analysis at the required loadcase or time step. 

In a fully coupled analysis, the thermal and structural analyses must be performed 

simultaneously with a continuous transfer of information between the two analyses. For 

instance, in addition to modelling the influence of the thermal field on the structural response, 

the effect of the structural response on the thermal field is represented. Temperatures are 

transferred from the thermal to the structural analysis, and the updated geometry is transferred 

from the structural to the thermal analysis. The analyses may be coupled on the incremental 

or iterative levels (iterative coupling is machine dependent). 

For true full coupling of two nonlinear fields, information transfer has to occur on an iteration 

level within each increment, so that in addition to preserving equilibrium of the local thermal 

and structural fields, equilibrium of the combined system is maintained. Iterative coupling is 

essential for strongly coupled systems, e.g. structure to structure contact. For weaker thermo-

mechanical coupling, information transfer at an increment level should provide an adequate 

solution. 

Heat dissipated due to plastic work 

The heat flux produced due to plastic work can be considered in a coupled analysis. In this 

type of problem the structural analysis is started first and the heat dissipated through elasto-

plastic deformation is transferred to a thermal analysis. The nodal temperatures may then be 

returned to the structural analysis where they can be used to produce thermal strains and 

compute temperature dependent properties. The following points should be considered when 

using this facility: 

 The heat flux generated due to plastic work is a function of the time increment over 

which the work is done. For a meaningful solution to this type of problem a dynamic 

structural and/or a transient thermal analysis should be undertaken. 

 In general, it is recommended that reading and writing to the data transfer file is 

carried out at the same point in the analysis. This avoids any inconsistency occurring 

between the time of generation of plastic work and the time of diffusion in the thermal 

analysis. 

 The thermal softening facility is only valid for nonlinear material models which allow 

input of a heat fraction. The heat fraction takes a value between 0 and 1 and represents 

the fraction of plastic work converted into heat. 

Initialisation of Structural Temperatures 

LUSAS structural elements allow you to input both an initial temperature field and a current 

temperature field. The structure is not strained if its current temperature field is the same as 

the initial temperature field; variations in temperature, defined by the current temperature 

field, from this initial temperature field, cause thermal straining. The nodal temperatures 

transferred from the thermal to the structural analyses are read directly into the current 

temperature field and the thermal strains are then calculated from the difference between the 
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current and initial fields. The initial field in this case is zero everywhere unless it is directly 

input using the structural temperature loads. It is possible to initialise the initial temperature 

field to the current temperature field which is read from the data transfer file. Further data 

transfers will be read into the current temperature field only. 

Initialisation of Reading And Writing Commands 

To maintain consistency between reading and writing on a specific increment both data reads 

and writes are performed at the end of the current increment, i.e. if data is required for use in 

the 100th step then it must be read in the 99th step. Similarly, if data is required to initialise 

the structural temperature or geometry field, it must be read on step zero. 

Data Transfer Between Joints And Links 

The physical nature of the joint and link elements is essentially different. Heat flow can occur 

between two unconnected bodies via convection and radiation across the intervening medium. 

On the other hand, joint elements introduce stiffness against displacement, implying a 

physical connection between two bodies. Whilst both may be true simultaneously, more 

usually, only one condition will apply. In these circumstances it is necessary to introduce 

dummy joints with springs of zero stiffness or links with zero conductivity to ensure that the 

appropriate element data is correctly transferred. 

Field Analysis 

Where a solution is required to 

the quasi-harmonic equation a 

field analysis may be performed. 

The quasi-harmonic equation 

defines the behaviour of a variety 

of field problems. Some of the 

more common quasi-harmonic 

applications, and the associated 

field variable, are listed in the 

table shown right. 

  

   Application 

Thermal conduction 

Seepage flow 

Incompressible flow 

Soap film 

Elastic torsion 

Elastic torsion 

Electric conduction 

Electrostatics 

Magnetostatics 

   Field Variable 

Temperature 

Hydraulic head 

Stream function 

Deflection 

Warping function 

Stress function 

Electric potential 

Electric potential 

Magnetic potential 

Two types of field analysis may be performed: 

 Steady State field analysis 

 Transient field analysis 

Facilities for thermo-mechanically coupled analysis are also available. 

The solution of this class of problem follows an identical process to that of the structural 

problem. The domain is discretised using a series of field elements, thermal material 

properties are specified, thermal loads are applied, and the equations solved for the values 

of the field variable at each nodal point. Thermal link elements or the specification of 

thermal surfaces determine how heat is conducted, convected or radiated across gaps and 
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spaces between different domains. Since the most common application is that of thermal 

conductivity, subsequent discussion will be directed towards this type of analysis. 

Steady State Thermal Analysis 

In a manner similar to static structural analysis, steady state field analysis assumes that the 

loaded body instantaneously develops an internal field variable distribution so as to 

equilibrate the applied loads. It should be noted that the use of temperature dependent 

material properties or loads renders the problem nonlinear. 

Transient Thermal Analysis 

Where time effects are significant in a field problem a transient field analysis should be 

performed. In a similar manner to structural dynamics, transient field analysis involves the 

evolution of a new field variable distribution from a set of initial conditions via a set of 

transition states evolving through time. 

Transient field analyses are controlled using the nonlinear and transient control. The initial 

conditions of the body must firstly be prescribed. This may be done by performing the 

appropriate linear or nonlinear steady state analysis. 

Linear transient analysis 

Integration Scheme 
   

beta  

Crank-Nicholson 
  

1/2 

Euler 
  

0 

Galerkin 
  

2/3 (default) 

Backward difference 
  

1 

The transient problem is integrated through time using a 2-point integration scheme. The type 

of integration scheme maybe changed on Advanced Time step parameters dialog accessed 

from the nonlinear and transient control dialog by specifying the parameter beta. Some of 

the more common 2-point integration schemes and their associated beta values are shown in 

the table above. 

Notes 

 In the limit the final solution should be the same as the steady state analysis subject to 

the new loading and boundary conditions; the transient analysis merely models the 

thermal inertia in moving from the initial to the final conditions. The body property 

which is used to describe this inertia is the effective heat capacity. 

 When choosing an increment of time, the stability of the incrementation scheme must 

be examined. When beta is greater than or equal to 0.5 the solution is 
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unconditionally stable (the Crank-Nicholson, Galerkin and Backward difference 

schemes are of this form). 

 When beta is between the limits 0 and 0.5 the solution is stable provided that: 

 

where  is the input parameter beta and max is the maximum eigenvalue of the 

system. 

 The time step used for implicit algorithms is dependent upon the number of modes 

that influence the response of the system. Generally, the major part of the response is 

governed by the lower modes so that: 

 

where  is the minimum eigenvalue of the system. 

 The Galerkin scheme is recommended since it generally provides good accuracy and 

is the least susceptible to oscillations. 

Nonlinear Transient Analysis 

For nonlinear transient analysis the backwards difference algorithm must be used (beta = 

1.0). The backward difference algorithm is unconditionally stable, and the time step length 

considerations are the same as for linear analyses. 

For analyses including a phase change, there is either an absorption or release of energy in 

order to create or break the molecular bonds. This is modelled by varying the effective heat 

capacity in the transient analysis. To do this the material property of enthalpy is introduced. 

Enthalpy, H, is defined as: 

 

where C is the effective heat capacity including the effects of the latent heat of evolution due 

to phase changes and  is the temperature. In the material data input both H and C may be 

specified. For analyses where phase changes are not represented, the effective heat capacity 

value C is used in the calculations. 

For analyses where phase changes are represented, tabular input should be used to define the 

variation of H with temperature, together with an initial value of C. Providing a variation in 

temperature exists at a point, the effective specific heat is then interpolated from the enthalpy 

values. If no variation exists, for example, in an area of the problem that has experienced no 

change in temperature from the initial temperature, then the initial value of C is used. 
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For nonlinear analysis the nonlinear control parameters are used to define the iterative 

strategy. The convergence section is utilised to provide tolerances for defining steady state, 

and either a field norm (temperature equivalent to the displacement norm), or a residual flow 

norm (equivalent to the residual force norm) may be used. 

Fourier Analysis 

Fourier elements offer an efficient method to solve problems in which axisymmetric 

structures are subjected to non axisymmetric loading, provided that the displacements are 

small and linear theory applies. The circumferential displacements and variations of load are 

expressed as the sum of the components of a Fourier series, whilst the axial and radial 

variations are described by the standard finite element formulation. Each term of the Fourier 

series is analysed individually and the results are then combined to provide the overall 

solution.  

Fourier elements can be used to model both solid and thin walled structures; in particular they 

offer an ideal method to obtain an initial estimate of the eigenvalues of thin walled structures 

without the expense of performing a full shell analysis on the complete structure. The choice 

between a full structural discretisation using solid or shell elements and the use of the Fourier 

element depends upon the number of Fourier terms that are required to accurately describe 

the load; if only a few terms are required then the Fourier element should be considered. 

A Fourier analysis can be considered as a generalisation of the standard axisymmetric 

analysis. The finite element mesh is defined in the XY-plane and may be axisymmetric about 

either the X or the Y axis. Loading is applied to the mesh in the standard manner using the 

loadcase properties, with its circumferential variation defined using the curve definition. 

Finally the Fourier components to be computed are input using the Fourier control as part of 

the loadcase properties. 

Supports are defined in the usual manner, with the declaration 

free, restrained or spring supports. For the n=0 harmonic the 

spring stiffness per unit radian must include a factor of 2p for 

the implicit integration around the surface. For harmonics 

other than n=0 the factor should be p. Certain restrictions are 

applied to the freedoms of nodes lying on the axis of 

symmetry. These conditions, in the table shown, are 

automatically imposed on the centre line nodes. 

   
Axisymmetric  
about X axis 

n=0 v, w=0 

n=1 u=0 

n>1 u, v, 
w=0 

   
Axisymmetric  
about Y axis 

n=0 u, 
w=0 

n=1 v=0 

n>1 u, v, 
w=0 

Dynamic, Eigenvalue And Harmonic Response Analyses 

A Fourier analysis processes each harmonic individually as they possess their own unique 

stiffness, mass and damping matrices and load vector. By selecting just one harmonic a 

dynamic, eigenvalue or harmonic response analysis can be executed for that particular 

harmonic. The complete structural response can be obtained by superimposing the different 

results from the selected harmonics. 

The Fourier control should specify just one harmonic of a series. The automatic calculation of 

the load coefficients from a given load input is suspended and you must input the appropriate 

load coefficient; if this is not known it may be obtained from a static analysis. Note that to 
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represent a global load, the applied load will have components in both the tangential and the 

radial directions (see the Theory Manual for details of the loading calculations). Only one 

loadcase may be processed. 

Inertial Loading 

The operation of the inertial loading, input using the load type body force, is slightly 

different to the other standard loads. Inertial loads are calculated from element volumes and 

applied accelerations. The specification of linear accelerations, angular velocities and angular 

accelerations is enough to define the forces acting on the structures since the element volume 

and density from which the mass is calculated are element properties. Depending on the input 

data, loads are applied for the n=0,1,2 harmonic components. However, the body force data 

must still be associated with a dummy load curve and must be declared in the first loadcase. 

In addition to the input accelerations, angular velocities and angular accelerations you can 

input an offset origin about which the rotations are applied. The local rotation about the finite 

element axis of symmetry should not be confused with the global rotation about the global 

axes. The local rotation implies that the body is rotating with respect to the finite element 

axes, while the global rotation is a rigid body rotation of the complete finite element model. 

For further details see the Theory Manual. 

Centripetal Load Stiffening 

Centripetal load stiffening has been applied to the n=0 harmonic, but there is no nonlinear 

stress stiffening contribution. 

Special Application to Non-Axisymmetric Structures 

In some instances, the structure may not be truly axisymmetric but it may be desirable to 

obtain an approximate response from an axisymmetric analysis. An example of this is a 

turbine where the turbine axis is axisymmetric but the fan blades are not. The use of the 

standard Fourier material properties is inappropriate for the fan blades since the hoop stresses 

introduced by the element material model provide significant artificial stiffening. To alleviate 

this problem the use of the plane stress material model input using the orthotropic materials 

properties is permissible provided that the element is given adequate torsional restraint. The 

use of this material model can be thought of as smearing the individual stiffness of the fan 

blades into an equivalent axisymmetric structure. 

For Fourier elements using orthotropic properties, body forces are applied using the 

associated load curve.  

If the load curve is input as a series of 1s and 

0s this is equivalent to selectively 

integrating the internal forces for each fan 

blade. The scheme is illustrated in the 

diagram. 
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Thermal Problems 

If temperature dependent material properties are used the temperature field must be 

axisymmetric. For non-temperature dependent materials, a general temperature field can be 

input in the same manner as the other element loads. Temperature loads cannot be used in 

dynamic or harmonic response analyses. 

Post-Processing 

Fourier results may be expanded using the Graph Wizard. 

Frontal Optimisation and LUSAS Solvers 

The frontal optimiser is set from the Model Properties> Solution - Optimiser options tab 

and is only invoked when the standard frontal solver is chosen. 

Selecting the Frontal Optimiser 

Front optimisation is only required when using the standard frontal solver. The frontwidth of 

the problem may be reduced by optimising the order in which the elements are presented. 

Optimising methods supported are: 

 Standard uses the standard LUSAS optimiser. 

 Akhras-Dhatt uses the Akhras-Dhatt optimiser. A number of iterations must be 

specified for this optimiser. The iterations are used to find the best starting point in the 

structure for the optimisation. The higher the number of iterations, the better the 

chance of locating the optimal starting point, but the longer the optimisation process 

takes. 

 Cuthill-McKee optimises the solution based on the Cutill-McKee optimiser. This 

algorithm bases its optimisation on a specified parameter. Options are: maximum 

bandwidth, RMS wavefront, bandwidth and profile. This optimiser was originally 

written by E.H. Cuthill and J.M. McKee, and was improved by G.C. Everstine. 

 Sloan uses the Sloan optimiser (default). 

If no optimiser is specified then the Sloan optimiser is used by default. 

Choosing the Solver 

Direct (e.g. frontal) solvers are more robust than iterative solvers and are applicable to all 

types of analysis. Direct solvers should always be used for very ill-conditioned problems 

since the time taken to obtain a solution is independent of the problem conditioning. Iterative 

(e.g. conjugate gradient) solvers are usually only applicable to static, linear analyses, and will 

perform best on large, well conditioned problems, since the time taken for solution is less 

dependent on the size of the problem than for direct solvers. Iterative solvers require far less 

storage (memory + disk space) than direct solvers. This means that iterative solvers 

sometimes have the advantage of remaining in memory where a direct solver would have to 

run "out of memory". Iterative solvers are only applicable for a single loadcase. 
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Support for specification of various solver types is available within LUSAS Modeller. The 

current solver options supported are as follows: 

 Direct (Frontal) selects a direct, sparse solution technique based on Gaussian 

elimination. Stiffness and load arrays are read into memory and assembled into the 

structural stiffness matrix and load vector. There is a choice of two direct solvers: 

 Standard Frontal- an element-by-element frontal solver which does not 

require assembly of the global stiffness matrix. This solver is applicable to all 

types of analysis present in LUSAS Solver. 

 Fast Multi-Frontal- a global frontal solver which assembles global stiffness 

and load data. This solver is applicable to all analysis types except for 

superelements, Guyan reduction and non-linear problems involving branching 

and bracketing. 

  

 Iterative (Conjugate Gradient) selects an iterative, sparse solution technique for 

solving static, linear analyses. The global stiffness matrix and load vector(s) are 

assembled, and is designed to run entirely in-memory. Three preconditioning 

techniques are available to assist the convergence rate of the conjugate gradient 

method: 

 Standard - The incomplete Cholesky preconditioning technique is the most 

robust (provided an appropriate drop tolerance is chosen), and is applicable to 

all analyses for which the conjugate gradient solver may be used. 

 Decoupled - The decoupled incomplete Cholesky preconditioning technique 

may be used for all analyses except those involving tied slidelines, thermal 

surfaces and Fourier elements. It generally leads to faster overall solution 

times than Incomplete Cholesky preconditioning, although more iterations are 

required for convergence. For less well conditioned problems, the conjugate 

gradient algorithm may not converge using this technique, so care should be 

taken. 

 Hierarchical - The hierarchical decoupled incomplete Cholesky 

preconditioning technique is only available for models consisting entirely of 

two- and three-dimensional, solid continuum, quadratic elements, and offers 

excellent convergence properties. It is by far the most effective technique for 

models of this type, and when used in conjunction with fine integration allows 

solutions to be obtained for relatively ill-conditioned problems. For very ill-

conditioned problems of this type (e.g. where the average element aspect ratio 

is high), an extra preconditioning option exists which will often yield a 

solution faster than using a direct solver. 

Care should be taken when solving problems with high aspect ratios (thin or elongated), or 

excessively curved or distorted elements, or extreme or widely disparate material properties, 

since all of these can lead to ill-conditioning. Also, the convergence of the iterative solver is 
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related to the condition number of the stiffness matrix which becomes worse for ill-

conditioned problems. 

The conjugate gradient iterative solver can be configured using the following parameters: 

 Drop tolerance- a value between 0.0 and 1.0 which measures the amount of new non-

zero entries (known as fill-in) allowed to remain in the preconditioning matrix during 

the incomplete Cholesky factorisation of the stiffness matrix. The default value is 1.0, 

leading to a very sparse preconditioning matrix suitable for well conditioned 

problems. For more ill-conditioned problems, however, this value should be decreased 

exponentially, and values in the range [1.0e-3, 1.0e-6] are recommended. The lower 

this parameter becomes, the larger the preconditioning matrix will be, giving rise to 

fewer iterations during the conjugate gradient solution, although each iteration will 

take longer to process. This parameter affects all preconditioning techniques, although 

the effect is less pronounced for the decoupled techniques. 

 Maximum number of iterations- an upper limit on the number of conjugate gradient 

iterations to be processed; the default value is 5000. If the convergence criterion has 

not been satisfied when the iteration limit is reached, LUSAS Solver will issue a 

warning and then continue the analysis. 

For the iterative solver, the following points need to be taken into account: 

 Conjugate gradient methods can only be used for problems having symmetric 

positive-definite matrices. By definition, standard linear, static analyses yield positive-

definite matrices in general, but mixed-formulation problems (such as pore pressure 

models) do not. 

 Problems involving constraint equations cannot currently be solved with the iterative 

solver, since the resulting stiffness matrix is non-positive-definite. 

 For problems with multiple loadcases, iterative solvers are less efficient since a 

separate iterative process is required for each loadcase, and the total time taken will 

increase in proportion to the number of load cases. By contrast, direct solvers incur 

very little extra cost when solving for multiple loadcases. 

 Guyan reduction and superelement analyses cannot be solved iteratively, since 

matrix reduction does not take place. 

 When using hierarchical basis preconditioning, if any midside degrees of freedom are 

supported or prescribed, their corresponding vertex neighbours must also be supported 

or prescribed. For example, if a midside node is fixed in the x-direction, all nodes on 

the same edge of that element must also be fixed (or prescribed) in the x-direction. 

 The iterative solver will perform very poorly if there is not enough physical memory 

for the solution to proceed in-memory. To guard against this, a data check (OPTION 

51) may be performed (as with the direct solvers), which will estimate the amount of 
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memory the iterative solver would use with the specified drop tolerance and choice of 

preconditioning technique.  

 The iterative solver has limited error diagnostics to warn against ill-defined or 

incompletely specified models. If this is suspected, the analysis should be run through 

the standard frontal solver for more comprehensive error diagnostics. 

For further information see the Solver Reference Manual 

Support with Modelling and Analysis Problems  

The engineers in LUSAS Technical Support are available to help all clients with a current 

support and maintenance contract and assist with any problems that may be encountered. 

However, to identify the cause of a problem will take time, especially if the analysis is large. 

To reduce the time taken in diagnosing input errors the analysis model should be thoroughly 

checked. It is good practice to systematically carry out checks as a matter of course whether 

or not there appears to be a problem with the solution obtained. 

With the aim of producing a more efficient service, some general pointers are given as to 

what information should be made available when calling the support desk. This information 

will help the support engineers get to the bottom of your problem more quickly: 

 The exact text of any warning or error message(s). 

 Machine specification operating system, memory and available disk space. 

 A copy of the model or data file causing problems. 

 A list of the last commands used in LUSAS Modeller or a copy of the session file. 

 The contents of the last LUSAS Modeller error log LUSASM_x.ERR 

 Full details of the LUSAS Modeller/LUSAS Solver version numbers in use, the 

LUSAS Solver version number is written to the header section of the output file and 

the LUSAS Modeller version number is obtained from the Help> About LUSAS 

Modeller menu item.. 

 For complex or difficult to describe problems, email or fax a simple diagrammatic 

representation before calling to aid any discussion. 

Try to be logged onto the machine when calling or be close enough to the machine to try a 

suggestion provided by the support engineer. 

For an explanation of the errors which may occur during the Solution see Appendix B - 

LUSAS Solver Trouble Shooting 

Sending files to LUSAS Technical Support 

Use the LUSAS Support Tool to create a compressed file of all relevant data to send to 

LUSAS Techincal Support 
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Pre-Analysis Checks 

1. Check the consistency of your co-ordinate systems between the finite element model 

and any engineering drawing that you have worked from. 

2. Check key drawing dimensions against co-ordinates of respective points in the model. 

3. Check the mesh for cracks and voids. Checks for cracks must be made to ensure 

that the features form a continuous structure.  

4. Check for correct material properties and assignments. 

5. Check for consistent units. 

6. Check for correct orientation of beam properties. 

7. Check for correct boundary conditions (loads/supports). 

8. Check element thickness against original model data (plates/shells). 

9. Check reversed normals for plates/shells/2-D. 

10. Check element shapes for aspect ratio, skew, warp, taper, curvature and centrality 

of mid-side nodes. Warning messages will be present in the output file for all of the 

above. 

11. From the LUSAS datafile dialog, File> LUSAS datafile menu item, click on the 

Output button to check that the output provides sufficient checking information in the 

LUSAS Solver output file (e.g. reactions).  

Notes 

 It is often a good idea to carry out a „pilot‟ analysis on a crude model to check load 

paths and equilibrium. 

 In order to ensure that an adequate mesh density is used a mesh sensitivity study 

should be carried out.  

 It is good practice to keep an up to date log book with adequate plots (including 

hidden line views) to cover all parts of the model. It is also useful to set-up a reference 

system to select individual regions of the model using the groups facility. 

 Keep a log of analysis runs for future reference. Note information such as element 

types, numbers of loadcases, frontwidth, file sizes, run-times, etc. 

 Keep regular backups of model.  

 When carrying out nonlinear or transient analysis it is always best to run a linear 

analysis first. No time is really wasted as the model can easily be subsequently 

converted for the nonlinear or transient analysis afterwards. 
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 It is advisable to add in nonlinear behaviour in stages. For example in a material and 

geometrically nonlinear run containing slidelines it would probably be advisable to 

start with only slidelines, then add the geometric nonlinearity and finally add the 

nonlinear material effects. In this way you can ensure that each nonlinear procedure is 

stable before progressing to the next. 

Running an Analysis 

To create a LUSAS datafile and run an analysis either click on the Solve button , or use 

the File> LUSAS Datafile menu item. 

Solver Licence Selection 

When running an analysis, LUSAS Modeller passes all details of the licence it is running with 

to LUSAS Solver. It includes the minimum set of licence options required to solve the job, 

and a teaching and training identifier if Modeller is running in teaching and training mode.  

To find a suitable Solver licence with which to run an analysis Solver does the following: 

 By default a Solver licence with the same licence key number or 25 character key as 

the Modeller licence is sought and if available and valid is used. 

 If the Solver licence that matches the Modeller licence is in use, or is invalid or 

unavailable, Solver will re-order all suitable Solver licences and internally list them 

such that the least functional Solver licence that is still able to solve the job is listed 

first.  

 Once listed, Solver will tumble through the licences in the list until one is found that is 

both valid and available. This is then used for the duration of the analysis. 

Creating shortcuts 

Shortcuts can be created to tie a licence type to a shortcut used to run LUSAS Solver. For 

more information see the LUSAS Configuration Utility. 

Post-Analysis Checks 

All Analysis Types 

1. Check the deformed mesh for each loadcase to ensure the model has deformed as 

expected. 

2. Compare your finite element results with estimates of stress and deflection from hand 

calculations. This may not always be possible to do very accurately, but an estimated 

should be obtainable. 

3. Check reactions for equilibrium. 
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4. Check magnitudes of displacements and stresses. If possible compare to hand 

calculation. 

5. Check for matrix conditioning messages. Small pivot and diagonal decay warning 

messages are invoked when the stiffness matrix is poorly conditioned. Diagonal decay 

means that round-off error during the solution has become significant which could 

lead to inaccurate results. A poorly conditioned stiffness matrix is the result of a large 

variation in magnitude of the diagonal terms. This could be caused by large stiff 

elements being connected to small less stiff elements or elements with highly 

disparate values of stiffness (e.g. a beam may have a bending stiffness that is orders of 

magnitude less than it's axial stiffness).  

 

A negative pivot in a non-linear analysis usually means that a limit or bifurcation 

point has been encountered. However, negative pivots sometimes occur during the 

iterative solution (which sometimes means that the load step is too big) but disappear 

when the solution has converged. If negative pivots occur and the solution will not 

converge then first try reducing the load step. 

 

If the solution still does not converge a limit or bifurcation point may have been 

encountered in which case the solution procedure may need to be changed. Running 

the problem under arc length control gives the best chance of negotiating a limit or 

bifurcation point. A load limit point can also be overcome by using prescribed 

displacement loading. 

6. Check the LUSAS Solver output file for other warning or error messages. 

7. Check adequate mesh density. 

8. Check average nodal stress calculations are not carried out across discontinuities. 

9. Check the model summary information available in the LUSAS Solver output file. 

This gives the total length, area, volume and mass for the structure together with the 

centre of gravity, moments of inertia and resultant applied load at the origin. 

Dynamic Analysis Types 

1. Check the first natural frequency against hand calculation. 

2. Check of convergence of the eigenvalue extraction algorithm. 

Non-linear Analysis Types 

1. Check convergence of the non-linear analysis. 
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Chapter 8 : Viewing 

the Results 

  

Introduction 

This section deals with procedures for results processing. It covers manipulation of results 

files, selection of the correct results type and loadcase, and differences between results 

viewing coordinate systems.  

 Results Processing provides an overview of results processing. 

 Results Files covers manipulation of results files. 

 Results Selection covers selection of the active loadcase, a fibre location and a 

composite layer. It outlines all the different results types available during post-

processing. 

 Results Transformation presents the options for transforming results. 

Results Processing 

 Results processing, also known as post-processing, is the manipulation and visualisation of 

the results produced from an analysis. Prior to visualising and extracting results, further 

calculations may be carried out to create or assemble results, or the results model can be 

manipulated to create results at particular model locations for a particular results viewing use. 

Depending on the type of analysis any of the following results calculation, manipulation or 

viewing can be carried out: 
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Further Calculations 

 Combinations and envelopes 

 Wood and Armer reinforcement 

 Fatigue analysis of a linear model 

 Design factors 

 Composite failure criteria 

 Modal analysis 

 Beam stress resultant from beam and 

shells 

 Expansion of Fourier analysis results 

 User defined results 

Manipulating the Results Model 

 Plotting results for groups 

 Results on a section through the model 

 Slideline results processing  

 Thermal surface results processing 

Visualising and Extracting Results 

 Deformed mesh 

 Contour plots 

 Results as vectors 

 Bending moment and force diagrams 

 Concrete crack patterns 

 Yield of nonlinear material 

 Peak values 

 Plotting beam stresses 

 Plotting results for assigned attributes 

 Graphing of results 

 Animation sequences 

 Printing results to the screen or a file 

 Generating a Report 
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Results Files 

When an analysis is performed by LUSAS Solver a results file will be created. For historical 

reasons this has a .mys extension. By default the results file is automatically loaded into 

LUSAS Modeller on top of the model file after LUSAS Solver has been run. 

The information in the results file is stored in a binary form and may only be accessed using 

LUSAS Modeller. The results file will contain the results of the analysis and sufficient model 

information to process the results. Full details of the finite element mesh (nodes and 

elements), material and geometric property numbers, support positions and equivalent nodal 

loads are stored in the results file. 

Opening Results Files 

Results may be loaded on top of a model or used stand-alone. Results are usually loaded 

automatically when analysis is carried out and are offered for opening if a results file of the 

same name as a model file is detected when a model is opened. Results files may also be 

opened in isolation manually using the File> Open menu item.  

 Load results on top of current model 

Results are normally processed by reading 

the results file on top of an existing model 

file. This enables the visibility of the model 

to be controlled by the assigned attributes 

and all model data including group 

information is present to aid results 

manipulation. Supports and loading attributes 

as assigned for each loadcase can be seen. 

When results are loaded on top of a model 

file only the results are loaded from the .mys 

file. Multiple results files may be loaded 

when accessing results from a number of 

analyses at the same time. Subsequent results 

files may be loaded on top of an existing model or an existing results file.  

 

The  Treeview above shows a results file loaded on top of a model file.  
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 Results Only 

When results files are opened stand-alone 

the mesh definition and all of the results are 

read from the .mys file. This method is used 

when access to model information, such as 

feature definitions or group names, is not 

required or is not available for results-

processing. Subsequent results may be 

loaded on top of the first results file loaded. 

 

The  Treeview above shows the listing 

obtained for the same analysis when only the 

result file is loaded . 
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Results Selection  

Setting the Active Loadcase 

The active loadcase is the loadcase that provides the 

results for the current window. In this way a single 

window is used to plot results from a single loadcase, 

and multiple windows can be used to compare results 

from different loadcases. 

  

  

Setting the Active Fibre Location  

For plotting diagram results on bars and beams only, 

the active fibre location for which results will be 

plotted must be chosen. Fibre locations available for 

these elements can be seen and can be set active in the 

 Treeview. Fibre locations can visualised by 

double-clicking on the Geometric Line name and 

selecting the Visualise button on the dialog presented. 

Setting the Fibre Active shows results for just that 

fibre. Setting the Name Active shows results for all 

similarly named fibres throughout the model. 

  

Setting the Active Composite Layer  

With composites analysis, in order to plot results on 

composites laminae a particular lamina must be made 

active. Setting a Lamina active shows results for just 

that lamina. Composites layer information can be seen 

and visualised by double-clicking on the Laminate 

stack name and selecting the Visualise button on the 

dialog presented.  
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Results Types 

There are several different types of results entities available in each results file. Full details of 

the results available for each element type may be found in the Element Reference Manual.  

Each time results are displayed the results entity must be specified. Only result entities that 

are actually contained in the loaded results file are presented for selection. The following is a 

summary of all the results types: 

Structural Analysis 
   

Thermal Analysis 

 Displacement 

 Stress 

 Strain 

 Loading 

 Reaction 

 Reaction Stress 

 Residual 

 Velocity 

 Acceleration 

 Plastic Strain 

 Creep Strain 

 Rubber Stretch  

 Strain energy 

 Plastic work 

 Slideline 

 Named variables 

 State variables 

  
 Potentials  

 Fluxes  

 Gradients  

 Thermal Surface 

Notes 

 Stresses are stress resultants for beams, plates and shells (i.e. forces for beams and 

force/unit width for plates and shells). 

 For plates and shells top middle and bottom stress and strain are available. 

 When applicable, Wood Armer results, composite failure values, design factors and 

beam stresses are available from the Stress results type. 

 The results calculation and display may be controlled independently using the Result 

Plots dialog activated from the top level of the Groups context menu. See Groups for 

details. 

Results Transformation 

By default, displacements, loads, reactions, residuals, velocities and accelerations are output 

relative to the global Cartesian axis. For beams, joints and shells, stress and strain output is 

relative to element local axes. For all other elements stress/strain and creep/plastic strain 

results are output relative to the global system. 

Sometimes it is useful to transform the results to a consistent or alternative coordinate system. 

For example if the elements in a model are orientated such that their local axes vary from one 

another, the results may be transformed to a consistent direction. 
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Results can be transformed by editing the contour, values or vector layer properties or when 

using the print results wizard. 

Local and Global Results 

When specifying a results entity the results may be transformed relative to: 

 Local coordinate Transforms results relative to a specified local coordinate. Only 

available if a local coordinate has been defined. 

 Local Transforms results according to the local transformed freedoms for 

displacements, etc. or according to element local directions for stresses. 

 Material direction Transforms results relative to the local element material 

directions. 

 Specified angle (in the XY plane) Transforms results by defining a transformation 

angle in degrees about the global Z axis. The transformation angle is measured in a 

positive, anti-clockwise direction from the global X axis.  

The validity of each of the above transformation methods for different results entities is given 

in the table below. 

 

Results Entity 
   

Transformation 
   

Notes 

Stresses/Strains, 
Creep/Plastic Strains, 
Gradients 

  
Local coordinate 

  
Note that results for beams and joints will always 
be relative to the element local direction.  

  
  

Local element 
direction 

  
Gives results relative to the element local axes. A 
warning is issued to remind you to ensure a 
consistent set of directions are available for 
contouring. 

  
  

Material direction 
  

Gives results relative to the element material 
directions. A warning is issued to remind you to 
ensure a consistent set of directions are available 
for contouring. 

  
  

Angle 
  

 Note that beam and joint results will always be 
relative to the element local direction. 

Displacements, Loads, 
Reactions, Residuals, 
Velocities, Accelerations, 
Potentials 

  
Local coordinate 

  
Cartesian sets existing in the LUSAS Solver data 
file will be used to automatically create LUSAS 
Modeller local coordinate systems for use with 
this command. 

  
  

Angle 
  

For 3D elements care must be taken to ensure 
the transformation is valid by limiting the 
shell/plate elements showing results to those 
parallel to the global XY plane. 
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Notes 

 When viewing Wood Armer results this facility is used to set the direction of the X 

reinforcement. A skew angle may then be set independently to define the Y 

reinforcement direction. The default skew angle is 90 degrees. 

 When viewing shell moments and shear stresses using a cylindrical or spherical local 

coordinate the shell plane for resultants may be defined as rt, tz or rz where r is the 

radial direction,  t is the theta direction, and z is the cylindrical axis. 

Combinations and Envelopes 

Combinations and envelopes can be defined for manipulating results loadcases. 

 Combinations enable results from different 

loadcases to be added together. For example, 

the results from a self-weight loadcase and a 

concentrated load loadcase might be added, 

or perhaps the results from a dead load 

loadcase and an IMD loadcase used for 

spectral analysis might be added.   

 Combinations can be created from loadcases, 

or other combinations or envelopes.  

 Envelopes are used to pick out the maximum 

and minimum values from a number of 

results loadcases, combinations or other 

envelopes. When an envelope has been 

defined, a pair of loadcases are created 

containing the maximum and minimum 

envelope values.  

Defining a Combination or Envelope 

The Utilities menu is used to add a new combination or envelope. Combinations or envelopes 

may be defined at either the modelling stage prior to analysis, or at the results processing 

stage. Once defined, combinations and envelopes are treated as loadcases and are listed in the 

Loadcase  Treeview. Their properties may be edited by double-clicking on the entry in the 

Treeview.  

When the first load combination or envelope is added to the Treeview, a  Combination and 

envelope options object is also created. Double-clicking on this object displays a dialog on 

which results components can be selected for calculating and saving in the Modeller results 

file. When results components are selected prior to an analysis being carried out the results 

for the primary components chosen will be available for results processing immediately after 

the results file is loaded because results for these components will have been automatically 

saved (cached) in the Modeller results file. When results components are selected on the 
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Combination and envelope options dialog after an analysis has been carried out an option to 

calculate results for the components selected is provided. These results will also be cached in 

the Modeller results file to speed-up results viewing. If a model is saved these calculated 

results will also be saved. 

Combinations and envelopes can consist of any other available loadcase results, including 

other combinations and envelopes. Combinations and envelopes may contain results from 

more than one results file, if there are other results files open. 

Two types of combinations may be defined.  

 Basic combinations enable a single factor to be applied to each set of results included 

in the combination properties.  

 Smart combinations enable two factors to be applied to each set of results. The first 

factor is known as the permanent factor as it is always applied. The second factor is 

known as the variable factor as it is only applied if the load effects are adverse.  

A maximum smart combination (Max) will assemble results from the loadcases 

selected using just the permanent factors for negative load effects, and using 

permanent and variable factors for positive load effects. A minimum smart 

combination (Min) will assemble results from the loadcases selected using just the 

permanent factors for positive load effects, and using permanent and variable factors 

for negative load effects. 

If the Loadcases to consider option is chosen and an appropriate number entered, the 

smart combinations will be assembled in the manner described above, but the number 

of loadcases considered will be restricted to the number of loadcases specified. The 

loadcases used will be the most adverse for each combination i.e. the most positive for 

maximum combinations and the most negative for minimum combinations. All other 

load effects will be discarded. 

If the Variable loadcases option is chosen and an appropriate number entered, the 

smart combinations will be assembled in the manner described above, but two further 

criteria will be invoked. Firstly, the maximum combination will include only positive 

load effects, all negative load effects will be discarded. Likewise for the minimum 

combination, which will include only negative load effects. Secondly, the number of 

variable load factors used will be restricted to the number specified. The most adverse 

variable factors will be used in each combination and the remaining loadcases, which 

produce load effects of the correct sign, will be included with their permanent factors 

only.  

Different factors for permanent and variable effects may be specified for each 

combined results loadcase. The Permanent load factor is always applied while the 

Variable load factor is only applied if the effect is adverse. These options may be 

optionally displayed as Beneficial load factor and Adverse load factor respectively 

if the appropriate check box has been selected on the dialog displayed for the  

Combination and envelope options object. 

For further details see Appendix A. 
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Visualising The Results From Combinations And 

Envelopes 

Once defined, combinations and envelopes may be manipulated in the same way as other 

loadcases.  

LUSAS will display the results from the active loadcase. The active combination or envelope 

is selected from the  Treeview by selecting the appropriate envelope or combination with 

the mouse, clicking the right hand mouse button, and selecting the Set Active menu item 

from the context menu.  

When using smart combinations or envelopes the Set Active menu item will prompt for the 

primary component on which to base the combination or envelope. For an envelope this 

component will be used to decide which is the maximum or minimum loadcase and for a 

smart combination which factor to apply to each loadcase. When displaying or printing 

results the values for other components will be the coincident effects. For envelopes, if no 

component is specified all components are enveloped independently.  

An active loadcase is identified by a coloured icon in the  Treeview. Non-active loadcases 

are greyed-out. For envelopes and smart combinations either the maximum or minimum can 

be set active. 

Notes 

 Combinations are only applicable to linear elastic analyses. 

 Envelopes and combinations may be saved in the model file or in a new model file 

when a results file only is opened. 

 When a smart combination includes both envelope (Max) and envelope (Min), one of 

the envelopes will be ignored. Smart combination (Max) ignores envelope (Min) and 

smart combination (Min) ignores envelope (Max). 

 Spectral (IMD) loadcases can be combined with other loadcases such as those 

defining dead and live loads. Since spectral loadcases are computed from an 

eigenvalue analysis the sign of the displacements are always positive but the most 

adverse effects can be obtained by creating a combination including dead/live load 

and a spectral loadcase both with load factors of 1 and then creating a combination 

including a dead/live load with a load factor of 1 and a spectral loadcase with a load 

factor of -1.  

 When combining or enveloping results from multiple results files the mesh must be 

identical across results files. 

 When envelopes of envelopes or combination results are calculated they are 

automatically cached. Saving the model will also save the cached results to the 

Modeller Results File so they are available for future use. Subsequent access to these 

results will be similar to accessing results from a single loadcase 

 If the loadcase IDs which contain the most adverse effects are not required, 

enveloping can be significantly speeded up by placing an envelope within an 

envelope. 
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Tips 

 Sometimes, due to hardware restrictions, it may be convenient to run an analysis 

which contains many loadcases in parts. The loadcases from the separate results files 

may then be subsequently enveloped or combined. 

  

Basic Combination Example 
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Smart Combination Example 

 

For details of smart combination calculations see Appendix A 
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Enveloping Example 

Individual Loadcase Bending Moment Results 

 

Maximum Enveloped Bending Moment Diagram 

 

Minimum Enveloped Bending Moment Diagram 

 

Wood Armer Reinforcement 

The Wood Armer facility allows reinforced concrete slabs to be designed to resist a 

combination of moments [Mx, My] and a twisting moment [Mxy] using orthogonal (or skew) 

reinforcement.  Following a linear elastic analysis the Wood Armer facility determines the 

design moments [Mx(T), My(T), Mx(B), My(B)]. The procedure was originally developed 

for a moment field obtained from a plate analysis but may also be applied to shell or grillage 

analyses. 

For a slab modelled as a shell, subject to a moment field [Mx, My, Mxy] and a stress field 

[Nx, Ny, Nxy] the Wood Armer principles are extended (using the Clark Neilsen calculation). 

The final output [Nx(T), Nx(B), Ny(T), Ny(B), Fc(T) and Fc(B)] incorporates both bending 

and in-plane load effects. In order to obtain equivalent in-plane forces from the applied 

moments, it is necessary to establish the distances between the centroid of the reinforcement 

layers and the middle surface of the slab. This is calculated using the thickness of the shell 

elements entered in the geometric properties and the distance to the reinforcement centroid 

from the face of the slab, entered in the Wood Armer dialog. 

An approximate approach is also available for grillage elements whereby bending and 

twisting moments are converted into „equivalent‟ plate moments so that the Wood-Armer 

equations can then be used. An extra geometric property, 'effective width', has to be defined 



  Chapter 8 

    

331 

for the grillage to compute these equivalent moments. The effective width is defined in the 

grillage geometric attribute. 

Wood Armer properties are specified on the Wood Armer dialog which is activated when a 

Wood Armer component is selected from the contour, values or vector layer properties or 

from the print results wizard. The properties specified in the Wood Armer dialog are 

applicable to all layers. 

Wood Armer Assessment 

The Wood Armer calculation is generally based on a rationalised set of equations intended to 

enable efficient design. However, it is sometimes necessary to consider arrangements of 

reinforcement which have design strengths based on a different rationale. A typical 

application is the assessment of an existing structure. 

If the capacity of the section in the direction of the reinforcement is known the 'utilisation 

factor' based on optimal use of the available capacity can be computed. A utilisation factor 

greater than 1 signifies the slab is under-reinforced and extra reinforcement is required.  

Alternatively, the Wood Armer 'K factor' may be entered to proportion the applied twisting 

moment between the reinforcement directions. This allows any spare capacity that exists in 

either direction to be utilised. 

Notes 

 Grillage Wood-Armer results are only valid for small skew angles. 

 When calculating Wood Armer results the x direction may be transformed to set an 

angle between the global axes and the local axes.  

See the Theory Manual for further information. 

Fatigue Calculations 

Fatigue calculations can be performed on the results of a linear finite element stress analysis 

using the total life approach. This can be done for continuum elements only. The fatigue life 

may be expressed in terms of the damage that is done to the structure by a prescribed loading 

sequence or as the number of repeats of the sequence that will cause failure of the structure. 

Contour plots illustrating the fatigue life of the entire structure can be generated. The results 

from fatigue calculations may be viewed using any of the standard plotting techniques. 

Fatigue calculations of the life of a structure are defined from the Utilities> Fatigue menu 

item. 

S-N Curves 

S-N curves contain the variation in stress/strain values with the number of cycles to failure 

and are defined on a Log Log scale. An S-N curve is used to calculate the number of cycles to 

failure for each loadcase. Miner's rule is then used to combine the damage for each loadcase 

to give the total damage to the structure for the specified loading sequence. 
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Notes 

 Log values are used because of the large variation in magnitude of the input data. 

 If plotting the number of cycles to failure, then the number of cycles entered in the 

fatigue spectrum should sum to unity. 

 For information on standard S-N curves refer to BS5400. 

Fatigue loadcase  

Fatigue loadcases contain the loading spectrum defining 

the loading sequence in terms of a series of loadcases, 

each of which has an associated load factor, the number 

of cycles, and the component to be used in the fatigue 

calculation. 

Once defined fatigue loadcases are saved in the 

loadcase Treeview . Their properties may be edited 

by double-clicking on the fatigue loadcase. 

Fatigue Results 

Results from the fatigue calculations may be viewed using any of the standard methods, once 

the loadcase is set active. Fatigue results come from a component of stress, which is specified 

in the Fatigue loadcase. Two results are obtained from the calculations: 

 Loglife is the life expectancy of the structure based on the applied load. Results are 

presented as log10 of the number of cycles to failure. 

 Damage is a factor representing the damage the material has sustained due to the 

applied loading and number of cycles. A value greater than 1 indicates failure. 
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Notes 

 Fatigue calculations are only applicable to linear elastic analyses and for continuum 

elements only. 

 Fatigue loadcases may be saved in the model file or in a new model file when a results 

file only is opened. 

Fourier Results 

Before the results for the Fourier can be established, it is necessary to define a combination in 

which the Fourier harmonics are combined to provide an overall result. The combination is 

created using Utilities> Load Combination> Basic… menu item. 

Once the combination has been generated for all the harmonics required and the analysis run 

to create a results file, the combination loadcase should be set active. 

There are then two ways to view results from a Fourier analysis: 

 By manually specifying the angle around the circumference at which the results are 

required and using contours, values and vectors to view the results at that position in 

the model. 

 By using the graph wizard to display the variation of results around the circumference 

for a specified node. 

Design Factors 

Design factors provide a means of assessing the reserve strength capacity of a component or 

structure. To use this facility the results file must be loaded on top of the model file. The 

material strength and design factor are defined from the Attributes> Design Strength menu 

item and assigned to the model. The reserve strength can then be visualised over the entire 

model using the Utilities> Design Factors menu item. The following criteria are available: 

 Maximum Stress Theory (Rankine) 

 Maximum Shear Theory (Coulomb, Tresca) 

 Maximum Strain Energy Theory (Beltrami) 

 Maximum Distortion Energy Theory (Huber, von Mises, Hencky) 

 Maximum Strain Theory (St Venant) 

Results from each of the above criteria can be displayed as: 
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Design Factor  Calculation  Failure 

Failure/Yield Index actual/allowable >1 

Factored Failure/Yield Index (DF*actual)/allowable >1 

Factor of Safety allowable/actual <DF 

Reserve Factor (RF) allowable/(DF*actual) <1 

Margin of Safety RF-1 <0 

  

where:  

DF = Design factor defined with material strength 

allowable = allowable stress 

actual = actual stress 

See the Theory Manual for further information. 

Composite Layers 

When viewing composite results it is often useful to change the results orientation to material 

directions to view the results in fibre and off fibre directions. See Local and Global Results 

for more details. 

Note. A layer of a solid composite element is treated like a shell. Thus top, middle or bottom 

stresses can be obtained. 

Composite Failure Criteria 

Composite failure criteria is defined as an attribute from the Composite> Composite Failure 

menu item. It provides a means of assessing the reserve strength capacity of composite 

components without carrying out a full nonlinear analysis. To use this facility the results file 

must be loaded on top of the model file. 

 Longitudinal and transverse tensile and compressive strengths must be defined along 

with a shear strength (which cannot be zero) 

 Interaction type can be set to use Default, User, or Cowin values 

Once created the Composite Failure attribute should be assigned to the model geometry so 

that the reserve strength can be visualised over the entire model. Once assigned to the model 

the following stress components are available for display via selections made on the Contours 

properties dialog: 

 Tsai Hill 

 Hoffman 

 Tsai Wu 

 Hashin Fibre 
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 Hashin Matrix 

Results may be printed or displayed using standard results processing facilities. Note that a 

failure criteria greater than 1 indicates failure. See the Theory Manual for further information. 

Composite Failure Contours 

When using the Hashin failure material model the failure indicator (IFFLR) can be contoured. 

The indicator has the following values: 

Indicator (IFFLR)  Description 

0-1  No failure 

1-2  Matrix failure 

2-3  Fibre failure 

3+  Matrix and fibre failure 

Results may be printed or displayed using standard results processing facilities. 

Interactive Modal Dynamics 

The Interactive Modal Dynamics (IMD) facility within Modeller calculates the modal 

response of a system to a given input using the eigen modes and eigenvectors from an eigen 

analysis. (Note that the eigen analysis must have been performed with mass normalised eigen 

modes). An IMDPlus software option extends this capability to solve 2D and 3D seismic and 

moving load analyses using modal superposition techniques in the time domain. For details 

see the IMDPlus User Manual 

Interactive Modal Dynamics calculations within Modeller may be performed on single or 

multiple eigen modes, and at a single node or over the whole structure: 

 Response at a node Use the Graph Wizard to produce a graph of a specified results 

type against sample frequency range or time steps. 

 Response for all nodes Use an IMD loadcase to calculate the modal response of the 

whole structure to a specific frequency or at a particular response time. The results 

from the IMD calculation are then viewed using any of the standard plotting 

techniques such as contouring. 

Assumptions 

The working assumptions for the modal dynamics facility are as follows: 

 Linear The system is linear in terms of geometry, material properties and boundary 

conditions.  

 No Cross-Coupling There is no cross-coupling of modes caused by damping. This is 

reasonable as long as the damping of the structure does not exceed 10% of critical 

damping. 

 Low Modes Dominant The response is dominated by the lowest few modes. 
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Performing Modal Response Calculations 

Both the Graph Wizard and IMD Loadcase commands are initiated from the Utilities 

menu. The basic steps for both methods are as follows: 

1. Decide whether to perform a response analysis on a single node (Graph Wizard), or 

the whole structure (IMD loadcase). 

2. Select Eigen Modes Specify which modes to include in the analysis. 

3. Damping Specify the amount of modal damping. 

4. Excitation Apply a form of dynamic excitation to a specific node or at the supports. 

5. Results Type Choose the IMD calculation required, then set the required parameters. 

Modal Damping 

Modal damping is the damping associated with the displacements defined by the 

eigenvectors. Its value has no physical significance since the eigenvector contains an arbitrary 

normalising factor. 

Damping values can be specified explicitly or alternatively can be extracted from the results 

file. LUSAS Solver will only provide modal damping estimates if the relevant damping 

control data has been included in the eigenvalue analysis. By default, LUSAS Solver values 

will be zero. Damping is specified using percentage viscous and structural damping values. 

Notes 

 Structural damping is not used in modal response calculations in the time domain. 

 Structural damping is not applicable in spectral response calculations. 

 All damping ratios are expressed as percentages of critical damping. 

 Modal superposition techniques are not usually appropriate for structures with 

damping ratios higher than 10%, due to coupling between modes. Step-by-step 

dynamic analysis should be considered in such cases. 

Dynamic Excitation 

Eigenvalue analyses do not consider any applied load. Therefore, to carry out a dynamic 

structural analysis a load must be applied to the structure. These loads are specified either in 

terms of forces, or as motion by use of the large mass method: 

 Point Force To set the modal excitation to point force via a node number and a nodal 

freedom. This is equivalent to applying a unit concentrated force at the selected nodal 

degree of freedom. The value of the unit force depends on the chosen system of units. 
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In the case of SI units, a force of 1 Newton or a moment of 1 Newton metre will be 

applied. 

 Point Displacement (large mass method) Sets the modal excitation to point 

displacement via a node number and a nodal freedom. A force equal to the large mass 

is applied at the support point, thereby inducing a unit acceleration response, see note 

on large mass. Displacement control is effected by integrating the response twice in 

the frequency domain. Time domain displacement excitation is not currently 

supported. 

 Point Velocity (large mass method) Sets the modal excitation to point velocity via a 

node number and a nodal freedom. A force equal to the large mass is applied at the 

'support' point, thereby inducing a unit acceleration response, see note on large mass. 

Velocity control is effected by integrating the response once in the frequency domain. 

Time domain velocity excitation is not currently supported. 

 Point Acceleration (large mass method) Sets the modal excitation to point 

acceleration via a node number and a nodal freedom. A force equal to the large mass 

is applied at the 'support' point, thereby inducing a unit acceleration response, see note 

on large mass. 

 Real/Imaginary/Real & Imaginary Loading A load vector is extracted from 

specified eigenvalues (loadcases). In this case the modal forces are complex and 

therefore the modal forces are stored in two arrays - one for the real component and 

one for the imaginary. (For excitation types other than these the imaginary 

components will always be zero). Note that it is assumed that all applied forces are in 

phase. The chosen load vector need not be in the same results file as the eigenvectors 

used for the response calculation - typically only one load vector will be stored with 

the modes.  

 Support Motion To set the modal excitation to support motion. This is used when all 

the supports move together, for example in the analysis of an earthquake or when a 

small component attached to an airframe or vehicle chassis has a known vibration 

level. The calculations are based on participation factors calculated by LUSAS Solver. 

A participation factor defines the modal force resulting from a unit acceleration 

loading applied to the whole model in a specified direction. The participation factors 

for each mode in each of the global directions are stored in the results file and are used 

as modal forces in the support motion calculations. X, Y, Z direction motion or 

motion in any vector direction can be represented. General support motion can be 

modelled by applying a unit acceleration field to the model using body force loading, 

and selecting the resulting equivalent nodal forces as modal excitation. In the 

frequency domain absolute or relative support motion may be selected, the default 

being relative. 

Notes 

 Displacement and velocity excitations are not allowed for modal response calculations 

in the time domain. 
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 Support Motion excitation may be the most appropriate if all the supports move 

together. 

 Large Mass point displacement, velocity or acceleration excitation may be the most 

appropriate if the supports do not move together. 

 For Point Displacement, Velocity and Acceleration excitation, the displacement 

response is absolute and not relative to supports. 

 When using Support Motion excitation in the frequency domain, the displacement 

response may be specified as relative or absolute. If absolute is chosen then the 

motion of the support is added to the structural motion to give motion with respect to 

ground. This is useful for comparison with measured data. 

The Large Mass Method 

Interactive Modal Dynamics frequently employs an analysis technique referred to as the 

Large Mass Method. The reason for this is to earth the structure via a „moveable‟ object 

rather than a strict support to ground. This allows subsequent application of a force to the 

mass, in effect applying an acceleration to the structure. The size of this mass should be 

sufficient to ensure mass dominated local response, so that the motion of the point is 

described by Newton's Second Law (i.e. F = ma). A mass of 1E6 kg works well for most 

structures. Unduly large values may cause ill-conditioning problems. A force equal to the 

large mass is applied at the support point, thereby inducing a unit acceleration response. 

 

Modal Dynamics Results Types 

 Frequency domain response Harmonic, or forced, response analysis is used to 

investigate the effects of structural resonance (where structures are forced to vibrate 

harmonically at or near their own natural frequencies). Solution of the harmonic 

response problem as a modal analysis avoids the need to perform a full transient 

dynamic analysis. Simultaneously applied excitations may contain phase differences. 

 Time domain response (impulse or step-by-step dynamics) to dynamic excitation. 

The forcing function and the consequent response of a structure are defined in terms 
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of time histories. The Fourier transform of the time domain gives the corresponding 

quantity in the frequency domain. 

 Spectral response analysis An analysis in which a defined response spectra for a 

generic earthquake ground motion is used to estimate the maximum displacement or 

pseudo-velocity or acceleration during the earthquake, without the need for direct 

integration of the model over the complete duration of the event. Dynamic excitation 

is applied to all the supports simultaneously. A response spectrum curve defines the 

magnitude of excitation. If the damping in the response spectrum curve differs from 

that defined for the model a damping correction may be applied using one of formula 

provided. The maximum displacements, forces and stresses are computed throughout 

the structure for each eigenmode. These values may then combined to produce a 

single positive result using a spectral combinations. The spectral combinations 

available are CQC (default), SRSS and Absolute Sum. For further details see the 

LUSAS Theory Manual. 

 Power Spectral Density (PSD) Analyses the frequency response to a random modal 

vibration, such as aerodynamic loads acting on an aircraft component. A frequency 

PSD defines the frequency content of the random loading. Dynamic excitation should 

be applied to all the supports via support motion excitation.  

Frequency and Time Domain Response 

Frequency and time domain response calculations are the most commonly used. Usually, a 

node is excited across a frequency (or time) range to generate a graph for the frequency or 

time response (using the Utilities> Graph Wizard menu item). From the response across a 

range, a single frequency may be selected to perform an IMD calculation on the whole 

structure (using an IMD loadcase). The following diagrams illustrate this procedure: 

Results across a frequency range, or time history 

Response at a node calculated across a specified 
frequency range 

Response at a node calculated across a specified 
time history 
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Results at a specific frequency, or time step 

Response calculated at a specified frequency for 
the whole structure  

Response calculated at a specified time for the whole 
structure 

  

  

Frequency Power Spectral Density 

A Power Spectral Density (PSD) defines the frequency content of a random loading, such as 

turbulent pressure acting on an aircraft component, and are for use in modal random vibration 

response analysis. At present, random modal vibration calculations are restricted to single-

input systems, where the loading at all points is fully correlated. 

The value of PSD used in response calculations will be interpolated from a table of 

frequency/PSD values. A range of linear and logarithmic interpolation schemes are provided, 

in accordance with typical PSD specifications. Dialog input requires: Interpolation type, 

options are: Linear/Linear, Log/Linear, Linear/Log, Log/Log; Frequency; Amplitude. More 

copious PSD tables may more easily be defined by copying and pasting the data from a text 

file or spreadsheet.  

Response Spectrum 

Response spectrums for use in spectral analyses are defined from the IMD loadcase dialog.  
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The value of the frequency used in spectral calculations will be interpolated from a table of 

frequency-amplitude or period-amplitude values. More copious Response Spectrum tables 

may more easily be defined by copying and pasting the data from a text file or spreadsheet.  

 Frequency/Period/Displacement/Velocity/Acceleration The value of the frequency 

used in spectral calculations is interpolated from the values defined. The type of 

values entered, i.e. displacement, velocity, or acceleration should match the type of 

support motion which is used to excite the structure. For earthquake analyses it is 

usual to specify Acceleration, and to later specify a support motion using acceleration. 

 Spectral curve damping This value defines the percentage damping inherent in the 

response spectrum curve itself. If the Eurocode or Kapra damping correction formula 

are specified, the spectral response curve is adjusted to the viscous modal damping 

value specified in the IMD loadcase. When using other damping correction formulae 

the spectral curve is adjusted using only the viscous damping. For more details see 

Theory Manual. 
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Case Study. Forced Vibration of a Simply Supported Cantilever 

Consider the forced vibration of a simply supported cantilever beam. The beam is 

supported at one end and subjected to a uniformly distributed load. An eigenvalue 

analysis is carried out for 9 modes. Normalisation with respect to Global mass must be 

selected when defining the eigen control.  

Calculation of the modal results in the frequency domain is required for Displacement 

type response for the end node for the Y-direction displacement. Results are to be 

calculated over a suitable frequency range using a specified frequency step. The results 

type required will be Amplitude.  

Modal response calculations are carried out as follows: 

1. Read in the results file from the eigenvalue analysis. Use File> Open and specify 

the results file name. 

2. Click on Utilities> Graph Wizard. Choose Modal Expansion then click on the 

Next button. 

3. Click on Frequency to specify the frequency domain. 

4. Choose a Point force excitation, then click on the Set button to define the 

parameters. Excite the structure at the unsupported end node in the Y-direction. 

Enter the node number or, if the node is selected, choose the number from the 

drop-down list. Click on the OK button, then click on the Next button. 

5. Specify the results entity as Displacement, component DY and the results type as 

Amplitude. Take care to specify a realistic start, end and frequency step. Specify 

which node to calculate the response at, then click on the Next button. 

6. Specify a Title and X and Y axis labels, then click on the Finish button. This will 

create a standard frequency vs. amplitude plot for the response from the specified 

excitation. Two graph datasets will be created, the first containing the frequency 

range in the steps specified and the second containing the required amplitude 

values. 

User Defined Results 

Defining expressions 

 The User Defined Results dialog is accessed from the Utilities> User Defined Results menu 

item. It allows results components to be defined by creating arithmetic expressions based 

upon LUSAS results entities, components, model data and other user-defined results 

component calculations. A component name and description can also be entered.  

A results file must be loaded in order to define a user results expression.  
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 Clicking on the drop-list button  in the Entity cell lists all entities available for the 

particular results file loaded.  

 Clicking on the launch dialog button  in the Expression cell displays a dialog 

populated with valid variables for the selection made in the Entity field. By use of 

these variables and usual arithmetic syntax a user defined results expression can be 

built and assigned a name and a description. 

For details of expressions and functions supported see Input and Output of Real Numbers 

in LUSAS in Appendix E. 

 

Using named expressions 

After definition, the user results components created can be selected by name from the 

Component drop-down list on the Contours, Values, and Diagrams layers properties dialogs. 

All standard LUSAS results processing, viewing, animating, graphing, printing and report 

capabilities can be used with any user-defined results components. 

 

Visualising The Results 

Results visualisation is performed using results layers in the  Treeview . Each method of 

viewing results, described below, involves adding a layer to the current window. The 

properties of the results layers may then be set to display the required results in the specified 

style.  
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 Deformed Mesh Draws the deformed mesh shape of a structure when subjected to 

applied load or due to mode of vibration. 

 Contour Display the results on the model as colour fringes or lines of equal value.  

 Vector Displays vector results quantities as an arrow (or pair of arrows) on the model. 

 Values Marks result values on the model as symbols and/or values.  

 Diagrams Displays beam element shear force and bending moment diagrams. 

In addition to those layers listed above, an Annotation layer is used to hold contour key and 

other annotation data that may be added to the results viewing window. 

All results visualising will use the results from the active loadcase for the current window. 

The active loadcase is shown with a coloured icon in the   Treeview, and may be changed 

using the loadcase context menu. Non-active loadcases are shown with a greyed-out icon. 

Inserting a Results Visualisation Layer into the Current 

Window 

 Layers can be added (or removed) from the current window using the View> Drawing 

Layers menu item. A tick is displayed on the menu next to each layer contained in the current 

window. Alternatively, with nothing selected, right-click in the graphics area to display the 

context menu and add the appropriate layer. Another alternative is to select a layer name from 

the context menu of the Window name in the   Treeview. 

The display of layers in the current window can be turned on or off by right-clicking on the 

layer name in the  Treeview and selecting / deselecting the On/Off option. See Using 

Layers for more information 

Tips 

 Use the annotation tools to label the display. The annotation toolbar may be 

displayed using the View> Toolbars menu item. 

 When comparing different loadcases for the same results type, using multiple 

windows, or when creating an animation sequence, use a global scale (and a global 

contour range) so that scaling and contouring in each frame is relative to the first 

frame. 

Layer names for results layers 

Contours, Diagrams, Vectors and 

Values results layer names as added 

to and seen in the Layers  

Treeview have the component (such 

as Mx, My or Fz, for example), 

appended to the layer name followed 

by the entity type such as 
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(Force/Moment - Thick 3D Beam). If different component and entities are selected at a later 

time the layer name in the Layers  Treeview is updated to reflect the chosen selection. 

Deformed Mesh Plots 

The deformed mesh may be displayed at any time 

for a single loadcase. For a structural analysis this 

is the shape under load, whereas for an eigenvalue 

analysis this is the shape corresponding to the 

selected eigen mode. 

 Mesh Scaling is specified as either a 

deformation factor or a deformation 

magnitude. The deformation magnitude 

specifies the maximum deformation to be 

displayed on the page in millimetres. 

 Mesh Style The deformed mesh style may 

be altered as required using wireframe, 

solid colour, hidden mesh, and element 

effects.  

 

Comparing The Deformed And The Undeformed Shape 

Drawing the mesh and the deformed mesh together but in different pens is useful for 

visualising the deformations. 

 

In the example of the grillage shown, the scale of the deformed plot is greatly exaggerated 

using a scale factor of 10. The undeformed plot is drawn using a lighter pen colour to further 

clarify the display. 
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Notes 

 Other results visualisations may be displayed on the undeformed or deformed shape as 

required. 

 When carrying out contact analysis a unit deformation factor should be used to avoid 

misleading results. 

 When an analysis involves the activation and deactivation of elements, inactive 

elements may be hidden using the show activated only option on the visualise page 

of the mesh properties dialog. 

Contours 

Contours display the results of the active loadcase on the model as colour fringes or lines of 

equal results value.  

Contour Display Features 

 Contours may be plotted using colour fill and/or contour lines. Fill and line contours 

displayed together are useful for emphasising the contour levels. Contour labels are 

available if required. 

 Contours may be plotted on the deformed (loaded) shape or the undeformed shape. 

 Contours may be plotted using averaged nodal results to give a smoothed plot, or 

unaveraged nodal results to contour the results on an element-by-element basis, 

revealing any inter-element discontinuities. This is useful for checking mesh 

discretisation error and for displaying results across geometry or material 

discontinuities. 

 Contours can be plotted on shells, solids, bar and beam elements, on fleshed members 

and on layers of composite elements.  

 The maximum and/or minimum results value and node location can be annotated. 

 The appearance of the contour key can be adjusted to specify the number of 

significant figures, draw an outline around each colour in the key and draw red or blue 

uppermost. 
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Setting the Contour Levels 

By default the levels at which contours are plotted are calculated automatically but they can 

also be set explicitly. A contour level corresponds to the boundary between adjacent colour 

fringes, or the line of equal value. 

 Setting the range automatically can be done by specifying either the number of 

contours or the interval value between contours.  

 Automatic contours levels can be set to pass through a certain value. The maximum 

and minimum contours may also be specified. 

 A global range can be used to fix the contour levels between different contour 

displays. This is often used before animating contours, so that all animation frames 

use the same contour range. It is also useful to fix the contour levels manually when 

comparing results from different loadcases or when using multiple windows. 

Tip. Contours use the colour map to define the colours used. It is often useful to adjust the 

colour map so that low stress contours are set to white. This makes contour plots easier to 

understand, and also avoids excessive use of single colour ink when printing.  

Vectors 

Vectors are used to visualise both the magnitude and direction of specified results 

components. Vectors may be displayed at either nodes or Gauss points.  

Scale 

By default, vectors will be scaled such that a vector length of 6mm represents the maximum 

displayed results component. Alternatively, a scale factor can be specified.  



Modeller Reference Manual   

    

348 

Style 

Vectors may be drawn as lines or arrows. By default the colours used for drawing vectors in 

tension and compression are red and blue but the pens can be altered as required. 

Deformed Shape 

This image shows displacement vectors displayed on the deformed shape. 

 

Values 

Values are used to identify the location and value of results for both averaged nodal 

(smoothed), element nodal (unaveraged) and Gauss point values. Either maximum and/or 

minimum values may be visualised, and a percentage may be specified to determine whether 

values lying within a maximum/minimum range are displayed. Values may also be displayed 

at selected nodes. 

The Values layer is also used to display the locations of yield symbols and crack/crush 

planes. 

 

 
Maximum and minimum values marked Values plotted for selected (shrunk) elements 

 

 
Visualisation of yielded material Visualisation of concrete crack patterns on a 2D model 
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Tips: 

 The percentage range sets the range of values to display, starting from the maximum 

and/or maximum values. Setting this value to 100% displays all values, this is useful 

for displaying nodal results on the screen for a subset of a model. Setting this value to 

0% shows only the extreme maximum and/or minimum setting. 

 To prevent text labels from overlapping each other the elements on which that are 

drawn may be shrunk by specifying the % of elements remaining on the Mesh layer 

properties dialog. Additionally text may be given a rotation angle on the Values layer 

properties dialog to prevent text labels from overlapping each other. 

 Use the Show values of selection option to isolate only those values of interest, or to 

restrict labelling on complex models to selected nodes and elements only. 

 Gauss point values display the computed values from the analysis. These values may 

be particularly useful when examining results for nonlinear materials. 

 Unaveraged values display the computed values after they have been extrapolated to 

the element nodes but before they have been averaged. These values may be of 

particular interest when examining results around discontinuities in geometry of 

materials. 

Diagrams 

Bending moment and force diagrams may be drawn for any 2 or 3 dimensional frame 

structure comprised of bar or beam elements. All of the results for diagrams are located 

within the Stress results entity, and the results components available will depend upon the 

element type (see Element Reference Manual). The diagrams may be drawn using the element 

axes or screen axes. 

The following quantities may be represented: 

 Axial Forces local x direction beam forces. 

 Shear Forces through-thickness shear forces. 

 Bending Moments bending moment results. 

 Torsional Moments 
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Plotting Results for Groups 

By default results are computed and displayed on the visible model. When appropriate layers 

are present in Layers  Treeview, results can be selectively plotted for groups held in the  

Treeview by choosing the following Results Plots context menu items for each named group: 

 Show Results  

 Do Not Show Results  

 Show Results Only On This Group / Attribute 

When combined with group visibility options that can also be accessed via the context menu 

for each group name parts of the model can be isolated and have results plotted just for those 

regions.  

Pairs of symbols adjacent to each group name in the  Treeview show the status of model 

visibility and results display. 

When viewing results: 

 (green tick) All of the objects in this group are visible, but no results are being shown. 

 (blue tick) Some of the objects in this group are visible, but no results are being shown. 

 (red cross) None of the objects in this group are visible and no results are being shown. 

 (green tick, green border) All of the objects in this group are visible and showing results. 
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 (blue tick, blue border) Some of the objects in this group are visible and some are 

showing results. 

 (green tick, blue border) All of the objects in this group are visible but only some are 

showing results 

Notes 

 When choosing to show results for a material, geometric property or element mesh 

type that does not support (for example) the same Contour entity as that used for the 

previously plotted item, no results will be shown until a valid Entity and Component 

for the new selection is picked on the Contours property dialog accessed via the 

Layers  Treeview. 

 A black dot next to a group symbol  denotes the current group into which all new 

geometry will be added when created and hence has no relevance when viewing 

results.  

Plotting Results for Assigned Attributes 

By default results are computed and displayed on the visible model. With appropriate layers 

present in Layers  Treeview, results can be selectively plotted for attributes held in the 

Attributes  Treeview by right-clicking on the attribute name and then choosing Results 

Plots. The following context menu commands are available for Results Plots: 

 Show Results 

 Do Not Show Results 

 Show Results Only On This Attribute 

When combined with visibility options that can also be accessed via the context menu for 

each attribute selected features of the model can be isolated and have results plotted just for 

those features. This provides a means of producing isolated results for particular material 

types, geometry, or element mesh types without having to define individual groups for each 

of these items. But, if required, groups of features or elements may be defined and the Results 

Plots entry may be used to display selected results for a chosen group. 

Notes 

 When choosing to show results for a material, geometric property or element mesh 

type that does not support (for example) the same Contour entity as that used for the 

previously plotted item, no results will be shown until a valid Entity and Component 

for the new attribute selection is picked on the Contours property dialog accessed via 

the Layers  Treeview. 
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Nonlinear Material Results Display 

Two types of nonlinear material results may be displayed. Yield flags and crack/crush 

patterns. The availability of each depends on the material model assigned to the elements 

during the modelling stage. Crack and crush patterns are available for concrete models and 

yield flags are available for all nonlinear materials. 

  

 Yielded material 

Available from the Values layer, 

specify the results entity as Stress, 

and the type as Yield. Yield flags 

show the extent of the yielded 

material within a structure and are 

plotted at Gauss points. The 

nonlinear example here 

demonstrates how the spread of 

yielded material is visualised 

using a symbol at element Gauss 

points. 

  

This display is especially useful when used in conjunction with contours or an 

animated sequence when the onset and spread of yield can be highlighted.  

 Crack and Crush Patterns Crack and crush patterns can be displayed for models 

that use the Concrete material model. Crack patterns are visualised using the Values 

layer by specifying the Results Entity as Stress and the Type as Crack/Crush. 

 

 The patterns displayed show the extent of cracking/crushing and the orientation of 

the cracked and crushed planes. 

 
Crack pattern 

 
Crack and crush pattern 
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Results On Sections / Slices Through A Model 

Results can be plotted on sections or slices through a model by choosing the following menu 

commands available from the Utilities menu: 

 Section through 3D Cross-sections may be taken through a three-dimensional solid 

model to display results on a slice. Results are calculated at pseudo-nodes formed at 

the intersections of the slice with the element edges by linear interpolation of the 

nodal results. 

 Graph through 2D Graphs of results may be created along a line through a 2D 

continuum model or on a line through a section from a 3D model. Results are 

calculated at the intersections of the line section and the element edges hence a finer 

mesh will produce more sampling points. Force and moment values along the slice 

may also be computed. 

Section Through a 3D Model 

Slice sections may be cut at arbitrary positions 

through the model using the cursor to define 

either a horizontal or vertical slice in the View 

window. Slices may be generated in any plane 

by rotating the model to the desired orientation 

before a section is cut. 

By default the location of an arbitrary slice 

section through a model is not saved with the 

model. However, when cutting a slice section 

through the model an option to create an 

annotation polygon is provided. This annotation polygon effectively defines the location and 

orientation of the cutting plane and does get saved with the model. Annotation polygons may 

be re-selected if a model is reloaded at a later date in order to create a slice at the same 

location.  

Slice sections can also be created using surfaces that are created at slice section locations. 

These surfaces do not have to surround a model, they must simply be defined in the 

orientation of the cutting plane required. 

To use a saved cutting plane or a surface defining in cutting plane instead of indicating the cut 

using the cursor, the annotation polygon or surface should be selected before choosing the 

Utilities> Slice through 3D menu item, and By selected polygon / surface option. 

Notes 

 No results visualisation or printed results for slices are available unless the Display on 

slice(s) option has been selected on the Contours and Values properties dialogs or on 

the Print Results wizard dialog. 
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 3D sectioning/slicing is only available for 3-Dimensional solid models. For surface 

models refer to Graph Through 2D below. 

 A slice can form the basis for a line section using Graph Through 2D to graph 

results along a line through the centre of a three dimensional solid. 

Manipulating The Slice 

Once a 3D slice section has been defined, a slice 

exists as a group in the  Treeview, and may be 

manipulated using the View> Group menu item or 

from the group's context menu. For more details on 

viewing results on groups see Plotting Results for 

Groups.  

Notes 

 The mesh and nodes on the slice are 

displayed using the mesh layer  

properties. 

 The slice local axes and origin are displayed 

and moved from the slice properties accessed from the slice context menu. 

 The resultant local forces on the slice and the slice properties may be printed from the 

slice context menu. 

 Groups created from slice sectioning a 3D model cannot currently be retained when a 

model is saved. 

Graph Through 2D 

Arbitrary line sections may be taken through any surface model or on a slice cut through a 

three dimensional solid model. The process of cutting a slice will generate two graph datasets, 

the first containing the distance along the line section and the second containing the specified 

results along the line. The graph datasets are plotted automatically using the Graph Wizard. 

Graph datasets are stored in the Utilities  Treeview.  

By default line sections may be cut at arbitrary positions through the model using the cursor. 

Lines can also be defined to start and finish at points located on an underlying grid. When 

cutting a line section through the model an option to create an annotation line is provided. 

This may be used later for repeating the cut if a graph along the same line is required. To use 

an existing line (or annotation line), instead of indicating the cut using the cursor, the line (or 

annotation line) should be selected before choosing the Utilities > Graph through 2Dmenu 

item. 
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Notes 

 Care should be taken when slicing through voids, or holes, in the model as this can 

give misleading results. 

 Care should be taken when slices pass through parts of the model with non-uniform 

properties, such as parts of different materials or of different thickness. 

 Sometimes, due to model size, grid points are too close together to be usable. In these 

cases simply increase the grid size so that individual grid points can be selected. 

Graph Wizard 

Two types of graphs may be plotted: 

 Results quantities Any available result entity may be plotted against distance along 

the slice. 

 Axial force and bending moment This generates three datasets of distance, axial and 

bending stress along a line through a section: the axial force per unit width, moment 

per unit width and distance of the neutral axis to the midpoint of this line. For 

axisymmetric solids the moment per unit radian is printed as well. From these 

datasets, graphs of axial and bending stress versus depth of section are plotted. 

For more details on viewing results on graphs see Plotting Results on a Graph. 

Displaying Beam Stresses 

Beam stresses can be displayed on the fleshed section or at selected fibre locations. These 

stresses are computed using engineering beam theory which assumes that the normal stress is 

constant across the width of the beam cross section. This assumption can introduces 

significant errors due to shear lag when wide flanged sections are being used so these stresses 

should be used with caution. 

Beam stresses can be displayed as contours on the fleshed section or as values, diagrams or 

beam contours at fibre locations using the standard layer controls. When viewing stresses at 

fibre locations the value, diagram or contour is drawn at the actual position of the fibre on the 

cross section. 

Examples follow: 
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Filled contours plotted on fleshed beam sections 

  

 
Line contours plotted on fleshed beam sections 
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Line contours plotted at top beam fibre location 

  

 
Line contours and diagram stress results plotted at bottom beam fibre location 
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Fibre locations 

When plotting selected contour or diagram results 

for beams, a fibre location must be used to specify 

the place(s) on the beam section at which the 

results should be calculated and plotted. Results for 

individual fibres are plotted by setting that fibre 

location active for a particular geometric line 

attribute in the  Treeview. The active fibre is 

denoted with a black dot next to the fibre name. 

 

 Right-clicking on a fibre name in the  

Treeview and choosing Set Fibre Active 

will display results for just that fibre. 

 Right-clicking on a fibre name in the  Treeview and choosing Set Fibre Name will 

display results on all members with that fibre name. 

Notes 

 Standard sections extracted from the section library include extreme fibre locations for 

all sections.  

 The standard section property calculator automatically includes extreme fibre 

locations for all cross- sections that it supports. 

 Models created prior to version 14.2 will not have any fibre locations data stored for 

each beam. However, the relevant fibre location data can be added automatically by 

double-clicking on each Geometric line entry in the  Treeview and re-selecting the 

same section size from the appropriate sections library. 

 User-defined beam cross-sections require fibre locations to be defined manually in 

order for stresses to be displayed on the diagrams and values layers. 

Beam Stress Resultants From Beams and Shells 

The slice resultants from beams and shells facility allows the computation of the equivalent 

beam stress resultants for flat or curved thin and thick shell models. This allows the 

conversion of the results of a complex shell model into an equivalent beam analogy for use in 

design codes of practice. The slice resultants are computed using valid visible 3D beam and 

shell elements. Invisible elements are ignored. 

Slice locations 

The slice locations are defined using a path which can consist of straight lines and arcs or 

combined lines that contain straight lines and arcs in the selection. The path must be 

continuous without any branching characteristics. The slice path orientation is defined by 

either the order of selection when more than one line/arc is selected or the orientation of the 
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line/arc if only a single line/arc has been selected. The locations for the slices along the path 

can be defined using three methods: 

 From points or nodes in the selection If nodes or points are selected, these are 

projected onto the path perpendicular to the appropriate path segment tangent to 

obtain the slicing locations 

 Incremental distances from start of path Incremental distances can be entered to 

define the distances along the path for the slicing. Distances can be both positive and 

negative but the running total distance should remain within the length of the path. For 

example, 1@0;1@10;1@-5 will cut slices at distances of 0, 10 and 5 along the path 

 Absolute distances from start of path Absolute distances can be entered to define 

the distances along the path for the slicing. Distances must be positive and within the 

length of the path. For example, 0;5;10 will cut slices at distances of 0, 5 and 10 along 

the path 

 The Distance from reference origin to start of path can be also be entered. If this 

value is non-zero, the value is added to the distances along the path. 

The orientation of the slice local axes is defined from both the tangent of the path at the 

location of the slice and the direction that the model is viewed from. If the slicing path is in 

the plane of the screen the positive slice local z axis will be defined by the tangent of the path 

and the positive slice local y axis will be orientated in the out of screen sense. If slicing path 

is not in the plane of the screen, the positive slice local y axis will be defined perpendicular to 

the path tangent in the path tangent/out of screen plane. The positive slice local x axis will be 

defined perpendicular to both the slice local y and z axes.  

 Options are available for the calculation of the moments about either the Neutral axis 

or the Path intersection with the slice plane.  

Note: For the calculation of beam stress resultants it has to be assumed that plane sections 

remain plane under the action of the loading. The strain distribution over the whole section 

also is assumed to remain linear. The location of the neutral axis can therefore be calculated 

directly from the areas and stiffness of the contributing materials in the composite cross-

section (see Gere & Timoshenko, Mechanics of Materials, 3rd SI Ed., pg 301-). For the 

calculation of the neutral axis location, the Transformed-Section Method is used which 

incorporates Modular Ratio techniques. 

Slice options 

Additional options are available for the control of the slicing. These include: 

 Effective width If the effective width option is selected, the width of visible elements 

to include in the calculations can be specified. This effective width is centred on the 

slicing path in the screen plane at a perpendicular to the path. If the effective width is 

not used, all valid visible elements will be included in this direction. For both options, 

the slice is infinitely deep in the slice local y axis 
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 Include whole elements only If the effective width option is selected, the option to 

include whole elements only is available. If selected, partial elements intersected by 

the current slice will be ignored in the calculations 

 Smooth corners on path If the smooth corners on path option is selected, the average 

tangent of the path at a connection between two lines/arcs will be used for the slicing 

if the distance along the slice path exactly matches this path connection. If the smooth 

corners on path option is not selected, two slices will be taken at the connection using 

the tangents for both of the lines/arcs connecting at this location 

 Slicename prefix Allows user to input a user defined prefix for the slice names 

Loadcase 

Slice resultant results can be output for one or more loadcases 

 Active - prints slice results for the active loadcase to a slice output window. 

 All - prints slice results for all loadcases to a text file named 

SliceResultantsBeamsShells.prn in the current working directory. 

 Selected - prints slice results for entered loadcases to a text file named 

SliceResultantsBeamsShells.prn in the current working directory. As an example, 

entering 1-5,7 would select loadcases 1 to 7 excluding loadcase 6. 

Notes 

 The assumption that plane sections remain plane which is required for the calculation 

 Linear variation of stress is assumed for the approach and therefore low order flat 

shells are supported (3 or 4 noded thin and thick shells) and high order flat shells are 

calculated ignoring the mid-side nodes if they are coplanar with collinear edges. For 

curved high order shells the element is subdivided into constituent pseudo elements 

and each pseudo element interrogated using linear interpolation 

 The slicing path must be defined using straight lines, arcs or combined lines 

containing only these two line types. Splines and annotation lines cannot be used 

 Slice forces can only be computed relative to the intersection of the slicing path with 

the slice plane or the neutral axis based on the sliced section. No facilities are 

available for the transformation of slices without defining a separate path and 

recalculating the slices 

 Taking slices at the free end of a structure can lead to overestimation of the forces and 

moments on the section. This occurs due to the stresses in the section not returning to 

zero at a free and unloaded end 

 Taking slices at a supported end of a structure can lead to discrepancies in the forces 

and moments when compared to a beam model due to the end effects taken into 

account by the full 3D shell modelling 
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 Where a slice passes through a node in the structure, results are presented for the 

contributions of the elements on both sides of the slice. This is presented as results for 

the negative and positive local Z sides of the slice 

 Engineering thick beam elements are supported (BMS3 and BTS3) along with thin 

beam (BS3, BS4, BSL3 and BSL4) elements 

 Option 380 must be used for BTS3 elements when using eccentricitices/offsets 

 When using 3 or 4-noded shell elements the mesh density should be sufficiently fine 

to capture the behaviour of the structure 

 When modelling curved structures it is recommend that regular quadrilateral elements 

wherever possible 

 Printing results for more than one loadcase will overwrite the text file named 

SliceResultantsBeamsShells.prn each time. 

Slideline Results Processing 

When a results file is read into Modeller from an 

analysis that involves slidelines, a group is created for 

each slideline surface in the model. These groups can 

be accessed from the Group Treeview.  

A context menu for each group name provides options 

for making the members of a group visible or invisible 

and for selecting and deslecting the members of a 

group.  

Limited results for a selected slideline group can be 

printed by using the Print Results menu item on the 

context menu for that group. Full slideline results for 

the model as a whole can be printed using the Print 

Results Wizard. 

Printing Slideline Results 

The print results wizard is accessed from the Utilities menu. When Slideline results are 

selected the following six types of results can be chosen for printing: 

 Summary 

 System forces 

 Gap Forces 

 Contact forces 

 Contact Stresses 

 Section Results 

 Each type of result is described below. 
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Summary 

The summary presents a list of the maximum and minimum values of each slideline results in 

a table. 

System, Contact and Gap Forces 

There are three categories of force results: 

 System forces The normal and tangential gap forces at each slideline node are 

distributed across both slideline surfaces. These forces are assembled together and 

transformed into the global system directions to give the System Forces. 

 Gap forces Gap forces are computed from the normal penetration and the tangential 

movement of a node. They are the basic quantities used in the contact formulation. 

For example, with the penalty method the normal gap force at a node is obtained by 

multiplying the normal penetration with the contact stiffness. Coulomb‟s law of 

friction also uses gap forces. To check the application of the law, the normal and 

tangential gap forces should be compared. 

 Contact forces The normal and tangential gap forces at each slideline node are 

distributed across both slideline surfaces. These forces are assembled together and 

kept in the local directions, normal and tangential to the contact surfaces, to give the 

Contact Forces. The contact pressures and stresses are based on these forces. 

Contact Stresses 

This category contains results for the contact pressure normal to the surface and the contact 

stresses tangential to the surface at each node. 

Section Results 

This category contains generic contact results. It includes the status of each node as to 

whether it is in contact or out of contact, the normal penetration for each contacted node, the 

contact stiffness, the nodal contact area and the zonal contact distance. 

Graphing Slideline Results 

To graph slideline results, the slideline group of interest must be set visible from the group 

context menu in the Group Treeview . 

For two-dimensional analyses the graph wizard can be used to generate the variation of a 

particular slideline result along the slideline surface. The variation along the surface can 

either be graphed against distance or angle. 

For three-dimensional analyses the slideline results are graphed in the same manner as other 

results. 
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Plotting Contours, Values and Vectors for Slidelines 

For three-dimensional analyses, contours of contact results can be displayed by selecting 

Slideline Results as the entity on the Contours dialog. The full list of slideline results will 

then be available in the Component combo. 

Slideline values and vectors can be displayed for both two and three-dimensional analyses by 

selecting Slideline Results on the Values or Vectors dialog. With values the full list of 

slideline results components is available, whilst with vectors only Contact and System Forces 

are available. 

Note. When looking at the deformed mesh from a contact analysis, the exaggeration factor 

should be set to 1.0 to avoid a misleading visualisation. 
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Table of Slideline Results Availability 

Slideline Results components Label Contours Values Vectors Printing Graphing 

System forces             

Contact force in system x direction ForceX  Yes Yes Yes Yes Yes 

Contact force in system y direction ForceY  Yes Yes Yes Yes Yes 

Contact force in system z direction ForceZ  Yes Yes Yes Yes Yes 

Resultant contact force RsltForce  Yes Yes Yes Yes Yes 

Gap forces              

Tangential gap force in local x direction TanGapFrcX  Yes Yes   Yes Yes 

Tangential gap force in local y direction TanGapFrcY  Yes Yes   Yes Yes 

Resultant tangential gap force RsltTanFrc  Yes Yes   Yes Yes 

Gap force normal to contact surface NrmGapForc  Yes Yes   Yes Yes 

Contact forces             

Tangential contact force in local x direction TanForcex  Yes Yes Yes Yes Yes 

Tangential contact force in local y direction TanForcey  Yes Yes Yes Yes Yes 

Resultant Tangential contact force RsltTanFrc  Yes Yes Yes Yes Yes 

Contact force normal to contact surface NrmForce  Yes Yes Yes Yes Yes 

Contact stresses             

Contact stress in local x direction  ContStresx  Yes Yes   Yes Yes 

Contact stress in local y direction  ContStresy  Yes Yes   Yes Yes 

Contact pressure normal to contact surface ContPress  Yes Yes   Yes Yes 

Section Results             

Contact stiffness ContStiff  Yes Yes   Yes Yes 

Penetration normal to contact surface NrmPen  Yes Yes   Yes Yes 

In-contact/out-of-contact status ContStatus  Yes Yes   Yes Yes 

Nodal contact area  ContacArea  Yes Yes   Yes Yes 

Zonal contact parameter Zone Yes Yes   Yes Yes 

Zonal contact detection distance ZnCnDetDst  Yes Yes   Yes Yes 

Contact stiffness coefficient IntStfCoef Yes Yes   Yes Yes 

Thermal Surface Results 

The results from analyses involving thermal surfaces may be processed in a similar manner as 

other results. Extra result types are available for thermal surfaces.  

When reading a results file a group is automatically created for every thermal surface used in 

the analysis. These are accessed from the Group Treeview .  
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For 2D slidelines the graph wizard can be used to generate the variation of the thermal 

surface variables along the surface or as a history though the analysis. When multiple thermal 

surfaces are present results for specific thermal surface are viewed by setting the appropriate 

surface as only visible from the group context menu.  

For 3D problems contours of the thermal surface results may be displayed on the thermal 

surface. Values and vectors can be displayed for both 2D and 3D problems. The results on a 

thermal surface are displayed by selecting the Thermal Surface Results entity on the 

appropriate property dialog.  

Thermal surface results may be printed using the print results wizard. 

  

Thermal surface flow results Label 

Gap and environmental flow GapEnvFlw 

Radiation flow between segment RadFlwSeg 

Radiation flow to environment RadFlwEnv 

Total nodal flow TotalFlw 

  

Plotting Results on a Graph 

The Graph Wizard is used to draw XY graphs. The following results graphs may be plotted if 

the results are available:  

 Time history A history for a specified results type throughout an analysis with respect 

to time or increment. Graphs may be plotted for a named variable such as Total Load 

Factor or Response Time verses a specified results quantity such as displacement in 

X, equivalent stress or sum of reaction over a set of specified nodes. The following 

history datasets are available: 

 Nodal Averaged or summed. 

 Gauss Point results for a selected element and Gauss point (Element Gauss 

numbers may be determined using the labels layer). 

 Named Named result variables for a linear analysis such as loadcase ID, a 

transient analysis such as response time, or a nonlinear analysis such as total 

load factor. 

 Strain energy and plastic work Total strain energy or total plastic energy for 

the elements showing results. 

 Previously defined 

 Fourier expansion The displacements, stresses and strains output from a Fourier 

analysis are coefficients of corresponding sine and cosine functions. The evaluation of 
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these functions around the circumference of the model is achieved graphically using 

the Graph Wizard. 

 Modal expansion Graphs the modal response of a structure to dynamic excitation 

using the results from an eigenvalue analysis. Various results entities may be plotted 

against a frequency range or sampling time for selected eigenmodes. 

 Load curve Graphs a defined load curve. 

 Variation Graphs a variation function. 

 Specified datasets Graphs two previously defined datasets. 

 Thermal surfaces Graphs results along a thermal surface. 

 Slideline (assigned to line) Graphs results along a slideline.  

Note: To graph a specified results entity against distance along a slice through a planar 

structure or on a slice of a three dimensional solid structures see Graph Through 2D. 

Graph Properties 

LUSAS uses the Graph Wizard to take you through each step of creating the X and Y 

datasets and placing them into a graph. The graph wizard is started from the Utilities menu. 

The X and Y datasets are then stored in the Utilities Treeview . 

 

The graph window is split in to the graph area on the right and the graph data table on the 

left. 

Tip. Zoom in on a part of the graph by boxing with the mouse. To unzoom right-click on 

graph area to display the context menu and select unzoom. 

Plotting Families Of Curve Data On The Same Graph 

If a graph already exists, then further curves may be added to the first graph by choosing the 

Add to existing graph option of the final page of the Graph Wizard. In this way families of 

curves may be drawn on the same graph using a different colour for each one.  
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Editing Graphs 

Once a graph has been plotted, the appearance and even the data on the graph may be 

modified. This may be done by selecting the Edit> Graph Properties menu item from the 

graph context menu. 

Editing Graph Data 

To change individual data points on the graph (for example to add an origin to a curve), make 

the graph data table editable by checking the Editable graph table box on the General Graph 

Properties page of the Graph Properties dialog. The following facilities are then available: 

 New data points may be added by adding new rows to the grid either by using Insert 

Row from the Edit menu or by pressing the Tab key when the cursor is in the final 

cell. 

 Data points may be deleted by deleting the data in the grid. 

 Blocks of data from a spreadsheet may be pasted. New rows will be added to the grid 

as necessary. 

Note. These changes are made to the graph only and are not stored in the corresponding graph 

dataset. 

Pasting Graph Data To Spreadsheets 

 

To paste graph data to a spreadsheet, use Copy from the Edit menu when the data has 

been highlighted in the graph data table, then paste into the spreadsheet. 

It is also possible to export selected or all 

graph datasets to a .csv file by using the 

context menu for the Graph entry or 

graph dataset name in the Utilities 

treeview. Columns of data are created 

with graph dataset names being written to 

row one of each column. 

Printing Graphs 

 

Graphs may be printed using the File> Print command. Because graphs are created 

as separate windows a single graph will be printed on each page. 

 

  

To print multiple graphs together use Copy from the Edit menu when the graph area 

is active, then paste into a suitable word processor. 
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Case Study. Plotting Families Of Curves 

To compare results at different nodes a graph will be plotted of the stress throughout an 

analysis at three nodes, say 6, 25, and 60. Using a suitable results file, first select the 

nodes with the cursor, then: 

1. Start the Graph Wizard from the Utilities menu.  

2. Choose Time History, click Next. 

3. For the X axis choose Named variable, click Next, choose Response Time, click 

Next. 

4. For the Y axis choose Nodal, click Next, specify the results entity as Stress, 

specify node number 6, click Next. 

5. Either type suitable graph and axes titles, or leave them blank to use default 

names, click Finish. The graph is displayed. 

6. Repeat steps 1 and 2.  

7. For the X axis choose Named variable, click Next, but this time choose 

Previously defined, click Next. Select Response Time from the drop-down list, 

click Next. 

8. For the Y axis choose Nodal, click Next, specify the results entity as Stress, 

specify node number 25, click Next. 

9. Choose Add to existing graph, make sure to specify the correct graph from the 

list if there is more than one, click Finish. The new data will be added to the first 

graph. 

10. Repeat steps 1, 2 and 7. 

11. For the Y axis choose Nodal, click Next, specify the results entity as Stress, 

specify node number 60, click Next. 

12. Repeat step 9.  

Creating Animation Sequences 

Animations are useful for checking a staged construction modelling process has been defined 

correctly or for visualising the changing results of a nonlinear, dynamic or transient analysis. 

Sometimes the manner in which a structure deforms is not always obvious when comparing 

its undeformed and deformed shapes and it may be better understood using animation. An 

animation displays a sequence of pictures showing the status of the model or results type for 

selected loadcases. 

The structure may be animated in two ways. Both types of animation are created from the 

Utilities> Animation Wizard menu item. 
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 Active Loadcase (for results loadcases only) The results from a single loadcase, or 

eigenvector mode shape, may be animated according to a trigonometric function (sine, 

square or saw tooth). A full sine wave (-1 to 1) is useful for animating mode shapes 

obtained from an Eigen analysis while a half sine wave (0 to 1) is useful in animating 

a static load. 

 Load History animates chosen model or results loadcases producing a animation 

frame for each.  

 

The content of the animation sequence is defined by the contents of the current 

window when the Animation Wizard is started. For example to animate contours, add 

a contour layer to the current window prior to running the animation wizard. 

 

Notes 

 If contours are to be included in an animation, it is useful to fix contour levels across 

multiple loadcases using a global or manual scale before creating the animation 

sequence. Setting the contour levels for the highest level of loading, will fix contour 

levels on each screen of the animation sequence relative to the others. The spread of 

stress or other entity can then be seen more readily. 

 When animating deformed models it is recommend that the resize button  is 

switched off before creating the animation to prevent re-scaling during the animated 

sequence. 
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 Animation is carried out using pixel dumps, hence a complicated picture is no more 

time consuming to display than a simple picture, but may take more time to assemble 

initially. However, increasing the number (or size) of segments will require a 

proportionately larger amount of memory. 

 The only model loadcases (that is, those loadcases that are saved with a model) 

available for inclusion in an animation are basic modelling loadcases and basic load 

combinations. Envelope and Smart Combination loadcases that are saved with a 

model cannot be animated. 

 When animating staged construction models the mesh layer display should be set to 

Show activated elements only in order to see the model building sequence. 

Controlling the Animation 

The buttons at the bottom of the animation window allow the animation to be speeded up or 

slowed down, stepped frame by frame, and looped. The 1:1 button controls the aspect ratio 

when the window is resized. 

Saving Animation Files 

Animation files may be saved as Windows standard .avi files using the File> Save As AVI 

menu item. The .avi format can be viewed by double clicking on the file from within the File 

Explorer. When creating .avi files it is recommended the “Microsoft Video 1” compression 

method is used to reduce the file size. Selecting this option will produce a good reduction in 

file size and, perhaps more importantly,should enable trouble free playback on the majority of 

PCs.  

Using the Animation Builder Toolbar 

The animation tool builder tool bar can be found using the View> Toolbars menu item. 

Animation sequences may be edited, or can be created 

frame by frame, using the animation builder toolbar.  

Printing Results 

 

Selected results values may be output to the screen in a tabular listing format for the active 

loadcase or for selected loadcases. Once listed the results can be printed or saved to a 

spreadsheet. The results for each loadcase are displayed on a separate tab in the print results 

window. A model info tab appears in all output windows and provides basic information 

about the model. 

To print results to the screen his use the Utilities> Print Results Wizard menu item.  

 Active Loadcase outputs selected results from a single loadcase. 
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 Load History outputs selected results for one or more loadcases.  

Entity 

The Entity chosen dictates the type of results printed. When smart combinations or envelopes 

are present the primary component can be set such that all other values are associated values 

which occur at the same time as the enveloped component. Only those components applicable 

for the elements used in the model will be displayed.  

The entities and results types available (when applicable) are: 

None 

 Eigenvalues - eigenvalue, frequency and error norm. 

 Participation Factors - participation factors in X, Y and Z directions. 

 Mass participation factors - mass participation factors in X, Y and Z directions. 

 Sum of mass participation factors - sum of mass participation factors in X, Y and Z 

directions. (This enables the % of active mass in each direction to be determined, as 

the sum of the mass participation factors in each direction should be unity). 

Displacement, Residual, Reaction, Reaction Stress, Loading, 

Potential, Flux, Gradient 

 Component -  component results in tabular format. 

 Summary - maximum and minimum visible values and their position on the model. 

Stress/Strain 

 Component - component results in tabular format. 

 Summary - maximum and minimum visible values and their position on the model. 

 Principal - principal values in tabular format. 

 Wood-Armer components - Wood-Armer reinforcement moments and forces in 

tabular format. 

 Wood-Armer assessment - Wood-Armer reinforcement moments and forces in 

tabular format. 

 Fatigue or Damage Results - fatigue (Log Life) and damage results in tabular format. 

 Energy - strain energy and plastic work results. 

 State variables - extra nonlinear material parameters. 

Slideline results 

 Component - component results in tabular format. 
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 Summary - maximum and minimum visible values and their position on the model. 

 System forces - forces in global or current transformed directions. 

 Gap forces - forces required to reverse nodal penetration. 

 Contact forces -forces generated across contact surfaces. 

 Contact stresses - contact stresses computed as contact force/contact area in normal 

and tangential directions. 

 Section results - generic contact results e.g. contact state, normal penetration etc. 

For more details see slideline results processing. 

Thermal surfaces results 

 Component - underlying nodal results. 

 Summary - maximum and minimum values (according to the extent specified) and 

their position on the model. 

 Flows - flow components. 

 View factors - summary of view factor sums across segments. 

Transformation of results 

Printed results may be transformed to be relative to a specified local coordinate, according to 

element local directions for stresses, relative to the local element material directions, or to a 

specified angle in the XY plane. 

Location 

When applicable, printed results can be obtained for the following locations: 

 Averaged nodal - Average nodal (smoothed) results from visible elements. Nodal 

results are extrapolated from the Gauss point values within each element before 

averaging. 

 Gauss Point - Gauss point values internal to the visible elements. The most accurate 

results available from the analysis.  

 Element Nodal - Unaveraged nodal results for visible elements. Nodal results are 

extrapolated from the Gauss point values within each element. 

 Coordinates When the optional Coordinates checkbox is enabled the global X, Y 

and Z positions of the nodes or gauss points (as appropriate) are included as separate 

columns in the printed output. If a column heading is double-clicked the results will 

be sorted in ascending or descending order based upon coordinates. This enables 

sorting of nodal and gauss results data by coordinate. 

Extent 

The printed results for selected loadcases are governed by the following extent options:  
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 Elements showing results - default option which prints results only for those 

elements that are displaying them in the Modeller view window. 

 Visible model - prints results all elements that are visible in the Modeller view 

window. 

 Full model - prints results for all elements of the model regardless of whether the 

elements are visible or displaying results in the Modeller view window. 

 Specified group - prints results for a specified named group. Only active if group 

names have been defined. 

Printed results for automatically created slices 

When section slices have been defined on a 3D model (with corresponding groups being 

automatically created in the Groups treeview) the results for just the automatically-defined 

groups/slices can be printed to the print results window by selecting the Display for slice(s) 

check box. Note that the automatically created group name 'Slices' is a collective name for the 

automatically created slice group names and does not contain results. 

Results display and manipulation 

The results for each selected loadcase are displayed on a separate tab in the print results 

window. A model info tab also appears in all output windows and provides basic information 

about the model. When the Printed Results window is displayed a context menu can be 

invoked which allows for the printed results data to be manipulated:  

 Properties The number of significant figures or decimal places can be changed. 

 Sorting of data Results data can be sorted in ascending or descending order. In 

addition, data sorting can be achieved by double-clicking on a header to sort by that 

column name. A second double-click on the same header will carry-out a reverse sort.  

 Saving to a spreadsheet The contents of the current tab or all tabs can be saved to a 

spreadsheet or to a text file.  

 Copying to the clipboard Selected cells or the whole grid can be copied to the 

clipboard.  

 Printing The Print option sends the contents of the active tab to the printer. 

  

  

 



Modeller Reference Manual   

    

374 

Manipulating printed loadcase results 

Printing results for Envelopes or Combinations 

When the active loadcase is an envelope or smart combination the results printed will show 

the primary component (e.g. Fx) marked with an asterisk. Additionally, for Envelopes only, 

the loadcase in which the maximum or minimum value was extracted will be tabulated in the 

LCID (Loadcase ID) column.  

When enveloping on All components, the loadcase from which the results are extracted 

cannot be tabulated because each individual results component may have come from a 

different loadcase. 

  

Envelope results for primary component Fx showing 

Loadcase ID 

Envelope results for primary component All 

 (No Loadcase ID can be shown) 

Notes 

 Selected slice and slideline data and results may be printed from the group context 

menu. 

 To print results and include model images in a report style format see Generating 

Reports  

Printing and Saving Pictures 

Views of the LUSAS model in the graphics area may be printed directly to the default printer 

from the graphics area using the print  button.  

The File> Print Preview menu item is useful for visualising the document prior to printing 

taking place. Using the File> Print menu item allows alternative printer settings to be used. 

Note. When a model is created the default paper size (for printing use) is now set from the 

settings of the default printer installed on the local PC. This should help ensure that regional 

paper sizes are used in preference to otherwise specified sizes. 
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Saving pictures for use in LUSAS reports and other applications 

Views of the LUSAS model can be saved as BMP, JPG, or WMF files using the File> 

Picture Save menu item. BMP and JPEG files are saved to a fixed size of 1800 pixels in 

width with a height proportional to the size of the graphics window when the file was saved. 

JPEG files are the most efficient to save in terms of file size. Windows Meta Files now 

contain bitmaps instead of vectors for the modelling information with correspondingly 

smaller file sizes. Text and annotation layer information held in a WMF file is vector-based 

and is therefore scalable. 

Note. The contents of the graphics window can also be copied (and subsequently pasted) for 

use in other applications by clicking the right mouse button and selecting Copy from the 

context menu.  

Saving pictures for viewing in Expose 

Pictures can also be saved as LUSAS Picture Files for viewing only in the LUSAS picture 

file utility program, Expose. Note that Graphs cannot be saved in LUSAS picture file format. 

The contents of the graphics area can also be transferred to the Windows clipboard using the 

copy  button. 

Generating Reports 

Report templates (which are created, modified and saved 

in the Reports Treeview for each model) hold the 

information required to generate reports of your model or 

results data. Each time a report is to be viewed, the report 

details that are specified in the report template are 

extracted from your model and results files and used to 

create the report.  

You build a report by defining chapters that reference the 

model and results data that you want to include in the 

report. The modelling and results data you select can be 

restricted to particular model geometry, model attributes or loadcases, or for particular results 

entities, and data can be listed for all of, or just parts of your model. Additional user content 

such as screen captures, saved images or additional text can also be added. These user content 

items appear as separate chapters in the report.  

Each report template can include any number of chapters that define the model attributes and 

analysis results to be viewed. Note that the creation of results chapters is only possible when 

results are loaded on top of a model. Any number of reports templates may be created and 

saved in the  Reports Treeview of a model. The order of information in a report can be 

changed by dragging and dropping the chapter names up and down the Report Treeview. 

 Reports are viewed in a third-party industry standard report viewer called BusinessObjects 

Crystal Reports (included with your LUSAS software). Report data may be exported to 

Microsoft Excel spreadsheets for additional calculations to be carried out as well as being 

exported in PDF, RTF (for use in Microsoft Word), HTML and other formats. 
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If it is desired that only results values are to be viewed on screen or be selectively printed or 

output to spreadsheets the Print Results Wizard can be used. 

 

Creating a Report 

A new (empty) report template is created by selecting the Utilties> Report menu item or 

from right-clicking New Report from the Reports context menu in the Report  Treeview. 

On the Report properties dialog: 

 The report Title is optional and is used 

as a title in the exported report. 

 Units for a report are, by default, the 

same as those of the model. However, it 

is possible to prepare a report in a 

different system of units, in which case 

all values seen in the report will be 

converted appropriately.  

 It is also possible to control the number 

of significant figures and decimal 

places seen in the report. These can also be specified independently for each chapter 

 If For all chapters is selected the values for significant figures or decimal places 

chosen on this dialog will be used throughout the report. This option overrides any 

different values set inside each chapter. 

 The Report name is the name added to the Report  Treeview. By default reports 

are named Report 1, Report 2 etc if no name is specified. 

Once a New Report entry has been added to the Report  Treeview, selecting the report 

name and using its context menu enables the adding of chapters to a report, modifying, 

viewing, renaming, or deleting of a report. Report templates are saved in the Report  

Treeview when a model is saved. 

Adding a Report Chapter 

Model properties, loadcase and basic combinations, envelopes and smart combination results, 

eigenvalue results and user information such as images and text may be added to a report in 
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the form of chapters. Each chapter represents one single aspect of the model. Multiple 

chapters may be added and re--ordered as necessary in the Report  Treeview.  

Chapters are added to a report by selecting the Add Chapter menu item from the Report 

name context menu (accessed by right-clicking the mouse button).  

The following chapters can be added: 

 Model Properties 

 Loadcase/Basic Combination results 

 Envelope/Smart Combination results 

 Eigenvalue results 

 User Content 

Add or Edit a Model Properties Chapter 

 

The Model Properties tab of the Chapters dialog allows model geometry, attributes and 

loadcase/IMD loadcase information to be added to the report via the use of tick boxes.  

The Report on… button displays a dialog which controls the scope of the chapters to be 

created. By default, the whole model is selected, but a report could also created for just the 

visible model or for a specified group.  

It is also possible to control the number of significant figures or decimal places for this 

chapter as presented in the report. 

Note: It is possible to visit this dialog several times to create multiple chapters, each of which 

can have different ordering, scope and loadcase choices.  For example you can create one 

chapter describing the lines in group 1 and subsequently to create a different chapter 
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describing the lines in group 2. Once created, the order of chapters in the report can be 

modified at any time by dragging and dropping them up and down the Report  Treeview. 

Add or Edit a Results Subchapter (for an Entity) 

You can create or modify a section within a results chapter. Select the Add... button on the 

Chapters dialog to display this dialog. 

 The Entity chosen dictates the type of 

results. The component chosen is only 

appropriate to Envelopes and Smart 

Combinations and controls the primary 

component – equivalent to the 

component chosen when the Envelope or 

Combination is set active.  

 The Transformed and Wood Armer 

settings behave as on other dialogs. 

 Use the All Components or Specify 

components and … buttons to control 

which results component values will be 

added to the report. 

 The Location drop-down specifies 

whether Averaged nodel, Gauss Point 

or Element Nodal results should be 

calculated. 

 The Summary checkbox chooses whether or not to display a summary for each 

results component chosen. This summary consists of the maximum and minimum 

values encountered, along with their location. Note that sub-reports cannot be created 

from Summary results information when listed in a report. 

 The Tabular results checkbox chooses whether or not to display a table of numerical 

results. If chosen, a value will be written to the report for each component, for each 

loadcase, for each node or gauss point chosen. Such tables can be very large. Note that 

sub-reports can be created from Tabular results information when listed in a report. 

 Additionally, Nodal coordinates can be added to the report. These take the form of 

additional columns of data in the tabular results, one each for the X, Y, and Z 

coordinates of each node. 

 The number of Significant figures or Decimal places can be specified for values 

written to the report for this chapter. 
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 Add or Edit a Loadcase Results Chapter 

 

  

The Loadcase/Basic Combination results tab of the Chapters dialog is only shown if a 

results file is loaded.  

The Envelope/Smart Combination results tab (not shown) is only added to the dialog if a 

model contains envelope or smart combination results.  

 Use the Add... button to add entities for inclusion in the report as results sub-chapters. 

When added, results sub-chapters are shown in a grid form at the top of the dialog. By 

selecting the Entity name in the grid you can subsequently Edit or Delete existing 

content. 

 Use Order by... to dictate the order in which the tabular results sub-headers are 

presented. This is similar to the concept of sorting data by column header in a 

spreadsheet program. The order by options are: Loadcase / Features, Features / 

Loadcase and Loadcase / Mesh. The use of the Order by facility is of particular 

importance when exporting results to a spreadsheet format where the use of Order by 

Loadcase / Mesh is recommended because of the reduced number of blank lines it 

creates in the output file. 

 Use the Loadcases… button to display a dialog which restricts the chapter to display 

results for All, Active or Specified loadcases or combinations. By default, all 

loadcases are selected. 

 Use the Report on... button to display a dialog which controls the scope of the chapter 

to be created, for example to restrict the chapter to display results for the Full model, 

the Visible model or a Specified group only. By default, the whole model is selected. 

 Chapter name can be edited if the default or previously entered name is to be altered. 
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Note: It is possible to visit this dialog several times to create multiple chapters, each of which 

can have different ordering, scope and loadcase choices.  For example you can create one 

chapter describing the displacements for the whole of a model and subsequently to create a 

different chapter describing the stress in a particular group of elements. Once created, the 

order of chapters in the report can be modified at any time by dragging and dropping them up 

and down the Report  Treeview. 

Add or Edit an Eigenvalue Results Chapter 

 

The Eigenvalue results tab of the Chapters dialog is only shown if a model contains 

eigenvalue results. The following eigenvalue results can be selected for listing: 

 Eigenvalues 

 Participation factors 

 Mass participation factors 

 Sum mass participation factors 

The number of significant figures or decimal places for this chapter can be specified. 

The Chapter name can be specified or edited if the default or previously entered name is to 

be changed. 
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Add or Edit a User Content Chapter 

 

The User Content tab of the Chapters dialog allows images or text files to be added to the 

report using the Add file... button.  

The Capture screen button takes a snap-shot of the current Graphics Area and allows saving 

it as a fixed-size BMP, JPG or WMF file to the working folder (by default) or to any other 

specified folder.  

Clicking the OK button adds this image to the report as a separate chapter. Only BMP files 

currently appear in the preview pane. Each image added to the report is added as a separate 

chapter.  

Note: It is possible to visit this dialog several times to create multiple chapters. Once created, 

the order of chapters in the report can be modified at any time by dragging and dropping them 

up and down the Report  Treeview. 

Chapter Extent 

The extent of data that the chapter is to report on can be specified by selecting either:   

 Elements showing results - prints results only for those elements that are displaying 

them in the Modeller view window. 

 Visible model - prints results all elements that are visible in the Modeller view 

window. 

 Full model - defaults option which prints results for all elements of the model 

regardless of whether the elements are visible or displaying results in the Modeller 

view window. 

 Specified group - prints results for a specified named group. 
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For example, if the selected chapter describes Materials, by selecting a Specified group only 

the Material assignments used in that group will be present in that chapter. 

Loadcase Selection 

The loadcases, combinations or envelopes that the chapter is to report on can be specified by 

selecting either: 

 All 

 Active 
 Specified. 

If multiple loadcases are specified, multiple entries will appear in the report. 

Viewing a Report 

Reports are viewed from the Report  Treeview by double-clicking on the report name or by 

choosing the View Report... menu item from the report name context menu. After a short 

delay whilst the report data is assembled and formatted, a report consisting of all the selected 

chapters will be displayed inside the third-party BusinessObjects Crystal Reports viewer. 

 

BusinessObjects Crystal Reports viewer 

The BusinessObjects Crystal Reports viewer is a linked-in third-party application that is 

widely used in industry to present and manipulate report data. It has a toolbar that provides 

the following buttons / facilities for viewing, manipulating, printing and exporting the 

selected LUSAS model and results data: 

  

 

Report Viewer Toolbar Buttons 

 Export Report permits reports or sub-reports to be exported to a variety of formats to 

any of the following destinations:  
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 To a file on your disk (Disk file). 

 To an Application on your computer that will open once the file has been created. 

 To a folder in your mail client (Exchange). 

  Print Report prints the current report or sub-report view only to a specified printer. 

 Toggle Group Tree permits the viewing of loadcase/feature numbers in sub-reports in a 

treeview style format 

 Page selection These options provide the means of moving 

or jumping to a specific page. 

 Stop Loading stops the loading of large files 

 Refresh refreshes the view contents 

  Search Text provides the means to find and jump to particular words in the report or 

sub-report. 

  adjusts the size of the page view 

  Close Current View closes the sub-report view leaving other views visible until they 

are closed. To go back to the LUSAS Modeller window the report viewer must be closed by 

using the report window's main Close button. 

Notes 

 When viewing a report using the Crystal Reports viewer no changes can be made in 

LUSAS Modeller. The only way a LUSAS model or the report listing (as held in the 

LUSAS Report Treeview) can be re-edited is to close the report view. This is to 

ensure that the report data always matches the model from which it is created. 

 When a report is first loaded into the report viewer the Page Down key will not work 

until the view has acquired focus. Simply click anywhere in the view to set the focus. 

 When saving to disk the default export directory is a temporary directory specified by 

the report viewing software that is used. Browse to your LUSAS project directory if 

you wish to save your report file with your model. The number of pages to be 

exported or saved can be specified. 

Creating and Viewing Sub-Reports 

When viewing a report, selected sections of data may be viewed in a sub-report. This can be 

particularly useful when wanting to export selected data to another application as, for 

instance, when exporting report results data to a spreadsheet. It also provides an easy way of 

visually printing selected pages of a main report. 
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 To create a sub-report from a section of a normal report double-click on the main 

body of the data where you wish a sub-report to be generated, or double-click on a 

feature or loadcase name. A new tab will appear in the report viewer next to the 

Preview tab.  

 Selecting the Toggle Group Tree  button will permit the viewing of the 

loadcase/feature numbers in the sub-reports in a treeview style format as shown on the 

following image. 

 

  

Note that it is also possible to create a sub-report from a sub-report. For example, when a sub-

report containing results for a set of loadcases is being viewed, a sub-report for a particular 

loadcase, or for a particular feature such as a line, surface or volume, could also be created. 

 To create a sub-report from a sub-report view double-click on the loadcase name (as 

shown in the previous image) or feature for which the sub-report should be created. 

A new tab will appear in the report viewer next to the previous sub-report tab as 

shown on the following image. 
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Notes 

 Not all sections of a report can be selected to make a sub-report. The cursor will 

change to a magnifying glass when it is over data that can be selected for a sub-report.  

 The toolbar buttons such as Export Report, Print Report, etc., act on the currently 

selected preview tab (and hence, the currently selected report view). This means that 

only those pages in the particular report or sub-report that is being viewed will be 

exported or printed. 

 To delete the visible sub-report select the Close Current View  button at the top-

right of the report viewer toolbar. 

Exporting Report Data 

When viewing a report, report data may be exported to a variety of formats to any of the 

following destinations by use of the Export Report button  

 To an Application on your computer that will open once the file has been created 

 To a file on your disk (Disk file ) 

 To a folder in your mail client (Exchange) 

In each case the number of pages to be opened or saved can be specified. 

Note that when saving to disk the default export directory is a temporary directory specified 

by the report creation software that is used. Browse to your LUSAS project directory to save 

your report file with your model if required. 

When the number of columns in a report become too large for a portrait view use Page Setup 

(accessed from the Report Name context menu) to either change the report page margins, or 

to change the report page orientation to Landscape. 
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Exporting Report Data to a Spreadsheet 

When viewing a report, report data may be exported to a spreadsheet such as Excel by use of 

the Export Report button  

 Select a Format of: Microsoft Excel 97-2000 - Data only (.XLS) 

 Select a Destination of: Application 

 Select Custom format options 

Note that use of the Results chapter Order by... option to dictate the order in which the 

tabular results sub-headers are presented is of particular importance when outputting results 

data to a spreadsheet. The option to order results data according to Loadcase / Mesh is 

recommended because of the reduced number of blank lines it creates in the output file. 

 The images that follow show an example of a sub-report created with Loadcase / Mesh order 

and the corresponding results exported to an MS Excel spreadsheet. 

This Order by option should be set prior to exporting the data as follows: 

1. In the Report  Treeview, select the Results Chapter name and use its context menu 

to the select Modify menu item which, in turn, will display the Edit Chapter dialog. 

2. Use the Order by... drop-down to select Loadcase / Mesh and click OK 

3. In the Report  Treeview, select the report name containing data to be exported and 

use its context menu to select View Report 

4. After the report is displayed in the report viewer, find the Results Chapter containing 

data to be exported and double-click in the body of the data to create a sub-report 

5. If results for a particular loadcase is to be exported, double-click on that loadcase data 

to create a further sub-report 

6. Lastly, use the Export Report button  to allow selection of the Format and 

Destination of the results data to be created. 

Example output 

The images that follow show an example of a sub-report created by LUSAS with Loadcase / 

Mesh order and the corresponding results exported to a Microsoft Excel spreadsheet. 
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Sub-report listing ordered by Loadcase / Mesh 

 
Sub-report data exported to a Microsoft Excel spreadsheet. 

Exporting Report Data to a Word Document 

When viewing a report, report data may be exported to a Word Document by use of the 

Export Report button  This will require you to: 

 Select a Format of: Microsoft Word - Editable (RTF) 

 Select a Destination of: Application 

 Select a page range. 

Note that the Results chapter Order by... option which dictates the order in which the tabular 

results sub-headers are written is particular use when exporting results data. If you do not 

wish to group the results per feature (e.g. per line) which is the default, then the option to 

order by Loadcase / Mesh should be used. 

This Order by... option should be set prior to exporting the data as follows: 

1. In the Report  Treeview, select the Results Chapter name and use its context menu 

to the select Modify menu item which, in turn, will display the Edit Chapter dialog. 

2. Use the Order by... drop-down to select the Order required e.g. Loadcase / Mesh and 

click OK 
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3. In the Report  Treeview, select the report name containing data to be exported and 

use its context menu to select View Report 

4. After the report is displayed in the report viewer, find the Results Chapter containing 

data to be exported and double-click in the body of the data to create a sub-report. 

5. If results for a particular loadcase is to be exported, double-click on that loadcase data 

to create a further sub-report. 

6. Lastly, use the Export Report button  to allow selection of the Format and 

Destination of the results data to be created. 

Example output 

The images that follow show an example of a report created by LUSAS and the same data 

exported to an Microsoft Word document. 

  

Report listing in the report viewer Report data exported to a Microsoft Word document. 

Printing Report Data 

When viewing a report, report data may be printed by selecting the Print Report button  

in the BusinessObjects Crystal Reports toolbar. 

Deleting Report Data 

To delete the visible report or sub-report select the Close Current View  button at the 

top-right of the report viewer toolbar. 
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Appendix A : Smart 

Combination 

Examples 

  

Smart Combination Examples 

The following examples demonstrate how the different factors and settings can be used in 

smart combinations. For the purposes of these examples the results at a single node are going 

to be considered. 

 Case 1 - Considers a node where long term load effects are all negative.  

 Case 2 - Considers a node where short-term load effects are of mixed sign.  

 Case 3 - Considers a node where short-term load effects are of mixed sign with the 

“Loadcases to consider” set to four.  

 Case 4 - Considers a node where short-term load effects are of mixed sign with the 

“Loadcases to consider” set to four and the “Variable loadcases” set to four.  

 Case 5 - Considers a node where short-term load effects are of mixed sign with the 

“Loadcases to consider” set to four and the “Variable loadcases” set to one.  

Smart Combination - Case 1 

Consider a node where long term load effects are all negative.  

In this instance the permanent and variable load factors are considered and will be added 

together based on the nodal result being adverse. 

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for positive 

load effects. 
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Loadcase 

 
Nodal 
result 

 
Permanent 
factor 

 
Variable 
factor 

Factor used for  
maximum 
combination 

 
Factored nodal 
results 

Dead load -20 1.0 0.15 1.0  -20 x 1.0 = -20 

Deck surfacing  -10 1.0 0.75 1.0 -10 x 1.0 = -10 

Superimposed 
load 

-15 1.0 0.2 1.0 -15 x 1.0 = -15 

    Smart combination (Max) -45 

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects. 

  
 
Loadcase 

  
Nodal 
result 

  
Permanent 
factor 

  
Variable 
factor 

Factor used for 
maximum 
combination 

  
Factored nodal 
results 

Dead load -20 1.0 0.15 1.0 + 0.15 -20 x 1.15 = -23 

Deck surfacing  -10 1.0 0.75 1.0 + 0.75 -10 x 1.75 = -17.5 

Superimposed load -15 1.0 0.2 1.0 + 0.2 -15 x 1.20 = -18 

    Smart combination (Min) -58.5 

Smart Combination - Case 2 

Consider a node where short-term load effects are of mixed sign.  

In this instance the permanent and variable load factors are considered and will be added 

together based on the nodal result being adverse. However as the permanent effects have been 

set to zero, this will only combine the results that are adverse. 

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for positive 

load effects. 
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Loadcase 

 
Nodal 
result 

 
Permanent 
factor 

 
Variable 
factor 

Factor used for  
maximum 
combination 

 
Factored nodal 
results 

Temperature -5 0 1.3 0  -5 x 0 = 0 

Wind  -5 0 1.4 0 -5 x 0 = 0 

Settlement -10 0 1.2 0 -10 x 0 = 0 

Live load 1 -20 0 1.5 0 -20 x 0 = 0 

Live load 2 -15 0 1.5 0 -15 x 0 = 0 

Live load 3 10 0 1.5 0 + 1.5 10 x 1.5 = 15 

Live load 4 -5 0 1.5 0 -5 x 0 = 0 

    Smart combination (Max) = 15 

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects. 

  
 
Loadcase 

 
Nodal 
result 

 
Permanent 
factor 

 
Variable 
factor 

Factor used for 
maximum 
combination 

 
Factored nodal 
results 

Temperature -5 0 1.3 0 + 1.3 -5 x 1.3 = -6.5 

Wind  -5 0 1.4 0 + 1.4 -5 x 1.4 = -7 

Settlement -10 0 1.2 0 + 1.2 -10 x 1.2 = -12 

Live load 1 -20 0 1.5 0 + 1.5 -20 x 1.5 = -30 

Live load 2 -15 0 1.5 0 + 1.5 -15 x 1.5 = -22.5 

Live load 3 10 0 1.5 0  10 x 0 = 0 

Live load 4 -5 0 1.5 0 + 1.5 -5 x 1.5 = -5 

    Smart combination (Min) =  -83 

  

Within the smart combination facility there are also two check boxes marked “Loadcases to 

consider” and Variable loadcases”. These additional options are used for a number of bridge 

design codes that require the loadcases in the combination to be filtered. 

Smart Combination - Case 3 

Consider a node where short-term load effects are of mixed sign with the “Loadcases to 

consider” set to four.  
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In this instance the permanent and variable load factors are considered and will be added 

together based on the nodal result being adverse. With the number of “Loadcases to consider” 

set to four, only the four most positive resultants will be combined for the Max combination 

and the four most negative resultants will be combined for the Min combination. 

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for positive 

load effects. The number of load effects summed is restricted to the number of loadcases 

specified. The loadcases used are the most adverse, for example the most positive for max 

combination and all other load effects assembled are discarded. 

  
 
Loadcase 

 
Nodal 
result 

 
Permanent 
factor 

 
Variable 
factor 

Factor used for 
maximum 
combination 

 
Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Used 

Settlement -10 0.7 0.8 0.7 -10 x 0.7 = -7 Not 
used 

Live load 1 -20 0.7 0.8 0.7 -20 x 0.7 = -14 Not 
used 

Live load 2 -15 0.7 0.8 0.7 -15 x 0.7 = -10.5 Not 
used 

Live load 3 10 0.7 0.8 0.7 + 0.8 10 x 1.5 = 15 Used 

Live load 4 -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Used 

    Smart combination (Max) =  4.5   

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects. The number of load effects summed is restricted to the number of loadcases 

specified. The loadcases used are the most adverse, for example the most negative for min 

combination and all other load effects assembled are discarded. 
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Loadcase 

 
Nodal 
result 

 
Permanent 
factor 

 
Variable 
factor 

Factor used for  
maximum 
combination 

 
Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 + 0.8 -5 x 1.5 = -7.5 Used 

Wind  -5 0.7 0.8 0.7 + 0.8 -5 x 1.5 = -7.5 Not 
used 

Settlement -10 0.7 0.8 0.7 + 0.8 -10 x 1.5 = -15 Used 

Live load 1 -20 0.7 0.8 0.7 + 0.8 -20 x 1.5 = -30 Used 

Live load 2 -15 0.7 0.8 0.7 + 0.8 -15 x 1.5 = -22.5 Used 

Live load 3 10 0.7 0.8 0.7 10 x 0.7 = 7 Not 
used 

Live load 4 -5 0.7 0.8 0.7 + 0.8 -5 x 1.5 = -7.5 Not 
used 

    Smart combination (Min) =  -75   

Smart Combination - Case 4 

Consider a node where short-term load effects are of mixed sign with the “Loadcases to 

consider” set to four and the “Variable loadcases” set to four.  

In this instance the permanent and variable load factors will only be considered for the 

number of loadcases specified as the number of Variable loadcases to consider. The factors 

will be added together based on the nodal result being adverse. The remaining loadcases are 

considered using the permanent factor. With the number of “loadcases to consider” set to 

four, only the four most positive resultants will be combined for the Max combination and the 

four most negative resultants will be combined for the Min combination. However by setting 

the “variable loadcases” to four, only positive results will be considered for the Max 

combination and negative results for the Min combination.  

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for the number 

of positive load effects specified by the number of Variable loadcases to consider. The 

remaining positive load effects will only use the permanent factor. The number of load effects 

summed is restricted to the number of loadcases specified and the other loads are discarded. 

The loadcases used are the most adverse, for example, the most positive are used for a 

maximum combination and all other load effects assembled are discarded. Also with the 

variable loadcases set to four the max combination will include only positive load effects, all 

negative load effects are discarded. 
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Loadcase 

 
Nodal 
result 

 
Permanent 
factor 

 
Variable 
factor 

Factor used for  
maximum 
combination 

 
Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 0.8 0.7 -10 x 0.7 = -7 Not 
used 

Live load 1 -20 0.7 0.8 0.7 -20 x 0.7 = -14 Not 
used 

Live load 2 -15 0.7 0.8 0.7 -15 x 0.7 = -10.5 Not 
used 

Live load 3 10 0.7 0.8 0.7 + 0.8 10 x 1.5 = 15 Used 

Live load 4 -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

    Smart combination (Max) =  15   

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects for number of negative load effects specified by the number of Variable 

loadcases to consider the remaining negative load effects will only use the permanent factor. 

The number of load effects summed is restricted to the number of loadcases specified and the 

other loads are also discarded. The loadcases used are the most adverse, for example the most 

negative for min combination and all other load effects assembled are discarded. Also with 

the variable loadcases set to four the min combination will include only negative load effects, 

all positive load effects are discarded. 
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Loadcase 

 
Nodal 
result 

 
Permanent 
factor 

 
Variable 
factor 

 
Factor used for maximum 
combination 

 
Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 + 0.8 -5 x 1.5 = -7.5 Used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -.5 Not 
used 

Settlement -10 0.7 0.8 0.7 + 0.8 -10 x 1.5 = -15 Used 

Live load 1 -20 0.7 0.8 0.7 + 0.8 -20 x 1.5 = -30 Used 

Live load 2 -15 0.7 0.8 0.7 + 0.8 -15 x 1.5 = -22.5 Used 

Live load 3 10 0.7 0.8 0.7  10 x 0.7 = 7 Not 
used 

Live load 4 -5 0.7 0.8 0.7 -5 x 1.5 = -3.5 Not 
used 

    Smart combination (Min) =  -75   

Smart Combination - Case 5 

Consider a node where short-term load effects are of mixed sign with the “Loadcases to 

consider” set to four and the “Variable loadcases” set to one. The permanent and variable 

load factors will only be considered for the number of loadcases specified as the number of 

Variable loadcases to consider. The factors will be added together based on the nodal result 

being adverse. The remaining three loadcases are considered using the permanent factor. 

With the number of “loadcases to consider” set to four, only the four most positive resultants 

will be combined for the Max combination and the four most negative resultants will be 

combined for the Min combination. However by setting the “variable loadcases” only positive 

results will be considered for the Max combination and negative results for the Min 

combination.  

Smart combination (Max) will assemble results from the loadcases using just the permanent 

factors given for negative load effects and using permanent + variable factors for number of 

positive load effects specified by the number of Variable loadcases to consider the remaining 

positive load effects will only use the permanent factor. The number of load effects summed 

is restricted to the number of loadcases specified and the other loads are also the discarded. 

The loadcases used are the most adverse, for example the most positive for max combination 

and all other load effects assembled are discarded. Also with the variable loadcases set to one 

the max combination will include only positive load effects, all negative load effects are 

discarded. 
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Loadcase 

 
Nodal 
result 

 
Permanent 
factor 

 
Variable 
factor 

Factor used for  
maximum 
combination 

 
Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 0.8 0.7 -10 x 0.7 = -7 Not 
used 

Live load 1 -20 0.7 0.8 0.7 -20 x 0.7 = -14 Not 
used 

Live load 2 -15 0.7 0.8 0.7 -15 x 0.7 = -10.5 Not 
used 

Live load 3 10 0.7 0.8 0.7 + 0.8 10 x 1.5 = 15 Used 

Live load 4 -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

              

    Smart combination (Max) =  15   

  

Smart combination (Min) will assemble results from the loadcases using just the permanent 

factors given for positive load effects and using permanent + variable factors for negative 

load effects for number of negative load effects specified by the number of Variable 

loadcases to consider the remaining negative load effects will only use the permanent factor. 

The number of load effects summed is restricted to the number of loadcases specified and the 

other loads are discarded. The loadcases used are the most adverse, for example the most 

negative for min combination and all other load effects assembled are discarded. Also with 

the variable loadcases set to one the min combination will include only negative load effects, 

all positive load effects are discarded. 
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Loadcase 

 
Nodal 
result 

 
Permanent 
factor 

 
Variable 
factor 

 
Factor used for maximum 
combination 

 
Factored nodal 
results 

  

Temperature -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Used 

Wind  -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 0.8 0.7 -10 x 0.7 = -7 Used 

Live load 1 -20 0.7 0.8 0.7 + 0.8 -20 x 1.5 = -30 Used 

Live load 2 -15 0.7 0.8 0.7 -15 x 0.7 = -10.5 Used 

Live load 3 10 0.7 0.8 0.7 + 0.8 10 x 1.5 = 15 Not 
used 

Live load 4 -5 0.7 0.8 0.7 -5 x 0.7 = -3.5 Not 
used 

              

    Smart combination (Min) =  -51   
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Appendix B : LUSAS 

Solver Trouble 

Shooting 

  

LUSAS Solver Troubleshooting 

During an analysis, warning and error messages may appear in the LUSAS Solver output file. 

An error message will terminate the solution immediately. A warning message will attempt to 

continue the analysis. The most common warning and error messages are: 

 Negative Jacobian (Error) 

 Diagonal Decay (Warning) 

 Small Pivot (Warning) 

 Negative Pivot (Warning) 

 Zero Pivot (Error) 

A description of these Warning and Error messages follows. 

Negative Jacobian Errors 

A Jacobian determinant is a measure used to give an accurate value of the current area or 

volume of an element. A magnitude of less than or equal to zero will automatically invoke 

this message and may be a result of one of the following: 

 Incorrect definition of the 2D continuum and plate elements 
 

By design, LUSAS requires these element types to have an anti-clockwise node 

numbering sequence. The order is controlled from the underlying surface feature in 

which the element resides. If this message is output, the solution is to reverse the 

ordering of the surfaces for the elements having these warning messages output. Do 

this in LUSAS Modeller with the Geometry> Surface> Reverse menu item. 
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Note that, in LUSAS Modeller, the local axis system of the surface may be viewed 

prior to tabulation - the xy axis system displayed on each surface represents a right 

handed axis system, from which the anti-clockwise (or positive qz definition may be 

checked). 

 Too large a loading increment causing massive deformation of one or more 

elements 

This means that the elements are inverting. Note that this is only applicable for 

nonlinear analyses 

Diagonal Decay Warnings 

The stiffness matrix is a crucial component in a finite element analysis, but it can be poorly 

conditioned. Poor conditioning may result in round-off error, which is a loss of accuracy in 

the evaluation of the terms during the reduction process of the solution. This in turn leads to 

inaccuracies in the predicted displacements and stresses. 

LUSAS monitors the round-off error by evaluating the amount of diagonal decay present 

during the Gaussian reduction process. This criterion is based on the assumption that initially 

large diagonal terms accumulate errors proportional to their size. As reduction progresses, the 

diagonal term is reduced, amplifying the errors until they become a maximum when the 

diagonal term is the pivot. An indication of probable errors may be obtained by examining the 

change in magnitude of the diagonal term. 

The tolerance threshold above which a diagonal decay warning is output is actually quite 

conservative (controlled by a system variable DECAYL, default = 0.1E5). Although a check 

would always be recommended for any Warning of this description, significant effects are not 

generally expected until the decay reaches a value of 0.1E8 or greater. 

Poor conditioning of the stiffness matrix occurs because of large variations in the magnitude 

of diagonal stiffness terms and may be due to: 

 Large stiff elements being connected to small less stiff elements. An example may 

be where a stiff beam element is being used to transfer load into the structure. The 

stiffness of the beam would need to be reduced - typically, the beam would only need 

to be 1000 times the stiffness of the local elements. 

 Elements with highly disparate stiffnesses, e.g. a beam element may have a bending 

stiffness that is orders of magnitude less than it's axial stiffness. 

 

For instance, the cantilever beam problem is notoriously problematic with respect to 

ill-conditioning because of the potential for large differences between the axial and 

shear/rotational stiffness components. A typical stiffness matrix might be 

 



  Appendix B 

    

401 

The longer the beam, the greater the difference between  and . 

Potential data input mistakes leading to poor conditioning 

Poor conditioning may be as a result of deliberate modelling strategy but, more usually, an 

error in one or more of the following data input areas: 

 Mesh description - typical mistakes: 

 The aspect ratio of some elements are greater than the recommended limits 

(see the corresponding element section in the Element Reference Manual for 

further information). An ideal value is 1:1. however, values up to 1:10 are 

reasonable. Depending on the results required, this value may be increased still 

further (a test run would be recommended first). This problem is indicated by 

the WARNING message: "Unreasonably distorted element... " The only 

exception are explicit dynamic elements which really do require aspect ratios 

of 1:1. 

 Some element shapes are too distorted (see the corresponding element section 

in the Element Reference Manual for further information). 

 Geometric properties - typical mistakes: 

 Omission of values for any shear area parameters in the geometric properties 

for beams 

 Omission of values for other important properties, such as the torsional 

constant or thickness 

 Defining incompatible 1st and 2nd moment section properties for beams 

 Material properties - typical mistakes: 

 Different units used to define the nodal coordinates and the material 

properties. 

 Incorrect nonlinear material parameters (yield stress and hardening values 

particularly) 

 Inconsistent units throughout the model. This would only be of concern for 

dynamic analyses, where SI units are recommended. 

 Incorrect definition of orthotropic properties. The inequalities given in the 

appropriate element section of the theory manual need to be adhered to. 

Numerical instabilities may result when the material characterisations 

approach their limits (see Notes on material properties orthotropic for a list 

of these inequalities). 
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 Support nodes - typical mistakes: 

 The structure has not been restrained against free body translation and rotation. 

Each of the above suggestions are of interest because they make a contribution to the stiffness 

matrix. 

A further possibility is that the LUSAS Modeller model geometry is invalid because the 

element mesh contains gaps or has discontinuities in the connection of the elements. Such 

modelling problems may be found in LUSAS Modeller by: 

 Using the Mesh layer to view only the outline of the mesh. The view will show 

lines wherever a discontinuity occurs. 

 Using the Labels layer to draw the node numbers onto the mesh to see if any 

node numbering is overwriting at any point (indicating two nodes at the same 

point). Correction would normally require either a merging or an 

equivalencing operation. 

The diagonal decay message is closely related to the small pivot WARNING message (see 

below). See also the additional notes in the Theory Manual regarding the Gaussian solution 

method. 

Small Pivot Warnings 

See the section titled Diagonal decay warnings. 

Negative Pivot Warnings And Errors 

A negative pivot could be the result of poor conditioning so make sure you have seen the 

section titled Diagonal decay warnings. However, a well conditioned stiffness matrix can 

produce a negative pivot if: 

 The system is unstable- an unstable structure could be passing through a bifurcation 

or limit point, as shown in the following diagram: 
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Such a bifurcation point could permit another, non-physical, solution path to be 

followed because, numerically, it requires less energy. 

Every negative pivot warning occurring in the LUSAS output file represents a 

bifurcation point. A negative CSTIF value, together with a negative PIVMIN value 

corresponds to a limit point but a positive CSTIF and a negative PIVMIN correspond 

to a bifurcation point (although this is only the first one located in each case since 

limit points are detected by a change in sign of the slope of the force displacement 

curve). See The nonlinear logfile. 

A negative pivots sometimes occurs during the iterative solution (indicating that the 

load step may be too big) but disappear when the solution has converged. If negative 

pivots occur and the solution will not converge then first try reducing the load step. 

If the solution still does not converge, a limit or bifurcation point may have been 

encountered and the solution procedure may need to be changed. Running the problem 

under arc-length control gives the best chance of negotiating a limit or bifurcation 

point. A load limit point can also be overcome by using prescribed displacement 

loading. 

 The system is not adequately restrained - for example when using a 3D beam in a 

2D analysis. 

 Mechanism has been excited - This is a further possibility when reduced integration 

is used. The use of Option 18 will normally solve this problem. If the problem 

persists, continue with the use of the option but refine the mesh further. 

A count of the number of negative pivots is given in the LUSAS log file (parameter NSCH). 

Initially NSCH = 0 since, initially, a stable path is assumed. When NSCH = 1, an unstable 

point (limit or bifurcation) has been reached, PIVMN will give the value of the minimum 

pivot at this point. 

Notes 

 The use of LUSAS Option 62 is not recommended until all other checks have been 

carried out to ensure model integrity. 

 Before modifying the solution procedure to arc-length, the checklist given in the 

section above on small pivots should be checked. 

Zero Pivot Errors 

LUSAS uses a Gaussian reduction solution technique to solve the finite element equations. 

This technique requires the structure stiffness matrix to be non-singular. This means that for 

static analyses the structure, or any components of the structure, must not permit any rigid 

body displacements or rotations. Failure to comply with this criterion will result in a zero 

pivot message. 
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The error message includes the node and variable number that may be affected by the poor 

conditioning - these variables should be investigated in the model. Typical mistakes can 

include: 

 Omission of a support condition in one or more of the rigid body directions for the 

structure. 

 Insufficient additional restraint when connecting a beam element to a continuum 

element. In this case a rigid body torsional spin about the axis of the beam may occur. 

 Six degrees of freedom have been specified for a thick shell element, but the drilling 

rotation has not been correspondingly restrained. 

 Insufficiently large slideline interface stiffness coefficients allowing the two bodies to 

pass through each other as rigid bodies. The load increment may also be too large. 

 Incorrect nonlinear material parameters, such as a zero yield stress. 

 Joint elements may require investigation as the stiffnesses operate in local directions 

and can be easily defined incorrectly - as a result, the joint stiffnesses will not be 

providing support in the required directions. 

 There may be totally or partially unconnected elements within the structure as a result 

of incomplete merging or equivalencing of the model.  

Other Warnings 

Other warnings that may be found in the LUSAS output file include: 

 Aspect ratios warnings - See the appendix on element restrictions in the Element 

Reference Manual for more information. 

 Excessive curvature for beams warnings - See the appendix on element restrictions 

in the Element Reference Manual for more information. 

Notes On Orthotropic Material Properties 

For orthotropic material models the D matrix must be symmetric and a number of further 

relations must also be satisfied: 

Material properties orthotropic (e.g., QPM4) 

To maintain symmetry:  

nyx = nxy * Ey/Ex 

and to obtain a valid material: 

nxy < (Ex/Ey)1/2 

This applies to Fourier elements as a special case to simulate a bladed structure. 

Material properties orthotropic plane strain (e.g. QPN4).  

Ey * (nxy*Ez + nyz*nxz*Ex) = Ex * (nxy*Ez + nxz*nyz*Ey) 
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Material properties orthotropic axisymmetric (e.g. QAX4).  

To maintain symmetry: 

nyx = nxy * Ey/Ex 

nzx = nzx * Ez/Ex 

nzy = nyz * Ez/Ey 

and to obtain a valid material: 

nxy < (Ex/Ey)½ 

nxz < (Ex/Ez)½ 

nyz < (Ey/Ez)½ 

Material properties orthotropic solid (e.g. HX8, QSL8).  

To maintain symmetry: 

nyx = nxy * Ey/Ex 

nzx = nxz * Ex/Ez 

nzy = nyz * Ez/Ey 

and to obtain a valid material: 

nxy < (Ex/Ey)½ 

nxz < (Ex/Ez)½ 

nyz < (Ey/Ez)½ 

Material properties orthotropic thick (e.g. QSC4).  

To maintain symmetry: 

nyx = nxy * Ey/Ex 

and to obtain a valid material: 

nxy < (Ex/Ey)½ 

Notes 

 Option 16 can be used to override non-convergence as a result of poor conditioning. 

When Option 16 is specified and an increment has failed to converge within the 

maximum number of iterations allowed, LUSAS assumes convergence, writes the 

output/plot file results, and then continues with the next increment. Load step 

reductions can also be suppressed via the STEP REDUCTION section under the 

NONLINEAR CONTROL data chapter. Using these procedures may help to locate 

the source of the problem when investigating an unconverged configuration in the 

LUSAS Modeller post-processor. 

 A pivot refers to the diagonal element of the upper triangular matrix that is formed 

after elimination has been completed. Note that in the frontal solution these pivots are 

computed as soon as all the relevant equations have been assembled. 
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 Computation of det(K) as part of a nonlinear solution scheme is not necessary since a 

count of the number of negative pivots (NSCH in the log file) together with the value 

of PIVMN gives all the information required. 

 A zero pivot implies that det(K)=0. 

 If NSCH=2 then another unstable point has been reached and implies that det(K)>0. 

When An Eigenvalue Analysis Goes Wrong 

It is good practice to perform a linear static analysis prior to the eigenvalue analysis. This 

eliminates the added complexities of the dynamic variables and will enable a check on the 

basic stiffness matrix for the structure. Any warning or error messages in the LUSAS output 

file (such as zero, negative or small pivots) should be investigated.  

In the event of problems occurring after completing the linear static and the eigenvalue 

analysis consider some of the more common queries and their typical solutions as listed 

below.  

Eigenvalues are missing 

A Sturm sequence check is performed by default to indicate the number of modes which may 

be missing. 

 Check for Warnings or Errors Check the output file for any other warnings or 

errors. There may be diagonal decay or pivot warnings that will indicate node and 

element numbers and help to identify any suspect areas of the mesh. 

 Iteration Vectors Increase the number of starting iteration vectors. If any of the 

modes are close together, the default magnitude for this parameter may not be 

sufficient to allow accurate resolution in their extraction. 

 Convergence Tolerance Tighten the convergence tolerance since, again, some modes 

may be close together. This would normally also require an increase in the number of 

iterations permitted. 

 Convergence Achieved Ensure the solution converged correctly. If not, then increase 

the number of iterations permitted. 

 Mesh Refinement Increase the mesh refinement of the model in order to increase the 

number of degrees of freedom in the structure to simulate all the modes expected. 

 Symmetry Taking advantage of symmetry in an eigenvalue analysis may cause the 

inadvertent omission of several eigenvalues as a result of the corresponding symmetry 

supports restraining certain non-symmetric eigenmodes. 

 Increase Shift If a shift has been used to eliminate rigid body motions when 

analysing unsupported structures, then it may be that the value used is insufficient. 

The solution is typically not overly sensitive to changes in this parameter and, 

therefore, any changes tried should be in terms of orders of magnitude. 
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 Constraint Equations If constraint equations have been defined in the problem the 

Sturm sequence check may prove unreliable. This is a limitation of the Lagrange 

multiplier technique used in LUSAS. 

The Solution Did Not Converge 

 Check for Warnings or Errors Check the output file for any other warnings or 

errors. There may be diagonal decay or pivot warnings that will contain node and 

element numbers, and help identify any suspect areas of the mesh. 

 Iteration Vectors Increase the number of starting iteration vectors. If any of the 

modes are close together, the default magnitude for this parameter may not be 

sufficient to allow accurate resolution in their extraction. Increasing this parameter is 

also essential if only requesting a small number of eigenvalues (1-2). Ten iteration 

vectors would be a reasonable starting value for such a situation. This parameter is not 

used for Lanczos extraction. 

 Convergence Tolerance The convergence tolerance criteria may be too tight - try 

slackening this criteria. This would normally also require an increase in the number of 

iterations permitted. 

 Increase Shift If a shift has been used to eliminate rigid body problems when 

analysing unsupported structures, then it may be that the value used is not sufficient. 

The solution is typically not overly sensitive to changes in this parameter and, 

therefore, any changes tried may be in terms of orders of magnitude. 

Negative Eigenvalues Are Calculated 

 Check for Warnings or Errors Check the output file for any other warnings or 

errors. There may be diagonal decay or pivot warnings that will indicate node and 

element numbers and help to identify any suspect areas of the mesh. 

 Iteration Vectors Increase the number of starting iteration vectors. If any of the 

modes are close together the default magnitude for this parameter may not be 

sufficient to allow accurate resolution in their extraction. Increasing this parameter is 

also essential if only requesting a small number of eigenvalues (1-2). Ten iteration 

vectors would be a reasonable starting value for such a situation. 

 Convergence Achieved Ensure that the solution converged correctly. If not, then 

increase the number of iterations permitted. 

 Convergence Tolerance Tighten the convergence tolerance, since some modes may 

be close together and require greater numerical resolution. This may also require an 

increase in the number of iterations permitted. 

 Reduce Load Level Reduce the load applied to ensure that it is below the lowest 

expected buckling mode of the structure. A negative eigenvalue in a buckling analysis 

could also simply mean that the applied loading is in the opposite direction to that 

which would cause buckling; e.g. a strut subjected to tensile load instead of 

compression. 
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 Alternative Buckling QSL8 elements have given negative eigenvalues for thin 

structures and resulted in negative projected mass errors. The remedy is to use the 

alternative buckling algorithm where positive eigenvalues should be obtained. This is 

always the case except when the buckling load factor is less than unity. Adjust the 

load level to ensure that all the load factors are greater than 1 if this occurs. 

Additionally, use Option 18 (fine integration rule for the element) to overcome the 

excitation of any element mechanisms. 

Why Loading is Ignored in an Eigenvalue Analysis 

In a standard eigenvalue analysis, the loading will be ignored completely. For a linear 

analysis, once the eigen-pairs have been obtained, the stress distribution s for each mode 

shape F is evaluated using: 

s = D * B * F 

where D and B are the elastic constitutive and strain-displacement matrices 

respectively.  

The reason that the forces have no effect on the vibrational behaviour is because the loading 

conditions in a linear analysis do not affect the D or B matrices. To include their effects, a 

nonlinear D and B matrix must be evaluated prior to the eigen analysis. This is achieved by 

performing a static nonlinear analysis (with a geometrically nonlinear option) followed by an 

eigenvalue analysis. In this way the effects of the loads are included via the updated B matrix 

(and D matrix if a nonlinear material has been specified). 
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Appendix C : 

Keyboard Shortcuts 

  

Keyboard Shortcuts 

Selecting Model Features 

Features displayed in the graphics window may be selected using either specific cursors or by 

using normal cursor mode in conjunction with specific keys: 

Feature / Mesh Object Selection Options 

Hold the key shown down when using the left mouse button.  

Specific cursor  = Normal cursor + key 

  

  All geometry selection  

  

=  + G key 

    

  Point selection  =  + P key 

  Line selection  =  + L key 

  Surface selection  =  + S key 

  Volume selection  =  + V key 

  Mesh selection =  + M key 

  Node selection =  + N key 

  Edge selection =  + B key 
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  Face selection =  + F key 

  Element selection  =  + E key 

  Annotation selection  =  + A key 

Note. Key shortcuts can be used to override specific cursor selections. 

Area Selection Options 

Rectangular, circular, or polygonal areas can be selected by using specific area toolbar 

buttons or by using normal cursor mode with a specific key: 

Specific cursor  = Normal 
cursor + key 

  

  Click and drag the cursor to the opposite diagonal corner. 

  

=  

  Click the centre of the circle and drag the cursor to the required 

radius. 

=   + C 

key 

  Click each corner of a polygon and either double click to close the 

polygon or select Close Polygon from the context menu.  

=   + X 

key 

Memory shortcuts 

After features have been selected: 

Ctrl + M key = Set selected items into Selection Memory 

Selection Modifiers for All Cursors 

Features displayed in the graphics window may be added to, or removed from, any initial 

selection using these selection modifers: 

Shift key = Add to current selection 

Ctrl key = Toggle (include /exclude selection) 

Ctrl + Shift key = Remove from current selection 

Tab key = Cycle (items at the same location) 

Shift + Tab key = Cycle previous 

Alt key = Intersect mode. By default all items completely enclosed in a selected area will be 

selected. By holding down the Alt key, items intersecting the selection perimeter will also be 

selected. The Alt key may be used with, or independently from, the Shift or Ctrl keys. The 

Alt key can also be used with feature selection shortcuts e.g. Alt + Shft + L adds lines to the 

current selection. 

Alt + Return key = Display properties of item 
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'Datatip' + Return key = Adds current item to selection 

Browsing Selected Features 

Items in the current selection may be viewed in the Browse Selection window which can be 

displayed from the View> Browse Selection menu item. This window can also be triggered 

by a right mouse button click in the Selected area of the status bar at the bottom of the 

graphics area, or by right-clicking in a graphics window. Selected features can be deselected 

and reselected as necessary from those listed. 

Model Viewing Shortcuts 

The model can be rotated, zoomed, panned, and viewed at predefined orthogonal and non-

orthogonal views using specific cursors or view buttons, or by using normal cursor mode in 

conjunction with specific keys. Rotation, zoom and pan can also be carried out in other cursor 

input modes such as when defining lines by cursor or section slicing for example. 

Dynamic Pan (Drag) 

Specific cursor  = Normal cursor + key 

  

  Hold down the left mouse button to 

pan the model. 

  

=  + D key 

=  + Middle mouse button 

Note. Hold down the key(s) to restrain the pan for either specific or normal cursor mode 

about the axis stated: 

X or Shift key = Restrain in the screen X axis  

Y or Ctrl key = Restrain in the screen Y axis 

Dynamic Rotation 

Specific cursor  = Normal cursor + key 

  

  Rotates the model around various 

multiple axes. 

  

  

=  + D key 

=  + Middle + Left or  Right mouse 

button 

Note. The model is rotated about its centre unless any part of the model is selected in which 

case the model is rotated about the centre of the selection. Hold down the key(s) to restrain 

rotation about the axis stated: 

X or Shift key = Restrain in the screen X axis  

Y or Ctrl + Shift keys = Restrain in the screen Y axis 

Z or Ctrl key = Restrain in the screen Z axis  
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Dynamic Zoom 

Specific cursor  = Normal cursor + key 

  

 Hold down the left mouse button and 

move the mouse. 

  

=  + Scroll mouse wheel 

=  + Z key 

Note. If any part of the model is selected it is used as the centre of the zoom. 

Zoom 

  Drag a box around the region to be enlarged or click the left mouse button to zoom in 

progressively with each click. 

Ctrl key = Zoom out (when held at same time) 

Note. The cursor position dictates the centre of the zoom. 

Orthogonal Model Views 

These buttons are located in the status bar. 

  = View along the +X axis towards the origin 

  = View along the +Y axis towards the origin 

  = View along the +Z axis towards the origin 

Any of the views along these axes can be modified by using these key sequences which select 

an alternative view orientation: 

Shift key +  = View along the -X axis towards the origin   

Ctrl key +  = View along the -Y axis towards the origin 

Ctrl + Shift key +  = View along the -Z axis towards the origin 

Equivalent toolbar buttons for these view shortcuts can be found on the customisable toolbar 

dialog or by clicking the right mouse button on the orthogonal model view buttons. 

Non-Orthogonal Model Views 

  = Isometric view 

Ctrl key +  = Reverse isometric view 

  = Dimetric view 

Ctrl key +  = Reverse dimetric view 
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  = Trimetric view 

Ctrl key +  = Reverse trimetric view 

Useful Windows Shortcuts 

The following standard Windows shortcuts are useful when creating and printing models in 

LUSAS Modeller: 

Ctrl key + N key  = New 

Ctrl key + O key = Open 

Ctrl key + S  key = Save 

Ctrl key + P  key = Print 

Ctrl key + A  key = Select all items 

Ctrl key + C  key = Copy 

Ctrl key + X  key = Cut (for text only) 

Ctrl key + V  key = Paste 

Ctrl key + Z  key = Undo 

F2 key = Rename (when name is selected)  

F5 key = Redraw 
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Appendix D : Tip of 

the Day 

  

Tip of the Day 

When starting LUSAS Modeller useful tips can be optionally displayed. This is done by 

selecting the Help > Tip of the Day... menu item and ensuring that Show tips at Startup is 

selected. Next and Previous tips can be browsed. 

The following is the list of tips supplied in the current release version: 

 If you haven't already done so, please read the 'Getting Started' leaflet. 

 The 'Keyboard Shortcut Guide' will help you use LUSAS in an efficient manner 

 If you lose unsaved edits because of a power, hardware or software failure, restart 

LUSAS, open the model again and chose 'yes' when prompted to recover. 

 Saving your work frequently prevents data loss and makes undo/redo work faster. 

 Help is available even for greyed out buttons and menus. First click on the Help 

button on the main toolbar, then click on any menu item or toolbar button. 

 Right-clicking in a window displays a context menu relevant to both that window and 

any selection within it. 

 Toolbar buttons with a small triangle to the right hand side are menu buttons. Press 

the left hand side to use the top button, or the right hand side to display other buttons. 

 Holding down the Shift key while selecting will add to the current selection. 

 Holding down the Ctrl key while selecting will toggle an object's selection state. 

 Holding down the Alt key while selecting will additionally select items that intersect 

(cross) the selection perimeter. 

 Ctrl-A selects everything visible in the current window. 

 You may filter your selection to include only Volumes, Surfaces, Lines, Points, 

Elements, Nodes or Annotation by respectively holding down the V, S, L, P, E, N or 

A key while selecting. 

 Alt-Enter displays the properties of the current selection. 

 If you the hover the cursor over an object, a data tip will appear providing details of 

that object. 

 Pressing Enter whilst a data tip is showing will select the object described. 



Modeller Reference Manual   

    

416 

 To Zoom, Drag or Rotate the model hold the Z, D or R key down whilst moving the 

mouse. 

 Using the dynamic rotation while holding down the Ctrl key rotates the model in the 

plane of the screen. 

 Using the dynamic rotation while holding down the Shift key rotates the model about 

the screen X axis. 

 Using the dynamic rotation while holding down the Ctrl & Shift keys rotates the 

model about the screen Y axis. 

 Using the drag tool while holding down the Ctrl key drags the model up and down. 

 Using the drag tool while holding down the Shift key drags the model left and right. 

 If you have a 3 button wheel mouse, the wheel will zoom, holding the middle button 

will drag and holding the middle button and either of the other two buttons will rotate. 

 To change the rotation increment, visit the 'View' tab on the Window Properties dialog 

(right click in the current view) 

 To change the style of the XYZ axes arrows, visit the 'View Axes' tab on the Window 

Properties dialog (right click in the current view) 

 To change the selection or background colours, visit the 'General' tab on the Window 

Properties dialog (right click in the current view) 

 Most context menu functionality for attributes is also available for groups of 

attributes. This helps you check your model. 

 Dragging an attribute from the treeview and dropping it on a window assigns it to 

anything selected in that window. 

 Dragging and dropping layers in the layers treeview changes the order in which they 

are drawn. This is useful if, for example, your solid model is eclipsing your labels. 

 Dragging and dropping loadcases in the loadcase treeview changes the order in which 

they are analysed. 

 Dragging and dropping controls, attributes, or groups of attributes, in the loadcase 

treeview assigns them to a different loadcase. 

 The 'Selected' box in the status bar shows the number of objects are currently selected. 

 Pressing 'Tab' or clicking in the 'Selected' box in the status bar cycles through all the 

objects which could have been selected at the last mouse click. 

 Right-clicking in the 'Selected' box in the status bar allows access to a menu of 

selected objects. Choose 'Previous' when you have cycled the selection once too 

many! 

 The 'browse selection' window gives useful feedback on which items are currently 

selected. 

 The 'browse cyclable items' window shows all items which could possibly be selected 

at the chosen position. 

 To select an item with a known name, use the 'Advanced Selection' dialog. 

 To show the location of a named item, select it using 'Advanced Selection', right click 

on it in the 'Browse Selection' window, and chose 'find' from the menu. 

 If a message in the text output window refers to a particular object by name, double 

click on the message for help finding that object. 
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 Clicking in the 'Z' box in the status bar views the model from the positive end of the Z 

axis - and similarly with X and Y. (Hold down Ctrl while clicking to view from the 

reverse side). 

 Clicking the 'advanced' button on the LPI command bar lets you define macros for 

frequently used commands 

 The members of a group can be examined from the group's property page 

 The 'jump to' button on the 'hierarchy' tab of an object's property page can be used to 

select and show the properties of connected objects. 

 The 'assigned in active loadcase' option on an object's property page allows you to 

view either assignments in the active loadcase, or in any loadcase. 

 Treeviews can be moved to different tree frames by drag and drop. This is useful if 

you prefer to see more than one treeview at the same time. 

 Attributes can be assigned to the contents of groups by copying the attribute and 

pasting it onto a group in the treeview. 

 By saving a view using the Window menu, and naming it 'default', every new window 

will use the saved view. 

 Pressing the Ctrl and Break keys together will interrupt the current process. 

 For larger models save time by setting the manual redraw option (Window menu) and 

manually redraw (F5 key) at any time. 

 For larger models save time by setting the manual resize option (Window menu) and 

manually resize at any time. 

 For larger models save time by locking the mesh whilst making several geometry or 

mesh changes. Either manually remesh, or unlock once finished to reinstate automatic 

meshing 

 It is usually much quicker to undo several events all at once than to undo them 

individually 

 Many additional toolbar buttons are available via the View>Toolbars>Customise 

menu item 

 Selection is possible using several different criteria (e.g. connectivity, element type) - 

see the 'Advanced Selection' dialog 

 To retain a record of the commands used in a session, use the File>Script>Start 

Recording menu item. 

 You may use the Esc key to close any dialog. 

 Holding down the Shift and Control keys while selecting will remove from the current 

selection. For example, the current selection could be trimmed from a perpendicular 

view orientation to achieve a 3D selection. 

 A selection may be filtered to include only Geometry, Volumes, Surfaces, Lines, 

Points, Mesh, Elements, Nodes or Annotation by respectively holding down the G, V, 

S, L, P, M, E, N or A key while selecting. 

 Element faces may be selected by holding down the F key while selecting (LUSAS 

HPM users only) 

  LUSAS Solver can be paused by pressing the Pause key on your keyboard to 

temporarily free up PC resources if required. Press the Esc key to resume Solver. 
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 Errors and warnings reported in the Text Output window can be double-clicked to 

open the Identify Object facility which can be used to locate the referenced items. 

Editing and adding your own tips 

You can add your own tips by editing the text file named tips.txt which is held in the 

<LUSAS installation folder>\Programs\Config directory. 
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Appendix E : Real 

Numbers and 

Expressions in 

LUSAS 

  

Input and Output of Real Numbers in LUSAS 

The precision of user-entered real numbers is preserved both internally within LUSAS 

Modeller, and when re-displayed on dialogs.  

All real numbers are displayed in engineering-style notation (that is in 3,6,9 etc, powers of 

10; as in 89.6E3) rather than 8.96E4 or 0.896E5. This applies to all text entry fields, including 

the grids used in many places throughout the Modeller user interface.  

For cosmetic numbers that are system generated, like the current zoom factor, only a sensible 

number of significant figures is shown. This does not alter the precision stored, which will 

always be the maximum allowed by the operating system. 

Expressions and Functions Supported 

Expressions may be entered anywhere in LUSAS Modeller where numbers may be input. For 

example, in point definition, it is possible to enter 3+10, 4*6, and 5-1 as valid co-ordinates. 

All arithmetic operators including braces are available, as well as the standard trigonometry 

functions sin, cos, log etc. This facility is available in all text entry fields throughout the 

Modeller user interface. 

The following functions are also supported: 

Arithmetic 

(A), -A, A+B, A-B, A*B, A/B, A^B, ceil(A), floor(A), abs(A), 

max(A, B), min(A, B), pow(val, exp), mod(val, div) 
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Trigonometric 

sin, cos, tan, asin, acos, atan, sinh, cosh, tanh, sind, 

cosd, tand, asind, acosd, atand, atan2, atan2d 

Mathematical 

exp, log, log10, sqrt 

Logical 

A > B, A < B, A = B, not(A), and(A, B), or(A, B), boolEq(A, 

B), boolNE(A, B), gt(A, B), ge(A, B), lt(A, B), le(A, B), 

eq(A, B), ne(A, B), if (condition, then, else) 

Other 

Radians(angle) Converts an angle entered in degrees into an 

angle in radians 

Degrees(angle) Converts an angle entered in radians into an 

angle in degrees 
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Glossary 

  

abscissa 

The x axis of a graph.  See also  ordinate, graph dataset.  

acceleration 

Second derivative of displacement with respect to time. See alsovelocity.  

acronym 

a word formed by the initial letters of words or by initial letters plus parts of several words. For example, 

FORTRAN is an acronym for FORmula TRANslator.  

access 

The process of seeking, reading, or writing data on a storage unit.  

active load case 

Each graphics window used in a LUSAS Modeller has an active load case set. The active load case is marked 

with a dot in the Load case Treeview. To set a new active load case, click on another load case, right-click 

and choose Set Active from the shortcut menu.  

 In a model file (.mdl) attributes that have been assigned to load cases, such as loading, may only be 

visualised for the active load case.  

 In a results file (.mys) results are displayed for the active load case.  

adaptive analysis 

A series of analyses in which subsequent meshes are refined to reduce the overall errors in the solution.  

analytical surface 

A Surface that can be represented by an analytical expression, thus defining its internal geometry. LUSAS 

supports cylindrical, conical and spherical analytical Surfaces. See also  ruled surface, regular surface, 

irregular surface.  

angular acceleration 

A measure of the rate of change of rotational speed expressed in radians per second per second.  
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angular velocity 

A measure of rotational speed expressed in radians per second.  

animation 

Screens of information displayed in rapid succession to give the impression of movement.  

anisotropic 

Material allowing different material properties to be specified in arbitrary (non-orthotropic) directions by 

direct specification of the modulus matrix.  See also  orthotropic.  

annotation 

Information added to the screen to clarify a plot. This may take the form of text, lines, symbols, results 

summaries etc.  

application 

A computer program designed to meet specific user needs. This term is interchangeable with program.  

apply 

See  apply button.  

apply button 

This push button will carry out the actions signified by the chosen form subject to the parameters entered, 

then re-display the form allowing you to enter further data.  

arc-length method 

A generalised form of displacement control where the load level does not remain constant during each load 
increment so that convergence near limit points may be achieved. A benefit of the arc-length method is that it 

can stabilise the iterative process.  See also constant load level, line search. Also known as arc-length 

control.  

arrow keys 

On your computer keyboard, the keys you use to navigate around your screen. Each key is marked with an 

arrow and is named for the direction in which the arrow points. There is an UP ARROW, DOWN ARROW, 
LEFT ARROW and RIGHT ARROW key.  Also known as direction keys or cursor keys.  

ASCII 

Acronym for American Standard Code for Information Interchange. ASCII is a standardised 8-bit code used 

by most computers for interfacing.  

aspect ratio 

The ratio of longest side to shortest side of a finite element. It is important to take the aspect ratio into 
account as the quality of results is affected when it becomes too large.  
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assign 

To match up a feature with a previously defined attribute, you assign the attribute to the feature.  

association 

See  associativity.  

associative plasticity 

Plasticity formulation where the direction of plastic straining is normal to the yield surface. This is a common 

finite element implementation for non granular materials.  

associativity 

All features in LUSAS are defined in terms of lower order features, that is they are associative. When a point 
is moved all lines, surfaces and volumes are updated to reflect the new position.  

assumed strain 

A strain field used in the formulation of the general shell element to avoid shear locking‟ when it is used as a 

thin shell.  

attribute 

See  attribute dataset.  

attribute dataset 

Describes the properties of features to which it is assigned, for example materials, mesh, loading, etc.  

automatic incrementation 

Analysis scheme where successive levels of applied load are applied by specifying multiplying factors for a 

given load case. Successive load levels can be altered based on the previous convergence history.  

automatic masters 

A facility within a LUSAS Guyan reduction in which LUSAS automatically selects the master freedoms.  

averaged nodal results 

Most results are calculated at the Gauss points of an element and then extrapolated to the nodes using the 

element shape functions. When the results from all elements joined at a node are added together and divided 
by the number of contributing elements these are known as averaged nodal results.  See also  unaveraged 

nodal results, Gauss point results, shape functions.  

axial force 

The longitudinal force along the axis of a beam. See also  force diagram.  

axisymmetry 

A structure that has circular symmetry of geometry, material, supports and loading, such that a radian slice 

can be analysed.  
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b matrix 

Matrix of element shape function derivative terms describing the relationship between strain and 

displacement. It is used in the formation of the element stiffness matrix. See also  stiffness matrix, d 

~matrix.  

background grid 

A collection of triangular or tetrahedral shapes which are used to specify the element edge length when 

meshing surfaces automatically.  

backward Euler 

An implicit plasticity formulation in which the plastic strain normality condition is formulated at the trial 

stress position. See also  forward Euler.  

bandwidth 

See  frontwidth.  

bar element 

A straight or curved isoparametric line element without any rotational degrees of freedom used to model strut 

or truss structures.  

batch file 

A text file that contains MS-DOS commands. When you run the batch program, MS-DOS carries out the 

commands in the file as if you had typed them at the MS-DOS prompt. Used to set up an environment and 

run a program. A batch file has the extension bat. See also  script file. Also known as batch program.  

beam element 

A straight or curved line element with rotational degrees of freedom used to model frame structures.  See 
also  explicitly integrated beam, numerically integrated beam 

bending moment diagram 

A graphical representation of the bending moment results from a beam element drawn along the element. 

Maximum or minimum and end values are accessible.  See also  force diagram.  

beta angle 

The angle between the element axes and the line axes. 

biaxial 

A description of a material model in which two axes are considered to determine the material response. For 

instance, the biaxial concrete model uses the two principal stress directions. See also uniaxial, triaxial.  

bicubic patch 

A surface formed of cubic splines in which the internal geometry is defined as well as the boundary.  
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bifurcation point 

A point at which an alternative load-displacement path can be taken.  See also  limit point.  

binary file 

A random access file containing information that is in machine-readable form; it can be read only by an 

application.  

body force loading 

See constant body force.  

boot 

To start or restart your computer, loading the operating system from your hard disk or floppy disk.  See also  

hard disk, floppy disk .  

boundary conditions 

Loading, constraints and supports applied to a finite element model. Boundary conditions are sometimes 

termed nonlinear where the model changes in contact, such as with a lift-off support or a contact analysis. 

See also  constraint equation, supports.  

bracketing 

The accurate computation of a critical point which may be either a limit point or a bifurcation point.  

branching 

The tracing of an alternative solution path from a bifurcation point.  

buckling 

See  eigenvalue buckling.  

buffer 

A temporary area in which data is stored.  

Cartesian axis set 

A standard set of axes based on the global XYZ axis set but not necessarily in the same position or 
orientation. See also local coordinate system, cylindrical axis set.  

cascade 

The action of bringing down a secondary menu by selecting an entry on an upper menu level. Usually 

designated by a right facing arrow.  

central processor (CPU) 

The heart of the computer system. The CPU interprets and executes programs, routes information, controls 
input and output and temporarily stores data.  
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checking 

See  data check.  

checklist 

A list of items through which to work to establish the integrity of a model or its results.  

classical yield 

Plasticity formulation where yielding is independent of the sign (tension/compression) of the stress causing it 

(e.g. von Mises, Hill).  

close contact detection 

A facility that automatically inserts a small spring element between opposing surfaces of a slide pair when 
they are within a specified tolerance of any section of the opposing surface. The spring controls possible 

mechanisms in the initial response. See also contact.  

click 

To press and release a mouse button quickly.  

co-rotational 

Form of geometric nonlinearity in which large displacement effects are related to a set of axes that follow and 
rotate with the element.  

coarse integration 

A method of element integration using an alternate selection of a smaller number of Gauss points. See also  

fine integration.  

cohesion 

A material property of granular materials, such as soils or rocks, describing the degree of granular bond and a 
measure of the shear strength.  

colour fill 

Solid block colours used to represent stress patterns or different mesh views. 

combination 

See  load combination.  

combined line 

A LUSAS feature made up from a combination of individual connected line datasets. It can be used to 

simplify meshing.  

command bar 

Part of the LUSAS interface where commands may be typed. Displayed from the View menu. Also known 
as command line.  
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command file 

Commonly used sequences of commands may be grouped in a file and replayed at any time.  See also  sub-

session file.  

command line 

See  command bar.  

comments 

Notes attached to a data or command file for informational purposes only.  

compatible 

A description of data, programs or equipment that can be used between different kinds of computers.  

compiler 

A computer program that translates a program written in a programming language into a set of instructions in 
the language of the computer.  

component 

See  group.  

compound load 

a collection or set of defined discrete loads that are assigned to a model as a single loading attribute 

composite properties 

Define how individual materials are layered in a composite material.  

concatenation 

Joining two or more strings together to form a single string.  

conduction 

The process of energy exchange by kinetic motion or direct impact of molecules (fluids) or the drift of 

electrons (metals). See also  convection, radiation.  

concrete model 

A plane stress material model that mimics the nonlinear cracking of concrete. See also  orthogonal 

cracking, non-orthogonal cracking, cracking.  

conjugate gradient solver 

A solver that iterates towards a solution, judging convergence by a user-defined tolerance. This is in contrast 

to a direct solver, such as the frontal solver. Because the solution is inexact, very sensitive to the matrix 

conditioning and repeated for every load case, it is best suited to large, solid, well-conditioned, single load 

case analyses. See also  pre-conditioned conjugate gradient solver.  
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constant body force 

A load type that applies a force loading per unit volume. This load type can also be used to apply acceleration 

loading. Also known as  body force loading.  

consistent mass 

Distributed between the degrees of freedom. The mass matrix is not diagonal.  See also  lumped mass.  

constant load level 

When the load is applied in fixed increments and the chosen iterative algorithm is utilised to obtain 

convergence at each load level.  See also  line search, arc-length method.  

constitutive relationship 

The empirical relationship between stress and strain. May include thermal effects and be nonlinear with 

irreversible plastic deformation.  

constraint equation 

An additional relationship between different freedoms of a structure.  Also known as multi-point 

constraints.  

contact 

The action of bringing one portion of a finite element mesh into a position where it impacts on another part of 

the mesh. See also  impact.  

contact node 

Any node assigned for use on a slideline surface. Also known as a slideline node.  

contact zone 

The area of a model that is considered to be touching another part.  See also  zonal detection.  

contacted node 

A slideline node currently considered to be in contact with the opposing slideline surface.  

context-sensitive help 

Available by clicking on the Help button on the main toolbar, or by pressing Shift F1 on the keyboard. This 

puts the cursor into help mode, next click on any toolbar button, menu entry or other part of the LUSAS 

interface for context-sensitive help. Also know as pop-up help. See also  help.  

continuum element 

Finite element formulation based on classical continuum mechanics principles. The output from these 
elements is in terms of continuum stresses rather than stress resultants.  

contour plot 

A graphical representation of a results pattern across the surface of the model.  See also  colour fill.  
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control dataset 

A dataset containing LUSAS analysis control information. The parameters stored in these datasets control the 

progress of the analysis. A control dataset is assigned to a load ID.  See also  assign.  

convection 

The process of transmission of heat through liquids or gases at a body surface by means of the motion of the 

fluid. See also  conduction, radiation.  

convergence 

When using incremental iterative solution algorithms, a measure of the convergence of the solution is 

required to define whether equilibrium has been achieved.  See also  increment, Iteration, displacement 

norm, residual norm, work norm.  

coprocessor 

A microprocessor device connected to the central processor that performs specialised floating point 

computations more efficiently than the CPU alone.  See also  central processor.  

coupled analysis 

The interaction between a thermal and structural analysis may be studied by performing a coupled analysis.  
Also known as  thermo-mechanical coupling. See also  fully coupled, semi-coupled.  

copy 

To create a new feature by copying an existing one using a transformation dataset.  See also  move, 

transformation dataset.  

CPU time 

A measure of actual processing time, usually expressed in seconds. See also  elapsed time.  

CQC method 

A method used in spectral response analysis which gives a combination formula that includes all cross modal 
terms. Stands for complete quadratic combination.  See also  SRSS method, seismic analysis.  

crack tip elements 

A non-standard continuum element family, in which the mid-side nodes on 2 of the element edges are moved 

to the quarter point. This enables an accurate resolution of stresses to be obtained at a sharp notch or crack.  

cracking 

Material nonlinearity resulting from material failure. Most directly associated with the concrete (ductile 
fracture) material model in LUSAS.  

creep 

The time-dependent inelastic deformation of a material which causes a permanent change in the material 

once the loading is removed. Creep can occur as soon as the body is stressed and is independent of a yield 

criterion.  
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critical damping 

The damping value for which the impulse response is just oscillatory.  

critical point 

Either a limit point or a bifurcation point.  

critical time step 

The time step in an explicit dynamic analysis that satisfies the conditional stability criteria.  

critically damped system 

The dividing line between under-damped and over-damped systems where the equation of motion has a 

damping value that is equal to the critical damping.  

current group 

The group which will contain all newly defined geometry features. 

current stiffness parameter 

A measure of the current, overall structural stiffness. Originally unity, a lower value indicates a general 

softening whilst a higher value indicates a stiffening of the structure.  

cursor 

The device used to pick items from the graphics area and select menu entries. The hardware device used to 

control the position of the cursor is normally a mouse.  See also  cursor selection.  

cursor picking 

See  cursor selection.  

cursor keys 

See  direction keys.  

cursor selection 

To select an item with the cursor.  Also known as cursor picking.  

curve 

See  load curve.  

cycle 

Feature definitions can be rotated, or cycled, by one or more steps. For example, a surface may have the 

definition order of the lines cycled to change the local element axes.  See also reverse.  

cylindrical axis set 

An axis set based on a cylindrical form.  See also  Cartesian axis set, local coordinate system.  
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d matrix 

Matrix of material constants which describe the stress/strain or constitutive relationship for a material. See 
also  constitutive relationship.  

damage 

The damage done to a structure is used as a measure of how many loading cycles the structure will withstand 
before failure. Failure occurs when the damage reaches unity.  See also  fatigue, log life.  

damage material model 

A nonlinear material model in which the value of Young‟s modulus degrades with progressive loading.  

damage threshold 

The initial stress limit below which no material damage is assumed to occur when using the nonlinear 

damage material model. It is the linear elastic limit point.  

damping 

Any mechanism that dissipates energy. See also mechanism.  

data check 

A LUSAS analysis which progresses as far as the pre-solution stage. The data file is checked for errors and a 

plot file is created for visual checking in the post-processor. Frontal optimisation is carried out if the default 

solution order commands are included.  

data file 

The LUSAS database must be formatted before solution. The formatted analysis file is known as the data file.  

data transfer file 

A file used to store information during a coupled analysis for access by the secondary analysis. See also  

coupled analysis.  

default 

An action or value that a computer or program automatically assumes, unless a different value or instruction 

is given.  

define 

To create a dataset. Datasets are used to store information about features, attributes, utilities and results.  See 
also edit, feature, attribute.  

deformation gradient 

A tensor used in continuum mechanics for defining certain strain measures.  
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deformed mesh 

The mesh displayed in a deformed state when subject to an external load or when a mode shape is being 

displayed.  See also  undeformed mesh.  

degrees of freedom 

Express the manner in which the nodes are free to displace.  

delamination 

The separation of bonded plys in a laminated composite. It is often referred to as the edge effect because it is 

most common at the free edges of the structure.  

delimiter 

A character that marks the beginning or end of a unit of data.  

density 

A measure of the mass per unit volume of a structure. Also known as mass density. See also  mesh 

density.  

departure from linearity 

Achieved by using a hierarchical degree of freedom at a central node which represents the relative 
displacement of the two end nodes.  

device 

A piece of hardware that performs a specific function. For example, a printer.  

dialog box 

A box displayed on the computer screen to accept data input from the user.  See also  OK button, apply 

button.  

diagonal decay 

Is an indication of poor conditioning. It indicates that round-off error during the solution has become 

significant which may lead to inaccuracies in predicted results. A poorly conditioned stiffness matrix is the 

result of a large variation in magnitude of the diagonal terms. This could be caused by large stiff elements 

being connected to small less stiff elements or elements with highly disparate stiffnesses.  

diffuse radiation 

Radiative heat emitted equally in all directions from the source point.  

direct integration 

The equations of motion (including mass and damping effects) are integrated in the time domain. The 

solution is progressed at discrete time points - the time interval between each being the time step. Also 
known as step-by step-dynamics.  
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direction keys 

See arrow keys.  

directory 

Part of a structure for organising your files on a disk. A directory can contain files and other directories 
(called sub-directories). The structure of directories and sub-directories on a disk is called a directory tree.  

discrete point and patch loads 

May be used to distribute a given loading pattern over a number of features. Point loads apply a series of 

discrete point loads and patch loads apply an interpolated loading patch based on specified apex values.  Also 
known as HA/HB loading, General loading. See also  highway loads.  

discretisation 

Sub-division of features into finite elements.  

disk drive 

A device used to read from and write to disks. See also  hard disk, floppy disk.  

disk usage 

The amount of hard disk space used during an analysis. See also  hard disk 

diskette 

See  floppy disk.  

displacement 

The amount by which a node moves during loading is known as the displacement.  

displacement norm 

A LUSAS convergence parameter which expresses the limit for the sum of the squares of the iterative 
displacements as a percentage of the sum of the squares of the total displacements. See also residual norm, 

work norm, convergence.  

displacement vectors 

Arrows drawn on the screen to represent the direction and magnitude of resultant displacements for a model.  
See also vector plotting, principal stress vectors.  

distributed element loads 

Form of element load in which a load variation can be expressed along an element in terms of local or global 

axes.  

domain 

A term used for the external boundaries of a finite element problem.  
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double-click 

To rapidly press and release a mouse button twice without moving the mouse. Double-clicking carries out an 

action, such as starting an application.  

double-precision 

The use of two computer words to represent each number. Allows the use of twice as many digits as normal 

to represent a number and allows for extra precision in calculations. LUSAS is a double-precision 

application.  

draping 

The laying of a composite fabric over a surface 

draw 

The action of placing an entity onto the graphics screen.  

Drucker-Prager stress 

The scalar stress state obtained by combining the individual component stresses at a point according to the 

classical Drucker-Prager failure criterion. Typically used in the failure of soil or granular type materials.  
See also  Tresca stress.  

ductile fracture 

A nonlinear material process by which tensile stresses are progressively released from a cracked Gauss point. 
See also concrete model.  

DXF 

An acronym for AutoCAD Drawing eXchange Format, which can be read into LUSAS Graphics to form the 

basis of a model‟s features.  

dynamic analysis 

Analyses in which the effects of mass are included. This may be in the time domain using direct integration 
methods or in the frequency domain using eigenvalue extraction methods.  Also known as natural frequency 

analysis.  See also  direct integration, eigenvalue analysis, explicit dynamics.  

eccentricity 

A geometric property of a thin beam, plate or shell that allows an offset of properties from the nodal line such 

as any applied supports or loading. For thick beams an eccentricity is defined as an offset. 

edit 

To change the contents of an existing dataset. Properties from the edited dataset will automatically be used 
when the model is next tabulated.  See also  define.  

edge collapsing 

Edge collapsing is the process of removing elements with very short sides or acute angles by merging them 

with neighbouring elements. This is particularly useful when meshing models imported from CAD. 
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eigen mode 

The natural frequencies of a structure are calculated using an eigenvector analysis. The mode shape is known 

as the eigen mode. See also  eigenvector, mode shape.  

eigenvalue 

The frequency or load factor magnitude corresponding to the displacement shape resulting from an 

eigenvalue analysis. Eigenvalues can also be described as the roots of the characteristic equation of the 

system. The number of eigenvalues relates directly to the number of equations of motion of a system. The 
square root of the eigenvalues are the resonant or natural frequencies.  

eigenvalue analysis 

Extraction of natural modes of vibration of a structure. Also known as natural frequency analysis, dynamic 

analysis.  

eigenvalue buckling 

The procedure used by LUSAS to predict the buckling load of a structure.  Also known as linear buckling.  

eigenvector 

A deformed shape resulting from an eigenvalue analysis. If a structure is excited at a resonant frequency then 

the shape that it adopts is the mode shape corresponding to the eigenvalue. See also eigen mode, mode 

shape.  

elapsed time 

A measure of total time spent during an analysis or some other computer activity. This time can be greater 

than the CPU time as it includes effects of other system activity, such as disk access, file transfer, multiple 
users, etc. See also  CPU time.  

elasticity 

The property of a material to recover its original form on the removal of the loads.  

elasto-plastic 

Material behaviour that spans both linear and nonlinear regimes. See also  constitutive relationship.  

element 

See  finite element.  

element normal 

A vector that is orthogonal to the face of an element. Can be displayed graphically to check element face 

orientations.  

element results 

Results at nodes within a finite element that are unaveraged with nodal results from surrounding elements.  
See  unaveraged nodal results.  
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emissivity 

Ratio of the energy emitted by a real surface to the theoretical maximum possible at the same temperature. 

Emissivity is always in the range 0 - 1.0 (LUSAS assumes reflectivity = 1-emmisivity).  

end-of-file mark (EOF) 

A machine or machine equivalent that indicates that the last record of a file has been read.  

engineering strain 

A strain measure which has its reference as the current length as opposed to the undeformed length.  

enhanced strain 

A strain field used to modify standard continuum elements to improve accuracy in which the internal degrees 
of freedom are eliminated at the element level before assembly of the stiffness matrix for the structure.  

enthalpy 

A physical property of a material which governs how much heat is liberated or absorbed during a phase 

change.  

envelope 

Defines the maximum and minimum variation of results across specified load cases, combinations or other 

envelopes.  

environmental node 

A means of distributing heat which is transferred to the medium separating a number of thermal surfaces.  

environmental temperature 

A load type which describes the temperature of the medium surrounding a body.  

equilibrium 

A state where applied external loads on a model are balanced by the generated internal forces.  

equivalencing 

Nodes existing at a similar point in space may be replaced by a single node.  

equivalent stress 

See  von Mises stress.  

error message 

A visual indication of hardware or software malfunction or of an illegal data entry attempt or command 

sequence.  
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Eulerian geometric nonlinearity 

A strain formulation which has its reference as the current configuration.  See also  updated Lagrangian, 

total Lagrangian.  

excitation 

The forcing of a structure by an external influence. Excitation is often associated with dynamic loading.  

execute 

To carry out an instruction or perform a task.  

explicit dynamics 

High velocity dynamics, where the rate of loading is high compared to the natural frequencies of the structure 
being analysed. Explicit problems are classed as wave propagation problems where the behaviour of the 

wave front, dominated by high frequency components, is of engineering importance.  See also  impact, 

implicit dynamics.  

explicitly integrated beam 

A beam element based on engineers‟ theory of simple bending.  Also known as engineering beam.  

exploded view 

Mesh plots may be viewed with the element vertices moved towards the centroid of the element by a given 
amount (exaggeration factor).  

extension 

A three character set that follows a filename. The extension clarifies the filename to the application. It is 

separated from the filename by a full stop.  

extrapolation 

A process whereby values outside the limits of a field are extrapolated from values within the field. See also  

isoparametric mapping.  

face load 

A load type that converts a pressure over an element face in 2D or 3D into equivalent nodal loads. See also  

uniformly distributed load.  

fatigue 

When a material is subjected to repeated tensile stresses within the elastic range, the material tires and 
fractures after a large but finite number of repetitions of stress. This is termed fatigue. See also  damage, 

log life.  

feature 

Defines the spatial geometry of the structure. Uses an associative hierarchy.  See also  associativity.  
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feature loads 

Loads that are applied to a pre-processing feature. They can be varied using variation functions.  

fibre location(s) 

The position(s) defined on a beam cross-section that can be used to calculate beam stress results for plotting 
force and moment diagrams. 

field analysis 

Corresponds to the solution of the general „quasi-harmonic‟ equation. A wide variety of problem types are 

possible, including thermal, seepage, incompressible flow and elastic torsion.  

field elements 

Finite elements used in a field analysis.  See also  field analysis.  

file privilege 

The settings that can be given to a file or directory to control who on a system has access to read from, write 
to or execute the file.  

file protection 

The devices or procedures that prevent unintentional access or erasure of computer files or directories.  

file selector 

External files are chosen using a file selector box which is machine-dependent. Generally, the filename can 

be entered in an edit box or chosen with the cursor from a presented list. See also  dialog box.  

fine integration 

A method of element integration using an alternate selection of a larger number of Gauss points. Can 
sometimes have the effect of stiffening the mesh. See also  coarse integration.  

finite element 

A sub-region of the overall model for which the behaviour can be represented mathematically.  

first moment of area 

A standard section property used to determine the position of the centroid. The first moment of area about the 

x axis is defined as the integral of x with respect to the area of the section. First moments of area are zero for 

symmetrical sections.  See also  second moment of area, product moment of area.  

fixed disk 

See  hard disk.  

fleshing 

The display of a bar or beam element in its true cross-sectional form. 
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floppy disk 

A disk that can be inserted in and removed from a floppy disk drive.  Also known as diskette.  See also 

hard disk, disk drive.  

flow rule 

The process by which the direction of plastic straining is calculated. See also  associative plasticity, non-

associative plasticity.  

flux 

The rate of flow of heat, usually expressed per unit area.  

foam model 

Also known as crushable foam See  volumetric crushing model.  

force diagram 

The graphical display of axial or shear forces on the graphics screen.  See also  axial force, shear force, 

bending moment diagram.  

follower force 

See  non-conservative loading.  

forced response 

See  harmonic response.  

forward Euler 

An explicit plasticity formulation whereby the direction of plastic straining is computed as the yield surface 

is intersected. See also  backward Euler.  

Fourier Transform 

A method for finding the frequency content of a time varying signal.  

Fourier analysis 

Analysis of an axisymmetric structure with non-axisymmetric loading. Achieved by representing the 

circumferential variations of applied loads and structural displacements as the sum of harmonics of a Fourier 
series.  

fracture 

Any form of failure in which stress release occurs. See also  ductile fracture.  

frame diagram 

This is a graphical representation of the forces and moments in bar and beam structures.  
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frequency domain 

When the forcing function and response of a structure are defined in terms of their frequency content. The 

inverse Fourier transform of the frequency domain gives the corresponding quantity in the time domain. See 
also  time domain.  

freedom 

See degrees of freedom.  

FRF 

Denotes a frequency response function. This expresses the transfer function used in modal dynamics 

calculations to transfer from the global to the modal domain and allows frequency and time-domain response 

calculations to be carried out from the results of an eigenvalue analysis.  

friction angle 

Material property of granular properties, such as cohesive soils and rocks.  

frontal method 

A method of solving simultaneous equations based on Gaussian elimination.  

frontal optimiser 

The part of the code that controls optimisation. The order in which the elements are presented for solution 
makes a significant difference in the time taken and the space required for the solution. The frontal optimiser 

attempts to order the elements in an optimum manner. See also  optimisation.  

frontwidth 

The maximum number of unknowns at one time in the solution front is known as the frontwidth of the 

problem. See also  optimisation.  

fully coupled 

A coupled analysis in which the structural and thermal files are run at the same time and communicate with 
each other via a data transfer file. See also  coupled analysis, semi-coupled.  

fundamental mode 

The lowest dynamic natural frequency or buckling load factor of a structure. It is often associated with the 

simplest mode shape.  

gap 

A specified distance through which a structure must move before additional external forces come into play. 
Modelled in LUSAS using joint elements.  

Gauss point 

Position where numerical integration takes place within an element, hence giving the greatest accuracy of 

results.  

For more information see Gauss Point Quadrature Rules in the appendix of LUSAS Theory Manual 2 
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Gauss point results 

Results at the element Gauss point position. See also  Gauss point, averaged nodal results, unaveraged 

nodal results.  

general loads 

See  discrete point and patch loads.  

generalised freedoms 

Degrees of freedom specified in a modal dynamic analysis which are used in the reduction of the global 

system of equations. The accuracy of this method is determined by the selection of appropriate freedoms.  

generalised stress 

See  von Mises stress.  

geometric nonlinearity 

Arises from significant changes in the structural geometry during loading, for example snap-through of a 

hemispherical cap.  

geometric properties 

Define the geometrical information about the feature to which they are assigned which has not been 

specified, for example the thickness of a shell.  

global 

A term indicating that an entity is expressed relative to the global Cartesian axis set. See also  local.  

gradient 

See  temperature gradient.  

granular 

A characteristic of compound materials such as soils and rocks.  

graph dataset 

A dataset describing the x axis and y axis data required to construct and display a graph.  

graphics area 

See  graphics screen.  

graphics screen 

The LUSAS main window consists of the areas used to control the software and a central graphics area which 

displays graphical information.  
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group 

A collection of features given a reference name and used for manipulation of the model.  

Guyan reduction 

A finite element approximation to low frequency natural vibrations may be obtained by considering only 
those freedoms (known as master freedoms) whose contribution is of most significance to the oscillatory 

structural behaviour. The effective selection of master freedoms is central to the accuracy of the simulated 
structural response.  

grillage 

A finite element mesh made up of interlocking gril elements. See also  beam element.  

HA/HB loading 

See  discrete point and patch loads.  

hard copy 

A printed copy of computer output in a readable form, such as tabulated results, contour or graph plots.  

hard disk 

A data storage device usually fixed to a computer to act as the main data storage area. Data is read from and 
written to the disk using a disk drive. See also  disk drive, floppy disk.  

hollow volume 

A number of surfaces which are not perfectly merged together but are considered by Modeller to form a 

volume. 

hardening 

The post yield behaviour of a material.  

harmonic response 

The steady state response of a structure subject to one or more periodic or vibrating loads of constant 

frequency. Also known as forced response. See also  interactive modal dynamics.  

heat fraction coefficient 

The fraction of plastic work which is available to be converted into heat energy. This is used in temperature 

dependent and coupled analyses.  

help 

Available on-line by choosing Help topics from the Help menu or clicking on the Help push button on any 

dialog box. See also  context-sensitive help, dialog box.  
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highway loads 

A subset of discrete point and patch loads, usually in 2D, used to apply loads to bridges or similar structures.  
See discrete point and patch loads.  

Hilber dynamics 

This is an accurate and efficient direct integration scheme which uses equations based on assumptions made 
by Hilber, Hughes & Taylor. See also  direct integration.  

Hill criterion 

A yield criterion which caters for anisotropic plasticity. See also  Hoffman criterion.  

Hoffman criterion 

A yield criterion catering for pressure dependent anisotropic plasticity. See also  Hill criterion.  

hour-glassing 

An zero energy mode of deformation induced in an under-integrated element.  See also  mechanism.  

IGES 

International graphical exchange system.  See also  DXF, interface files.  

IMD 

See  interactive modal dynamics.  

ill-conditioning 

The state of the problem equations when they are numerically unstable. Can be caused by vastly different 

stiffnesses, or a badly supported structure.  

impact 

An analysis where one body hits another.  See also  contact, explicit dynamics.  

implicit dynamics 

Used for inertial problems where the response is dominated by low frequency components.  See also  

explicit dynamics.  

incompatible elements 

Elements using incompatible shape functions to achieve an enhanced stress resolution performance. See 
also  shape functions.  

increment 

A step in a nonlinear analysis where a portion of the total load is applied. Results can be obtained at each 

converged increment level.  



Modeller Reference Manual   

    

444 

incremental loading 

Application of a loading scheme in steps (or increments). Used in a nonlinear analysis when full load will not 

converge.  

initial stiffness method 

A modified Newton Raphson nonlinear solution method whereby the initial stiffness matrix is used 

exclusively throughout the analysis.  

inertia 

A measure of the forces that would be generated in a structure under dynamic excitation as a result of the 
mass of the structure.  

initial stress/strain 

Application of initial stress/strain without balancing forces will result in deformation. This is used as a load 
type in LUSAS.  

input/output (I/O) 

A general term for devices that communicate with a computer or for communication via those devices.  

integer 

A complete natural number having no fractional part. For example 32 is an integer while 32.1 is not.  

integration point 

See  Gauss point.  

interactive modal dynamics 

The use of results from an eigenvalue analysis to interactively calculate the frequency/time response of a 

structure. Also known as IMD.  

interface files 

Used to transfer CAD data into and out of LUSAS Graphics. See also  DXF, IGES.  

interface stiffness parameter 

A property of a slideline surface which controls the penetration of contacted surfaces.  

irregular mesh 

A mesh applied to a surface that has more than 4 sides.  

irregular surface 

A surface defined by more than 4 lines which may only be meshed using irregular meshing. 
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isobeam membrane 

A 2D membrane element which bends in-plane as a beam.  

isoflex plate 

A 2D thin plate which ignores through thickness shears. See also  Mindlin plate.  

isoparametric elements 

Finite elements formulated using an isoparametric mapping technique. See also  isoparametric mapping, 

mapping.  

isoparametric mapping 

Describes the geometry in exactly the same way as the displacement field, using the same shape functions. 

See also  shape functions, mapping.  

isotropic 

A term indicating that the material properties are the same in all directions. See also  orthotropic, 

anisotropic.  

iteration 

A step within a load increment where the analysis solver attempts to converge to an acceptable solution. See 
also  increment.  

joint element 

An element with translational (and rotational) stiffness, which may have initial gaps, contact properties and 
other nonlinear behaviour. Also known as a spring element.  

Kbyte (K) 

Signifies a quantity memory equal to 2 raised to the power 10 bytes, which is equal to 1024.  

kinematic 

Plasticity hardening formulation associated with translation, as opposed to expansion, of the yield surface.  

Kirchhoff beam 

Thin beam which ignores shear deformation.  See also engineering beam, numerically integrated beam.  

knife edge loads 

A special case of discrete patch load with two or three defining points to model a straight or curved knife 

edge load. See also  discrete point and patch loads.  

label 

A label can be drawn on the screen to show feature dataset numbers or the dataset numbers of attributes 

assigned to them. See also  feature, attribute, assign.  
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laminate 

An individual layer of a composite material. See also  layer, composite properties.  

large rotation 

A geometrically nonlinear analysis for beam, plate or shell elements where the rotational degrees of freedom 
undergo large incremental or total change.  

large displacement 

Common term for geometrically nonlinear analysis where the stiffness of the structure is not constant but 

becomes a function of displacement.  

latent heat 

The additional heat gain or release required to obtain a material thermal phase change. Phase change 

modelling requires a nonlinear thermal analysis.  

layer 

Certain finite elements, such as shells, are based on a layered formulation.  See also  composite properties.  

lift-off 

A change in a support condition that allows movement away from a support in a certain direction. Used 
where a structure rests on a foundation but there is no restraint to stop the structure from moving upwards if 

loading conditions dictate.  

limit point 

A local maximum point on the load displacement curve. See also  bifurcation point.  

line 

Feature defining a structural edge, passing through any number of points.  

line search 

A technique used to improve the convergence rate of Newton iteration by minimising potential energy.  See 
also constant load level, arc-length method.  

line section 

See  section line.  

linear analysis 

An analysis where the relationship between stress and strain is a straight line.  

linear buckling 

See  eigenvalue buckling.  



  Index 

    

447 

link element 

A thermal line element, similar to structural joint, which transmits temperature along its length by 

conduction, convection, and/or radiation.  

load combination 

The results from several load cases may be combined and viewed as an additional load case. This additional 

load case is called a combination. Combining loads is only valid for a linear elastic analysis.  

load curve 

A graphical representation of the variation of a load during an analysis. Can be expressed as a load factor in 
terms of increment or analysis time.  

loading dataset 

The loading applied to a structure is defined in a loading dataset then assigned to the required feature.  

local 

A term indicating that an entity is expressed relative to local element axes. See also  global.  

local axes 

The axis set used to define an element sign convention.  

local coordinate system 

May be used to specify the coordinates of a feature or a node in terms of a local Cartesian, cylindrical or 

spherical axis set.  See also  transformed freedom.  

local node/segment 

The node/element edge on a slideline surface which is geometrically closest to the node currently being 
considered in the slideline calculations.  

log life 

Log plot of cycles to failure over a structure. See also  fatigue, damage.  

lumped mass 

A diagonalised form of the mass matrix where the mass is lumped at the nodal positions.  See also  

consistent mass.  

mapping 

The numerical process by which quantities, for example shape, results or stiffness, are transferred from one 

position to another. Often associated with isoparametric elements. See also  isoparametric elements.  

mass matrix 

A matrix containing the mass terms in a finite element analysis.  See also  consistent mass, lumped mass.  



Modeller Reference Manual   

    

448 

mass normalisation 

Normalisation of eigenvectors with respect to mass. Must be carried out when eigenvalue results will be used 

to calculate harmonic or spectral response.  See also  normalisation, harmonic response, spectral 

response.  

master freedom 

Freedoms at which the mass contribution of the inertia effect is considered to be significant. See also  slave 

freedom, Guyan reduction.  

master index table 

The master index table is an area of memory that stores an overhead associated with every load case, 
increment, or time-step dump to a plot or restart file.  

master/slave 

Terms used to signify paired sets of attributes where the action of one item is subservient to the action of the 

other. This term is used in the assignment of slides, joint interface meshes and constraint equations.  

material properties 

Describe the stress-strain relationship and/or thermal properties of an element.  

matrix properties 

A material model used only for joint elements that allows direct definition of linear properties of stiffness, 
mass or damping.  

mechanism 

A deformation mode which has no associated energy (and is not a rigid body deformation) and is, therefore, 

unrestrained. Usually obvious in elastic problems but can have more subtle manifestations when using 
material or geometric nonlinearity.  

memory-resident program 

A program that is loaded into memory and is available even when another application is active.  Also known 
as a TSR.  

menu bar 

The area at the top of the main LUSAS window where pull-down menus are accessed.  

merging 

Similar features may be „merged‟ to give common definitions. Whether a feature is successfully merged with 

another will depend on the closeness of both members and the attributes assigned to them.  

mesh 

The discretisation of a body into small finite elements, whose individual behaviour can be predicted.  
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mesh dataset 

A dataset containing details of element discretisation.  

mesh density 

A term used to describe the relative numbers of elements in a finite element mesh. A dense mesh has more 
elements than a less dense or coarse mesh. Also known as mesh refinement.  

mesh lock 

The act of preventing a mesh from being updated until it is unlocked. Locking a mesh stops commands such 

as visualisation of loads and supports from forcing a re-mesh.  

mesh objects 

Nodes, edges and faces of an element (which itself is a mesh object too). 

mesh only modelling 

Models comprised of nodes and elements only with no geometric feature types such as points, lines, surfaces 

or volumes. 

message window 

Messages are displayed in a scrolling message window.  

mirror 

A form of transformation in which the model can be duplicated across a mirror plane.  

Mindlin plate 

These are thick plates which include shear deformation effects.  See also  isoflex plate.  

modal damping 

Damping associated with the displacements defined by the eigenvectors. Its value has no physical 
significance since the eigenvector contains an arbitrary normalising factor.  

modal domain 

The solution of a dynamics problem by utilising the system eigenvectors.  

modal synthesis 

A sub-structuring or superelement technique involving multiple Guyan reductions for very large natural 

frequency analyses.  

mode shape 

The displaced shape of a structure due to its natural frequency.  See also  eigenvector, eigen mode, 

eigenvalue analysis.  
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model file 

The LUSAS database is stored in a binary file called a model file.  

modified Newton-Raphson 

Modifications to the standard Newton-Raphson nonlinear solution method whereby the stiffness matrix is 
updated less frequently (common forms are referred to as KT1, KT2, Ko). More iterations are generally 

required, but the method can be computationally economical. See also  Newton-Raphson.  

modem 

An acronym for modulator demodulator. A modem converts data from a computer to analogue signals that 

can be transmitted down a telephone line. It also converts signals from a telephone line into a form the 
computer can use.  

modulus matrix 

A matrix of material constants that relates stress to strain. See also  rigidity matrix.  

move 

To alter the position of a feature using a transformation dataset.  See also  copy, transformation dataset.  

MS-DOS 

Acronym for Microsoft Disk Operating System.  

multi-point constraint 

See  constraint equation.  

natural frequency analysis 

See  eigenvalue analysis.  

negative pivot 

A well-conditioned matrix could produce a negative pivot if the system is unstable, i.e. passing through a 

bifurcation or limit point, or if the system is not adequately restrained, i.e. a 3D beam in a 2D analysis.  See 
also  pivot, small pivot.  

Newton-Cotes 

A form of numerical integration or quadrature. It is often used for through-thickness integrals since sampling 

points are located at the extremes of the range.  

Newton-Raphson 

A nonlinear solution method in which a solution is obtained using an iterative approach based on successive 

recalculation of the stiffness matrix. See also  modified Newton-Raphson.  

nodal equivalencing 

See  equivalencing.  
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nodal results 

Results at node positions. Displacements are calculated at nodes, whereas stress results are calculated at 

Gauss points and extrapolated to the nodal positions.  See also  averaged nodal results, unaveraged nodal 

results, Gauss point.  

node 

Finite Elements have their vertices defined by nodes. The nodes have degrees of freedom which are the 

unknowns at the solution stage.  

non-associative plasticity 

A plasticity formulation for granular materials in which the direction of plastic straining is not normal to the 

yield surface. See also  associative plasticity, plasticity.  

non-conservative loading 

When an applied force changes direction during an analysis to match the deformed shape of the model.  Also 
known as follower force.  

non-orthogonal cracking 

Formation of a second (subsequent) crack which is not normal to the first crack direction. That is a cracking 

formulation which allows re-computation of the principal stress directions following an initial cracked 

direction formation. See also  cracking, concrete model, ductile fracture, orthogonal cracking.  

non-planar 

Not lying in a flat plane.  See  planar.  

nonlinear 

A term encompassing all effects that do not have a basis in linear stress analysis. For example, geometric and 
material nonlinear effects and nonlinear boundary conditions.  

nonlinear elasticity 

A material which follows a nonlinear (i.e. not straight) path on loading but exhibits complete recovery on 

unloading.  

norm 

A measure used in convergence. See  convergence.  

normalisation 

A process where the maximum displacement of an eigenvalue analysis is expressed relative to unity or to the 

total mass of the problem.  

null 

A line mesh containing no elements which is used purely to define mesh spacing is termed a null mesh. A 

null slideline type allows definition of a slideline in a problem which introduces no contact effects. Slideline 
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types can be changed during an analysis, so contact can be introduced at a specified point by changing the 
slide type.  

numerically integrated beam 

A beam finite element based on numerical integration rather than engineers‟ simple bending theory.  See 
also  explicitly integrated beam, beam element.  

object  

A LUSAS object is a data entity, which is anything listed in the Treeview, or a geometric feature such as a 

Point or Line. LUSAS objects can be either edited or have their properties displayed via the shortcut menu 
(right mouse button). See also  OLE object.  

OK button 

Will apply the dialog box with the given parameters. See also  apply button, dialog box.  

on-line help 

See  help.  

OLE object  

A Windows application file that can be linked or embedded into a LUSAS model file. OLE is an acronym for 

Object Linking and Embedding.  

optimisation 

The process of reducing the frontwidth of a model to the minimum to increase speed of solution and reduce 
storage requirements. See also  frontal optimiser.  

options 

LUSAS options control certain aspects of the analysis. They are set in the data file.  See also  data file.  

options box 

Some LUSAS parameters have only a limited number of possible responses. These are gathered into lists and 

presented as options boxes.  

ordinate 

The y axis of a graph.  See also  graph dataset, abscissa.  

orthogonal cracking 

Spontaneous or subsequent double cracking whereby both principal stresses violate the cracking criteria and 
two orthogonal cracking planes develop. See also  concrete model, ductile fracture, non-orthogonal 

cracking, cracking.  

orthotropic 

An orthotropic material assumes that the material constants in the two or three principal directions may 
differ.  See also anisotropic.  
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oscillation 

Repeated numerical variation often associated with out of balance forces (residuals) in a nonlinear analysis.  

output file 

ASCII text file containing the results of a LUSAS analysis run. It contains warning or error messages from 
the analysis. It can optionally contain stress, strain, displacement and reaction results.  

over damped system 

A system which has an equation of motion where the damping exceeds the critical value. It has an 

exponentially decaying, non-oscillating impulse response.  

page format 

The layout of a page in a print file may be controlled so as to include headers, footers and titles.  

parameter 

A variable that is given a value for use by a program or command. Could also be known as a definable 

characteristic.  

parasitic shear 

See  shear locking.  

parametric language 

Facility for using variables and a control structure as tools during program operation.  

patch load 

See  discrete point and patch loads.  

patch test 

A test in which a convenient shape, for example a rectangle, has its interior divided into a non-symmetrical 

pattern of the element to be tested. The patch test then assumes a uniform strain over the rectangle, and 

applying the relevant boundary displacements checks that the finite element solution delivers a constant 
stress everywhere.  

peak value plot 

A post-processing plot that shows the largest maximum or minimum (or both) values of a results entity on the 

screen. The peak values can be shown as a symbol or as a value.  

penalty function method 

A method of monitoring the interaction of two contact surfaces which, upon contact, imposes interaction 
forces to oppose penetration.  
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penetration 

A term used in a contact analysis to define the relative overlap of meshes on separate contact surfaces. Also 
known as interpenetration.  

perfectly plastic 

A material that will not sustain additional load after yielding. The stress strain curve is effectively flat above 
the yield stress.  

peripheral 

An external input/output, printing or storage device.  

perspective view 

Takes into account the distance from the viewpoint to the object when displaying the plot.  

phase angle 

The ratio of the in phase component of a signal to its out of phase component gives the tangent of the phase 

angle of the signal.  

phase change 

The transformation of a material between phase, usually being accompanied by a liberation or absorption of 
heat.  

picking 

See  cursor selection.  

picture files 

Used to store LUSAS pictures in a neutral plotting format.  

pivot 

A pivotal term in a matrix that is being solved using Gaussian elimination.  See also  small pivot, negative 

pivot, diagonal decay.  

planar 

Lying in a flat plane.  See  non-planar.  

plastic hinge 

The formation of a position in a structure where the applied moment has exceeded the plastic moment 

capacity resulting in a loss of rotational stiffness or hinge.  

plasticity 

A nonlinear material description associated with yielding of material (e.g. metals, plastics, soils).  
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plot 

See  contour plot.  

plot file 

The binary results file written by the LUSAS solver which is used to pass results information to the post-
processor.  

plot scale 

The ratio of screen coordinates to model coordinates is known as the plot scale.  

point 

Defines the coordinates of the vertices of the structure.  

point load 

See  discrete point and patch loads.  

poisson's ratio 

A material property value indicating the amount of a longitudinal strain that is translated into a contraction 

due to lateral strain in a Hookean material.  

polar decomposition 

Method of decomposing a deformation gradient into a stretch and rotation tensor. See also  deformation 

gradient.  

polar second moment of area 

For a plane area in the XY-plane, the polar second moment of area is defined as the integral of X squared 

plus Y squared over the area of the section. The polar second moment of area thus equates to the second 
moment of area about the x axis plus the second moment of area about the y axis. For circular sections the 

second polar moment of area is equal to twice the second moment of area about the x or y axis. Also known 
as torsional moment of inertia.  

post-processing 

The process of viewing the analysis results.  

post-solution 

Any part of the finite element solution process following the computation of the displacements, for example 
strain, stress, moment recovery and output phases.  

power law 

A creep formulation using three material parameters which include primary, secondary and tertiary regions of 

creep behaviour. See also  strain hardening.  
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pre-conditioned conjugate gradient solver 

Iterative solution using a conjugate gradient solver is very sensitive to the matrix conditioning. For this 

reason the matrix is usually pre-conditioned before solution.  

pre-processing 

The process of building the model ready for analysis.  

pre-solution 

Any part of the finite element solution before the solution of the displacements. It is usually associated with 

the formation of elemental stiffness matrices and load vectors.  

prescribed variable 

The specification of the value of a nodal displacement or of a differential of nodal displacement with respect 

to time. Chiefly used to prescribe displacement values.  

pressure-dependent yield 

Plastic deformation where the amount of plasticity is dependent on the sign of stress (tension/compression). 
For example, Hoffman, modified von Mises material models.  

pressure loading 

Loading expressed in per unit area or unit length terms.  

primary creep 

The initial nonlinear part of the creep curve.  

principal stress vectors 

Vector plot showing maximum and minimum principal stress directions and relative magnitudes. In LUSAS 

the vectors are colour coded to indicate sign.  See also  vector plotting, displacement vectors.  

print file 

A text file to which information can be printed from LUSAS.  

product moment of area 

See also  first moment of area, second moment of area.  

program 

A series of instructions in a form acceptable to a computer. Also known as application.  

pseudo-nodes 

Dummy nodes created at element edges when a slice is cut in LUSAS. Results calculated at these pseudo-
nodes are used to contour the slice.  
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pseudo-time 

A numerical time quantity used in a creep analysis.  

pull-down menus 

Cascading menus may be „pulled down‟ from the main menu bar to pass instructions to LUSAS.  

quadrature  

Numerical (usually approximate) evaluation of an integral, for example Gauss, Newton-Cotes.  

quarternion 

A quantity consisting of a scalar and vector component which defines a rotation in 3D space. A normalised 

quarternion is sometimes referred to as an Euler parameter. 

quasi-harmonic 

A name for the governing field equations used in thermal or seepage analyses.  

radiation 

The energy emitted by bodies as a consequence of their temperature.  See also  convection, conduction.  

radio button 

When several parameters are mutually exclusive, they may be presented in a dialog box as a series of radio 

buttons. They are signified by diamonds or circles, and when one is clicked all others in that group will be 
released. See also  dialog box.  

rate dependent 

Time dependent material properties.  

Rayleigh damping 

A form of damping which is constructed from user specified proportions of the stiffness and mass matrix 

terms.  See also structural damping, viscous damping.  

reaction 

A force or moment calculated at a support position to counteract any applied loading.  

real number 

An ordinary number, either rational or irrational.  

reference path 

A route (or path) through the model that provides a concept of distance from an origin to each point in the 

model. 
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regular mesh 

A mesh lying on a regular surface consisting of the same numbers of divisions on opposing lines.  

regular surface 

A surface defined by 3 or 4 lines, hence may be meshed using any meshing technique.  See also  ruled 

surface.  

release 

The act of freeing a beam end rotation. Also known as moment end release.  

renumber 

To change the numbers of features. Usually used to rationalise feature numbers into consecutive ascending 

order.  

residual force 

A measure of the unbalanced force present in the structure after solution.  

residual norm 

A LUSAS convergence parameter which expresses the limit of the sum of the squares of all residual forces as 

a percentage of the sum of the squares of all external forces. See also  convergence, displacement norm, 

work norm.  

residual stress 

Stresses that are locked into the structure in its initial configuration.  

resonance 

The amplification of displacements occurring when the frequency of applied loading and natural vibrations 

coincide or are similar.  

restart file 

A file containing the relevant parts of a LUSAS analysis database that will allow an analysis to be restarted 

from a previously converged situation.  

restaint 

See Supports. 

resultant 

See  stress resultant.  

results calculator 

See  calculator.  



  Index 

    

459 

results dataset 

See  graph dataset.  

results file 

See  plot file.  

retained freedom 

A term used to describe master and slave freedoms used in a Guyan reduced eigenvalue extraction.  

reverse 

To reverse the orientation of a line, surface or volume feature.  See also  cycle.  

ribbed plate 

A 2D high performance incompatible membrane element. Takes into account both membrane and flexural 

deformations. Transverse shearing effects are ignored. Designed to be used in conjunction with ribbed plate 

beam elements.  

rigidity matrix 

A matrix of material constants that relate stress resultants to strain. See also  modulus matrix.  

round-off 

See  diagonal decay.  

RU/RL loading 

Light/standard rail loading similar to HA/HB.  

rubber 

A hyper-elastic nonlinear material description with (approximately) constant volume characteristics.  

ruled surface 

A surface which has at least two opposite lines that are straight. The special case of spherical surfaces are 

also considered to be ruled surfaces. Some surface operations will only work with ruled surfaces. For 
example, splitting, intersecting, filleting.  See also  analytical surface, regular surface, irregular surface.  

s-n curve 

A curve used to express damage done to a structure for a given number of loading cycles. Standard curves are 

available in BS5400. See also  fatigue, damage.  

sampling point 

Sampling points are the locations along a tendon profile at which calculated equivalent tendon loads will be 

applied to the model. 

See also  Gauss point.  
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screen annotation 

See  annotation.  

screen coordinates 

The coordinate system used to position annotations on the graphics area.  

script file 

A name given to a collection of UNIX commands used to set up an environment and to run a program.  See 
also  batch file, parametric language, command file.  

search area 

The area over which a general point or patch load is applied may be limited using a search area.  

secondary creep 

Commonly used linear region of the creep curve.  

second moment of area 

The second moment of area of a plane area with respect to the x axis is defined by the integral of x squared 

over the area. Also known as moment of inertia of area.  See also first moment of area, polar second 

moment of area, product moment of area.  

section line 

A section along a line, from which results can be taken and placed in graph datasets.  See  also  graph 

dataset, section slice.  

section slice 

A 2D slice through a 3D model on which contours can be displayed. The slice can be further interrogated 

using a section line to obtain a graph dataset.  See also  section line, graph dataset.  

segment 

A section of a contact surface. On a slideline a segment is an element edge, and on a slide surface a segment 

is an element face. In addition, an individual screen of graphics information processed during a LUSAS 
animation is termed a segment.  

seismic analysis 

An analysis of the effect of an earthquake on a structure. See  also  spectral response.  

semi-coupled 

A coupled analysis in which the structural and thermal analyses are run separately and one before the other. 

See also coupled analysis, fully coupled.  
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semi-loof beam 

A curved line element based on the semi-loof formulation.  See also  semi-loof shell.  

semi-loof shell 

A 3D plane stress thin shell element based on the semi-loof formulation where the element hinge (or loof) 

rotations are lumped together at the edge mid-side nodes.  

session file 

All commands issued during a LUSAS session will be recorded in a session file. This may be replayed to 
recover any work lost after a system crash.  

shear area 

The cross-sectional area of a structure that can be said to react transverse shear loading.  

shape functions 

Mathematical mapping functions used to define the variation of displacement or other variables within an 

element.  See also isoparametric mapping.  

shear force 

Transverse force.  See also  axial force, stress resultant.  

shear lag 

A delay or slow response in developing shear flow reactions to applied loads.  

shear locking 

Causes over stiff performance in bending and occurs as a result of the bending deformation mode requiring 

strain energy storage by shear strain as well as by normal strain.  Also known as parasitic shear.  

shear retention factor 

The factor by which the in-plane shear modulus is reduced following formation of a crack plane in the biaxial 

concrete model. See also  concrete model, ductile fracture.  

shell elements 

A form of plate element that considers both membrane and bending behaviour.  

shifting 

A procedure used in eigenvalue extraction where the stiffness matrix is shifted to overcome numerical 

problems when rigid body modes are present.  

SI units 

Units of the Système Internationale d‟Unités. The most relevant to finite element analysis are as follows. 
Length: metre (m); mass: kilogramme (kg); time: second (s); temperature: Kelvin (K); force: Newton (N); 

frequency: Hertz (Hz).  
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singular 

See  singularity.  

skew angle 

A measure indicating a departure from orthogonality for a bridge deck. Also used to specify the angle 
between reinforcement directions for Wood-Armer calculations.  

singularity 

A theoretical infinite stress, or a condition found during solution which indicates that insufficient information 

has been provided to solve the stiffness matrix. Often occurs due to insufficient specification of boundary 

conditions.  

slave freedom 

Freedoms in a model where the mass contribution of the inertia effect can be considered to be relatively 

insignificant. See also  master freedom, Guyan reduction, retained freedom.  

slide surface 

A 3D contact surface made up of surface boundaries. See also  slideline.  

slideline 

A 2D contact surface made up of line boundaries. See also  slide surface.  

slides 

Contact and impact problems may be analysed with the use of slide lines or slide surfaces on the contacting 

features. The LUSAS contact facility uses the penalty function approach.  See also slideline, slide surface, 

penalty function.  

smoothing 

The process of creating a smoother transition between stresses in adjacent elements by using a calculated 

nodal average value at common nodes. See also  averaged nodal results, unaveraged nodal results.  

small pivot 

Indicates a poorly conditioned stiffness matrix. See also  diagonal decay, negative pivot.  

snap through 

Large deflection nonlinear effect whereby a structure converts membrane to bending energy and adopts a 

stable but usually inverted configuration.  

solidification 

See  phase change.  
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spawn 

The action of creating a sub-process to carry out a specified task. LUSAS Graphics can spawn a process to 

run LUSAS Solver on UNIX machines.  

spacing ratios 

Used by line mesh datasets to express the variation in segment length when meshing a line.  

specific heat 

A thermal material property associated with the resistance to temperature change. It is the equivalent of 

inertia in a structural analysis.  

spectral curve 

Input curve for a response spectrum.  

spectral response 

An analysis in which a response spectra for a generic earthquake ground motion is used to estimate the 

maximum displacement or pseudo-velocity or acceleration during the earthquake, without the need for direct 

integration of the model over the complete duration of the event.  

spherical path 

See  arc-length method.  

spline 

A type of line defined between points, using a mathematical expression.  

spring element 

See  joint element.  

SRSS method 

A method used in spectral response analysis, where design displacements, stresses and forces are evaluated 

as the square root of the sum of the squares.  See also  CQC method.  

start-up file 

A file used to convey system set-up information to an application on start-up or at pre-defined points during 

its execution. The LUSAS start-up file can contain system parameters and valid LUSAS commands. These 

files are run when the program is initiated and when a new model is loaded or initialised.  

starting iteration vectors 

The number of terms used as initial guesses in an eigenvalue extraction. See also  Iteration.  

static 

An analysis which assumes that the response to the load is immediate because inertial effects are ignored.  
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steady state response 

The response of a system when all of the transient components have become insignificant.  See also  

transient response.  

steepest descent method 

Implicit plasticity algorithm by which inadmissible elastic trial stresses are returned to the yield surface.  

step-by-step dynamics 

See  direct integration, dynamic analysis.  

stiffness matrix 

The matrix containing terms that relate the displacement of a structure to the applied forces. See also  b 

~matrix, d ~matrix.  

strain energy 

The work done by an external force in displacing a structure is stored as strain energy. It may be released on 
unloading for elastic analyses or cause permanent deformation in elastic-plastic analyses.  

strain hardening 

The ability of a material to continue to accept stress following NL yielding, usually at a reduced rate.  

strain softening 

Post-yielding or cracking behaviour whereby continued loading results in a release of accumulated stress and 

a negative stress-strain slope. It is often called tension-stiffening with reference to the biaxial concrete model.  

stress recovery 

The process of calculating the stress results from the deformed shape and stiffness matrix.  

stress vectors 

See  principal stress vectors.  

stress resultant 

Generally useful in civil design and defined as stress per unit length (or width). Conversion to a stress is 
achieved by dividing by the thickness.  

string 

A character-based variable.  

structural damping 

Specifies the damping of each system mode of vibration via the hysteretic damping factor. See also  viscous 

damping, Rayleigh damping.  
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Sturm sequence check 

A stable procedure which indicates the number of eigenvalues below a given eigenvalue and is utilised to test 

for missing values. See also  eigenvalue.  

sub-session file 

Commands written to the LUSAS session file may also be selectively logged to a duplicate file. This is useful 

for creating a short command file of one or two commands during a LUSAS session. See also  command 

file.  

subspace iteration 

Evaluation of the lowest eigenvalues and corresponding eigenvectors is achieved by performing a 
simultaneous inverse iteration using a set of iteration vectors followed by a projection of the problem 

matrices onto the subspace formed by these vectors. See also  Iteration.  

substructure 

See  superelements.  

superelements 

Permit the finite element model to be divided into smaller, more manageable components which are then 

added together to form the complete structure. Individual components are known as superelements or 
substructures.  

superposition 

For a linear problem the solution is the same if it is found by adding together two or more individual loads or 

forcing functions and then solving or by solving for the separate loads or forcing functions and then 
combining the results or responses. The second method is called superposition. See also  load combination.  

support surface 

Four-sided surface used to define the internal geometry of an irregular non-planar surface.  

supports 

Describe how the model is restrained at its boundaries, or may be used to infer symmetry conditions on a 

model.  

surface 

Feature defining the faces of the structure. Defined as being bounded by lines.  See also  regular surface, 

irregular surface, ruled surface.  

system parameters 

The LUSAS Graphics and LUSAS Solver databases may be tuned on initialisation using system parameters 

in the start-up file.  

tabulation 

The process of creating an analysis data file from the pre-processing model file.  
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tangent stiffness 

The formation of the stiffness matrix at a given equilibrium position.  

temperature gradient 

The variation of temperature through the thickness of an element. This distribution induces bending.  

termination 

Completion point of an analysis. Termination is controlled using the termination line in a nonlinear or 

dynamic control.  

text output window 

A separate window is created to display information in a text format requested by the user.  See also  
message window, graphics screen.  

thermal analysis 

See  field analysis.  

thermal gap 

A space between two bodies in a thermal analysis through which heat will flow.  

thermo-mechanical coupling 

See  coupled analysis.  

thick element formulation 

An element formulation that includes the effect of transverse shear deformation.  

thickness update 

A procedure used in plane stress situations where the thickness is updated due to the effect of Poisson‟s ratio.  

thin element formulation 

An element formulation that ignores the effect of transverse shear deformation.  

tied slideline 

A type of slideline setting that effectively ties two disconnected meshes together to move as if connected. 
See also slides.  

time domain 

The forcing function and the consequent response of a structure are defined in terms of time histories. The 

Fourier transform of the time domain gives the corresponding quantity in the frequency domain. See also  

frequency domain.  
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time step 

The period over which the time is integrated in a dynamic analysis. See also  dynamic analysis.  

toggle 

The act of turning on or off a function.  

toggle button 

A button on a dialog which represents a parameter which may take only one of two values (for example 

yes/no).  

total Lagrangian 

A strain formulation which has its reference as the initial configuration at the start of the analysis.  See also 
updated Lagrangian, Eulerian geometric nonlinearity.  

transformation dataset 

Describes a transformation in space, for example a translation, mirror, etc. which may be used to generate, 

move or copy features. See also  move, copy.  

transformed freedom 

The transformation of the local axis system of a node from the global system.  

transient analysis 

The field equivalent to a structural dynamic analysis in which the effects of thermal inertia are included (i.e. 
specific heat).  

transient response 

System response that is not periodic.  

transition mesh 

A mesh generated on a regular surface where the number of divisions on any two opposite boundary lines are 
unequal.  

Tresca stress 

The scalar stress state obtained by combining the individual component stresses at a point according to the 

classical Tresca failure criterion. Typically used in the failure of soil or granular type materials. See also  

Drucker-Prager stress.  

triaxial 

A description of a material model in which three axes are considered to determine the material response. See 
also  biaxial, uniaxial.  

TSR 

An acronym for terminate-and-stay-resident program.  See  also  memory-resident program.  
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unaveraged nodal results 

Most results are calculated at the Gauss points of an element and then extrapolated to the nodes. When the 

results from the elements joined at a node are extrapolated to the nodes but not averaged together these are 
known as unaveraged nodal results. See also averaged nodal results, smoothing.  

undeformed mesh 

A mesh displayed in its original shape without any imposed deflections.  See also  deformed mesh.  

under damped system 

A system which has an equation of motion where the damping is less than critical. It has an oscillating 

impulse response.  

unified creep 

A creep formulation whereby creep and plasticity are combined.  

uniaxial 

A description of a material model in which one axis is considered to determine the material response. See 
also  biaxial, triaxial.  

uniformly distributed load 

A load type which specifies a load per unit length along a line element or a load per unit area for a surface 

element.  

units 

A system of dimensions in which the model and associated properties and loads are defined. See also  SI 

units.  

unzoom 

The action of reverting to an unmagnified view of the structural model. See also  zoom.  

updated Lagrangian 

A strain formulation which has its reference as the end of the last converged increment.  See also  Eulerian 

geometric nonlinearity, total Lagrangian.  

upgrade 

To expand a system by installing options or using revised or updated software.  

utility dataset 

A utility dataset stores items in the database that are not assigned directly to features.  See also  

transformation dataset, control dataset.  

variable 

A quantity that can assume any set of values as a result of processing data.  
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variation 

A dataset used to vary an attribute over a feature. A variation dataset can be described in terms of field 

variables, interpolation values and functions.  

vector plotting 

Results with both a magnitude and direction may be represented by a vector whose length is proportional to 

the magnitude.  See also  displacement vectors, principal stress vectors.  

velocity 

First derivative of displacement with respect to time. See also  acceleration.  

view factor 

A measure used in a thermal radiation analysis to indicate how much exposure a face has to the radiation 
emitted from another face. A view factor will vary between 0 for no exposure and 1.0 for full exposure.  

virtual work 

The principle of virtual work states that, for any small, virtual displacement imposed on a body, the total 

internal work must equal the total external work for equilibrium to be maintained.  

visco-elastic 

A nonlinear time-dependent model in which strain is totally recoverable.  

visco-plastic 

A nonlinear time-dependent model in which there is a permanent set after unloading.  

viscous damping 

Damping can be said to be viscous when the damping force is proportional to the velocity. See also  

structural damping.  

volume 

Feature defining the solid nature of a structure. Defined as being bounded by surfaces.  

volumetric crushing model 

Represents the behaviour of crushable foams and certain soils which exhibit significant volumetric strain. It 
is applicable to plane strain, axisymmetric and 3D stress states only.  

von Mises stress 

The scalar stress state obtained by combining the individual component stresses at a point according to the 

classical von Mises failure criterion. Typically used in the failure of metals.  Also known as generalised 

stress, equivalent stress.  

warping 

The degree to which the nodes of a shell element do not lie in the same plane.  
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wdl file 

A windows definition language file used by LUSAS GRAPHICS to define the main menu bar and associated 

pull-down menus.  

wildcard 

A character that represents one or more other characters. For example, *.exe represents all files that end with 

the .exe extension.  

window 

A component screen area within the LUSAS GRAPHICS work area. For example, graphics window, text 
window.  

Wood-Armer 

Method of calculating the moments of resistance required in reinforcement that are placed in any two 

directions of a linear solution.  

word 

The set of bits comprising the largest unit that the computer can handle in a single operation.  

work norm 

A LUSAS convergence parameter which expresses the limit for the work done by residual forces based on 

iterative displacements as a percentage of the work done by the loads in the first iteration of a nonlinear 
problem. See also  convergence, displacement norm, residual norm.  

write-protect 

An action that can be taken with a diskette to prevent data being written to it. There is a switch in the corner 

of the diskette which when moved into the open position write-protects the diskette.  

XMS memory 

Extended memory that can be accessed by using the eXtended Memory Specification from Lotus, Intel, 

Microsoft and AST. LUSAS applications work with an extended memory manager which makes sure that 
only one application is using a portion of memory at any one time.  

yield criterion 

The condition used to establish whether a material has reached its ultimate elastic condition. See also  yield 

stress.  

yield flags 

Indicate the spread of plasticity in a nonlinear material by plotting yielded Gauss points.  

yield stress 

The level of stress at which a material is said to start unrecoverable or plastic behaviour. See also  Tresca 

stress, von Mises stress.  
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Young’s modulus 

The linear relationship between stress and strain for a Hookean material.  

zonal detection 

The area around each node on a slide surface that is used to search for contacting nodes on another surface.  

zoom 

The action of increasing the display magnification of a specified portion of the graphics screen or structural 

model. 
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Index 

A 

absolute envelope, 324 

acceleration loading, 200 

activation/deactivation of elements, 223 

active composite lamina, 248 

active composite layer, 321 

active fibre, 321 

active load case, 321 

active loadcase, 321 

active mesh, 119 

Age, 222 

Akhras-Dhatt optimiser, 309 

analysis, 313, 314 

analysis control, 279, 280 

animation, 368 

annotating the screen, 40 

frame coordinates, 42 

model coordinates, 42 

arbitrary sections 

calculation of properties, 276 

arc line, 79 

arc-length control, 284 

Area Selection, 410 

assign, 115 

associativity, 69 

attributes, 115, 116, 118, 119 

Australia steel sections, 152 

automatic equivalencing, 221 

axes, 249 

axisymmetric, 307 

B 

background grid, 131 

backup, 50 

basic combination, 327 

beam cross-section, 148 

beam loads, 199 

beam stress recovery, 358 

beam stresses, 355 

bending moment diagrams, 344 

BFP loading, 195 

birth and death, 223 

BMP, 375 

boolean geometry, 97 

boundary discretisation, 129 

Browsing Selected Features, 411 

buckling analysis, 292, 298 

C 

CAD, 114 

Canada steel sections, 152 

case studies, 44, 45, 114, 127 

geometry, 114 

meshing, 127 

CBF loading, 195, 217 
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centripetal stiffening, 296 

China steel sections, 153 

Cholesky  solver, 309 

CL loading, 195, 196, 217 

combinations, 324, 389 

combined line, 69, 82 

command bar, 9 

command files, 54 

command line, 9 

composite analysis, 241, 334 

Composite Damage Model, 177 

Composite layup 

defining, 243 

definition methods, 241 

visualisation, 245 

Composite model data 

visualisation, 247 

concentrated load, 195 

concrete heat of hydration, 164 

concrete material model, 164, 172, 352 

conduction, 227 

conjugate gradient solver, 309 

constant body force, 195 

constraint equations, 230 

contact, 227, 234 

contouring, 118, 343 

convection, 227 

coordinate system, 248 

copying geometry, 99 

coupled analysis, 302 

crack patterns, 352 

creep, 165, 176, 184, 291 

Cross-section, 148 

crushing material model, 182 

crystal reports, 382 

cursor, 75, 77, 85 

selection tool, 29 

customise startup templates, 44 

Cuthill-McKee optimiser, 309 

cycling geometric features, 111 

D 

Damage, 177 

damping, 223 

DAT, 66, 67 

data file, 50 

deactivate elements, 223 

deassigning attributes, 119 

default assignment, 151 

default attribute assignment, 116 

defining surface, 151 

definition for Surface, 151 

deformed mesh, 344 

delamination model, 141, 185 

deleting geometric features, 69 

design factors, 333 

Diagonal Decay, 400 

diagonal solver, 309 

diagrams, 349 

dimetric, 412 

Direction Definition, 273 

discrete loads, 201 

editing, 207 

discretisation, 120 

displacement loading, 200 

distance type 

multiple varying sections, 154 

Distributed Flux, 217 

distributed load, 196 

distributed mass, 140 

drained/undrained soil, 179 

draping, 243 
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Draping grid 

extending, 247 

visualisation, 247 

drawing attribute labels, 119 

Drucker-Prager material model, 171 

DXF, 60 

dynamic analysis, 300, 302 

E 

eccentricity, 150 

Eccentricity, 151 

edge collapsing, 128 

eigenvalue analysis, 292, 299, 406 

elasto-plastic material, 164, 167, 168, 

169, 171, 176 

ELDS loading, 199 

emulating behaviour, 14 

end releases for beam elements, 123 

envelopes, 324 

environmental load, 218 

ENVT/TDET loading, 218 

equivalencing, 220 

errors, 399 

EU steel sections, 153 

excel, 386 

Export 

files, 59 

Expressions 

supported, 419 

F 

facet, 71 

fatigue analysis, 331 

feature based models, 16 

Feature Selection, 409 

feature-based models, 16 

FiberSIM 

defining composite stack, 242 

Fibre directions 

visualisation, 246 

Fibre locations, 148, 358 

field loads, 217 

file types, 49, 50, 52, 53, 54, 55 

Fixing Mesh Problems, 136 

FLD loading, 196 

fleshing, 151 

Flux, 217 

foam material model, 182 

Fourier   expansion, 365 

Fourier analysis, 307 

Fourier results, 333, 365 

frequency response, 339 

Friction Pendulum, 187 

Frictional slideline, 234 

frontal solver, 309 

function, 259 

Functions 

supported, 419 

G 

general loads, 201 

geometric Attributes, 148 

Geometric Attributes, 151 

geometric nonlinearity, 282 

geometric properties, 149 

Geometric Properties, 147 

geometry, 69 

geometry orientation, 111 

getting help, 12 
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gnl, 282 

graph wizard, 354, 365 

graphing, 365 

groups, 33 

Guyan reduction analysis, 219, 294 

H 

HA/HB loading, 201 

Hashin failure contours, 335 

Hashin material model, 177 

heat of hydration, 164 

heat transfer, 227 

Heat transfer, 227 

help, 10 

hexahedral, 92 

highway load, 201 

Hill yield criteria, 167 

Hoffman yield criteria, 167 

holes, 86 

hollow volume, 95 

home view, 37 

hook contact, 190 

hyper-elasticity, 179 

I 

IFFLR, 335 

IGES, 62 

IMD, 299, 335, 365 

impact analysis, 234, 302 

Import 

files, 57, 59 

options, 57, 59 

Influence Attributes, 271, 272 

Initial Acceleration, 199 

Initial Velocity, 199 

Integration   options, 23 

interactive modal dynamics, 335 

interface elements, 137, 141 

interface files, 56 

interface material models, 352 

internal heat generation, 217 

inverse iteration solver, 295 

Isometric, 412 

isotropic material, 164 

J 

Joint 

defining and assigning, 137 

local axes, 139 

material properties, 140 

Joint and interface elements, 137 

joint material models, 187 

Joint Models, 187 

JPG, 375 

K 

keyboard shortcuts, 409 

knife edge load, 201 

KS steel sections, 153 

L 

labels, 74, 119 

Lamina thicknesses, 244 

Lanczos, 296 

lane load, 201 
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large strains, 179 

layup 

methods, 241 

Layup 

defining a composite stack, 243 

visualisation, 245 

Lead Rubber Bearings, 187 

libraries, 152, 164, 278 

Licensing, 13, 314 

lift-off, 190 

Line by manifolding, 78 

line elements, 145 

line feature, 69, 76 

linear, 187 

LMS CADA-X Files, 63 

load combinations, 324 

load curves, 254, 321 

load envelopes, 324 

Load train, 201 

loadcases 

creating, 252 

manipulating, 253 

viewing assignments, 254 

Loadcases 

creating, 252 

loading, 194 

local and global results, 323 

local coordinate, 248 

local sections, 153 

LT, 14 

lumped mass, 140 

M 

Manifolding, 91 

manipulating attributes, 116 

manipulating geometric features, 111 

manipulating the view, 37 

mass lumping, 140 

master degrees of freedom, 219 

master slideline, 235 

material data 

editing, 163 

material libraries, 164, 278 

material models, 165, 166, 167, 168, 169, 

170, 171, 176, 177, 178, 179, 180, 182, 

184, 185, 186, 187 

material properties, 162 

maximum value plots, 343 

maximum/minimum load, 324 

menus, 9 

merging geometric features, 103 

mesh, 98, 119 

mesh divisions, 120 

mesh lock, 137 

mesh objects, 15 

Mesh only models, 16 

mesh reset, 137 

mesh utilities, 136 

meshing techniques, 129 

Mesh-only models, 16 

message window, 9 

minimum value plots, 343 

mirror plane, 100 

modal dynamics, 335 

model file, 50 

Model Properties, 18 

model types, 15 

modeller licence selection, 13 

Modeller Results Files, 53 

Mohr-Coulomb material model, 170 

moving geometry, 99 

Multiple varying sections, 153 
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distance types and methods of 

assignment, 157 

N 

named components, 33 

natural frequency analysis, 292 

Negative Jacobian Errors, 399 

Negative Pivot, 402 

nodal equivalencing, 220 

nonlinear, 187 

nonlinear analysis, 162, 281, 287 

Non-Orthogonal Model Views, 412 

Non-structural mass elements, 140 

O 

Offsets, 149 

multiple varying sections, 155 

optimiser, 309 

orientation of geometry, 111 

Orthogonal Model Views, 412 

orthotropic material model, 164 

output, 317, 343, 368, 370 

P 

page layout, 39 

panning, 37 

patch load, 201 

Paths, 267 

PATRAN, 66 

PDSP/TPDSP loading, 218 

peak value plots, 343 

pen library, 26 

pentahedral, 92 

picture files, 54 

pictures, 374 

Pivot Errors, 403 

pivot problems, 399 

Planar, 76 

Plastic, 149 

playback 

script, 54 

Plotting results for attributes, 351 

Plotting results for groups, 350 

plotting results on a graph, 365 

plus elements, 144 

point feature, 69, 75 

point load, 201 

point mass, 140 

polymer material model, 184 

pore pressure, 179, 190 

power spectral density, 340 

prescribed loads, 200 

printed output, 370 

Printing and Saving Pictures, 374 

properties, 162, 223, 227 

properties dialog, 9 

PSD response, 335 

Q 

quadratic elements, 121 

R 

radiation properties, 227 

Real numbers, 419 

record 
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script, 54 

Reference path, 267 

report 

add chapter, 376 

add eigenvalue data, 380 

add image, 381 

add loadcase data, 379 

add model data, 377 

add user data, 381 

creating, 376 

creating subreports, 383 

delete, 388 

exporting, 385 

printing, 388 

results subchapter, 378 

spreadsheet output, 386 

viewing, 382 

word output, 387 

report generator, 375 

report template, 375 

reports, 375 

resize the model to fit the screen, 37 

results, 317, 322, 323, 343, 365, 368 

results file, 317, 319 

retained freedoms, 219 

reversing geometric features, 111 

right-click menu, 9 

rigidities, 166 

RIHG loading, 217 

rotating the model, 37 

rubber material models, 180 

S 

saving a view, 26 

scaling geometry, 99 

script 

recording, 44, 45 

script files, 53 

Scripts 

running with toolbar buttons, 46 

scrolling the model, 37 

search areas, 209 

processing loads outside, 212 

section library, 152 

Section property calculation, 274 

multiple varying sections, 156 

section through the model, 353 

seismic isolator, 187 

selecting model features, 28, 409 

selection memory, 32 

Selection Modifiers, 410 

server sections, 153 

session file, 54 

set default, 116 

setting active composite lamina, 248 

setting active loadcase, 254 

setting the environment colours and style, 

42 

shape wizard, 96 

shear force diagrams, 343 

shear lag 

with wide flanged sections, 355 

short-cut menu, 9 

Simulayt, 242 

slave degrees of freedom, 219 

slave slideline, 234 

slice, 353 

slidelines, 234, 366 

results, 361 

Sloan optimiser, 309 

smart combinations, 325, 389 

S-N curve, 331 

soil material modelling, 179 

solver, 314 

solver results files, 52 

solving the model, 50, 279 
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spectral response, 299, 336 

splitting geometric features, 81, 89 

splitting options, 89 

SSI and SSR loading, 198 

Standard sections 

calculation of properties, 275 

startup templates, 44 

status bar, 10 

STEP, 67 

stiffness analysis, 292 

STL, 68 

stress and strain, 198 

stress potential, 167 

stress resultant material model, 176 

stress vectors, 347 

structural damping, 223 

structural loads, 195 

Sturm sequence check, 295 

subreports, 383 

subspace iteration solver, 293 

superelements, 219 

support conditions, 190 

surface elements, 146 

surface feature, 69, 85 

T 

Tapering, 148 

TDET loading, 218 

TEMP loading, 197 

temperature loading, 197 

text output, 11 

thermal analysis, 217, 227, 302, 304, 305 

thermal restraint conditions, 190 

thermal surface graphs, 365 

Thermal Surface Results, 364 

thermal surfaces, 227 

Thermal surfaces, 227 

thermo-mechanical coupled analysis, 302 

Thickness, 151 

thin beam elements, 150 

Tied slidelines, 234 

time history, 339 

Tip, 415 

Tips, 415 

TMPE loading, 197 

toolbar buttons 

user-defined, 46 

toolbar groups, 45 

customising layout, 46 

toolbars, 45 

TPDSP loading, 218 

transformations, 99, 322 

transient analysis, 300, 302, 305 

translating geometry, 99 

treeview, 9 

Tresca material model, 169 

trimetric, 413 

troubleshooting, 399 

trouble-shooting, 406 

two-phase analysis, 179, 190 

U 

UDL loading, 196 

UK steel sections, 153 

undo / redo, 39 

uniformly distributed load, 196 

units, 279 

US steel sections, 153 

User, 153 

utilities, 257 
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V 

values, 348 

variations, 258 

vbs, 53 

vectored results plots, 343 

vehicle loading, 201 

velocity loading, 200 

vertical axis, 273 

view, 26, 411 

viscosity, 165, 178 

Viscous dampers, 187 

viscous damping, 223 

visual basic, 53 

Visualise, 148 

visualise users, 116 

visualising, 70, 118, 222, 343, 353, 365, 

369, 371 

contour plots, 346 

deformed mesh, 345 

results, 343, 353, 365, 368 

Visualising 

composite properties, 247 

volume elements, 146 

volume feature, 69, 92 

volumetric crushing material model, 182 

von-Mises material model, 167, 168 

W 

Window Properties, 43 

windows, 26, 413 

WMF, 375 

Wood Armer, 330 

Y 

yielded material visualisation, 352 

Z 

Zoom, 411 

zooming, 37 
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